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하늘 아래 새로운 것이 있을까 학문은 모방을 통해 발전하고 정보공유를 통해 세상에 대한 이해는 빨라지* ?

고 지식의 지평선은 넓어진다고 생각합니다 이 자료는 출처를 밝히지 않고 자유로이 사용하셔도 됩니다 많. .

이 사용하셔야 제가 쓰레기를 만들어 낸 것이 아니라는 위안을 받을 수 있으니까요.
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마이컴이란 프로그램 메모리 데이터 메모리 입출력 포트 등으로 구성된 작은 규모의 컴퓨터인 마이크로컴퓨터, ,

의 기능을 단일칩에 집적해 구현한 단일칩 마이크로컴퓨터를 지칭하는 말로 마이크로콘트롤러라고도 불리운다 마.

이컴은 아래와 같은 특성을 갖기 때문에 모든 산업 전반에 걸쳐 다양하게 응용되고 있다.

� 소형화와 경량화 다양한 기능을 기술에 의해 단일 칩에 집적해 구현했기 때문에 제품 제작시 소형화와: VLSI

경량화를 실현할 수 있다.

� 쉽고 편리한 개발 입출력 인터럽트 처리 비트 조작 명령어가 많아 프로그램 작성이 수월하여 개발을 빨리: , ,

할 수 있다.

� 저가격 개발비 부품비와 제작비를 감소시켜 제품의 가격을 저렴하게 할 수 있다: , .

� 융통성 프로그램 변경만으로 기능을 변경하거나 확장시키는 것을 짧은 시간내에 수월하게 할 수 있다: .

� 신뢰성 마이크로컴퓨터의 기능이 기술에 의해 단일 칩에 집적되어 있기 때문에 제품의 부품수를 줄일: VLSI

수 있어 제품의 구성을 간단하게 하고 고장률을 줄일 수 있으며 고장시 유지 보수가 쉽다.

마이컴의 시초는 인텔사가 년 여개의 트랜지스터를 집적하여 개의 명령어 개의 주소선 개의1971 2300 , 46 , 12 , 16

내부 비트 범용레지스터를 사양으로 의 발진주파수에서 동작하도록 만든 비트 마이컴 이다 그 후4 108kHz 4 4004 .

인텔은 년에는 를 개선한 비트 마이크로 프로세서를 년에는 을 개선한 비트1972 4004 8008 8 , 1973 8008 8080 8

프로세서를 발표하였다 년에는 에서 중앙처리장치와 메모리 입출력 장치를 단일칩에 내장한. 1975 TI , , TMS1000

시리즈를 출시하여 마이컴 시대를 열었고 이후 마이크로프로세서의 개발은 연산용 프로세서와 제어용 마이컴으로

분화되었다 년에는 비트 마이컴 가 포함된 시리즈를 인텔사에서 출시하고 그 상. 1976 8 8048, 8748, 8035 MCS48

위버전인 시리즈의 을 년에 출시한 이 후 여러 회사에서 계속적으로 향상된 기능의 마이컴을 출MCS51 8051 1981

시하고 있다.

인텔의 모토로라의 마이크로의 이나 삼성전자의 등 비트의 고성능 마80960, 68332, ST ST40 STR7, KS32 32

이컴도 있지만 아직 비트 마이컴이 가전제품 카메라 리모콘 전자레인지 공기청정기 등 사무8 (TV/VCR, CD, , , , ) ,

기기 모니터 마우스 키보드 스캐너 프린터 복사기 팩스 시스템 바코드리더 탁상계산기 하드디스크( , , , , , , , PC LAN , , ,

등 통신기기전화기 자동응답기 모뎀 발신자 확인기 등 자동차 속도측정기 운항제어 자), ( , , , ), (ABS, , Power seat, ,

동경보기 온도제어 연료제어 센서 제어 등 계측기 자동차 주행 시험장의 점수 계, , , Air bag , Sun roof ), , CCTV,

산장치 신용카드리더 공정제어 등 산업 전반에 걸쳐 다양하게 응용되고 있는 형편이다 그리고 인텔의, PLC, , .

모토로라의 마이크로의 시리즈 의 시리즈 의 의8051, 68HC11, ST ST7 , Microchip PIC , Zilog Z88C00, Atmel AVR

등의 비트 마이컴에서 의 은 교육로봇8 Atmel AVR (robotkim.com), US Technology(www.us-technology.co.kr),

로보블록 마이컴월드 등 국내 여러 회사에서 값싼 키트를 공급하고(roboblock.co.kr), (www.micomworld.co.kr)

있으며 이 플래쉬롬을 내장하여 값싸고 쉽게 프로그래밍이 가능한 이점을 갖고 있어 초보자들이 쉽게 구현해AVR

볼 수 있으므로 여기에서는 그 가운데 시스템 개발의 기초와 응용을 다룬다AVR ATmega128 .

장에서는 의 구조와 기능에 대하여 설명하고 장에서는 시스템 개발을 위한 환경을 꾸미는1 ATmega128 2 AVR

방법과 어셈블리어와 언어에 대한 설명을 한다 장에서는 기초적인 프로그램과 단순 입출력을 위한 프로그램C . 3

작성과 실습을 다루고 장에서는 타이머와 인터럽트를 사용한 프로그램 작성과 실습을 다룬다 장에서는 응용실4 . 5

험으로 마이컴 시스템의 고기능화를 위해 사용되는 키보드 와 변환 모터 스피커 등 다양한FND, , D/A A/D , , , LCD

주변장치에 대한 설명과 이들을 이용한 응용 시스템을 위한 프로그램 작성과 실습을 다룬다.

아무쪼록 본 책이 독자들의 마이컴 시스템 개발 능력을 향상시키는데 일조하길 바랍니다.

년 여름 최한호2007
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1.1.1.1.1.1.1.1.1.1.1.1. 개요개요개요개요AVRAVRAVRAVR 개요개요개요개요AVRAVRAVRAVR 개요개요개요개요AVRAVRAVRAVR

1.1.1.1.1.1.1.1.1.1.1.1.1.1.1.1.1.1.1.1.1.1.1.1. 의 일반적 특징의 일반적 특징의 일반적 특징의 일반적 특징AVRAVRAVRAVR의 일반적 특징의 일반적 특징의 일반적 특징의 일반적 특징AVRAVRAVRAVR의 일반적 특징의 일반적 특징의 일반적 특징의 일반적 특징AVRAVRAVRAVR

은 사의 마이컴들로 저가의 고기능 마이컴으로 다음과 같은 특성을 갖고 있다AVR Atmel .

� 유사 구조 명령어가 많고 복잡하며 주소지정방식도 다양한RISC (Reduced Instruction Set Code) : CISC

방식이 사용된 에 비해 명령어와 주소지정방식이 작지 않지만 유사(Complex Instruction Set Code) 8051 RISC

구조로 연산 및 전송이 레지스터간에 직접 이루어지고 명령어의 길이가 비트 워드로 고정적이어 디코딩이 쉬16 1

운 특징을 갖고 있으며 발진주파수를 분주해서 내부클록으로 사용하는 과 달리 발진주파수와 같은 내부클8051

록을 사용하며 대부분 기계사이클에 명령어가 실행되어 보통 당 의 처리속도를 보인다 결국 통상1 1MHz 1MIPS .

적인 처럼 명령어와 주소지정방식이 작지 않아 어셈블리어 프로그램 작성에서 불리하지도 않으면서도 통상RISC

적인 처럼 속도가 매우 빠른 유사 의 특성을 갖고 있다RISC RISC .

� 하바드 구조의 메모리 구성 처럼 프로그램 메모리와 데이터 메모리가 구분되지 않은 폰노이만 방식이: Z80

아니고 과 같이 프로그램 메모리와 데이터 메모리가 분리되어 있는 하바드 구조를 채택하였다TMS320 .

� 저전력 소모 기술을 채택하고 있어 소비전력이 매우 적고 동작전압이 로 큰 장점이 있다: CMOS 1.8-5.5V .

다양한 동작 모드를 제공해 저전력 동작을 지원한다.

� 큰 잡음여유와 입력 임피던스 기술을 채택하고 있어 잡음여유와 입력 임피던스가 큰 장점이 있으나: CMOS

정전기 및 과전압에 의한 파손 위험이 큰 단점도 있다.

� 고집적 기술에 의해 플래시롬 메모리와 변수 저장을 위한 및 이 작은: CMOS 1K-256Kbyte EEPROM SRAM

칩 하나에 내장되어 있다.

� 고속 유사 구조와 개의 레지스터 사용과 고집적으로 대부분 기계사이클에 명령어가 실행되어 보통: RISC 32 1

당 의 처리속도를 보인다1MHz 1MIPS .

� 효율적인 프로그래밍 언어를 고려하여 설계하였으며 개의 레지스터와 와 유사한 주소지정 방식를 사용: C 32 C

하고 있으며 비트와 비트의 산술 연산을 지원하여 효율적으로 최적의 프로그램을 가능하게 한다16 32 .

� 다양하고 값싼 개발 도구 공짜의 개발 도구인 와 값싼 평가보드나 키트가 이용가능하다: AVR Studio Starter .

� 다양한 사양 지원 핀에서 핀의 외형과 이에 상응하는 메모리와 기능을 갖는 다양한 시리즈의 제품이 존: 8 100

재하여 적절한 응용에 대응하여 제어기를 개발할 수 있다.

� 지원 내부에 롬라이터와 같은 기능을 하는 부분이 내장되어 있어 내부 플래시롬ISP (In System Program) :

을 롬라이터없이 읽고 쓰기가 가능하여 따로 값 비싼 롬라이터를 이용하지 않고도 기판 상에 마이컴을 실PCB

장하고 전원과 클럭이 공급되는 상태에서 프로그래밍이 가능한 기능이 제공된다ISP .

1.2.1.2.1.2.1.2.1.2.1.2.1.2.1.2.1.2.1.2.1.2.1.2. 의 종류의 종류의 종류의 종류AVRAVRAVRAVR의 종류의 종류의 종류의 종류AVRAVRAVRAVR의 종류의 종류의 종류의 종류AVRAVRAVRAVR

사의 비트 마이컴 은 크게 시리즈로 나뉠 수 있다 표 은 의 사양을 보여Atmel 8 AVR Tiny, AT90, Mega . 1 AVR

준다.

� 시리즈 핀수가 핀 정도의 작은 외형으로 대부분 외부 시스템버스가 없고 내부에 정Tiny : 8-24 1K-2K byte

도의 플래시 메모리를 가지고 있어 용량도 작은 편이다 를 지원하지 않고 타이머가 없으며 비트. UART RTC 16

타이머가 없고 비트 타이머만 개 있는 등 기능이나 성능이 비교적 낮지만 가격이 저렴하여 소형제어기에8 1-2

적당하다.

� 시리즈 핀 정도의 외형을 갖고 내부에 정도의 플래시 메모리와Mega : 28-100 8K-256Kbyte 256-4K byte

정도의 과 의 을 내장하고 있다 의 클럭에서 의 속도를 갖는 등 성EEPROM 512-4K byte SRAM . 20MHz 20MIPS

능과 기능이 높으나 가격도 높다.
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� 시리즈 중간정도 사양을 가진 시리즈로 의 경우에는 사양화 되었다AT90 : AT90S .

DeviceDeviceDeviceDevice FlashFlashFlashFlash
(K)(K)(K)(K)

EEPROMEEPROMEEPROMEEPROM
(K)(K)(K)(K)

SRAMSRAMSRAMSRAM
(byte)(byte)(byte)(byte)

M a xM a xM a xM a x
I/OI/OI/OI/O

F.maxF.maxF.maxF.max
(MHz)(MHz)(MHz)(MHz) Vcc (V)Vcc (V)Vcc (V)Vcc (V) 16-bit16-bit16-bit16-bit

TimersTimersTimersTimers
8-bit8-bit8-bit8-bit
TimerTimerTimerTimer

PWMPWMPWMPWM
채널채널채널채널( )( )( )( ) UARTUARTUARTUART TWITWITWITWI A/DA/DA/DA/D

채널채널채널채널( )( )( )( ) 인터럽트인터럽트인터럽트인터럽트

AT90PWM1 8 0.5 512 19 16 2.7-5.5 1 1 7 No -- 11 26

AT90PWM2 8 0.5 512 19 16 2.7-5.5 1 1 7 Yes -- 11 29

AT90PWM216 16 0.5 1024 19 16 2.7-5.5 1 1 10 Yes -- 11 29

AT90PWM3 8 0.5 512 27 16 2.7-5.5 1 1 10 Yes -- 11 29

AT90PWM316 16 0.5 1024 27 16 2.7-5.5 1 1 10 Yes -- 11 29

ATmega128 128 4 4096 53 16 2.7-5.5 2 2 8 2 Yes 8 34

ATmega1280 128 4 8192 86 16 1.8-5.5 4 2 16 4 Yes -- 57

ATmega1281 128 4 8192 54 16 1.8-5.5 4 2 9 2 Yes -- 48

ATmega128RZAV 128 4 8192 54 16 1.8-5.5 4 2 9 2 Yes -- 48

ATmega128RZBV 128 4 8192 86 16 1.8-5.5 4 2 16 4 Yes -- 57

ATmega16 16 0.5 1024 32 16 2.7-5.5 1 2 4 1 Yes -- 20

ATmega162 16 0.5 1024 35 16 1.8-5.5 2 2 6 2 -- -- 28

ATmega164P 16 0.5 1024 32 20 1.8-5.5 1 2 6 2 Yes 8 31

ATmega165 16 0.5 1024 54 16 1.8-5.5 1 2 4 1 USI -- 23

ATmega165P 16 0.5 1024 54 16 1.8-5.5 1 2 4 1 USI -- 23

ATmega168 16 0.5 1024 23 20 1.8-5.5 1 2 6 1 Yes 6/8 26

ATmega168P 16 0.5 1024 23 20 1.8-5.5 1 2 6 1 Yes 8 26

ATmega169 16 0.5 1024 54 16 1.8-5.5 1 2 4 1 USI -- 23

ATmega169P 16 0.5 1024 54 16 1.8-5.5 1 2 4 1 USI -- 23

ATmega2560 256 4 8192 86 16 1.8-5.5 4 2 16 4 Yes -- 57

ATmega2561 256 4 8192 54 16 1.8-5.5 4 2 9 2 Yes -- 48

ATmega256RZAV 256 4 8192 54 16 1.8-5.5 4 2 9 2 Yes -- 48

ATmega256RZBV 256 4 8192 86 16 1.8-5.5 4 2 16 4 Yes -- 57

ATmega32 32 1 2048 32 16 2.7-5.5 1 2 4 1 Yes -- 19

ATmega324P 32 1 2048 32 20 1.8-5.5 1 2 6 2 Yes -- 31

ATmega325 32 1 2048 54 16 1.8-5.5 1 2 4 1 USI -- 23

ATmega3250 32 1 2048 69 16 1.8-5.5 1 2 4 1 USI -- 32

ATmega3250P 32 1 2048 69 20 1.8-5.5 1 2 4 1 USI -- 32

ATmega325P 32 1 2048 54 20 1.8-5.5 1 2 4 1 USI -- 23

ATmega328P 32 1 2048 23 20 1.8-5.5 1 2 6 1 Yes 8 26

ATmega329 32 1 2048 54 16 1.8-5.5 1 2 4 1 USI -- 25

ATmega3290 32 1 2048 69 16 1.8-5.5 1 2 4 1 USI -- 25

ATmega3290P 32 1 2048 69 20 1.8-5.5 1 2 4 1 USI -- 25

ATmega329P 32 1 2048 54 20 1.8-5.5 1 2 4 1 USI -- 25

ATmega406 40 0.5 2048 18 1 4.0-25 1 1 1 -- Yes -- 23

ATmega48 4 0.25 512 23 20 1.8-5.5 1 2 6 1 Yes 6/8 26

ATmega48P 4 0.25 512 23 20 1.8-5.5 1 2 6 1 Yes 6/8 26

ATmega64 64 2 4096 54 16 2.7-5.5 2 2 8 2 Yes -- 34

ATmega640 64 4 8192 86 16 1.8-5.5 4 2 16 4 Yes -- 57

ATmega644 64 2 4096 32 20 1.8-5.5 1 2 6 1 Yes -- 31

ATmega644P 64 2 4096 32 20 1.8-5.5 1 2 6 2 Yes -- 31

ATmega645 64 2 4096 54 16 1.8-5.5 1 2 4 1 USI -- 23

ATmega6450 64 2 4096 69 16 1.8-5.5 1 2 4 1 USI -- 32

ATmega649 64 2 4096 54 16 1.8-5.5 1 2 4 1 USI -- 25

ATmega6490 64 2 4096 69 16 1.8-5.5 1 2 4 1 USI -- 25

ATmega64RZAPV 64 2 4096 32 20 1.8-5.5 1 2 6 2 Yes -- 31

ATmega64RZAV 64 2 4096 32 20 1.8-5.5 1 2 6 1 Yes -- 31

ATmega8 8 0.5 1024 23 16 2.7-5.5 1 2 3 1 Yes 6/8 18

ATmega8515 8 0.5 512 35 16 2.7-5.5 1 1 3 1 -- -- 16

ATmega8535 8 0.5 512 32 16 2.7-5.5 1 2 4 1 Yes -- 20

ATmega88 8 0.5 1024 23 20 1.8-5.5 1 2 6 1 Yes 6/8 26

ATmega88P 8 0.5 1024 23 20 1.8-5.5 1 2 6 1 Yes 8 26

ATtiny11 1 -- -- 6 6 2.7-5.5 -- 1 -- -- -- -- 4

ATtiny12 1 0.0625 -- 6 8 1.8-5.5 -- 1 -- -- -- -- 5

ATtiny15L 1 0.0625 -- 6 1.6 2.7-5.5 -- 2 1 -- -- 4 8

ATtiny2313 2 0.125 128 18 20 1.8-5.5 1 1 4 1 USI -- 8

ATtiny24 2 0.125 128 12 20 1.8-5.5 1 1 4 -- USI 8 17

ATtiny25 2 0.125 128 6 20 1.8-5.5 -- 2 4 -- USI 4 15

ATtiny26 2 0.125 128 16 16 2.7-5.5 -- 2 2 -- USI 11 11

ATtiny261 2 0.125 128 16 20 1.8-5.5 1 2 2 -- USI 11 19

ATtiny28L 2 -- 32 11 4 1.8-5.5 -- 1 -- -- -- -- 5

ATtiny44 4 0.25 256 12 20 1.8-5.5 1 1 4 -- USI 8 17

ATtiny45 4 0.25 256 6 20 1.8-5.5 -- 2 4 -- USI 4 15

ATtiny461 4 0.25 256 16 20 1.8-5.5 1 2 2 -- USI 11 19

ATtiny84 8 0.5 512 12 20 1.8-5.5 1 1 4 -- USI 8 17

ATtiny85 8 0.5 512 6 20 1.8-5.5 -- 2 4 -- USI 4 15

ATtiny861 8 0.5 512 16 20 1.8-5.5 1 2 2 -- USI 11 19

표 1 의 종류와 사양. AVR
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1.3.1.3.1.3.1.3.1.3.1.3.1.3.1.3.1.3.1.3.1.3.1.3. 의 특징의 특징의 특징의 특징ATmega128ATmega128ATmega128ATmega128의 특징의 특징의 특징의 특징ATmega128ATmega128ATmega128ATmega128의 특징의 특징의 특징의 특징ATmega128ATmega128ATmega128ATmega128

그림 은 의 블록선도로 다음과 같은 특징을 갖는다1 ATmega128 .

� 유사 구조 대부분 한 클럭에 동작하는 개의 명령어 개의 비트 범용 레지스터 에서RISC : 133 , 32 8 , 16MHz

의 성능 사이클에서 실행되는 내장 곱셈장치16MIPS , 2

� 개의 모드 모6 Sleep : idle, ADC noise reduction, power save, power down, standb, extended standby

드 지원

� 메모리 의 번까지 를 이용해 쓰고 지우기 가능한 플래시 롬 내장하고 있으며 부트 코드: 128K byte 10000 ISP

영역으로 사용 가능 십만번까지 쓰고 지우기 가능한 바이트의 내장 바이트의 을 내장 최, 4K EEPROM , 4K SRAM ,

대 바이트의 외부 데이터 메모리 추가 가능 소프트웨어의 보안을 위한 프로그램 잠금 기능 제공64K ,

� 개의 범용레지스터와 직접 연결되어 수학연산 논리연산 비트 연산을 보통 한 개의 시스템 클럭안에ALU : 32 , ,

서 수행한다.

� 프로세서가 안정적으로 동작하는지 감시하는 기능을 수행한다 프로세서에 이상이 생겨 일Watchdog Timer : .

정 시간마다 가 리셋되지 않게 되는 경우 시스템에 인터럽트를 발생시켜 프로세서를 초기화 시Watchdog Timer

키는 동작이 이루어지게 하여 안정적인 동작을 보장할 수 있다.

� 입출력 개의 비트 병렬 포트와 개의 비트 병렬 포트로 총 개의 프로그램 가능한 입출력 선I/O : 6 8 I/O 1 5 I/O 53

을 갖고 있다.

� 타이머카운터 개의 비트 타이머타이머 와 와 개의 비트 타이머타이머 와 를 가지고 있다 이들/ : 2 8 ( 0 2) 2 16 ( 1 2) .

은 개의 비트 출력 비트 출력 출력비교 단자 등과 관련되어 동작한다2 8 PWM , 2-16 PWM , .

� 변환기 채널의 비트 변환기를 제공한다 이들은 개의 단일입력 혹은 개의 차동입력 채널로 사AD : 8 10 AD . 8 7

용 가능하며 개중 프로그램이 가능한 입력 게인 을 갖는 개의 채널이 존재한다, 8 (1x, 10x, 200x) 2 .

� 비교기 아날로그 비교기를 개 내장하고 있다: 1 .

� 발진기 발진기를 내장하고 있으며 외부에서 크리스탈을 접속해 정확한 클럭소스를 사용할 수도 있다: RC .

� 직렬통신포트 동시 양방향 전송이 가능한 범용 동기비동기 직렬 통신 기능을 제공하(Serial Port) : / (USART)

는 직렬통신포트를 개 존재하여 쉽게 통신을 구현할 수 있다2 RS232C .

� 인터럽트 리셋과 개의 외부인터럽트를 포함하여 총 개의 인터럽트 벡터를 가지고 있다: 8 35 .

� 인터페이스 인터페이스로 플래시 퓨즈 비트를 프로그램이 가능하며 내장된JTAG : JTAG , EEPROM, , Lock ,

상태에서 디버그를 가능하게 한다.

� 인터페이스 는 오직 라인을 이용한 통신 방법으로SPI (Serial Peripheral Interface) : SPI 3 MOSI (Master

Out Slave In), MISO (Master In Slave Out), 신호를 이용한다 에서 개발되었으SCK (Serial ClocK) . Motolora

며 와 가 에 동기하여 데이터를 교환하는 방식으로 마이컴의 리셋 핀을 으로 한 상태에Master Slave SCK RST( ) 0

서 앞의 세 시그널을 이용하여 메모리의 데이터를 읽고 쓰기가 가능하다 즉 내부에 롬라이터와 같은 기능을 하.

는 부분이 내장되어 있어 내부 플래시롬을 롬라이터없이 읽고 쓰기가 가능하므로 가 지원되면 따로 롬라이터SPI

를 이용하지 않고도 기판 상에 마이컴을 실장하고 전원과 클럭이 공급되는 상태에서 프로그래밍이 가능한PCB

기능이 제공된다ISP(In System Programming) .

� 동작 범위 정상적인 동작의 경우 모드의 경우 파워 다운 모드의 경우 마이크로 이하를: 5.5mA, idle 1.6mA, 1 A

소비한다 도부터 도사이에서 동작가능하고 의 경우 에서 최대 에서 동작 가. -40 85 ATmega128L 2.7-5.5V 8MHz

능하고 의 경우 에서 최대 에서 동작 가능하다, ATmega128 4.5-5.5V 12MHz .
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그림 1 의 블록선도출처. ATmega128 ( :ATMEL)

1.4.1.4.1.4.1.4.1.4.1.4.1.4.1.4.1.4.1.4.1.4.1.4. 외형과 핀 기능외형과 핀 기능외형과 핀 기능외형과 핀 기능외형과 핀 기능외형과 핀 기능외형과 핀 기능외형과 핀 기능외형과 핀 기능외형과 핀 기능외형과 핀 기능외형과 핀 기능

은 그림 와 같이 핀을 갖는 형 또는 형ATmega128 2 64 TQFP(Thin Quad Flat Pack) MLF(Micro Lead Frame)

이 있다.

� RESET 핀 입력단자로 레벨이 입력되면 리셋되어 는 일반적으로 번지를 가르키( 20) : 1 PC(Program Counter) 0

고 번지부터 프로그램이 시작됨 절 참조 리셋시 대부분의 레지스터는 으로 된다0 (1.5.9 ). 0 .

� 핀 발진용 증폭기 입력 및 출력 단자XTAL1, XTAL2( 24,23) : .

� 핀 전원 입력 단자Vcc( 21,51) : .

� 핀 그라운드 입력 단자GND ( 22,53,63) : .

� 핀 변환기 및 포트 에 대한 공급 전압AVCC( 64) : AD F
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그림 2 의 핀배치출처. ATmega128 ( :ATMEL)

� 핀 참조 전압AREF( 62) : ADC

� PEN 핀 를 활성화시키는 단자로 일반적인 동작모드에서는 사용하지 않고 파워 온 리셋시 상태로 유( 1) : SPI 0

지해 를 허용하게 한다SPI

� 포트 핀 내부 풀업 저항이 있는 비트 양방향 입출력 단자 외부메모리를 둘 경우에는A (PA7~PA0: 44-51) : 8 .

주소버스 와 데이터버스 로 사용(A7-A0) (D7-D0) .

� 포트 핀 내부 풀업 저항이 있는 비트 양방향 입출력 단자 용 단자 혹은 단자B (PB7~PB0: 10-17) : 8 . SPI PWM

로도 사용된다표 참조( 2 ).

포트 핀 다른 특수 기능

핀PB7( 17) 타이머 용의 비교신호 출력 혹은 타이머 용의 비교신호 출력OC2,OC1C : 2 1 C

핀PB6( 16) 타이머 용의 비교신호 출력OC1B : 1 B

핀PB5( 15) 타이머 용의 비교신호 출력OC1A : 1 A

핀PB4( 14) 타이머 용의 비교신호 출력OC0 : 0

핀PB3( 13) 채널의 마스터 데이터 입력 혹은 슬레이브 데이터 출력 신호 단자MISO : SPI

핀PB2( 12) 채널의 마스터 데이터 출력 혹은 슬레이브 데이터 입력 신호 단자MOSI : SPI

핀PB1( 11) 채널의 마스터 클럭 출력 혹은 슬레이브 클럭 입력 신호 단자SCK : SPI

핀PB0( 10) SS 태널의 슬레이브 선택 입력 신호 단자: SPI

표 2 포트 의 다른 기능 설명. B

� 포트 핀 내부 풀업 저항이 있는 비트 양방향 입출력 단자 외부메모리를 둘 경우에는C (PC7~PC0: 35-42) : 8 .

주소버스 로 사용된다(A15-A8) .
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� 포트 핀 내부 풀업 저항이 있는 비트 양방향 입출력 단자 타이머용 단자 혹은 외부인D (PD7~PD0: 25-32) : 8 .

터럽트용 단자로도 사용된다표 참조( 3 ).

포트 핀 다른 특수 기능

핀PD7( 25) 타이머 클럭 입력T2 : 2

핀PD6( 26) 타이머 클럭 입력T1 : 1

핀PD5( 27) 외부클럭 입출력XCK : USART1

핀PD4( 28) 타이머 입력 캡춰ICP1 : 1

핀PD3( 29) 외부인터럽트 혹은 송신INT3/TXD1 : 3 USART1

핀PD2( 30) 외부인터럽트 혹은 수신INT2/RXD1 : 2 USART1

핀PD1( 31) 외부인터럽트 혹은 선 방식의 직렬 인터페이스용 데이터 단자INT1/SDA : 1 2

핀PD0( 32) 외부인터럽트 혹은 선 방식의 직렬 인터페이스용 클록 단자INT0/SCL : 0 2

표 3 포트 의 다른 기능 설명. D

� 포트 핀 내부 풀업 저항이 있는 비트 양방향 입출력 단자 타이머용 단자 외부인터럽트E (PE7~PE0: 2-9) : 8 . , ,

아날로그 비교기 용 단자로도 사용된다표 참조, USART ( 4 ).

포트 핀 다른 특수 기능

핀PE7( 2) 외부인터럽트 혹은 타이머 입력 캡춰INT7/ICP3 : 7 3

핀PE6( 3) 외부인터럽트 혹은 타이머 클럭 입력INT6/T3 : 6 3

핀PE5( 4) 외부인터럽트 혹은 타이머 용의 비교신호 출력INT5/OC3C : 5 3 C

핀PE4( 5) 외부인터럽트 혹은 타이머 용의 비교신호 출력INT4/OC3B : 4 3 B

핀PE3( 6) 비교기 입력 혹은 타이머 용의 비교신호 출력AIN1/OC3A : - 3 A

핀PE2( 7) 비교기 입력 혹은 외부 클럭 입출력AIN0/XCK0 : + USART0

핀PE1( 8) 프로그램 데이터 출력 케이블의 와 연결 혹은 송신PDO/TXD0 : (ISP MISO ) USART0

핀PE0( 9) 프로그램 데이터 입력 케이블의 와 연결 혹은 수신PDI/RXD0 : (ISP MOSI ) USART0

표 4 포트 의 다른 기능 설명. E

� 포트 핀 내부 풀업 저항이 있는 비트 양방향 입출력 단자 변환기 혹은 인터F (PF7~PF0: 54-61) : 5 . AD JTAG

페이스용 단자로도 사용된다표 참조( 5 ).

포트 핀 다른 특수 기능

핀PE7( 54) 입력채널 혹은 테스트용 데이터 입력 단자ADC7/TDI : ADC 7 JTAG

핀PE6( 54) 입력채널 혹은 테스트용 데이터 출력 단자ADC6/TDO : ADC 6 JTAG

핀PE5( 54) 입력채널 혹은 테스트용 모드 선택 단자ADC5/TMS : ADC 5 JTAG

핀PE4( 54) 입력채널 혹은 테스트용 클럭 단자ADC4/TCK : ADC 4 JTAG

핀PE3( 54) 입력채널ADC3 : ADC 3

핀PE2( 54) 입력채널ADC2 : ADC 2

핀PE1( 54) 입력채널ADC1 : ADC 1

핀PE0( 54) 입력채널ADC0 : ADC 0

표 5 포트 의 다른 기능 설명. F

� 포트 핀 내부 풀업 저항이 있는 비트 양방향 입출력 단자 외부 메모리G (PG4~PE0: 19, 18, 43, 34, 33) : 8 .

접속을 위한 스트로브 신호용 타이머용 발진기 단자로도 사용된다표 참조, RTC(Real Time Counter) ( 5 ).
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포트 핀 다른 특수 기능

핀PG4( 19) 타이머 의 기능 사용시 클럭 발생을 위한 수정발진자 접속단자TOSC1 : 0 RTC

핀PG3( 18) 타이머 의 기능 사용시 클럭 발생을 위한 수정발진자 접속단자TOSC2 : 0 RTC

핀PG2( 43) 외부 메모리에 접근할 때 하위주소값을 래치하도록 신호를 출력ALE :

핀PG1( 34) RD 외부 테이터 메모리를 읽을 때 사용되는 스트로브 신호 출력 단자로 사용:

핀PG0( 33) WR 외부 데이터 메모리에 쓸 때 사용되는 스트로브 신호 출력 단자로 사용:

표 6 포트 의 다른 기능 설명. G

1.5.1.5.1.5.1.5.1.5.1.5.1.5.1.5.1.5.1.5.1.5.1.5. 의 메모리의 메모리의 메모리의 메모리ATmega128ATmega128ATmega128ATmega128의 메모리의 메모리의 메모리의 메모리ATmega128ATmega128ATmega128ATmega128의 메모리의 메모리의 메모리의 메모리ATmega128ATmega128ATmega128ATmega128

의 메모리는 프로그램 메모리와 데이터 메모리가 분리된 하바드구조로 프로그램 메모리는 바ATmega128 128K

이트의 크기로 가 가능한 플래쉬롬이 내장되어 있다메모리맵은 그림 의 좌측 참조 데이터메모리는 램과ISP ( 3 ).

으로 나뉠 수 있는데 그림 의 우측은 데이터 메모리의 램의 가지 가능한 메모리 맵 구조를 보여준다EEPROM 3 2 .

그림 3 의 메모리 맵출처. ATmega128 ( : ATMEL)

� 플래시 프로그램 메모리 그림 의 좌측에 보여진 것처럼 비트 단위로 접근 가능한 바이트의 주소공간: 3 16 64K

번지에서 번지을 갖는 플래시롬이 프로그램 메모리로 내장되어 있다(0000 FFFF ) .

� 데이터 메모리 : 데이터 메모리는 크게 램과 롬으로 나뉠 수 있고 램은 그림 의 우측에 보여진 것처럼 바3 32

이트의 범용레지스터 번지에서 번지 바이트의 레지스터 그리고 의 이 내장되어 있고(0000 001F ), 64 I/O , 4K SRAM

롬은 으로 만번 쓰기가 가능한 바이트가 내장되어 있다 그림 의 우측에 보여진 것처럼 이전의 구EEPROM 10 4K . 3

형 모델과의 호환성을 유지하기 위하여 바이트의 맵을 사용하는 와 내ATmega103 (4K - 100) configuration B

장된 바이트 전부를 사용하는 모드노말 모드를 지원한다 그림 의 우측에 보여진 것처럼4K configuration A ( ) . 3

바이트까지 외부 램의 연결이 가능하다60K .

1.5.1.1.5.1.1.5.1.1.5.1.1.5.1.1.5.1.1.5.1.1.5.1.1.5.1.1.5.1.1.5.1.1.5.1. 프로그램 메모리프로그램 메모리프로그램 메모리프로그램 메모리프로그램 메모리프로그램 메모리프로그램 메모리프로그램 메모리프로그램 메모리프로그램 메모리프로그램 메모리프로그램 메모리

� 구성 바이트의 번까지 쓰기가 가능한 플래시롬으로 그림 의 좌측에 보여진 것처럼 비트 단위: 128K 10000 3 16

로 접근 가능한 바이트의 주소공간 번지에서 번지을 갖는다 부트로더 섹션과 응용프로그램 섹션64K (0000 FFFF ) .

으로 나뉠 수 있다.

� 역할 비트 또는 비트 구조로 되어 있는 각 명령어가 프로그램 메모리에 개의 번지를 차지하며 저장: 16 32 1~2
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된다.

� 프로그래밍 통신방식을 이용한 에 의하여 프로그램을 쓰거나 에뮬레이터를 사용하거나 병렬: SPI ISP , JTAG

프로그래밍 모드를 이용하여 프로그램을 쓸 수 있다.

1.5.2.1.5.2.1.5.2.1.5.2.1.5.2.1.5.2.1.5.2.1.5.2.1.5.2.1.5.2.1.5.2.1.5.2. 데이터메모리데이터메모리데이터메모리데이터메모리 ::::데이터메모리데이터메모리데이터메모리데이터메모리 ::::데이터메모리데이터메모리데이터메모리데이터메모리 :::: 범용 레지스터범용 레지스터범용 레지스터범용 레지스터범용 레지스터범용 레지스터범용 레지스터범용 레지스터범용 레지스터범용 레지스터범용 레지스터범용 레지스터

� 구성 그림 과 와 같이 바이트로 내부메모리의 번지에서 번지를 차지한다: 3 4 32 00 1F .

� 역할 의 레지스터와 같은 가 따로 있지 않고 개가 모두 역할을 하여 기본적인 사칙연산을: 8051 A ALU 32 ALU

수행하고 일부의 상수 데이터를 사용하는 연산명령은 에서 수행한다R16-R31 .

그림 4 범용레지스터출처. ( :ATMEL)

1.5.2.1.1.5.2.1.1.5.2.1.1.5.2.1. 레지스터레지스터레지스터레지스터X,Y,ZX,Y,ZX,Y,ZX,Y,Z

그림 와 같이 은 각각 개씩 합쳐져서 개의 비트 레지스터인 레지스터로 사용될 수 있4,5 R26-R31 2 3 16 X,Y,Z

다 이들은 데이터 메모리의 비트 주소를 간접 지정하는 포인터로 사용되며 레지스터 의 쌍는. 16 Z (R30, R31 )

명령에서 메모리값에 접근할 때 사용한다LPM, ELPM, SPM .

그림 5 레지스터출처. XYZ ( :ATMEL)

1.5.3.1.5.3.1.5.3.1.5.3.1.5.3.1.5.3.1.5.3.1.5.3.1.5.3.1.5.3.1.5.3.1.5.3. 데이터 메모리데이터 메모리데이터 메모리데이터 메모리데이터 메모리데이터 메모리데이터 메모리데이터 메모리데이터 메모리데이터 메모리데이터 메모리데이터 메모리 레지스터레지스터레지스터레지스터: I/O: I/O: I/O: I/O 레지스터레지스터레지스터레지스터: I/O: I/O: I/O: I/O 레지스터레지스터레지스터레지스터: I/O: I/O: I/O: I/O

그림 과 에서처럼 바이트로 구성되며 내장된 각종 장치를 제어하기 위한 레지스터로 명령을3 6 64 I/O IN, OUT

사용하여 입출력 장치에 접근한다 이들은 그림 의 괄호에 표시한 것처럼 번지에서 번지까지 존재하지. 6 0x20 0x5F

만 명령을 사용할 때는 그림 에 표시한 것처럼 에서 로 지칭해야 한다 번지에서IN, OUT 6 0x00 0x3F . 0x00(0x20)

번지에 위치하는 개의 레지스터는 명령을 사용하여 비트 어드레싱이 가능하0x1F(0x3F) 32 CBI, SBI, SBIC, SBIS

다.
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그림 6 의 레지스터출처. ATmega128 I/O ( :ATMEL)

1.5.3.1.1.5.3.1.1.5.3.1.1.5.3.1. 상태레지스터상태레지스터상태레지스터상태레지스터(SREG)(SREG)(SREG)(SREG)

상태레지스터 는 의 연산 후 상태와 결과를 표시하는 레지스터로 의 에(SREG:Status REGister) ALU 8051 PSW

해당한다.
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� 비트 전체 인터럽트를 허용하도록 설정하는 비트로 및 명령으로 이7(I : Global Interrupt Enable) : SEI CLI

비트를 제어할 수 있다인터럽트 처리가 시작되면 자동적으로 클리어되고 명령을 만나면 원래 상태로 복구. RETI

된다 개별 인터럽트의 허용은 인터럽트 마스크 레지스터로 설정한다. .

� 비트 명령을 사용하여 어느 레지스터의 한 비트값의 복사가 가능하다6(T : Bit Copy Storage) : BLD, BST .

� 비트 산술연산의 가감산에서 비트 에서 올림수가 발생하면 로 세트 연산에5(H : Half Carry Flag) : 3 1 . BCD

사용하며 레지스터의 에 해당한다8051 PSW AC .

� 비트 플랙 과 의 값으로 정수들의 크기를 판단할 때 사용한다4(S : Sign Bit) : N V XOR(eXclusive OR) .

� 비트 의 보수 연산에서 오버플로를 표시한다3(V : 2's Complement Overflow Flag) : 2 .

� 비트 연산 결과값의 최상위 비트가 로되어 의 보수표현을 사용하는 경우 연산 결과2(N : Negative Flag) : 1 2

가 음수임을 표시한다.

� 비트 연산 결과값이 이 되었음을 표시한다1(Z : Zero Flag) : 0 .

� 비트 연산으로 자리올림이나 자리내림이 발생하면 로 세트된다 레지스터의0(C : Carry Flag) : 1 . 8051 PSW

에 해당한다CY .

1.5.3.2.1.5.3.2.1.5.3.2.1.5.3.2. 스택 포인터스택 포인터스택 포인터스택 포인터 (SP)(SP)(SP)(SP)

� 서브루틴이나 인터럽트 호출시 이들을 처리하고 다시 본래 위치로 되돌아오기 위한 복귀주소인 프로그램카운

터 값의 내의 스택 위치 또는 할 내의 스택 위치를 표시한다 프로그램에서 지역변수(PC) SRAM , push pop SRAM . C

를 저장하거나 어셈블리 프로그램에서 임시 데이터를 저장하는 용도로도 사용한다.

� 초기값은 인데 사용자 프로그램에서 의 초기값은 적어도 번지 이상의 값으로 설정한다0x0000 SP 0x0100 .

� 값이 저장될 때는 값이 만큼 증가하고 증가된 값이 가리키는 내부램에 하위바이트 가 먼저 저장PC SP 1 SP (PCL)

되고 다시 값이 만큼 증가하고 증가된 값이 가리키는 내부램에 상위바이트 가 저장된다SP 1 SP (PCH) .

� 와 은 바이트 데이터만이 대상이 되는데 명령이 내려지면 바이트 데이터를 저장하기 전에 먼push pop 1 push 1

저 값이 만큼 증가하여 증가된 값이 가리키는 내에 데이터가 저장되고 명령이 내려지면 현재SP 1 SP SRAM pop

값이 가리키는 내부램에서 바이트 데이터를 꺼낸 후에 값이 만큼 감소한다SP 1 SP 1 .

1.5.3.3.1.5.3.3.1.5.3.3.1.5.3.3. 레지스터레지스터레지스터레지스터RAMPZ(RAM Page Z select)RAMPZ(RAM Page Z select)RAMPZ(RAM Page Z select)RAMPZ(RAM Page Z select)

� 레지스터 의 쌍로 명령을 사용해 메모리값에 접근할 때 로 하면Z (R30, R31 ) LPM, ELPM, SPM RAMPZ0=1

에서 에 접근하고 로 하면 에서 에 접근할 수 있다0x8000 0xffff RAMPZ0=0 0x0000 0x7fff .

1.5.4.1.5.4.1.5.4.1.5.4.1.5.4.1.5.4.1.5.4.1.5.4.1.5.4.1.5.4.1.5.4.1.5.4. 데이터 메모리 확장데이터 메모리 확장데이터 메모리 확장데이터 메모리 확장::::데이터 메모리 확장데이터 메모리 확장데이터 메모리 확장데이터 메모리 확장::::데이터 메모리 확장데이터 메모리 확장데이터 메모리 확장데이터 메모리 확장:::: 레지스터레지스터레지스터레지스터I/OI/OI/OI/O 레지스터레지스터레지스터레지스터I/OI/OI/OI/O 레지스터레지스터레지스터레지스터I/OI/OI/OI/O

에 추가된 각종 를 제어하기 위한 레지스터로 바이트 에서 번지로 레지스터처ATmega128 I/O 160 (0x60 0xff ) I/O

럼 명령을 사용할 수 없고 명령어로 접근해야 한다그림 참조IN, OUT LD, LDS, LDD, ST, STS, STD ( 7 ).

1.5.5.1.5.5.1.5.5.1.5.5.1.5.5.1.5.5.1.5.5.1.5.5.1.5.5.1.5.5.1.5.5.1.5.5. 데이터 메모리 내부데이터 메모리 내부데이터 메모리 내부데이터 메모리 내부::::데이터 메모리 내부데이터 메모리 내부데이터 메모리 내부데이터 메모리 내부::::데이터 메모리 내부데이터 메모리 내부데이터 메모리 내부데이터 메모리 내부:::: SRAMSRAMSRAMSRAMSRAMSRAMSRAMSRAMSRAMSRAMSRAMSRAM

� 구성 은 의 이 내장되어 있다 그림 의 우측에 보여진 것처럼 이전의 구형: ATmega128 4K SRAM . 3

모델과의 호환성을 유지하기 위하여 바이트의 맵을 사용하는 와 내장ATmega103 (4K - 100) configuration B

된 바이트 전부를 사용하는 모드노말모드를 지원한다 노말모드의 경우 에서4K configuration A ( ) . 0x0100

번지를 점유한다0x10ff .

� 접근법 또는 의 명령을 사용하여 비트 직접 데이터에 의한 번지값을 지정: LS, LDS, LDD ST, STS, STD 16

하여 접근하거나 레지스터를 사용하여 간접지정으로 접근한다X,Y,Z .

� 역할 프로그램에서 사용되는 사용자 변수의 저장영역이나 스택영역으로 사용된다: .
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그림 7 의 확장 레지스터출처. ATmega128 I/O ( :ATMEL)

1.5.6.1.5.6.1.5.6.1.5.6.1.5.6.1.5.6.1.5.6.1.5.6.1.5.6.1.5.6.1.5.6.1.5.6. 데이터 메모리데이터 메모리데이터 메모리데이터 메모리 : EEPROM: EEPROM: EEPROM: EEPROM데이터 메모리데이터 메모리데이터 메모리데이터 메모리 : EEPROM: EEPROM: EEPROM: EEPROM데이터 메모리데이터 메모리데이터 메모리데이터 메모리 : EEPROM: EEPROM: EEPROM: EEPROM

� 은 으로 만번 쓰기가 가능한 바이트가 내장되어 있는데 내부 램 확장 레ATmega128 EEPROM 10 4K , I/O, I/O

지스터와는 별개의 주소가 할당되어 있어 용 주소 레지스터 데이터레지스터EEPROM (EEARH, EEARL), (EEDR),
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제어 레지스터 를 이용해 접근한다(EECR) .

1.5.6.1.1.5.6.1.1.5.6.1.1.5.6.1. 레지스터레지스터레지스터레지스터EEAREEAREEAREEAR

� 의 비트 에서 비트 항상 으로 읽히며 향후 버젼을 위해 유보되어 있는 비트들이다EEAR 12 15 : 0 .

� 의 비트 에서 비트 읽고 쓸 의 바이트의 주소 지정에 사용된다 초기EEAR 11(EEAR11) 0(EEAR0) : EEPROM 4K .

값은 부여되지 않고 임의의 값이 될 수 있다 항상 에 접근하기 전에 주소값을 지정하도록 한다. EEPROM .

1.5.6.2.1.5.6.2.1.5.6.2.1.5.6.2. 레지스터레지스터레지스터레지스터EEDREEDREEDREEDR

� 쓰기의 경우에는 의 주소에 쓰여질 값을 임시로 저장하거나 읽기의 경우에는 읽힌 값을 저장한다EEAR .

� 초기값은 이다0x00 .

1.5.6.3.1.5.6.3.1.5.6.3.1.5.6.3. 레지스터레지스터레지스터레지스터EECREECREECREECR

� 비트 비트 유보된 비트들이다7- 4 : .

� 비트 로 설정되면 비트가 이 될때3(EERIE : EEPROM Ready Interrupt Enable) : 1 EEWE 0 EEPROM Ready

인터럽트를 발생하는 기능을 가진다.

� 비트 를 로 설정할때 에 쓰기가 가능하도록2(EEMWE : EEPROM Master Write Enable) : EEWE 1 EEPROM

허용할지 여부를 결정한다.

� 비트 가 로 설정되면 가 로 되고 나서 클록 사이클 이1(EEWE : EEPROM Write Enable) : EEMWE 1 EEWE 1 4

내에 의 데이터를 이 가리키는 의 주소에 쓴다 쓰기가 완료되면 는 자동적으로EEDR EEAR EEPROM . EEMWE 0

이 된다.

� 비트 의 읽기 스트로브로서 레지스터에 적절한 주소값이0(EERE : EEPROM Read Enable) : EEPROM EEAR

부여된 경우 를 로 해야 읽기가 시작될 수 있다EERE 1 EEPROM .

1.5.6.4.1.5.6.4.1.5.6.4.1.5.6.4. 쓰기과정쓰기과정쓰기과정쓰기과정EEPROMEEPROMEEPROMEEPROM

� 다음의 과정을 거쳐 쓰기가 이루어지는데 쓰기가 수행되고 나면 는 다음 명령을 실행하기 전에 클럭 동CPU 2

안 멈추고 쓰기는 가 플래시메모리에 쓰기를 할 때는 불가능하다EEPROM CPU .

가 일 될 때까지 기다린다EEWE 0 .①

레지스터의 비트가 이 될 때까지 기다린다SPMCSR SPMEN 0 .②

쓰기할 주소를 레지스터에 저장한다EEPROM EEAR .③

쓰기할 데이터를 레지스터에 저장한다EEPROM EEDR .④

레지스터의 는 로 는 으로 설정한다EECR EEMWE 1 EEWE 0 .⑤

클럭 사이클 이내에 를 로 설정한다 그리고 쓰기가 수행된다4 EEWE 1 . .⑥

� 위의 쓰기 과정에서 는 순서가 바뀌어도 상관없다 과정중에 인터럽트가 발생되면 의 동작, . , EEMWE③④ ⑤ ⑥

제한시간이 초과되어 쓰기 동작이 실패하게 되므로 이를 방지하기 위해 과정동안에는 상태레지스터- SREG③ ⑥

의 비트를 으로 설정하여 인터럽트 발생을 금지시켜야 한다I 0 .

� 쓰기 과정 중에 파워다운 슬립모드에 진입하면 파원다운 슬립모드에 제대로 진입하지 못하게 되므EEPROM

로 파워다운 모드에 진입하려면 쓰기가 완료되었는지를 확인해야 한다EEPROM .

� 전원 전압이 낮은 동안에는 데이터가 손상될 수 있다 이를 방지하기 위해 내부 감지기EEPROM . Brown-out

를 작동하게 하고 전원전압이 낮아지면 리셋되도록 하드웨어를 구성하는 것도 괜찮다.

1.5.6.5.1.5.6.5.1.5.6.5.1.5.6.5. 읽기과정읽기과정읽기과정읽기과정EEPROMEEPROMEEPROMEEPROM

가 일 될 때까지 기다린다EEWE 0 .①
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읽기할 주소를 레지스터에 저장한다EEPROM EEAR .②

레지스터의 를 로 설정한다EECR EERE 1 .③

데이터를 레지스터로부터 읽는다EEPROM EEDR .④

1.5.7.1.5.7.1.5.7.1.5.7.1.5.7.1.5.7.1.5.7.1.5.7.1.5.7.1.5.7.1.5.7.1.5.7. 외부 데이터 메모리외부 데이터 메모리외부 데이터 메모리외부 데이터 메모리외부 데이터 메모리외부 데이터 메모리외부 데이터 메모리외부 데이터 메모리외부 데이터 메모리외부 데이터 메모리외부 데이터 메모리외부 데이터 메모리

은 노말모드에서 번지에 외부 데이터 메모리로 사용가능하며 이들은 외부 램 외부ATmega128 0x1100-0xffff ,

플래쉬 롬 또는 나 변환기와 같은 주변장치의 인터페이스용으로 사용할 수 있다 이를 위해 다음과 같은LCD AD .

기능이 제공된다.

주변장치와 적절한 인터페이스를 위한 의 대기 사이클을 지정할 수 있다0-3 .①

개의 섹터로 외부 데이터 메모리를 분할하고 이들에 독립적인 대기 사이클을 지정할 수 있다2 .②

비트 주소의 상위바이트에 중 필요한 갯수의 비트만을 주소 버스로 동작하게 할 수 있다16 .③

데이터 버스의 신호들이 동작할 때 전류 소비량이 감소되도록 기능을 설정할 수 있다Bus-keeper .④

1.5.7.1.1.5.7.1.1.5.7.1.1.5.7.1. 외부 메모리 인터페이스외부 메모리 인터페이스외부 메모리 인터페이스외부 메모리 인터페이스

� 외부 램 연결을 위한 핀 레지스터를 이용해서 설정한다: MCUSR .

핀 핀 의 포트 처럼 하위주소와 데이터버스로 사용된다PA7~PA0( 44~ 51) : 8051 0 .①

핀 핀 의 포트 처럼 상위주소버스로 사용된다PC7~PC0( 35~ 42) : 8051 2 .②

핀 외부메모리에 접근할 때 에서 출력되는 하위주소값을 래치할ALE(Address Latch Enable, PG2, 43) : PA③

수 있도록 에서 레벨값을 출력해준다CPU 1 .

④ RD( 핀 외부 테이터 메모리를 읽을 때 사용되는 스트로브 신호 출력 단자로 사용PG1, 34) :

⑤ WR 핀 외부 데이터 메모리에 쓸 때 사용되는 스트로브 신호 출력 단자로 사용(PG0, 33) :

� 외부램 연결 블록선도 그림 은 외부램과의 연결을 보여준다: 8 .

그림 8 외부램의 연결출처. ( :ATMEL)

� 외부램 읽기쓰기 과정( ) :

외부 램 읽기 명령이 내려지면 신호가 레벨이 되고 는 하위주소 버스로 하위주소 값을ALE 1 Port A(AD7:0)①

내보내고 는 상위주소 버스로 페이지 값을 출력시킨다Port C(A15:8( .

가 레벨인 동안 하위주소값은 래치되어 가 레벨이 된 후에도 래치에 값이 보존된다ALE 1 ALE 0 .②

읽기신호③ RD 쓰기신호( WR 가 레벨로 변하여 활성상태로 되면) 0

외부 램의 혹은 이 활성화되고 외부 램의 데이터 값이 를 통해 로Output Enable( Write Enable) Port A CPU④

읽혀지도록램에 쓰여지도록 한다 외부램과의 인터페이스는 기본적으로 클럭 사이클에 수행되나 소프트웨어적( ) . ( 3

으로 개의 여분의 대기 사이클을 줄 수도 있다1-3 .)
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1.5.7.2.1.5.7.2.1.5.7.2.1.5.7.2. 레지스터레지스터레지스터레지스터MCUCRMCUCRMCUCRMCUCR

레지스터는 의 전체적인 기능을 설정하는데 비트 과 을 사용해서 외부MCUCR(MCU Control Register) CPU 7 6

데이터 메모리 영역을 설정할 수 있다.

� 비트 로 세트하면 핀 핀 핀 핀7(SRE:external SRAM/XMEM Enable) : 1 PA7-PA0( 44- 51), PC7-PC0( 35- 42),

핀ALE(PG2, 43), RD( 핀PG1, 34), WR 핀 핀들을 외부메모리와 인터페이스를 위한 핀들로 설정하게(PG0, 33)

되고 으로 하면 병렬 포트로 동작하도록 한다0 .

� 비트 외부 메모리와 인터페이스 할 때 외부 데이터의6(SRW10:Wait-state Select Bit for Upper Sector) :

섹터에 부여하는 여분의 대기 사이클의 수를 레지스터의 비트와 조합되어 설정한다Upper XMCRA SRW11 .

일때 대기 사이클은 개 일때 개 일때 개 일때 개를 준다[SRW11:SRW10]=00 0 , 01 1 , 10 2 , 11 3 .

1.5.7.3.1.5.7.3.1.5.7.3.1.5.7.3. 레지스터레지스터레지스터레지스터XMCRAXMCRAXMCRAXMCRA

레지스터는 외부 데이터 메모리 영역을 분할하거나 대기 사이XMCRA(eXternal Memory Control Register A)

클의 수를 설정할 수 있다.

� 비트 비트 외부 데이터 메모리 영역을 와 개의 섹터로 분할하여 각 섹터에6(SRL2)~ 4(SRL0) : Lower Upper 2

별도로 대기 사이클의 수를 설정할 수 있도록 한다.

그림 9 를 이용한 메모리 분할출처. SRL2-SRL0 ( :ATMEL)

� 비트 비트 외부 메모리와 인터페이스 할 때3~ 2(SRW01~SRW00:Wait-state Select Bit for Lower Sector) :

외부 데이터의 섹터에 부여하는 여분의 대기 사이클의 수를 설정한다 일때 대기Lower . [SRW01:SRW00]=00

사이클은 개 일때 개 일때 개 일때 개를 준다0 , 01 1 , 10 2 , 11 3 .

� 비트 외부 메모리와 인터페이스 할 때 외부 데이터의1(SRW11:Wait-state Select Bit for Upper Sector) :

섹터에 부여하는 여분의 대기 사이클의 수를 레지스터의 비트와 조합되어 설정한다Upper XMCRA SRW11 .

일때 대기 사이클은 개 일때 개 일때 개 일때 개를 준다[SRW11:SRW10]=00 0 , 01 1 , 10 2 , 11 3 .

1.5.7.4.1.5.7.4.1.5.7.4.1.5.7.4. 레지스터레지스터레지스터레지스터XMCRBXMCRBXMCRBXMCRB

레지스터는 버스 키퍼 기능을 설정하고 외부 메모리 주소의 상XMCRB(External Memory Control Register B)

위 바이트에서 어느 부분까지가 주소지정에 사용되는지를 설정한다.

� 비트 로 세팅되면 핀 핀 의 값들이 보존7(XMBK:eXternal Memory Bus-Keeper enable) : 1 PA7-PA0( 44- 51)

되는 버스 키퍼 기능을 활성화시킨다.

� 비트 비트 유보된 비트들이다6~ 4 : .

� 비트 비트 이하의 외부 메모리를 사용하는 경우 상위주소2~ 0(XMM2~0 : eXternal Memory high Mask) : 60K

버스로 사용되는 의 일부분만이 주소버스로 사용되도록 하고 나머지는 입출력 포트로 설정하는데 사용된port C
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다 만약 로 하면 포트 모두를 입출력 포트로 설정하고 이면 와 만을. [XMM2:XMM1:XMM0]=111 C , 110 PC0 PC1

주소버스로 설정하고 이면 이면 이면 이면 이, 101 PC0~PC2, 100 PC0~PC3, 011 PC0~PC4, 010 PC0~PC5, 001

면 을 주소버스로 설정하고 이면 포트 모두를 주소버스로 설정한다PC0~PC6 , 000 C .

1.5.8.1.5.8.1.5.8.1.5.8.1.5.8.1.5.8.1.5.8.1.5.8.1.5.8.1.5.8.1.5.8.1.5.8. 메모리 비트메모리 비트메모리 비트메모리 비트locklocklocklock메모리 비트메모리 비트메모리 비트메모리 비트locklocklocklock메모리 비트메모리 비트메모리 비트메모리 비트locklocklocklock

메모리의 보호를 위해 설정하는데 사용하는 바이트 구조의 비트로 디폴트로 비트값이 로 되어 있고 프로그램1 1

하면 으로 설정되고 명령에 의해 로 환원된다 그림 은 비트의 구성을 보여준다 그리고 그림0 chip erase 1 . 10 lock .

은 비트 값에 따른 모드 설정값과 각 모드에 따른 메모리 보호기능을 보여준다11 lock .

그림 10 의 구성출처. Lock bit ( :ATMEL)

그림 11 설정에 따른 기능 출처. Lock bit ( :ATMEL)
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1.5.9.1.5.9.1.5.9.1.5.9.1.5.9.1.5.9.1.5.9.1.5.9.1.5.9.1.5.9.1.5.9.1.5.9. 퓨즈 비트퓨즈 비트퓨즈 비트퓨즈 비트퓨즈 비트퓨즈 비트퓨즈 비트퓨즈 비트퓨즈 비트퓨즈 비트퓨즈 비트퓨즈 비트

의 기본적인 설정용으로 사용되며 바이트로 모두 개의ATmega128 Extended Fuse, Fuse High, Fuse Low 3

바이트로 구성되어 있다 디폴트로 비트값이 로 되어 있고 프로그램하면 으로 설정되고 명령에 의해. 1 0 chip erase

영향을 받지 않으므로 메모리 비트의 을 으로 하여 퓨즈 비트를 변경할 수 없도록 할 수 있다 퓨즈 비Lock LB1 0 .

트를 먼저 설정하고 메모리 비트를 설정해야 한다Lock .

1.5.9.1.1.5.9.1.1.5.9.1.1.5.9.1. Extended Fuse ByteExtended Fuse ByteExtended Fuse ByteExtended Fuse Byte

비트 만 사용하여 과 호환모드의 설정 타이머 동작의 설정에 사용한다1~0 ATnega103 , Watchdog .

� 비트 디폴트 상태로는 으로 설정되어 과 호환모드로 되어 있다 로 프로그램하면 노1(M103C) : 0 ATmega13 . 1

말모드로 의 고유기능을 전부 활용할 수 있다ATmega128 .

� 비트 디폴트 상태로는 로 설정되어 워치독 타이머 기능이 동작하도록0(WDTON: WatchDog Timer ON) : 1

한다.

1.5.9.2.1.5.9.2.1.5.9.2.1.5.9.2. Fuse High ByteFuse High ByteFuse High ByteFuse High Byte

� 비트 디폴트 상태로는 로 설정되어 를 허용한다7(OCDEN:On Chip Debug eNable) : 1 On chip debug .

� 비트 디폴트 상태로는 로 설정되어 를 허용한다6(JTAGEN : JTAG ENable) : 1 JTAG .

� 비트 디폴트 상태로는 로 설정되어 를 통한 직렬 프로그래밍을 허용한다5(SPIEN : SPI Enable) : 1 SPI .

� 비트 클럭 옵션을 설정한다 절 참조4(CKOPT) : (1.6 ).

� 비트 디폴트 상태로는 로 설정되어 할 때 의 내용을 보호한다3(EESAVE) : 1 Chip Erase EEPROM .

� 비트 부트 사이즈를 선택하는 데 사용한다그림 참조2~1(BOOTSZ1~0) : ( 12 ).

� 비트 의 선택에 사용한다 디폴트 상태로는 로 설정되어 번지를 리셋 주0(BOOTRST) : Reset vector . 1 0x0000

소로 하고 이면 그림 에 주어진 값을 리셋 주소로 사용한다0 12 .

그림 12 부트 사이즈의 선택출처. ( :ATMEL)

1.5.9.3.1.5.9.3.1.5.9.3.1.5.9.3. Fuse Low ByteFuse Low ByteFuse Low ByteFuse Low Byte

� 비트 디폴트 상태로는 로 설정되어 의 기능을 레벨값에 따라 트리거되7(BODLEVEL) : 1 Brown Out Detector

도록 설정한다.

� 비트 디폴트 상태로는 로 설정되어 의 기능6(BODEN: Brown Out Detector ENable) : 1 Brown Out Detector

을 허용한다.

� 비트 시간을 설정한다 절 참조 디폴트 상태로는 의 값을 갖는다5~4(SUT1~0) : Start up (1.6~7 ). 10 .

� 비트 클럭 소스를 설정한다 절 참조 디폴트 상태로는 의 값을 갖고 있어 디폴트3~0(CKSEL3~0) : (1.6 ). 0001

상태로는 의 내부 발진기를 통한 클록을 사용하도록 설정되어 있다1MHz RC .
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1.6.1.6.1.6.1.6.1.6.1.6.1.6.1.6.1.6.1.6.1.6.1.6. 시스템 클록과 슬립 모드시스템 클록과 슬립 모드시스템 클록과 슬립 모드시스템 클록과 슬립 모드시스템 클록과 슬립 모드시스템 클록과 슬립 모드시스템 클록과 슬립 모드시스템 클록과 슬립 모드시스템 클록과 슬립 모드시스템 클록과 슬립 모드시스템 클록과 슬립 모드시스템 클록과 슬립 모드

1.6.1.1.6.1.1.6.1.1.6.1.1.6.1.1.6.1.1.6.1.1.6.1.1.6.1.1.6.1.1.6.1.1.6.1. 클록 분배클록 분배클록 분배클록 분배클록 분배클록 분배클록 분배클록 분배클록 분배클록 분배클록 분배클록 분배

그림 에 보여진 것처럼 은 다양한 소스에 의해 클록을 발생시키고 분배가 가능하다 또한 내부의13 ATmega128 .

각 부분은 모두 동시에 클록이 필요치 않아 소비 전력을 절약시키기 위해 개별적으로 공급을 차단할 수도 있다.

� 클록CPU ( 범용레지스터 상태레지스터 데이터 메모리와 같은 핵심적인 동작과 관련된 클록으) : , , AVR

로 공급을 차단하면 이들의 동작을 멈추게 한다.

� 클록I/O ( 타이머 등 모듈 대부분에서 사용되는 클록이다 외부인터럽트 모듈에서도) : , SPI, USART I/O .

사용되나 일부 외부인터럽트는 클록의 공급이 차단되어도 인터럽트 처리가 된다I/O .

� 플래쉬 클록( 플래쉬롬과의 인터페이스를 제어하며 보통 클록과 동시에 사용된다) : CPU .

� 비동기 타이머 클록( 외부 수정 발진기를 소스로 하는 비동기 타이머용 클록이다) : 32kHz .

� 변환기 클록AD ( 변환기용의 클록으로 와 클록을 정지시키고 변환을 이루어지도록 하) : AD CPU I/O AD

여 노이즈를 줄일 수 있도록 한다.

그림 13 의 클록 분배출처. ATmega128 ( :ATMEL)

1.6.2.1.6.2.1.6.2.1.6.2.1.6.2.1.6.2.1.6.2.1.6.2.1.6.2.1.6.2.1.6.2.1.6.2. 클록 발생과 선택클록 발생과 선택클록 발생과 선택클록 발생과 선택클록 발생과 선택클록 발생과 선택클록 발생과 선택클록 발생과 선택클록 발생과 선택클록 발생과 선택클록 발생과 선택클록 발생과 선택

가지의 클록발생원이 존재하며 와 레지스터를 이용하여 클록발생원과 주파수를 설5 CKSEL3~0 SUT1~0, XDIV

정한다.

1.6.2.1.1.6.2.1.1.6.2.1.1.6.2.1. 내부 디폴트 클록 발진기내부 디폴트 클록 발진기내부 디폴트 클록 발진기내부 디폴트 클록 발진기RC( )RC( )RC( )RC( )

� 단자의 연결 내부 발진기를 사용하므로 에는 아무 것도 연결하지 않는다XTAL1, XTAL2 : XTAL1, XTAL2 .

� 의 설정 퓨즈 하이 바이트의 비트 를 로 설정해야 한다CKOPT : 4 CKOPT 1 .
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� 의 설정 퓨즈 로우 바이트의 비트 의 값들을 로 하면 으로 하CKSEL3~0 : 3~0(CKSEL3~0) 0001 1MHz, 0010

면 로 하면 으로 하면 의 클록을 사용한다 디폴트 상태로는 의 값을 갖고2MHz, 0011 4MHz, 0100 8MHz . 0001

있어 디폴트 상태로는 의 내부 발진기를 통한 클록을 사용하도록 설정되어 있다1MHz RC .

� 의 설정 퓨즈 로우 바이트의 비트 의 값들을 로 설정하는 것은 유보되어 있고 나머SUT1~0 : 5~4(SUT1~0) 11

지 값들 으로 하면 기동시간이 클럭으로 설정된다 또한 로의 설정은(00,01,10) 6 . 00 BOD(Brown Out Detector)

사용에 권장되고 로 하면 리셋의 경우 추가적으로 의 지연이 발생하고 사용에 권, 01 4.1 ms Fast rising power

장되고 로 하면 리셋의 경우 추가적으로 의 지연이 발생하고 사용에 권장된다, 10 65ms slowly rising power .

� 내부 발진기를 통해 발생되는 클럭은 주파수가 부정확하므로 확장된 레지스터인I/O OSCCAL(OSCillator

레지스터를 조정해서 사용한다 의 값이 이면 으로 설정한 값의CALibration) . OSCCAL 0x00 CKSEL3~0

의 주파수값이 클록으로 사용되며 이면 이면 의 주파수값이 클50%~100% , 0x7F 75%~150%, 0xFF 100%~200%

록으로 사용된다.

1.6.2.2.1.6.2.2.1.6.2.2.1.6.2.2. 외부 발진기외부 발진기외부 발진기외부 발진기RCRCRCRC

� 단자의 연결 그림 와 같이 연결하고 커패시터의 값은 적어도 이상으로 한다XTAL1, XTAL2 : 14 22pF .

그림 14 외부 발진기의 연결출처 사. RC ( :ATMEL )

� 발진주파수 클럭의 주파수 값은:  로 결정된다.

� 의 설정 으로 설정하면 내부의 커패시터가 사용되므로 그림 의 커패시터 를 연결하면 안CKOPT : 0 36pF 18 C

된다.

� 의 설정 그림 참조CKSEL3~0 : 15

그림 15 외부 발진기 동작 모드 출처. RC ( :ATMEL)

� 의 설정 그림 참조SUT1~0 : 16 .

그림 16 외부 발진기의 기동시간 선택출처. RC ( :ATMEL)
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1.6.2.3.1.6.2.3.1.6.2.3.1.6.2.3. 외부 수정발진기외부 수정발진기외부 수정발진기외부 수정발진기

에 수정이나 세라믹 를 연결하여 사용하는 경우이다XTAL1, XTAL2 resonator .

� 단자의 연결 그림 과 같이 연결하고 커패시터의 값은 그림 을 참조한다XTAL1, XTAL2 : 17 18 .

그림 17 외부 수정 발진기의 연결출처. ( :ATMEL)

� 의 설정 그림 참조CKOPT : 18 .

그림 18 외부 수정 발진기 동작 모드 출처. ( :ATMEL)

� 의 설정 그림 과 참조CKSEL3~0 : 18 19

그림 19 수정발진기의 기동시간 선택출처. ( :ATMEL)

� 의 설정 그림 참조SUT1~0 : 19 .

1.6.2.4.1.6.2.4.1.6.2.4.1.6.2.4. 저주파 수정 발진기저주파 수정 발진기저주파 수정 발진기저주파 수정 발진기

에 저주파수 수정을 연결하여 사용하는 경우이다XTAL1, XTAL2 .

� 단자의 연결 그림 과 같이 연결하고 수정은 를 사용한다XTAL1, XTAL2 : 17 32.768kHz .

� 의 설정 으로 설정하면 내부의 커패시터가 사용되므로 그림 의 커패시터들을 연결하면 안CKOPT : 0 36pF 14
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된다.

� 의 설정 로 설정한다CKSEL3~0 : 1001 .

� 의 설정 그림 참조SUT1~0 : 20 .

그림 20 저주파수정발진기의 기동시간 선택출처. ( :ATMEL)

1.6.2.5.1.6.2.5.1.6.2.5.1.6.2.5. 외부 클록외부 클록외부 클록외부 클록

� 단자의 연결 외부의 클럭 신호를 단자에 연결하고 단자는 비워둔다XTAL1, XTAL2 : XTAL1 XTAL2 .

� 의 설정 으로 설정하면 내부의 커패시터가 사용된다CKOPT : 0 36pF .

� 의 설정 으로 설정한다CKSEL3~0 : 0000 .

� 의 설정 퓨즈 로우 바이트의 비트 의 값들을 로 설정하는 것은 유보되어 있고 나머SUT1~0 : 5~4(SUT1~0) 11

지 값들 으로 하면 기동시간이 클럭으로 설정된다 또한 로의 설정은(00,01,10) 6 . 00 BOD(Brown Out Detector)

사용에 권장되고 로 하면 리셋의 경우 추가적으로 의 지연이 발생하고 사용에 권, 01 4.1 ms Fast rising power

장되고 로 하면 리셋의 경우 추가적으로 의 지연이 발생하고 사용에 권장된다, 10 65ms slowly rising power .

� 유의점 클럭 주파수가 이상 변동하면 시스템의 동작이 불안정해지므로 변동이 없도록 해야 한다: 2% .

1.6.2.6.1.6.2.6.1.6.2.6.1.6.2.6. 레지스터를 이용한 클럭 주파수 조정레지스터를 이용한 클럭 주파수 조정레지스터를 이용한 클럭 주파수 조정레지스터를 이용한 클럭 주파수 조정XDIVXDIVXDIVXDIV

레지스터를 이용하여 클럭 발생원을 로 분주한 주파수값을 시스템 클럭으로 사용할XDIV(Xtal DIVide) 2~129

수 있도록 설정할 수 있다.

� 비트 로 설정되면 클럭발생원의 주파수 값 을 의 값으로 설정7(XDIVEN:Xtal DIVide ENable) : 1 (clk) XDIV6~0

한 값을 이용하여 다음의 공식에 따라 모든 클럭의 주파수값 으로 설정한다d (f) .

   

� 비트 클럭 주파수의 분주비를 설정한다6~0(XDIV6~0) : .

그림 21 슬립모드의 설정출처. ( :ATMEL)

1.6.3.1.6.3.1.6.3.1.6.3.1.6.3.1.6.3.1.6.3.1.6.3.1.6.3.1.6.3.1.6.3.1.6.3. 모드모드모드모드SleepSleepSleepSleep 모드모드모드모드SleepSleepSleepSleep 모드모드모드모드SleepSleepSleepSleep

전원을 절약할 수 있는 가지의 다양한 슬립모드가 제공된다6 . 레지스터를 설정하여 모드를 선택하고MCUCR

명령을 실행하여 슬립모드에 돌입하도록 한다SLEEP .
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1.6.3.1.1.6.3.1.1.6.3.1.1.6.3.1. 레지스터를 이용한 모드 설정레지스터를 이용한 모드 설정레지스터를 이용한 모드 설정레지스터를 이용한 모드 설정MCUCRMCUCRMCUCRMCUCR

의 비트 비트 를 이용해 모드를 설정한다MCUCR(MCU Control Register) 5(SE), 4,3,2(SM1,SM0,SM2) .

� 비트 디폴트는 으로 로 세트되면 명령시 슬립모드의 돌입이 허용한다5(SE:Sleep Enable) : 0 1 SLEEP .

� 비트 그림 과 같은 형태로 값을 조절하여 모드를 설정할 수 있다4,3,2(SM1,SM0,SM2) : 21 .

1.6.3.2.1.6.3.2.1.6.3.2.1.6.3.2. 모드모드모드모드IdleIdleIdleIdle

의 동작은 멈추지만 아날로그 비교기 타이머 워치독 인터럽트의 동작은 유지CPU SPI, USART, , ADC, TWI, , ,

된다.   클럭은 차단되지만 나머지 클럭은 공급된다.

1.6.3.3.1.6.3.3.1.6.3.3.1.6.3.3. 모드모드모드모드ADC noise reductionADC noise reductionADC noise reductionADC noise reduction

의 동작은 멈추지만 타이머 워치독 인터럽트의 동작은 유지된다CPU ADC, TWI, 0, , .     

클럭은 차단되지만 나머지 클럭은 공급된다 가 잡음에 영향을 덜받아서 정밀하게 동작할 수 있도록 하는 모. ADC

드로 의 동작이 활성화된 경우 모드로의 돌입은 변환이 자동으로 시작된다ADC ADC noise reduction ADC .

1.6.3.4.1.6.3.4.1.6.3.4.1.6.3.4. 모드모드모드모드Power-downPower-downPower-downPower-down

외부 수정 발진기 또는 세라믹 의 동작이 정지되며 워치독 인터럽트의 동작은 유지된다 모든resonator TWI, , .

클럭이 차단되어 비동기 모듈의 동작만이 가능하다 이 모드가 해제될 때는 클럭이 안정적으로 되기 위해 충분한.

여유 기동시간이 필요한데 이를 사용자가 지정할 수 있다.

1.6.3.5.1.6.3.5.1.6.3.5.1.6.3.5. 모드모드모드모드Power-savePower-savePower-savePower-save

모드와 유사하나 레지스터의 비트를 로 설정하여 타이머 을 단자로Power-down ASSR AS0 1 0 TOSC1, TOSC2

입력되는 외부 클럭에 의하여 비동기로 동작시킬 때 사용하는 것이 다른 점이다.  클럭을 제외한 모든 클

럭이 차단된다.

1.6.3.6.1.6.3.6.1.6.3.6.1.6.3.6. 모드모드모드모드StandbyStandbyStandbyStandby

외부 수정 발진기 또는 세라믹 을 클럭 발생원으로 한 경우에만 가능한 슬립모드로 모드resonator Power-down

와 유사하나 발진기가 동작하는 것이 다르다 해제되어 정상동작이 개시되는데 개의 클럭 사이클만이 소요된다. 6 .

1.6.3.7.1.6.3.7.1.6.3.7.1.6.3.7. 모드모드모드모드Extended StandbyExtended StandbyExtended StandbyExtended Standby

외부 수정 발진기 또는 세라믹 을 클럭 발생원으로 한 경우에만 가능한 슬립모드로 모드resonator Power-save

와 유사하나 발진기가 동작하는 것이 다르다 해제되어 정상동작이 개시되는데 개의 클럭 사이클만이 소요된다. 6 .

그림 22 슬립모드의 동작 요약출처. ( :ATMEL)
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1.6.3.8.1.6.3.8.1.6.3.8.1.6.3.8. 슬립모드의 동작 요약슬립모드의 동작 요약슬립모드의 동작 요약슬립모드의 동작 요약

� 동작 의 를 로 세트하고 을 그림 에 따라 모드를 설정하고 명령어를 실행 시킨: MCUCR SE 1 SM2~0 21 SLEEP

다 개의 동작모드 동. 6 Idle, ADC noise reduction, Power-down, Power-save, Standby, Extended Standby

작 요약은 그림 에 주어졌다22 .

� 인터럽트에 의한 해제 슬립모드안에서 인터럽트를 만나면 가 동작을 시작하고 슬립모드가 해제되는데: MCU

기동시간 이외에 사이클이 더 경과한 후에 동작이 개시되고 인터럽트 서비스를 다 실행하고 슬립모드에 돌입하4

도록 한 이전의 명령의 바로 뒤에 이어지는 명령으로 복귀된다 해제된 모든 레지스터와 메모리에 있는SLEEP .

내용은 슬립모드 이전의 값이 보존된다.

� 리셋에 의한 해제 슬립모드에서 리셋이 발생하면 슬립모드가 해제되고 리셋동작이 수행된다: .

1.7.1.7.1.7.1.7.1.7.1.7.1.7.1.7.1.7.1.7.1.7.1.7. 과 타이머과 타이머과 타이머과 타이머Reset WatchdogReset WatchdogReset WatchdogReset Watchdog과 타이머과 타이머과 타이머과 타이머Reset WatchdogReset WatchdogReset WatchdogReset Watchdog과 타이머과 타이머과 타이머과 타이머Reset WatchdogReset WatchdogReset WatchdogReset Watchdog

1.7.1.1.7.1.1.7.1.1.7.1.1.7.1.1.7.1.1.7.1.1.7.1.1.7.1.1.7.1.1.7.1.1.7.1. 리셋리셋리셋리셋리셋리셋리셋리셋리셋리셋리셋리셋

� 정상적으로 동작하고 있는 마이컴이 리셋되면 모든 레지스터값이 디폴트값으로 초기화되고 프로그램은 리I/O

셋벡터에서 시작된다 리셋은 가지의 발생원이 존재한다. 5 .

그림 23 리셋 관련 내부 회로 블록선도출처. ( :ATMEL)
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파워온 리셋 공급전원이 그림 에 정의된: 24① 이하일 때 리셋되는 것.

외부 리셋 :② RESET핀에 이상동안 그림 에 정의된50ns 24 이하의 신호가 입력되면 리셋되는 것

리셋 공급전원이 마이크로초 이상동안 그림 에 정의된Brown-out : 2 24③ 이하로 떨어져 감Brown-out

지기가 작동해 리셋되는 것.

워치독 리셋 워치독 타이머가 지정한 주기 이상이 경과되어 워치독 기능이 동작할 때 리셋되는 것:④

리셋 이 연결되어 있고 명령 명령에 따라 선택된 리셋 레지스JTAG AVR : JTAG JTAG AVR_RESET JTAG⑤

터에 논리 이 저장되어 있는 경우 리셋되는 것1

그림 24 리셋 관련 변수출처. ( :ATMEL)

1.7.1.1.1.7.1.1.1.7.1.1.1.7.1.1. 파워온 리셋파워온 리셋파워온 리셋파워온 리셋(POR)(POR)(POR)(POR)

� 전원 투입후 제대로 리셋이 되지 않으면 와 레지스터들이 제대로 초기화되지 못하여 마이컴은 임의의 위PC

치에서 명령을 시작하게 되는데 이를 막기 위해 전원 투입후 자동으로 리셋이 되도록 하는 것을 파워온 리셋이

라 한다.

� 회로는POR 보다 공급전원이 작으면 동작이 시작되는데 공급전원이 투입되고 나서 곧바로 정상적인 레

벨로 올라가지 못하고 그림 처럼25 보다 작으므로 회로가 작동되어 파워온 리셋 동작이 시작되고 공POR

급전원이 에 도달하면 시간지연카운터를 동작시켜 일정한 시간 동안 리셋을 유지시킨다.

그림 25 파워온 리셋 동작 타이밍도출처. ( :ATMEL)

1.7.1.2.1.7.1.2.1.7.1.2.1.7.1.2. 외부 리셋외부 리셋외부 리셋외부 리셋

� RESET핀에 이상 동안 그림 에 정의된50ns 24 이하의 신호가 입력되면 리셋이 시작되는데 그림 에26

서처럼 리셋신호가 저전압을 유지하다가 이상으로 올라가면 시간지연카운터를 동작시켜 일정한 시간 
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이 부가적으로 경과될 때까지 리셋을 유지시킨다.

그림 26 외부리셋 동작 타이밍도출처. ( :ATMEL)

1.7.1.3.1.7.1.3.1.7.1.3.1.7.1.3. 리셋리셋리셋리셋Brown-outBrown-outBrown-outBrown-out

� 마이컴 내부에 있는 저전압 검출회로 가 공급전원이 마이크로초 이상동안 그림(BOD:Brown-Out Detector) 2

에 정의된24 이하로 떨어지면 발생된다.

� 그림 의 동작 타이밍도처럼 발생하는데 전압 스파이크에 의한 오동작을 줄이기 위해 히스테리시스 특성을27

갖도록 하여 전압이 감소하여    이하로 될 때 리셋동작이 시작되고 전압이 증가하여

   이상으로 된 후 시간지연카운터를 동작시켜 일정한 시간 이 부가적으로 경과될

때까지 리셋을 유지시킨다.

그림 27 저전압 검출 리셋 동작 타이밍도출처. ( :ATMEL)

� 기능은 절에 설명된 의 비트를 로 하여 활성화시킬 수 있고BOD 1.5.9 Fuse Low byte BODEN 1 BODKEVEL

비트에 따라 그림 처럼 설정할 수 있다24 .

1.7.1.4.1.7.1.4.1.7.1.4.1.7.1.4. 워치독 리셋워치독 리셋워치독 리셋워치독 리셋

� 워치독 타이머가 지정한 주기 이상이 경과되면 그림 처럼 클럭 사이클의 리셋펄스가 발생하여 리셋동작이28 1

시작되고 리셋펄스가 끝나면 시간지연카운터를 동작시켜 일정한 시간 이 부가적으로 경과될 때까지 리셋을

유지시킨다.

그림 28 워치독 리셋 동작 타이밍도출처. ( :ATMEL)
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1.7.1.5.1.7.1.5.1.7.1.5.1.7.1.5. 레지스터레지스터레지스터레지스터MCUCSRMCUCSRMCUCSRMCUCSR

레지스터는 마이컴의 리셋 발생원에 대한 정보를 제공한다MCUCSR(MCU Control and Status Register) .

� 비트 리셋이 발생한 경우 로 세트된다 파워온 리셋이나 을 써넣음으로4(JTRF:JTAG Reset Flag) : JTAG 1 . 0

써 클리어된다.

� 비트 워치독 리셋이 발생한 경우 로 세트된다 파워온 리셋이나 을 써넣음으3(WDRF:Watch Reset Flag) : 1 . 0

로써 클리어된다.

� 비트 리셋이 발생한 경우 로 세트된다 파워온 리셋이나 을2(BORF:Brown-Out Reset Flag) : Brown-out 1 . 0

써넣음으로써 클리어된다.

� 비트 외부 리셋이 발생한 경우 로 세트된다 파워온 리셋이나 을 써넣음1(EXTRF:EXTernal Reset Flag) : 1 . 0

으로써 클리어된다.

� 비트 파워온 리셋이 발생한 경우 로 세트된다 파워온 리셋이나 을 써넣0(PORF:Power-On Reset Flag) : 1 . 0

음으로써 클리어된다.

1.7.2.1.7.2.1.7.2.1.7.2.1.7.2.1.7.2.1.7.2.1.7.2.1.7.2.1.7.2.1.7.2.1.7.2. 워치독 타이머워치독 타이머워치독 타이머워치독 타이머워치독 타이머워치독 타이머워치독 타이머워치독 타이머워치독 타이머워치독 타이머워치독 타이머워치독 타이머

1.7.2.1.1.7.2.1.1.7.2.1.1.7.2.1. 워치독 타이머의 구성워치독 타이머의 구성워치독 타이머의 구성워치독 타이머의 구성

� 역할 프로세서가 안정적으로 동작하는지 감시하는 기능을 수행한다 프로세서에 이상이 생겨 일정 시간마다: .

워치독 타이머가 리셋되지 않게 되는 경우 시스템을 리셋시켜 마이컴의 안정적인 동작을 보장하도록 한다 워치.

독 타이머의 리셋은 명령을 실행하거나 워치독의 동작을 금지시키거나 마이컴이 리셋된는 경우 리셋된다WDR .

� 구성 그림 처럼 구성되어 마이컴 내부의 발진기와는 별개로 내장되어 있는 워치독발진기와 그 곳에서: 29 RC

만들어지는 클럭을 받아 이를 가지로 분주하는 워치독 프리스케일러 레지스터의 설정값에 따1MHz 8 , WDTCR

라 마이컴 리셋을 발생시키는 논리회로로 구성된다.

그림 29 워치독 타이머의 구성출처. ( :ATMEL)

1.7.2.2.1.7.2.2.1.7.2.2.1.7.2.2. 레지스터레지스터레지스터레지스터WDTCRWDTCRWDTCRWDTCR

� 비트 디폴트 값은 이다 비트가 일때 로 세트되어야 한다4(WDTOE:WatchDog Turn-Off Enable) : 0 . WDE 0 1 .

그렇지 않으면 워치독은 비활성화된다 로 세트되면 클록이 지난 후에 하드웨어적으로 클리어된다 안전 레벨. 1 4 .

과 에서 프리스케일러 비트를 바꾸는 경우 로 세트되어야 한다1 2 1 .

� 비트 디폴트 값은 이다 로 세트되면 워치독 타이머가 활성화되고 으로 클리3(WDE:WatchDog Enable) : 0 . 1 0

어되면 비활성화된다 는 비트가 로 세트된 경우에만 클리어될 수 있다. WDE WDCE 1 .
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� 비트 디폴트 값은 이다 워치독 타이머가 활성화된 경우2~0(WDP2~0: Watch-Dog timer Prescaler2~0) : 0 .

프리스케일러를 그림 처럼 설정한다30 .

그림 30 워치독 타이머 프리스케일러의 설정출처. ( :ATMEL)

1.7.2.3.1.7.2.3.1.7.2.3.1.7.2.3. 워치독의 설정워치독의 설정워치독의 설정워치독의 설정

� 워치독 타이머의 안전레벨 설정 절에 소개된 의 비트들 값으로 안전레벨: 1.5.9.1 Etended Fuse Byte 0, 1, 2

로 그림 에 보여진 것처럼 설정할 수 있다퓨즈의 비트값들은 프로그램되면 이되고 프로그램되지 않으면31 ( 0 1).

그림 31 워치독 타이머의 설정출처. ( :ATMEL)

� 안전레벨 과 호환모드로 그림 에 보여진 것처럼 초기에는 워치독이 금지되어 있다 를0 : ATmega103 31 . WDE

로 세트하면 워치독이 허용된다 를 바꿔 즉 프리스케일러의 값을 바꿔 타임아웃 주기를 변경시키는1 . WDP2~0

것에는 제한이 없으나 워치독 타이머를 비활성화시키려면 다음의 과정을 거쳐야 한다.

레지스터에 동시에 로 세트시킨다WDTCR WDCE=1, WDE=1 .①

클록 사이클 이내에 으로 클리어시킨다4 WDE=0 .②

� 안전레벨 디폴트 상태이다 그림 에 보여진 것처럼 초기에는 워치독이 금지되어 있다 를 로 세트1 : . 31 . WDE 1

하면 워치독이 허용된다 를 바꿔 즉 프리스케일러의 값을 바꿔 타임아웃 주기를 변경시키거나 워치독. WDP2~0

타이머를 비활성화시키려면 다음의 과정을 거쳐야 한다.

레지스터에 동시에 로 세트시킨다WDTCR WDCE=1, WDE=1 .①

클록 사이클 이내에 비트와 비트에 원하는 값을 쓴다4 WDE WDP2~0 .②

� 안전레벨 그림 에 보여진 것처럼 초기에 워치독이 허용되어 있고 가 로 세트되어 있고 워치독을2 : 31 WDE 1

비활성화시킬 수 없다 를 바꿔 즉 프리스케일러의 값을 바꿔 타임아웃 주기를 변경시키려면 다음의 과. WDP2~0

정을 거쳐야 한다.

레지스터에 동시에 로 세트시킨다WDTCR WDCE=1, WDE=1 .①

클록 사이클 이내에 으로 클리어시키고 비트에 원하는 값을 쓴다4 WDCE=0 WDP2~0 .②
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2.2.2.2.2.2.2.2.2.2.2.2. 시스템 개발 기초시스템 개발 기초시스템 개발 기초시스템 개발 기초ATmega128ATmega128ATmega128ATmega128 시스템 개발 기초시스템 개발 기초시스템 개발 기초시스템 개발 기초ATmega128ATmega128ATmega128ATmega128 시스템 개발 기초시스템 개발 기초시스템 개발 기초시스템 개발 기초ATmega128ATmega128ATmega128ATmega128

2.1.2.1.2.1.2.1.2.1.2.1.2.1.2.1.2.1.2.1.2.1.2.1. 명령어 분류와 주소지정 방식명령어 분류와 주소지정 방식명령어 분류와 주소지정 방식명령어 분류와 주소지정 방식명령어 분류와 주소지정 방식명령어 분류와 주소지정 방식명령어 분류와 주소지정 방식명령어 분류와 주소지정 방식명령어 분류와 주소지정 방식명령어 분류와 주소지정 방식명령어 분류와 주소지정 방식명령어 분류와 주소지정 방식

� 명령어 기본 형식 명령어는: 명령코드 코드 와(OP :OPeration code) 오퍼랜드 로 구성되는데 명령코(operand)

드는 명령 그 자체이고 오퍼랜드는 명령의 대상으로 레지스터 메모리 상수값이 사용될 수 있으며 명령에 따라, ,

오퍼랜드 없이 명령코드에 포함되는 경우가 있다 명령코드는 대부분 비트의 길이이지만. 16 LDS, STS, JMP,

개의 명령어는 비트이다CALL 4 32 .

� 실행시간에 따른 분류 실행하는데 기계사이클를 요구하여 기계사이클 명령어예 와: 1~4 1 ( : ADD Rd, Rr)①

기계사이클 명령어예 기계사이클 명령어예 혹은 기계사이클 명령어2 ( :ADIW Rdl, K) 3 ( :ELPM LPM) 4② ③ ④

예 혹은 로 나뉠 수 있다( :RETI RET) .

� 기능에 따른 분류 데이터전송 산술과 논리 연산 분기 비트 조작 제어 명령으로 나눌 수 있다: , , , , MCU .

데이터전송 명령 내부램이나 외부램의 데이터 전송을 위한 명령으로:① MOV, MOVW, LDI, LD, LDD, LDS,

ST, STD, STS, LPM, ELPM, SPM, IN, OUT, PUSH, 등 가지가 관계된다POP 16 .

산술과 논리연산 명령 가감산 증감 곱하기 등 산술연산과 논리연산 명령어로: , ,② ADD, ADC, ADIW, SUB,

SUBI, SBC, SBCI, SBIW, AND, ANDI, OR, ORI, EOR, COM, NEG, SBR, CBR, INC, DEC, TST, CLR, SER,

MUL, MULS, MULSU, 등 가지가 관계된다FMUL, FMULS, FMULSU 28 .

분기 명령 조건을 따져 분기하거나 프로그램의 실행순서를 바꾸는 명령으로:③ RJMP, IJMP, JMP, RCALL,

ICALL, CALL, RET, RETI, CPSE, CP, CPC, CPI, SBRC, SBRS, SBIC, SBIS, BRBS, BRBC, BREQ, BRNE,

BRCS, BRCC, BRSH, BRLO, BRMI, BRPL, BRGE, BRLT, BRHS, BRHC, BRTS, BRTC, BRVS, BRVC, BRIE,

등이 관계된다BRID .

비트 조작 명령 비트값에 대한 비트조작 불리안 연산 명령으로: 1 SBI, CBI, LSL, LSR, ROL, ROR, ASR,④

SWAP, BSET, BCLR, BST, BLD, SEC, CLC, SEN, CLN, SEZ, CLZ, SEI, CLI, SES, CLS, SEV, CLV, SET,

등이 관계된다CLT, SEH, CLH .

제어 명령 등 개의 제어 관련 명령MCU : NOP, SLEEP, WDR, BREAK 4 MCU⑤

� 오퍼랜드의 주소지정방식

① 직접상수지정 방식 오퍼랜드로서 상수값을 사용하는 방식이다: .

직접주소지정 방식 오퍼랜드로서 개의 레지스터의 주소값을 직접 지정한다I/O : 64 I/O .②

③ 레지스터직접주소지정 방식 이 오퍼랜드로서 지정된다: R0~R31 .

④ 데이터 직접주소지정 방식 오퍼랜드로서 데이터 메모리 영역의 비트 주소값을 직접 지정한다: 16 .

⑤ 데이터 간접지정 방식 오퍼랜드의 주소를 저장하고 있는 레지스터를 이용하여 간접적으로 지정한다: X,Y,Z .

선증가 데이터 간접지정방식 데이터 간접지정방식과 비슷하나 레지스터값을 먼저 만큼 감소시킨다: X,Y,Z 1 .⑥

후증가 데이터 간접지정방식 데이터 간접지정방식과 비슷하나 레지스터값을 명령 실행 후에 만큼: X,Y,Z 1⑦

증가시킨다.

변위 데이터 간접지정방식 데이터 간접지정과 비슷하나 레지스터값에 변위값을 합하여 사용한다: Y,Z .⑧

프로그램 메모리 상수 지정방식 레지스터를 사용하여 프로그램 메모리 영역의 상수값을 지정한다: Z .⑨

후증가 프로그램 메모리 상수 지정방식 프로그램 메모리 상수 지정방식과 비슷하나 레지스터 값을 명령: Z⑩

실행 후에 만큼 증가시킨다1 .
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2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2. 명령어 요약명령어 요약명령어 요약명령어 요약명령어 요약명령어 요약명령어 요약명령어 요약명령어 요약명령어 요약명령어 요약명령어 요약

다음은 의 명령을 요약한 것으로 항목에서 은 수행에 걸리는 기계사이클 은 명령 수ATmega128 #clocks , Flags

행으로 영향을 받는 의 비트를 의미한다 그리고 다음의 정의들이 사용된다CSEG . .

Rd Destination register R0~R31 Rr Source register R0~R31
b, s 바이트 데이터의 비트번호값 0~7 P 레지스터 주소값I/O (0-31/63)
K 비트 상수값8 k,q 상수
Rdl R24, R26, R28, R30. X Indirect address register R27:R26

Y Indirect address register R29:R28 Z Indirect address register R31:R30

표 7 어셈블리 명령에 쓰인 약자의 의미.

� 분기 명령분기 명령분기 명령분기 명령

그림 32 분기 명령 모음 출처. ( :ATMEL)

� 제어 명령제어 명령제어 명령제어 명령MCUMCUMCUMCU

그림 33 제어 명령 모음 출처. MCU ( :ATMEL)
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� 데이터전송 명령데이터전송 명령데이터전송 명령데이터전송 명령

그림 34 데이터 명령 모음출처. ( :ATMEL)

� 산술과 논리 연산 명령산술과 논리 연산 명령산술과 논리 연산 명령산술과 논리 연산 명령

그림 35 산술과 논리 연산 명령 모음출처. ( :ATMEL)
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� 비트 조작 명령비트 조작 명령비트 조작 명령비트 조작 명령

그림 36 비트 조작 명령 모음 출처. ( :ATMEL)

2.2.1.2.2.1.2.2.1.2.2.1.2.2.1.2.2.1.2.2.1.2.2.1.2.2.1.2.2.1.2.2.1.2.2.1. 어셈블리어의 일반형태어셈블리어의 일반형태어셈블리어의 일반형태어셈블리어의 일반형태어셈블리어의 일반형태어셈블리어의 일반형태어셈블리어의 일반형태어셈블리어의 일반형태어셈블리어의 일반형태어셈블리어의 일반형태어셈블리어의 일반형태어셈블리어의 일반형태

� 어셈블리어의 일반형태는 아래와 같다.

라벨 개 이상의 공백 명령어혹은 지시어 개 이상의 공백 주석[ + : + 1 ] + ( ) + [1 + ; + ]

예( : START: LDI AL, 0b10000000 에 이진수 값을 넣어라;AL 10000000 . )

� 라벨 은 기호주소로 분기명령이나 참조에 사용되는(Label) 심볼 로 심볼과 바로 뒤에 공백없이(Symbol) ① :

콜론 을 두고 콜론과 명령어는 개 이상의 공백을 두어야 한다 어셈블러어셈블리어를 기계어로 바꾸어주는( ) 1 . (②

프로그램에 따라 다르지만 길이는 보통 에서 수십개까지의 기호가 허용되고 에서 심볼은 영문자) 1 AVR Studio4

와 숫자와 특수문자 의 조합을 사용하고 처음은 반드시 숫자가 아닌 기호영문자나 로 시작해야한다(_) ( _) . ③

과 같은 어셈블러 특수 심볼 그리고 명령어와 지시어 등 예약어는 심볼로 사용될 수 없고 심볼은 보R0-R31 ④

통 명령어 지시어와 함께 대문자와 소문자의 구분이 없다 에서 구분을 하게 옵션 설정 가능, (AVR Studio4 ).

� 주석은 반드시 앞에 세미콜론을 붙여야 하는데 어셈블러는 세미콜론과 같은 줄에 존재하며 세미콜론 뒤쪽에;( )

존재하는 글은 주석으로 여기고 모두 무시한다.

2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2.2. 지시어 의사 명령지시어 의사 명령지시어 의사 명령지시어 의사 명령( )( )( )( )지시어 의사 명령지시어 의사 명령지시어 의사 명령지시어 의사 명령( )( )( )( )지시어 의사 명령지시어 의사 명령지시어 의사 명령지시어 의사 명령( )( )( )( )

� 지시어란 기계어로 번역되지 않고 어셈블러에게 어떤 정보만을 제공하는 것으로 의사명령이라고 불린다.

� CSEGCSEGCSEGCSEG 프로그램 메모리에 해당하는 코드 세그먼트의 시작을 정의한다 파라메터를 갖고 있지 않다: . .

� DSEGDSEGDSEGDSEG 데이터 메모리 세그먼트의 시작을 정의한다 파라메터를 갖고 있지 않다: SRAM . .

� ESEGESEGESEGESEG 데이터 메모리 세그먼트의 시작을 정의한다 파라메터를 갖고 있지 않다: EEPROM . .

� EQUEQUEQUEQU 개 이상의 공백 심볼 개 이상의 공백 상수값의 형태로 어떤 심볼의 값을 정의하는데: .EQU +1 + +1 +

사용된다 를 사용하면 숫자로 된 값대신에 기억하기 쉬운 심볼을 사용하여 프로그램을 쉽게 할 수 있다. EQU .

어셈블러에서는 기계어로 번역할 때 라벨을 상수값으로 대체하여 해석하게 된다 한 번 할당된 값은 수정되거나.

다시 정의될 수 없다.

예 : .EQU BUF= 0x20 기계어로 번역시 는 으로 대체된다; BUF 0x20 .
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� SETSETSETSET 와 유사하나 나중에 다시 정의되어 수정 가능하다: EQU .

� DEFDEFDEFDEF 개 이상의 공백 심볼 개 이상의 공백 레지스터이름의 형태로 기억하기 쉬운 심볼에: .DEF +1 + +1 +

레지스터를 할당하여 프로그램을 쉽게 할 수 있다 나중에 다시 정의되어 수정 가능하고 같은 레지스터에 여러.

가지 심볼을 할당할 수 있다.

예 : .DEF BUF= R0 는; BUF R0

� UNDEFUNDEFUNDEFUNDEF 개 이상의 공백 심볼의 형태로 심볼에 레지스터를 할당한 것을 해제한다: .UNDEF +1 + .

예 : .UNDEF 를 해제BUF ; BUF

� ORG :ORG :ORG :ORG : 개 이상의 공백 주소의 형태로 바로 뒤에 오는 프로그램 명령어의 시작번지나 데이터의 시.ORG +1 +

작번지 지정에 사용된다 주소로는 숫자 뿐만 아니라 라벨도 사용될 수 있다 다음과 같은 프로그램의 경우 명령. .

어 와 그 이후의 명령은 프로그램 메모리의 번지를 시작으로 차례로 저장된다LDI AL, 0b10000000 20 .

예: .CSEG
.ORG 0x0020

START: LDI AL, 0b10000000 에 이진수 값을 넣어라;AL 10000000 .
.............

� BYTEBYTEBYTEBYTE 심볼 개 이상의 공백 개 이상의 공백 숫자의 형태로 데이터 세그먼트에: +: +1 +.BYTE +1 + SRAM

숫자 만큼의 메모리를 바이트 단위로 예약해둔다.

예 : CNT: .BYTE 1 을 위해 바이트를 유보해 두라;CNT 1 .

� DBDBDBDB 라벨 개 이상의 공백 개 이상의 공백 데이터의 형태로 바이트 비트(Define Byte) : +: + 1 +.DB +1 + 1 (8 )

단위로 숫자나 문자 데이터들을 프로그램 메모리나 세그먼트에 저장할 때 사용한다EEPROM .

예 : .ESEG
DATA: DB 1, 2, 'S' 라벨 번지에 을 에 를 에 를 저장; DATA 1 DATA+1 2 DATA+2 ‘S' .

� DWDWDWDW 라벨 개 이상의 공백 개 이상의 공백 데이터의 형태로 워드 바이(Define Word) : +: + 1 +.DW +1 + 1 (2

트 비트 단위로 숫자나 문자 데이터들을 프로그램 메모리나 세그먼트에 저장할 때 사용한다,16 ) EEPROM .

� DDDDDDDD 라벨 개 이상의 공백 개 이상의 공백 데이터의 형태로 워드(Define Doubleword) : +: + 1 +.DD +1 + 2

바이트 비트단위로 숫자나 문자 데이터들을 프로그램 메모리나 세그먼트에 저장할 때 사용한다(4 , 32 ) EEPROM .

� DQDQDQDQ 라벨 개 이상의 공백 개 이상의 공백 데이터의 형태로 워드(Define Quadword) : +: + 1 +.DQ +1 + 4 (8

바이트 비트단위로 숫자나 문자 데이터들을 프로그램 메모리나 세그먼트에 저장할 때 사용한다, 64 ) EEPROM .

� INCLUDEINCLUDEINCLUDEINCLUDE 개 이상의 공백 파일이름 의 형태로 외부의 파일을 하여 어셈블할: .INCLUDE + 1 +"+ +“ include

때 사용한다.

� IFIFIFIF 개 이상의 공백 조건식의 형태로 조건식을 만족하면 아래 부분를 어셈블한다: .IF + 1 + .

� ELIFELIFELIFELIF 개 이상의 공백 조건식의 형태로 앞선 의 조건을 만족시키지 않는 다른 조건을 판단할: .ELIF + 1 + IF

때 사용하며 주어진 조건식을 만족하면 아래 부분를 어셈블한다.

� IFDEFIFDEFIFDEFIFDEF 개 이상의 공백 심볼의 형태로 심볼이 정의되어 있으면 아래 부분을 어셈블한다: .IFDEF + 1 + .

� IFNDEFIFNDEFIFNDEFIFNDEF 개 이상의 공백 심볼의 형태로 심볼이 정의되지 않았으면 아래 부분을 어셈블한다: .IFNDEF + 1 + .

� ELSEELSEELSEELSE 와 같은 조건문에서 이전 조건이 만족되지 않으면 아래 부분을 어셈블한다: IF, IFDEF, IFNDEF .

� ENDIFENDIFENDIFENDIF 의 형태로 조건 블록의 마지막을 표시한다: .ENDEF .

� 혹은혹은혹은혹은ENDMENDMENDMENDM ENDMACRO :ENDMACRO :ENDMACRO :ENDMACRO : 혹은 의 형태로 마크로를 정의를 종료할 때 사용한다.ENDM .ENDMACRO .

� MACRO :MACRO :MACRO :MACRO : 개 이상의 공백 마크로이름의 형태로 마크로를 정의할 때 사용한다 마크로는.MACRO + 1 + .

로 지정된 개까지의 파라메터가 사용될 수 있고 마크로를 호출할 때는 아래의 예에서처럼 마크로 이@0~@9 10

름 다음에 공백을 두고 해당 파라메터를 차례로 를 사용해 나열하면 된다, .

예: .MACRO SUBL16 ; Start macro definition
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� ERRORERRORERRORERROR 개 이상의 공백 주의문장 의 형태로 어셈블시 주의문장을 출력하고 어셈블을 중: .WARNING + 1 +" “

지한다.

예: .IFDEF EXPTEST

� WARNINGWARNINGWARNINGWARNING 개 이상의 공백 주의문장 의 형태로 어셈블시 주의문장을 출력하나 처: .WARNING + 1 +" “ ERROR

럼 어셈블을 중지하지는 않는다.

예: .IFDEF EXPTEST

2.2.3.2.2.3.2.2.3.2.2.3.2.2.3.2.2.3.2.2.3.2.2.3.2.2.3.2.2.3.2.2.3.2.2.3. 숫자 문자 연산자숫자 문자 연산자숫자 문자 연산자숫자 문자 연산자, ,, ,, ,, ,숫자 문자 연산자숫자 문자 연산자숫자 문자 연산자숫자 문자 연산자, ,, ,, ,, ,숫자 문자 연산자숫자 문자 연산자숫자 문자 연산자숫자 문자 연산자, ,, ,, ,, ,

� 오퍼랜드로 상수값을 사용할 때는 반드시 진법 표현을 명확히 해야 한다 진수의 경우에는 를 앞에 붙여주. 2 0b

고 예 진수의 경우에는 혹은 를 붙여주고 진수의 경우 를 붙여주고 진수의 경우에( : 0b00000000), 16 0x $ , 8 O , 10

는 아무런 표시도 하지 않는다.

� 문자상수값은 반드시 앞뒤에 반드시 따옴표 를 붙여준다 문자열의 경우에는 큰 따옴표를 사용한다(’) . .

� 오퍼랜드에 사용되는 수식의 연산자에는 산술연산자 논리 연산자 비교 연산자 조건연산자가 있다, , , .

� 산술연산자로 더하기 빼기 나누기 곱하기 나머지가 정수가 되도록 나눈 나누기 연산의 나머지+( ), -( ), /( ), *( ), %(

값을 결과로 내놓는 연산 오른쪽으로 이동 왼쪽으로 이동이 있다mode ), <<( ), >>( ) .

� 논리 연산자로 논리곱 논리합 비트단위 비트단위 비트단위 비!(NOT), &&( ), ||( ), ~( NOT), &( AND), |( OR), ^(

트단위 이 쓰인다exclusive OR) .

� 비교 연산자로 동치== ( ), != (Not Equal), < (Less Than), <= (Less than or Equal to), > (Greater

가 있다Than), >= (Greater than or Equal to) .

� 조건 연산자로 아래와 같은 형식으로 사용하며 삼항 연산자로 보통 불린다 조건식이 참이거나 이 아니면 식. 0

을 처리하고 거짓이거나 이면 식 를 처리하라는 의미이다1 0 2 .

변수 조건 식 식= ( ) ? 1 : 2;

2.2.4.2.2.4.2.2.4.2.2.4.2.2.4.2.2.4.2.2.4.2.2.4.2.2.4.2.2.4.2.2.4.2.2.4. 함수함수함수함수함수함수함수함수함수함수함수함수

� 의 하위 바이트값을 돌려준다LOW(x) : x .

� 의 번째 바이트값을 돌려준다HIGH(x) : x 2 .

� 의 번째 바이트값을 돌려준다BYTE2(x) : x 2 .

� 의 번째 바이트값을 돌려준다BYTE3(x) : x 3 .

� 의 번째 바이트값을 돌려준다BYTE4(x) : x 4 .

� 의 비트 값을 돌려준다LWRD(x) : x 15~0 .

� 의 번째 바이트값을 돌려준다HWRD(x) : x 4 .

� 의 비트 값을 돌려준다PAGE(x) : x 16~21 .

� EXP2(x) : 값을 돌려준다.
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� LOG2(x) : 값의 정수부를 돌려준다.

� 의 정수부분을 돌려준다INT(x) : x .

� 의 소수부분을 돌려준다FRAC(x) : x .

� 를 명령에 적절한 형태의 부호있는 바이트 수로 변환한다Q7(x) : x FMUL/FMULS.FMULSU 1 .

� 를 명령에 적절한 형태의 부호있는 바이트 수로 변환한다Q15(x) : x FMUL/FMULS.FMULSU 1 .

� 의 절대값을 돌려준다ABS(x) : x .

� 라는 심볼이 정의된 경우 을 돌려준다DEFINED(x) : x 1 .

2.3.2.3.2.3.2.3.2.3.2.3.2.3.2.3.2.3.2.3.2.3.2.3. AVR Studio4AVR Studio4AVR Studio4AVR Studio4AVR Studio4AVR Studio4AVR Studio4AVR Studio4AVR Studio4AVR Studio4AVR Studio4AVR Studio4

는 사 에서 개발한 용의 소프트웨어 개발툴로 현재AVR Studio ATMEL (http://www.atmel.com) AVR Ver

이 나와있어 윈도우즈에 기반한 통합 개발환경을 제공한다 에뮬레이터와 시뮬레이터를 동시에 사용할4.13.528 .

수 있고 어셈블러를 제공한다 만약에 등의 에뮬레이터가 의 직. AVRISP, JTAG ICE, STK500, ICE40, ICE50 PC

렬포트에 접속되어 있으면 에뮬레이터로 동작하고 그렇지 않으면 시뮬레이터로 동작한다.

2.3.1.2.3.1.2.3.1.2.3.1.2.3.1.2.3.1.2.3.1.2.3.1.2.3.1.2.3.1.2.3.1.2.3.1. 새 프로젝트 등록과 실행 파일 만들기새 프로젝트 등록과 실행 파일 만들기새 프로젝트 등록과 실행 파일 만들기새 프로젝트 등록과 실행 파일 만들기새 프로젝트 등록과 실행 파일 만들기새 프로젝트 등록과 실행 파일 만들기새 프로젝트 등록과 실행 파일 만들기새 프로젝트 등록과 실행 파일 만들기새 프로젝트 등록과 실행 파일 만들기새 프로젝트 등록과 실행 파일 만들기새 프로젝트 등록과 실행 파일 만들기새 프로젝트 등록과 실행 파일 만들기

초기화면초기화면초기화면초기화면①①①① : 을 에서 내려받아 설치하고 실행하면 그림AVR Studio Ver 4.13.528 http://www.atmel.com 37

과 같은 초기화면이 뜬다 상단에 메뉴가 있고. [File], [Project], [Build], [View], [Tools], [Debug], [Help]

등의 메뉴를 갖는 라는 이름의 작은 창이 있고 그 이외에[New Project], [Open] Welcome to AVR Studio 4

라는 이름의 작은 창이 있다I/O View, Message .

그림 37 의 초기화면. AVR Studio
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실행실행실행실행New Project :New Project :New Project :New Project :②②②② 라는 이름의 작은 창의 메뉴 를 클릭하면Welcome to AVR Studio 4 [New Projct]

그림 과 같은 창이 뜨게 된다 이 창에서 프로젝트 형태어떤 어셈블러를 사용할 것인가를 결정 프로젝트 이38 . ( ),

름 어셈블리어 파일 이름 파일들이 위치할 디렉토리를 결정할 수 있다, , .

그림 38 의 실행. New Project

프로젝트의 설정프로젝트의 설정프로젝트의 설정프로젝트의 설정③③③③ 그림 와 같이 메뉴에서 로 을 선택하고: 39 Project type Atmel AVR Assember Project

와 은 적절한 값으로 설정한다여기에서는 각각name Initial File, Location ( hhchoi, hhchoi, C:\Documents and

로 설정했다 그러면 그림 처럼 메뉴가 활성화된다Settings\GX620\My Documents\avr\at128 ). 39 [Next] .

그림 39 프로젝트의 설정.
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플랫폼과 디바이스 설정플랫폼과 디바이스 설정플랫폼과 디바이스 설정플랫폼과 디바이스 설정DebugDebugDebugDebug④④④④ 와 은 적절한 값으로 설정하고: Project name Initial File, Location

메뉴를 누르면 그림 과 같이 디버그 플랫폼과 디바이스를 설정하는 창이 뜬다 은[Next] 40 . Debug platform

를 선택하고 는 을 선택하고 마지막으로 메뉴를 누른다AVR Simulator Device ATmega128 [Finish] .

그림 40 디버그 플랫폼과 디바이스의 설정.

에디터 창 생성에디터 창 생성에디터 창 생성에디터 창 생성⑤⑤⑤⑤ : 디버그 플랫폼과 디바이스를 설정하고 메뉴를 누르면 그림 과 같이 프로젝트 설[Finish] 41

정단계에서 지정한 어셈블리 파일의 코드를 작성할 수 있는 파일 이름을 갖는 에디터 창과 라는 이름의 조Project

그만 창이 뜬다.

그림 41 프로젝트 등록의 최종 결과로 생긴 에디터 창.
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실행실행실행실행BuildBuildBuildBuild⑥⑥⑥⑥ 어셈블리 파일의 코드를 작성한 이후에 메인창의 메뉴를 그림 처럼 선택하여 실행시: [Build] 42

킨다.

그림 42 실행. Build

에러없이 종료된 결과에러없이 종료된 결과에러없이 종료된 결과에러없이 종료된 결과 ::::⑦⑦⑦⑦　　　　 그림 은 에러없이 실행파일이 만들어진 경우를 보여준다 라는 이름의 창에43 . Build

실행파일을 생성한 결과가 보여진다.

그림 43 성공적으로 실행파일이 만들어진 결과.
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에러가 있을 때 결과에러가 있을 때 결과에러가 있을 때 결과에러가 있을 때 결과 ::::⑧⑧⑧⑧ 그림 는 실행파일을 만드는 과정에서 문법적인 에러가 발생한 경우를 보여준다44 .

창에 에러가 발생한 행번호와 에러메시지가 나타나 있음을 알 수 있다 에러메시지 부분을 더블클릭하면 에Build .

러가 발생한 위치로 커서가 자동적으로 이동하여 손쉽게 에러를 수정할 수 있게 한다.

그림 44 에러가 있을 때 결과.

2.3.2.2.3.2.2.3.2.2.3.2.2.3.2.2.3.2.2.3.2.2.3.2.2.3.2.2.3.2.2.3.2.2.3.2. 디버깅과 시뮬레이션디버깅과 시뮬레이션디버깅과 시뮬레이션디버깅과 시뮬레이션디버깅과 시뮬레이션디버깅과 시뮬레이션디버깅과 시뮬레이션디버깅과 시뮬레이션디버깅과 시뮬레이션디버깅과 시뮬레이션디버깅과 시뮬레이션디버깅과 시뮬레이션

선택선택선택선택Debug :Debug :Debug :Debug :①①①① 문법적인 에러가 없어 실행파일이 만들어진 경우 그림 과 같이45 [Debug->Start

메뉴를 선택하면 디버깅과 간단한 시뮬레이션을 할 수 있다Debugging] .

그림 45 메뉴. [Debug->Start Debugging]
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시작시작시작시작Debug :Debug :Debug :Debug :②②②②　　　　 디버그세션을 시작하면 과 같이 창이 레지스터의 값들을 비트별로 그래픽하게46 I/O View I/O

확인할 수 있도록 변하고 에디터 창에 노란 화살표가 나타난다.

그림 46 세션의 시작. Debug

실행실행실행실행View->Register :View->Register :View->Register :View->Register :③③③③　　　　 디버그 세션에서 메인메뉴의 를 실행하면 그림 처럼[View->Register] 47

라는 이름의 창이 뜬다 디버깅하며 값이 바뀌는 레지스터의 값이 창에 나타난다Register . R0~R31 Register .

그림 47 디버그 세션에서 메인 메뉴 의 실행. [View->Register]
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실행실행실행실행View-> Memory :View-> Memory :View-> Memory :View-> Memory :④④④④　　　　 디버그 세션에서 메인메뉴의 를 실행하면 그림 처럼[View->Memory] 48

라는 이름의 창이 뜬다 그 창에는 그림 에 보여진 것처럼Memory . 48 [Data], [EEPROM], [Extended I/O],

의 서브메뉴가 있는데 이를 이용하여 데이터 메모리 레지스[I/O], [Program], [Register] SRAM , EEPROM, I/O

터 프로그램 메모리 레지스터의 값 중 특정한 어느 하나를 선택하여 변화를 모니터할 수 있다, , R0~R31 .

와 같은 역할을 하는 메뉴가 더 존재한다[View->Memory] [View->Memory2], [View->Memory3] .

그림 48 디버그 세션에서 메인 메뉴 의 실행. [View->Memory]

실행실행실행실행View-> Watch :View-> Watch :View-> Watch :View-> Watch :⑤⑤⑤⑤　　　　 디버그세션에서 메인메뉴의 를 선택하면 라는 자그만 창이[View->Watch] Watch

뜨는데 그림 처럼 에 레지스터나 심볼값을 입력하고 이들 값의 변화를 모니터할 수 있다49 Name .

그림 49 디버그 세션에서 메인 메뉴 의 실행. [View->Watch]
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디버그세션에서 여러 가지 메뉴디버그세션에서 여러 가지 메뉴디버그세션에서 여러 가지 메뉴디버그세션에서 여러 가지 메뉴 ::::⑥⑥⑥⑥　　　　 디버그세션에서 메인메뉴 의 하위 메뉴에는 그림 처럼 여러[Debug] 50

가지가 있는데 이중 메뉴는 브레이크포인트 또는 커서가 놓인 곳까지 실행하도록 한다[Run to Cursor] . [Step

는 한 명령씩 실행하도록 하며 는 서브루틴 콜도 한 명령 수행처럼 수행하도록 하고Into] [Step Over] [Auto

는 에서 알아서 적당한 지점까지 실행한다 디버그세션에서 메인메뉴의 를 선Step] Studio4 . [Goggle Breakpoint]

택하면 커서가 놓인 곳을 브레이크포인트로 설정하거나 해제한다 그 이외에 다양한 메뉴를 활용해 손쉽게 디버깅.

할 수 있다.

그림 50 메뉴의 하위메뉴들. [Debug]

2.4.2.4.2.4.2.4.2.4.2.4.2.4.2.4.2.4.2.4.2.4.2.4. 의의의의AVR ISPAVR ISPAVR ISPAVR ISP의의의의AVR ISPAVR ISPAVR ISPAVR ISP의의의의AVR ISPAVR ISPAVR ISPAVR ISP

2.4.1.2.4.1.2.4.1.2.4.1.2.4.1.2.4.1.2.4.1.2.4.1.2.4.1.2.4.1.2.4.1.2.4.1. 마이컴 시스템 개발 방법마이컴 시스템 개발 방법마이컴 시스템 개발 방법마이컴 시스템 개발 방법마이컴 시스템 개발 방법마이컴 시스템 개발 방법마이컴 시스템 개발 방법마이컴 시스템 개발 방법마이컴 시스템 개발 방법마이컴 시스템 개발 방법마이컴 시스템 개발 방법마이컴 시스템 개발 방법

2.4.1.1.2.4.1.1.2.4.1.1.2.4.1.1. 를 이용하는 법를 이용하는 법를 이용하는 법를 이용하는 법ICE (In Cricuit Emulator)ICE (In Cricuit Emulator)ICE (In Cricuit Emulator)ICE (In Cricuit Emulator)

� 의 역할의 역할의 역할의 역할ICE :ICE :ICE :ICE : 개발중인 의 마이컴 역할을 임시적으로 대신해주도록 타겟 시스템과 동일한 마Target System

이컴을 내장한 시스템

� 연결연결연결연결 :::: 타겟 시스템의 마이컴을 빼고 그 자리에 의 출력핀을 꼽고 한편 는 호스트 컴퓨터와도 연결된ICE ICE

다.

� 동작동작동작동작 :::: 소스코드 프로그램을 호스트 컴퓨터에서 과 같은 소프트웨어 개발툴을 사용해서 디버깅하고 실행PK51

파일을 만들어 에 다운로드 시키면 는 자신의 램에 저장하고 그 프로그램을 자신의 마이컴으로 실행시키ICE ICE

는데 그 핀들이 출력핀으로 타겟 시스템 마이컴 핀자리에 대신 들어가 있어 결국 타겟 시스템의 마이컴 역할을

수행한다.

� 특징특징특징특징 :::: 는 싱글 스텝 동작 역어셈블링 브레이크 기능 등 고기능으로 시스템 개발용에 가장 편리한 장비이ICE , ,

나 고가로 교육용에는 부적합하다.

2.4.1.2.2.4.1.2.2.4.1.2.2.4.1.2. 를 이용하는 법를 이용하는 법를 이용하는 법를 이용하는 법ROM EmulatorROM EmulatorROM EmulatorROM Emulator

� 롬에뮬레이터의 역할롬에뮬레이터의 역할롬에뮬레이터의 역할롬에뮬레이터의 역할 :::: 개발중인 타겟 시스템의 프로그램 메모리 역할을 임시적으로 대신해주는 마이컴 시스
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템

� 연결연결연결연결 :::: 타겟 시스템의 프로그램 메모리를 빼고 그 자리에 롬에뮬레이터 출력핀을 꼽고 한편 호스트 컴퓨터와

도 연결된다.

� 동작동작동작동작 :::: 소스코드 프로그램을 호스트 컴퓨터에서 과 같은 소프트웨어 개발툴을 사용해서 디버깅하고 실행PK51

파일을 만들어 롬에뮬레이터에 다운로드 시키면 롬에뮬레이터는 자신의 램에 저장하고 롬에뮬레이터 출력핀들이

타겟 시스템 프로그램 메모리 핀자리에 대신 들어가 있으므로 결국 타겟 시스템의 롬 역할을 수행한다.

� 특징특징특징특징 :::: 과 같이 프로그램메모리가 외장형인 경우에는 적절한 개발방법이 될 수 있으나 롬이 내장된Z80, 8031

과 같은 형태는 일부러 롬을 장착해야하므로 하드웨어적으로 복잡해지는 단점이 있다 롬에뮬레이터는 롬을8051 .

대신하는 것이라 에 비해 저가의 시스템이다ICE .

2.4.1.3.2.4.1.3.2.4.1.3.2.4.1.3. 를 이용하는 법를 이용하는 법를 이용하는 법를 이용하는 법ROM WriterROM WriterROM WriterROM Writer

� 롬라이터의 역할롬라이터의 역할롬라이터의 역할롬라이터의 역할 :::: 실행파일를 에 기록해주는 마이컴 시스템PROM

� 연결연결연결연결 :::: 타겟 시스템의 롬을 빼서롬 내장형 마이컴의 경우에는 마이컴을 뺀다 롬라이터에 장착하고 호스트 컴( )

퓨터와 연결한다.

� 동작동작동작동작 :::: 소스코드를 호스트 컴퓨터에서 과 같은 소프트웨어 개발툴을 사용해서 디버깅하고 실행파일을 만PK51

들어 롬라이터에 다운로드 시키면 롬라이터는 장착된 롬에 프로그램을 기록하고 기록이 다 끝나면 롬을 빼서 타

겟시스템에 장착하고 프로그램을 실행한다.

� 특징특징특징특징 :::: 프로그램을 교체할 때 마다 타겟 시스템의 롬을 빼어 롬 소거 롬 기록 다시 롬의 장착과 실행을 되풀, , ,

이해야하므로 엄청난 시간과 노력이 소모되며 실행하며 타겟 시스템에서의 상황을 모니터하기 어려워 디버깅도

힘이드나 나 롬에뮬레이터에 비해 롬라이터는 저가이다ICE .

2.4.1.4.2.4.1.4.2.4.1.4.2.4.1.4. 외부 을 이용하는 법외부 을 이용하는 법외부 을 이용하는 법외부 을 이용하는 법RAMRAMRAMRAM

� 외부 램의 역할외부 램의 역할외부 램의 역할외부 램의 역할 :::: 타겟 시스템에 여분의 외부램을 장착하고 이를 개발할 프로그램을 위한 메모리로 사용

� 연결연결연결연결 :::: 롬에 호스트 컴퓨터와 통신을 위한 모니터프로그램이 기록된 타겟 시스템과 호스트 컴퓨터를 연결한다.

호스트 컴퓨터에서 타겟시스템과 통신을 위한 터미널프로그램으로는 윈도우 기본 프로그램중 하나인 하이퍼터미

널이 널리 이용된다.

� 동작동작동작동작 :::: 소스코드를 호스트 컴퓨터에서 소프트웨어 개발툴을 사용해서 디버깅하고 실행파일을 만들어 하이퍼

터미널과 같은 터미널프로그램을 사용하여 모니터프로그램이 기록된 타겟 시스템에 다운로드 시키면 타겟 시스

템은 이를 외부램에 저장하고 이를 실행한다.

� 특징특징특징특징 :::: 호스트 컴퓨터인 의 통신용 소프트웨어예 하이퍼터미널를 통해 타겟 시스템과 통신할 수 있고 실PC ( : )

행 상황을 모니터할 수 있어 값싸고 실용적인 방법이나 일부러 램을 장착하고 미리 모니터프로그램을 기록해야

하는 등이 불편하다 교육용으로 많이 사용된다. .

2.4.1.5.2.4.1.5.2.4.1.5.2.4.1.5. 를 이용하는 법를 이용하는 법를 이용하는 법를 이용하는 법ISPISPISPISP

� 의 역할의 역할의 역할의 역할ISP :ISP :ISP :ISP : 은 내장 플래시롬의AVR 인터페이스를 제공한다 는 오직SPI (Serial Peripheral Interface) . SPI

라인을 이용한 통신 방법으로3 MOSI(Master Out Slave In), MISO(Master In Slave Out), SCLK(Serial

신호를 이용한다 에서 개발되었으며 와 가 에 동기하여 데이터를 교환하는CLocK) . Motolora Master Slave SCLK

방식으로 마이컴의 리셋 핀을 으로 한 상태에서 앞의 세 시그널을 이용하여 플레시롬의 데이터를 읽고RST( ) 0

쓰기가 가능하다 즉 내부에 롬라이터와 같은 기능을 하는 부분이 내장되어 있어 내부 플래시롬을 롬라이터없이.

읽고 쓰기가 가능하므로 가 지원되면 따로 롬라이터를 이용하지 않고도 기판 상에 마이컴을 실장하고SPI PCB

전원과 클럭이 공급되는 상태에서 프로그래밍이 가능한 기능이 제공된다ISP (In System Programming) .

� 연결연결연결연결 :::: 타겟 시스템과 호스트 컴퓨터를 값싼 용 인터페이스를 사용하여 연결한다ISP .

� 동작동작동작동작 :::: 소스코드를 호스트 컴퓨터에서 과 같은 소프트웨어 개발툴을 사용해서 디버깅하고 실행파일을 만PK51
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들어 호스트 컴퓨터에 설치한 용 소프트웨어를 통해 기판 상에 마이컴을 실장하고 전원과 클럭이 공급ISP PCB

되는 상태에서 프로그래밍한다.

� 특징특징특징특징 :::: 약간의 회로 추가로 시스템의 디버깅이 용이하고 업그레이드가 쉬운 시스템을 만들 수 있다는 장점이

있다 나 처럼 내부에 플래시롬이 내장되어 있고 를 지원하는 마이컴을 사용해야. AT89S8252, AT89Sxx AVR SPI

하며 부피가 커지고 제품 단가가 올라간다는 단점이 있다.

2.4.2.2.4.2.2.4.2.2.4.2.2.4.2.2.4.2.2.4.2.2.4.2.2.4.2.2.4.2.2.4.2.2.4.2. 용 다운로더용 다운로더용 다운로더용 다운로더AVR ISPAVR ISPAVR ISPAVR ISP용 다운로더용 다운로더용 다운로더용 다운로더AVR ISPAVR ISPAVR ISPAVR ISP용 다운로더용 다운로더용 다운로더용 다운로더AVR ISPAVR ISPAVR ISPAVR ISP

2.4.2.1.2.4.2.1.2.4.2.1.2.4.2.1. 와와와와AVR Studio ATAVRISPAVR Studio ATAVRISPAVR Studio ATAVRISPAVR Studio ATAVRISP

사의 는 마이컴의 프로그램을 개발하고 디버깅할수 있는 윈도우기반의 소프트웨어 개Atmel AVR Studio4 AVR

발툴로 통합 개발환경을 제공하는데 뿐만 아니라 과 의 플래시롬을 프로그래밍하는 기AVR AT89S51 AT89S52 ISP

능도 지원한다 를 이용한 를 위해서는 사의 라는 직렬통신 케이블을 사용해야. AVR Studio ISP Atmel ATAVRISP

하는데 는 호스트컴퓨터인 의 시리얼포트와 실장된 마이컴의 신호핀간의 직렬인터페이스ATAVRISP PC SPI RS-232

를 제공한다 는 사의 홈페이지인 에서 공짜로 다운로드 받을 수 있는 반. AVR Studio Atmel http://www.atmel.com

면에 는 구입해야 한다ATAVRISP .

2.4.2.2.2.4.2.2.2.4.2.2.2.4.2.2. AtmelAtmelAtmelAtmel 프로그래머프로그래머프로그래머프로그래머AVR ISPAVR ISPAVR ISPAVR ISP

사의 프로그래머는 마이컴의 내장 플래시롬을 하기위한 윈도우즈 기반의 소프트웨어로Atmel AVR ISP AVR ISP

호환기종인 와 의 도 가능하다 프로그래머를 이용한 는 호스트컴MCS-51 AT89S8252 AT89S53 ISP . AVR ISP ISP

퓨터인 의 프린터포트와 타겟시스템 마이컴의 신호핀간 인터페이스회로가 필요한데 그림 과 같이PC SPI 51

가 들어가 있어 신호를 제어하는 매우 간단한 회로면 충분하다 여기에서 은 기판 상에74HC244 . ISP CON PCB

실장되어 전원과 클럭이 공급되는 상태에서 과 연결한다 의 를 할 때는 딥스위치를 으로 하여AVR . AVR ISP on

에서 공급되는 전원을 에 넣어 작동시키고 를 다 끝낸 경우에는 딥스위츠를 로 하여VCC 74HC244 ISP off

를 꺼버려 와 마이컴의 연결을 차단한다 그림에서 는 가 진행중일 때 불이 들어와 알리는 기74HC244 PC . LED ISP

능을 하는 것으로 프린터 포트 번핀 의 번과 번핀 와 저항은 굳이 연결 안해도 된다8 (D6), 74HC244 4 16 , LED .

는 사의 홈페이지인 에서 공짜로 다운로드 받을 수 있다AVR ISP Atmel http://www.atmel.com .

그림 51 용의 인터페이스 회로. Atmel AVR ISP, PonyProg2000, CodevisonAVR ISP

2.4.2.3.2.4.2.3.2.4.2.3.2.4.2.3. PonyProg2000PonyProg2000PonyProg2000PonyProg2000

은 윈도우즈기반의 직렬통신을 통한 여러 다양한 마이컴과 을 읽고 쓰기위한 공짜 소프트PonyProg2000 PROM

웨어로 에서 무료로 다운로드 가능하다 는 원래 직렬통신을 위한 것이지http://www.lancos.com . PonyProg2000

만 그림 에 주어진 용 인터페이스회로를 사용해서 의 프린터포트와 타겟시스템 마이컴의51 Atmel AVR ISP PC

신호핀간에 연결해도 되고 에 주어진 직렬포트용 인터페이스회로를 사용해도 된다SPI http://www.lancos.com .
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2.4.2.4.2.4.2.4.2.4.2.4.2.4.2.4. Codevisin AVRCodevisin AVRCodevisin AVRCodevisin AVR

비교적 저렴한 수십만원대의 컴파일러로 바이트까지 용량 제한이 있는 평가판을 인터넷에서 자유롭게 다운로2K

드 받아서 사용가능한 컴파일러와 그림 의 용 인터페이스회로를 사용해서 가 가능Codevision AVR C 51 ISP ISP

하다 연결할 때 의 는 의 와 의 는 마이컴의 핀. ISP CON VCC AVR VCC , ISP CON SCK AVR SCK PB1(SCK, 11),

의 는 의 핀 의 는 핀 의ISP CON MOSI AVR PE0(PDI/RXD0, 9), ISP CON MISO PE1(PDO/TXD0, 8), ISP CON

는 의RST AVR RESET 핀 과 연결한다 프로그램 다운로드 하는 과정은 다음 절에서 설명할 것이다( 20) . .

2.5.2.5.2.5.2.5.2.5.2.5.2.5.2.5.2.5.2.5.2.5.2.5. 컴파일러컴파일러컴파일러컴파일러Codevision AVR CCodevision AVR CCodevision AVR CCodevision AVR C 컴파일러컴파일러컴파일러컴파일러Codevision AVR CCodevision AVR CCodevision AVR CCodevision AVR C 컴파일러컴파일러컴파일러컴파일러Codevision AVR CCodevision AVR CCodevision AVR CCodevision AVR C

� 용 컴파일러들 다음과 같은 가지 정도가 많이 사용된다AVR C : 3 .

사의 컴파일러 수백만원대의 고가의 컴파일러이지만 상대적으로 뛰어난 압축률과 안정된IAR EWAVR C :①

기능을 내장하고 있어 산업 현장에서 많이 사용되고 있다 바이트까지 용량 제한이 있는 평가판을 인터넷에서. 2K

자유롭게 다운로드 받아서 사용가능하다.

컴파일러 기본적으로 환경에서 동작하도록 만들어진 꽁짜의 컴파일러이나 언어와 다AVRGCC : text ANSI C②

른 점이 많은 편이라 언어에 익숙한 사람은 불편함을 느낄 수 있다ANSI C .

사의 컴파일러 비교적 저렴한 수십만원대의 컴파일러로 언어의 모HPinfotech Codevision AVR C : ANSI C③

든 구성요소와 거의 가깝게 구현되어 있다 바이트까지 용량 제한이 있는 평가판을 사의 홈페이지. 2K HPinfotech

에서 자유롭게 다운로드 받아서 사용가능하다http://www.hpinfotech.ro .

� 컴파일러의 특징은 다음과 같다 와 연계하여 디버깅이 가능하다Codevision AVR C . AVR Studio4 . ISP① ②

다운로더 프로그램을 내장하였다 프로그램을 자동으로 생성할 수 있는 를 내장하였다. CodeWizardAVR .③ ④

언어의 표준 라이브러리 이외에 캐릭터 필립스 버스ANSI C LCD, I2C , RTC DS1302, EEPROM DS2430, SPI

용 지연함수 등을 위한 에 특화된 다양한 라이브러리를 제공한다, AVR .

2.5.1.2.5.1.2.5.1.2.5.1.2.5.1.2.5.1.2.5.1.2.5.1.2.5.1.2.5.1.2.5.1.2.5.1. 새 프로젝트 등록하기와 옵션 설정하기새 프로젝트 등록하기와 옵션 설정하기새 프로젝트 등록하기와 옵션 설정하기새 프로젝트 등록하기와 옵션 설정하기새 프로젝트 등록하기와 옵션 설정하기새 프로젝트 등록하기와 옵션 설정하기새 프로젝트 등록하기와 옵션 설정하기새 프로젝트 등록하기와 옵션 설정하기새 프로젝트 등록하기와 옵션 설정하기새 프로젝트 등록하기와 옵션 설정하기새 프로젝트 등록하기와 옵션 설정하기새 프로젝트 등록하기와 옵션 설정하기

초기화면초기화면초기화면초기화면①①①① : 평가판을 에서 내려 받은 후 실행파일http://www.hpinfotech.ro 을 실행하면 그setup_eval.exe

림 와 같이 의 메뉴를 갖고52 [File], [Edit], [View], [Project], [Tools], [Settings], [Windows], [Help]

이라는 이름을 가진 초기화면이 나타난다CodeVisonAVR .

그림 52 의 초기화면. CodevisionAVR Compiler
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실행실행실행실행New Project :New Project :New Project :New Project :②②②② 메뉴를 선택하면 이라는 작은 창이 생성된다 그 때 그[File->New] Create New File .

림 과 같이 를 선택하고 버튼을 클릭한다53 project OK .

그림 53 메뉴의 실행과 새로운 프로젝트 생성. [File->New]

사용 여부의 설정사용 여부의 설정사용 여부의 설정사용 여부의 설정CodeWizardAVRCodeWizardAVRCodeWizardAVRCodeWizardAVR③③③③ 창에서 를 선택하고 버튼을 클릭하면 그림: Create New File project OK

와 같이 의 사용여부를 묻는 창이 생성되는데 를 선택한다 은 입54 CodeWizardAVR Confirm No . CodeWizardAVR

출력포트의 방향 칩의 종류와 주파수 외부 인터럽트 타이머 변환기 동기 및 비동기 통신 등을, AVR , , , AD , , LCD

대화창을 통해 쉽게 설정할 수 있는 위저드 기능을 제공하여 쉽게 프로그램을 할 수 있도록 하는데 스스로 공부

하면 쉽게 알 수 있으므로 여기에서는 설명을 따로 하지 않고 일단 를 사용하지 않는 것으로 하CodeWizardAVR

여 설명한다.

그림 54 사용 여부를 설정하기 위한 창. CodeWizardAVR
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프로젝트 이름 설정프로젝트 이름 설정프로젝트 이름 설정프로젝트 이름 설정④④④④ 의 사용여부를 묻는 창이 생성되어 를 선택하면 그림: CodeWizardAVR Confirm No 55

처럼 라는 이름의 대화상자가 생성되는데 대화상자내의 저장위치 메뉴에서 적당한 위치를Create New Project [ (I)]

선택하고 자신이 원하는 프로젝트 이름예 을 파일이름 메뉴의 입력창에 기입한 후에 저장 버튼을( :test) [ (N)] [ (S)]

클릭한다.

그림 55 에서 새로운 프로젝트 이름의 설정. CodevisionAVR

프로젝트 옵션 설정하기프로젝트 옵션 설정하기프로젝트 옵션 설정하기프로젝트 옵션 설정하기 ::::⑤⑤⑤⑤ 프로젝트 이름을 설정예 하고 나면( :test) [Files], [C Complier], [Before Make],

메뉴를 갖고 있는 라는 이름의 대화창이 생성된다 의 주파수를[After Make] Configure Project test.prj . 16MHz

사용하는 을 대상으로 하는 경우 그림 처럼 설정하면 된다ATmega128 56 .

그림 56 에서 프로젝트 옵션 설정하기. CodevisionAVR
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2.5.2.2.5.2.2.5.2.2.5.2.2.5.2.2.5.2.2.5.2.2.5.2.2.5.2.2.5.2.2.5.2.2.5.2. 새 소스 파일 만들기새 소스 파일 만들기새 소스 파일 만들기새 소스 파일 만들기새 소스 파일 만들기새 소스 파일 만들기새 소스 파일 만들기새 소스 파일 만들기새 소스 파일 만들기새 소스 파일 만들기새 소스 파일 만들기새 소스 파일 만들기

실행실행실행실행New Project :New Project :New Project :New Project :①①①① 메인창의 메뉴를 선택하면 이라는 작은 창이 생성된다[File->New] Create New File .

그 때 그림 과 같이 를 선택하고 버튼을 클릭한다57 source OK .

그림 57 메뉴의 실행과 새로운 파일생성. [File->New]

에디터 창 생성에디터 창 생성에디터 창 생성에디터 창 생성②②②② : 에서 를 선택하고 버튼을 클릭하면 그림 처럼 특정 디렉토Create New File source OK 58

리명 라는 이름을 갖는 코드를 작성할 수 있는 에디터 창이 뜬다 그 창에 파일을 작성한다 작성시\untitled,c C . .

메뉴를 활용하면 작성을 쉽게 할 수 있다 자세한 사항은 메[Navigator], [Code Templates], [Clipboard] . [Help]

뉴를 통해 얻을 수 있다.

그림 58 에서 새로운 파일의 작성. CodevisionAVR
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실행실행실행실행Save AsSave AsSave AsSave As③③③③ 소스코드의 작성을 완료하고 메인창의 메뉴를 선택하면 특정 디렉토리: [File->Save as...]

명 라는 이름의 대화상자가 생성되는데 대화상자내의 저장위치 메뉴에서 적당한 위치를 선택하\untitled,c As [ (I)]

고 자신이 원하는 파일 이름예 을 파일이름 메뉴의 입력창에 기입한 후에 저장 버튼을 클릭한다( : fnd) [ (N)] [ (S)] .

그러면 본 예에서는 에 가 저장된다at128 fnd.c .

그림 59 메뉴를 통한 파일 저장. [File->Save As]

2.5.3.2.5.3.2.5.3.2.5.3.2.5.3.2.5.3.2.5.3.2.5.3.2.5.3.2.5.3.2.5.3.2.5.3. 프로젝트에 소스파일 등록하고 실행파일 만들기프로젝트에 소스파일 등록하고 실행파일 만들기프로젝트에 소스파일 등록하고 실행파일 만들기프로젝트에 소스파일 등록하고 실행파일 만들기프로젝트에 소스파일 등록하고 실행파일 만들기프로젝트에 소스파일 등록하고 실행파일 만들기프로젝트에 소스파일 등록하고 실행파일 만들기프로젝트에 소스파일 등록하고 실행파일 만들기프로젝트에 소스파일 등록하고 실행파일 만들기프로젝트에 소스파일 등록하고 실행파일 만들기프로젝트에 소스파일 등록하고 실행파일 만들기프로젝트에 소스파일 등록하고 실행파일 만들기

실행실행실행실행Configure :Configure :Configure :Configure :①①①① 소스파일은 프로젝트에 등록이 되어야 컴파일하고 디버깅이 가능하다 그림처럼.

을 실행해 새 프로젝트를 생성하거나 기존의 프로젝트를 열어 놓은 상황에서 메인창의CodevisionAVR

를 실행하면 그림 과 같은 대화창이 새롭게 생성된다[Project->Configure] 60 Configure Project .

그림 60 메뉴의 실행. [Project->Configure]
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실행실행실행실행Add :Add :Add :Add :②②②② 그림 과 같은 대화창에서 메뉴를 선택하면 그림 과 같은60 Configure Project [Add] 61 Add File

라는 이름의 대화창이 생성되는 데 대화상자내의 찾는 위치 메뉴에서 적당한 위치예 를 선To Project [ (I)] ( :at128)

택하고 파일 이름예 을 파일이름 메뉴의 입력창에 기입한 후에 열기 버튼을 클릭한다( : fnd) [ (N)] [ (O)] .

그림 61 메뉴를 통한 소스파일 등록. Add

실행 결과실행 결과실행 결과실행 결과Add :Add :Add :Add :③③③③ 라는 이름의 대화창에서 파일을 등록하면 그림 와 같이 프로젝트에Add File To Project 62

등록된 결과를 대화창을 통해 확인할 수 있다 다른 파일을 더 등록하려면 마찬가지 과정을 통Configure Project .

해 실행한다 특정 파일을 프로젝트에서 제거하려면 대화창에서 파일을 선택하고 메. Configure Project [Remove]

뉴를 통해 제거하면 된다 본 예에서는 디렉토리의 가 프로젝트에 등록된 것을 그림 에서 확. at128 fnd,c test.prj 62

인할 수 있다 등록을 다했으면 대화창에서 메뉴를 누르고 나간다. [OK] .

그림 62 메뉴를 통한 소스파일 등록 결과. Add
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실행실행실행실행Make :Make :Make :Make :④④④④ 소스파일을 프로젝트에 등록을 완료한 후에 그림 처럼 메인창의 메뉴를 통63 [Project->Make]

해 실행파일을 생성한다.

그림 63 의 실행. CodeVisionAVR Make

에러없이 종료된 결과에러없이 종료된 결과에러없이 종료된 결과에러없이 종료된 결과 ::::⑤⑤⑤⑤ 그림 는 에러없이 실행파일이 만들어진 경우를 보여준다 이라는 이름64 . Information

의 창이 생겨 결과를 설명한다Make .

그림 64 에서 의 성공적인 결과. CodevisionAVR Make
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에러가 있을 때 결과에러가 있을 때 결과에러가 있을 때 결과에러가 있을 때 결과 ::::⑥⑥⑥⑥ 그림 는 실행파일을 만드는 과정에서 문법적인 에러가 발생한 경우를 보여준다65 .

창에 결과가 나타나 있고 창에 에러가 발생한 행번호와 에러메시지가 나타나 있음을 알 수Information messages

있다 창의 메뉴를 클릭하면 창이 없어지고 그림 과 같이 된다 에러메시지 부분을 더블클릭. Information [OK] 66 .

하면 에러가 발생한 위치로 커서가 자동적으로 이동하여 손쉽게 에러를 수정할 수 있게 한다.

그림 65 에서 파일에 에러가 있을 때 결과. CodevisionAVR Make

에러 수정에러 수정에러 수정에러 수정 ::::⑦⑦⑦⑦ 그림 에서 창의 메뉴를 클릭하면 창이 없어지고 그림 과 같이 된다 에러65 Information [OK] 66 .

메시지 부분을 더블클릭하면 에러가 발생한 위치로 커서가 자동적으로 이동하여 손쉽게 에러를 수정할 수 있게

한다.

그림 66 를 이용한 문법에러의 수정. CodeVisionAVR
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2.5.4.2.5.4.2.5.4.2.5.4.2.5.4.2.5.4.2.5.4.2.5.4.2.5.4.2.5.4.2.5.4.2.5.4. 디버깅디버깅디버깅디버깅디버깅디버깅디버깅디버깅디버깅디버깅디버깅디버깅

설정설정설정설정Debugger :Debugger :Debugger :Debugger :①①①① 문법적인 에러가 없이 성공적으로 가 되어 실행파일이 만들어진 경우Make AVR Studio4

가 설치되어 있으면 이를 이용해 디버깅과 간단한 시뮬레이션을 할 수 있다 그림 과 같이 메. 68 CodeVisionAVR

인메뉴 를 선택하면 라는 이름의 대화창이 생성되는데 가[Settings->Debuger] Debugger Settings AVR Studio4

설치된 디렉토리와 디버거의 이름을 입력하고 메뉴를 클릭한다[OK] .

그림 67 의 선택. Debugger

선택선택선택선택Debug :Debug :Debug :Debug :②②②② 문법적인 에러가 없어 실행파일이 만들어진 경우 가 설치되어 있으면 그림 과AVR Studio4 67

같이 메뉴를 선택하면 디버깅과 간단한 시뮬레이션을 할 수 있다[Tools->Debugger] .

그림 68 메뉴. [Tools->Debugger]
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프로젝트 선택프로젝트 선택프로젝트 선택프로젝트 선택 ::::②②②② 메뉴를 선택하면 그림 처럼 가 실행되며 프로젝트를[Tools->Debugger] 69 AVR Studio4

선택하기 위한 라는 이름의 대화창이 생성된다Welcome to AVR Studio4 .

그림 69 의 프로젝트 선택창. AVR Studio4

파일 선택파일 선택파일 선택파일 선택cof :cof :cof :cof :③③③③ 라는 이름의 창의 메뉴 을 클릭하면 그림 과 같은Welcome to AVR Studio4 [Open] 70

이라는 이름의 대화창이 생성된다 파일 이름 메뉴에 디버깅하려하는 파일Open Project File or Object File . [ (N)]

을 하여 생성된 파일들 중에서 이 로 끝나는 파일을 선택한다 본 예에서는 를 하였Make extension cof . fnd.c make

으므로 를 선택한다 그리고 열기 메뉴를 더블클릭한다fnd.cof . [ (O)] .

그림 70 파일의 선택 대화창. cof
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프로젝트 생성프로젝트 생성프로젝트 생성프로젝트 생성 ::::④④④④ 파일을 선택하면 그림 과 같은 이라는 이름의 대화cof 71 Save AVR Studio Project File

창이 생성된다 적당한 이름을 파일이름 메뉴의 입력창에 쓰고 저장 메뉴를 클릭한다. [ (N)] [ (S)] .

그림 71 디버깅을 위한 프로젝트 생성.

플랫폼과 디바이스 설정과 디버깅하기플랫폼과 디바이스 설정과 디버깅하기플랫폼과 디바이스 설정과 디버깅하기플랫폼과 디바이스 설정과 디버깅하기DebugDebugDebugDebug⑤⑤⑤⑤ 적절한 프로젝트 이름을 설정하고 나면 그림 과 같이 디: 40

버그 플랫폼과 디바이스를 설정하는 창이 뜬다 은 를 선택하고 는. Debug platform AVR Simulator Device

을 선택하고 마지막으로 메뉴를 누른다 그러면 그림 처럼 디버그세션이 시작되고ATmega128 [Finish] . 72 /O

창이 레지스터의 값들을 비트별로 그래픽하게 확인할 수 있도록 변하고 에디터 창에 노란 화살표가 나타View I/O

난다 이 이후의 과정은 절을 참조하면 된다. 2.3.2 .

그림 72 에서 를 이용한 디버깅화면. CodeVisionAVR AVR Studio4
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2.5.5.2.5.5.2.5.5.2.5.5.2.5.5.2.5.5.2.5.5.2.5.5.2.5.5.2.5.5.2.5.5.2.5.5. 플래쉬롬플래쉬롬플래쉬롬플래쉬롬플래쉬롬플래쉬롬플래쉬롬플래쉬롬플래쉬롬플래쉬롬플래쉬롬플래쉬롬 프로그래밍하기프로그래밍하기프로그래밍하기프로그래밍하기ISPISPISPISP 프로그래밍하기프로그래밍하기프로그래밍하기프로그래밍하기ISPISPISPISP 프로그래밍하기프로그래밍하기프로그래밍하기프로그래밍하기ISPISPISPISP

설정설정설정설정Programmer :Programmer :Programmer :Programmer :①①①① 프록그램의 시뮬레이션까지 끝내어 완벽해진 경우 의 프로그램메모리에ATmega128

를 통해 프로그램을 다운로드 해야한다 의 메인메뉴 를 선택하면 그ISP . CodeVisonAVR [Settings->Programmer]

림 과 같은 대화창이 생성된다 그림 의 병렬 인터페이스 회로를 사용하는 경우73 . 51 ISP [AVR Chip

는 그림 처럼 으로 선택하고 는 과 연결된 병렬포Programmer Type] 73 STK200+/300 [Print Port] ATmega128

트를 선택한다.

그림 73 프로그래머 설정 화면. AVR Chip

실행실행실행실행Programmer :Programmer :Programmer :Programmer :②②②② 프로그래머의 설정이 이루어 졌으면 의 메인메뉴CodeVisonAVR [Tools-> Chip

를 선택한다 그러면 그림 와 같은 이라는 이름을 갖는 대화Programmer] . 74 CodeVisionAVR Chip Programmer

창이 생성된다.

그림 74 의 칩 프로그래머 대화창. CodeVisionAVR
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파일 선택파일 선택파일 선택파일 선택rom :rom :rom :rom :③③③③ 이라는 이름을 갖는 대화창이 생성된다 대화창의 메CodeVisionAVR Chip Programmer .

뉴 를 선택하면 그림 와 같은 이라는 이름의 대화창이 생성[File->Load FLASH] 75 Load File to FLASH Buffer

된다 찾는 위치 메뉴에서 파일이 존재하는 위치예 를 선택하고 를 통해 만들어진 이나. [ (I)] ( :at128) make rom hex,

파일 이름예 을 파일이름 메뉴의 입력창에 기입하거나 선택한 후에 열기 버튼을 클릭한다bin ( : fnd.rom) [ (N)] [ (O)] .

그림 75 다운로드할 이나 혹은 파일의 선택. rom hex bin

실행실행실행실행erase chip :erase chip :erase chip :erase chip :④④④④ 그림 의 병렬 인터페이스 회로와 시스템이 연결되어 있고 전원이 들51 ISP ATmega128

어간 상태에서 다운로드할 파일을 선택한 다음 대화창의 메뉴hex CodeVisionAVR Chip Programmer

를 선택하면 그림 과 같은 창이 생성되고 새로 써 넣기 전[Program->Erase Chip] 76 FLASH Erasure checking

에 롬의 내용을 지운다Flash .

그림 76 플래시롬을 지우는 과정을 보여주는 창.
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⑤⑤⑤⑤ 프로그램 다운로드프로그램 다운로드프로그램 다운로드프로그램 다운로드 :::: 위의 과정을 거친 다음 대화창의 메뉴CodeVisionAVR Chip Programmer

를 선택하면 그림 과 같은 창이 생성되고 플래쉬롬에[Program->Frash] 77 Verifying the FLASH programming

프로그램이 다운로드 된다.

그림 77 프로그램의 다운로드 과정을 보여주는 창.

2.5.6.2.5.6.2.5.6.2.5.6.2.5.6.2.5.6.2.5.6.2.5.6.2.5.6.2.5.6.2.5.6.2.5.6. 프로그래밍하기프로그래밍하기프로그래밍하기프로그래밍하기EEPROM ISPEEPROM ISPEEPROM ISPEEPROM ISP 프로그래밍하기프로그래밍하기프로그래밍하기프로그래밍하기EEPROM ISPEEPROM ISPEEPROM ISPEEPROM ISP 프로그래밍하기프로그래밍하기프로그래밍하기프로그래밍하기EEPROM ISPEEPROM ISPEEPROM ISPEEPROM ISP

실행실행실행실행Programmer :Programmer :Programmer :Programmer :①①①① 의 메인메뉴 를 선택한다 그러면 그림CodeVisonAVR [Tools-> Chip Programmer] .

와 같은 이라는 이름을 갖는 대화창이 생성된다74 CodeVisionAVR Chip Programmer .

파일 로드파일 로드파일 로드파일 로드EEPROM :EEPROM :EEPROM :EEPROM :②②②② 대화창의 메뉴 으로 화CodeVisionAVR Chip Programmer [File->Load EEPROM]

일을 선택해서 로드하거나 을 선택해 이라는 이름을 갖는 대화창을 생성[Edit->EEPROM] Edit EEPROM Buffer

시키고 직접 편집을 한다.

다운로드다운로드다운로드다운로드 ::::③③③③ 위의 과정을 거친 다음 대화창의 메뉴 를 선택하면Chip Programmer [Program->EEPROM]

그림 과 비슷한 창과 창이 차례대로 생성되76, 77 EEPROM programming Verifying the EEPROM programming

고 이 프로그램된다EEPROM .

2.6.2.6.2.6.2.6.2.6.2.6.2.6.2.6.2.6.2.6.2.6.2.6. 프로그래밍에서 유의할 점프로그래밍에서 유의할 점프로그래밍에서 유의할 점프로그래밍에서 유의할 점CCCC 프로그래밍에서 유의할 점프로그래밍에서 유의할 점프로그래밍에서 유의할 점프로그래밍에서 유의할 점CCCC 프로그래밍에서 유의할 점프로그래밍에서 유의할 점프로그래밍에서 유의할 점프로그래밍에서 유의할 점CCCC

2.6.1.2.6.1.2.6.1.2.6.1.2.6.1.2.6.1.2.6.1.2.6.1.2.6.1.2.6.1.2.6.1.2.6.1. 프로그램의 구성 요소프로그램의 구성 요소프로그램의 구성 요소프로그램의 구성 요소CCCC 프로그램의 구성 요소프로그램의 구성 요소프로그램의 구성 요소프로그램의 구성 요소CCCC 프로그램의 구성 요소프로그램의 구성 요소프로그램의 구성 요소프로그램의 구성 요소CCCC

프로그램은 지시어 심볼 문장 블록의 가지 구성요소가 있다C , , , 4 .

� 지시어 또는 키워드 프로그램 명령어들과 같이 컴파일러가 특별한 의미로 인식하는 예약된 문자들: C C

� 심볼 지시어와 달리 사용자가 특별히 의미를 부여한 문자이다 알파벳 대문자와 소문자과 숫자와 가 가능하: . _

며 첫문자는 반드시 숫자가 아니어야 하며 대 소문자가 구별된다.

� 문장 프로그램 실행 단위로 반드시: 세미콜론으로 끝낸다;( ) .

� 블록 : 로 시작해 로 끝 맺으며 여러개의 문장을 묶은 것이다{ } .

2.6.2.2.6.2.2.6.2.2.6.2.2.6.2.2.6.2.2.6.2.2.6.2.2.6.2.2.6.2.2.6.2.2.6.2. 프로그램의 일반적 형식프로그램의 일반적 형식프로그램의 일반적 형식프로그램의 일반적 형식CCCC 프로그램의 일반적 형식프로그램의 일반적 형식프로그램의 일반적 형식프로그램의 일반적 형식CCCC 프로그램의 일반적 형식프로그램의 일반적 형식프로그램의 일반적 형식프로그램의 일반적 형식CCCC

는 매우 자유로운 형식의 언어인데 프로그램 파일은 소스파일과 헤더파일로 구분된다C C .
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� 헤더파일 여러 소스파일에 공통으로 들어가는 함수의 프로토타입의 선언문 새로운 데이터형의 정의 또는: ,

다른 헤더파일을 시킨다 전역 변수의 선언문이나 함수의 정의는 헤더파일에 두지 않는 것이 좋include . (global)

다.

� 소스파일 일반적으로 전처리문 선언문 주석 함수 및 사용자 정의 함수 등으로 구성된다: , , , main .

2.6.2.1.2.6.2.1.2.6.2.1.2.6.2.1. 전처리전처리전처리전처리

문자로 시작하며 다음과 같은 지시어들이 존재한다# .

� 외부 파일로부터 소스를 읽어 들인다 디렉토리에 존재하는 외부파일은 로 묶어주어#include : . include < >

시키고 현재의 디렉토리에 존재하는 외부파일은 로 묶어 준다include “ ” .

� 매크로나 상수를 정의한다 매크로의 정의가 길어 한줄에 쓰지 못할 때는#define : . 를 사용해 줄 바꾼다\ .

� 매크로나 상수 정의를 취소한다#undef : .

� 매크로나 상수가 정의되어 있다면 해당부분만 컴파일한다#ifdef : .

� 매크로나 상수가 정의되어 있지 않다면 해당부분만 컴파일한다#ifndef : .

� 어떤 조건을 만족하면 해당부분만 컴파일한다#if : .

� 와 같은 조건문에서 또 다른 조건에 의한 분기조건을 정의하여 그 조건이 만족하면 해#elif : ifdef, ifndef, if

당부분만 컴파일한다.

� 와 같은 조건문에서 이전 조건이 만족되지 않으면 해당부분만 컴파일한다#else : ifdef, ifndef, if .

� 조건 블록의 마지막을 표시한다#endif : ifdef, ifndef, if, elif, else .

2.6.2.2.2.6.2.2.2.6.2.2.2.6.2.2. 선언문선언문선언문선언문

함수와 변수 등 심볼을 선언하는 부분이다 변수는 문자형인지 정수형인지 실수형인지 데이터형을 선언하고 함. , ,

수의 경우에는 함수의 이름 함수를 처리하고 난 후 리턴할 데이터형 전달받을, , 인수의 데이터형 등 함수의 프로

토타입을 선언한다 결과를 리턴하지 않는 경우. 를 쓴다void .

2.6.2.3.2.6.2.3.2.6.2.3.2.6.2.3. 주석주석주석주석

� 와/* 로 시작해서*/ : /* 로 끝 맺으면 그 사이의 글자는 컴파일러가 무시한다 과 사이에 줄을 바꿔도*/ . /* */

그 사이의 글자는 주석으로 간주된다.

� 를 사용하면 같은 줄에서 뒤의 글자는 컴파일러가 무시한다// : // // .

2.6.2.4.2.6.2.4.2.6.2.4.2.6.2.4. 함수와함수와함수와함수와 함수 부분함수 부분함수 부분함수 부분mainmainmainmain

반드시 하나의 블럭으로 되어 있어 어떤 내용을 처리하고 그 결과를 리턴하는 등 실제적인 프로그램을 기술하

는 부분이다 다음의 형태를 띤다. .

리턴데이터형 함수명 데이터형 인수 데이터형 인수([ 1, 2, ...])
프로그램 내용{ }

리턴데이터형은 내용을 처리하고 난 후 리턴할 결과 데이터 형태가 정수형인지 문자형인지 실수형인지 등 무, ,

엇인지를 기술하는 부분이다 결과를 리턴하지 않는 경우 를 쓴다 함수명은 함수의 이름을 나타내는 심볼이. void .

며 프로그램을 처리할 때 전달받을 값은 인수들을 통해 하는 데 함수를 정의할 때 인수들의 데이터형과 함께 ( )

안에 써 넣는다 전달받을 값이 없으면 인수를 안쓰거나 라고 쓴다 함수는 함수명이 으로 반드시. void . main main

프로그램에서 만들어야 하는 함수이다C .

2.6.3.2.6.3.2.6.3.2.6.3.2.6.3.2.6.3.2.6.3.2.6.3.2.6.3.2.6.3.2.6.3.2.6.3. 기본 데이터형기본 데이터형기본 데이터형기본 데이터형기본 데이터형기본 데이터형기본 데이터형기본 데이터형기본 데이터형기본 데이터형기본 데이터형기본 데이터형

언어에서 데이터는 문자와 숫자로 분류할 수 있고 또한 상수와 변수로 구분할 수 있다 변수는 사용범위에 따C .

라 광역또는 전역 과 지역 변수가 있다 그리고 이들 데이터는 기본적으로 문자형 정수형 실수형( , global) (local) . , ,
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으로 구분할 수 있다 표 에 기본 데이터형 지시어의 설명이 주어졌다. 5 .

� 문자 알파벳과 특수기호들로 컴퓨터에 표현하려면 특정 코드를 사용해야 하는데 언어에서는 아스키코드를: C

사용한다 문자 한개를 표현할 때는 식으로 기호를 사용하고 개 이상의 문자열의 경우에는 기. 'a', 'b', '@' ' ' 2 “ ”

호를 사용한다.

� 숫자 정수와 소수로 나뉠 수 있다 정수는: . 진수10 , 진수16 , 진수 등을 사용하는데 진수를 가장 많이 쓰8 16

며 진수는 숫자 앞에 를 붙여 주고 진수는 만 붙여주고 진수는 이나 를 붙이지 않고 표기한다 소16 0x 8 0 10 0 0x .

수의 경우에는 과 같은 식으로 소수를 쓰는 방법과 식으로 지수를 사용하는 방법이 있다 음수0.0123 1.23E-2 .

의 경우에는 를 숫자 앞에 붙이고 양수의 경우- 를 생략해도 된다+ .

� 상수 프로그램내에서 값의 변화가 없는 데이터를 지칭한다: .

� 변수 값의 변화가 있는 데이터를 지칭하며 값을 마음대로 바꿀 수 있는 기억장소를 의미한다 변수는 전역: .

지역 정적 외부 변수 레지스터 로 나뉠 수 있다함수 부분 설명 참조(global), (local), (static), (extern) , (register) ( ).

데이터형 지시어 크기 범위

문자형
char 바이트1 -128 ~ 127
unsigned char 바이트1 0 ~ 255

정수형

int 바이트2 -32768 ~ 32767
unsigned int 바이트2 0 ~ 65535
long 바이트4 -2147483648 ~ 214783647
unsigned long 바이트4 0 ~ 42967295

실수형
float 바이트8 ± 1.2E-38 ~ ± 3.4E38

double 바이트8 ± 1.2E-38 ~ ± 3.4E38

표 8 기본 데이터형.

2.6.3.1.2.6.3.1.2.6.3.1.2.6.3.1. 문자형문자형문자형문자형

문자형 데이터는 바이트 크기로 하나의 문자를 의미하며 작은 숫자나 아스키 문자를 표현하기 위해 사용되는1

데 지시어로 부호가 없는 형태에 와 부호가 있는 형태에char unsigned 를 사용한다 형은char . char -128 ~127

사이의 값을 갖고 형은 사이의 값을 갖는다unsigned char 0 ~ 255 .

2.6.3.2.2.6.3.2.2.6.3.2.2.6.3.2. 정수형정수형정수형정수형

정수를 표현하기 위해 사용되는 지시어로 int, unsigned int, 가 있다 는 바이트 크기long, unsigned long . int 2

로 사이의 값을 갖고 는 바이트 크기로 사이의 값을 갖는다 은-32768 ~ 32767 unsigned int 2 0 ~ 65535 . long

바이트 크기로 사이의 값을 갖고 는 바이트 크기로-2147483648 ~ 214783647 unsigned long 4 0 ~

사이의 값을 갖는다4294967295 .

2.6.3.3.2.6.3.3.2.6.3.3.2.6.3.3. 실수형실수형실수형실수형

실수를 표현하기 위해 사용되는 지시어로 float, 이 있는데 는 바이트 크기로double , float 8 ± 1.2E-38 ~

± 사이의 값을 갖고 은 바이트 크기로3.4E38 , double 8 ± 1.2E-38 ~ ± 사이의 값을 갖는다3.4E38 .

2.6.3.4.2.6.3.4.2.6.3.4.2.6.3.4. 변수나 상수 이름 짓는 법변수나 상수 이름 짓는 법변수나 상수 이름 짓는 법변수나 상수 이름 짓는 법

� 알파벳 대문자와 소문자과 숫자와 가 가능하며 대 소문자가 구별된다_ .

� 변수이름의 첫 글자는 숫자가 아니어야 한다.

� 가 아닌 특수문자는 사용이 안된다_ .

� 지시어는 사용할 수 없다.

� 되도록이면 헝가리언 표기법에 따라 특별한 접두어를 사용해서 변수이름을 짓는다 포인터를 정의할 때는 접.

두어 문자열은 플래그를 정의할 때는 카운터나 형을 정의할 때는 접두어 형은p, str, f, int c, long l, unsigned
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형은 를 접두어로 사용하면 알아보기 쉽다int u .

2.6.3.5.2.6.3.5.2.6.3.5.2.6.3.5. 상수 정의상수 정의상수 정의상수 정의

� 을 사용하여 다음과 같은 식으로 정의한다 여기에서 문자의 끝에 가 들어가지 않음에 유의해야 한다#define . ; .

#define 상수이름 상수값

� 지시어를 사용하여 다음과 같은 식으로 정의한다const .

const 데이터형 상수이름 상수값= ;

2.6.3.6.2.6.3.6.2.6.3.6.2.6.3.6. 변수 선언과 초기화변수 선언과 초기화변수 선언과 초기화변수 선언과 초기화

변수는 함수내의 첫부분에서 선언하거나 함수 밖에서 프로그램 첫부분에서 선언할 수 있다 함수내의 첫부분에.

서 선언하면 지역변수가 되어 함수내에서만 사용할 수 있으며 함수 밖에서 선언하면 전역변수가 되어 정의된 소

스 프로그램내의 모든 함수에서 사용 가능하다 다음과 같은 식으로 선언하고 초기화 한다 변수명 만 선언하는. . 1

경우에는 안에 주어진 값과 기호는 생략 가능하다[ ] [ ] .

데이터형 변수명 초기값 변수명 초기값1[= 1, 2= 2, .... ];

2.6.4.2.6.4.2.6.4.2.6.4.2.6.4.2.6.4.2.6.4.2.6.4.2.6.4.2.6.4.2.6.4.2.6.4. 확장 데이터형확장 데이터형확장 데이터형확장 데이터형확장 데이터형확장 데이터형확장 데이터형확장 데이터형확장 데이터형확장 데이터형확장 데이터형확장 데이터형

컴파일러는 절에 주어진 의 데이터형에 더해 등CodeVisionAVR 2.6.3 ANSI C bit, eeprom, flash, sfrb, sfrw

의 데이터형을 지원해주어 하드웨어 특성을 활용할 수 있도록 하였다AVR .

2.6.4.1.2.6.4.1.2.6.4.1.2.6.4.1. 데이터형데이터형데이터형데이터형bitbitbitbit

범용 레지스터와 레지스터에 비트 단위의 데이터를 위치시킨다 데이터형은 일반적으로 광역I/O R2~R14 1 . bit

변수로 선언된다 레지스터에 비트 단위의 데이터를 위치시키는 지역 변수의 선언도 개까지 허용된다. R15 1 8 .

2.6.4.2.2.6.4.2.2.6.4.2.2.6.4.2. 데이터형데이터형데이터형데이터형eepromeepromeepromeeprom

메모리에 위치한 상수 데이터를 접근하는데 사용한다EEPROM .

2.6.4.3.2.6.4.3.2.6.4.3.2.6.4.3. 데이터형데이터형데이터형데이터형flashflashflashflash

플래쉬 메모리에 위치한 상수 데이터를 접근하는데 사용한다.

2.6.4.4.2.6.4.4.2.6.4.4.2.6.4.4. 데이터형데이터형데이터형데이터형sfrb, sfrwsfrb, sfrwsfrb, sfrwsfrb, sfrw

레지스터를 바이트 혹은 워드 단위로 접근하는데 사용한다 컴파일러의 데이터형과 유사하다 신I/O . Keil C sfr .

텍스는 다음과 같다.

심볼 레지스터주소값sfrb 1 = IO ; 심볼 레지스터주소값sfrw 2 = IO ;

레지스터들은 디렉토리 밑에 디바이스명칭 예 의 형태로 헤더파일에 정의되어 있으므로I/O \INC .h( :mega128.h)

사용자는 별도로 선언할 필요없이 헤더파일을 프로그램 선두에 시켜서 사용하면 된다 즉 예로include .

용으로 프로그램을 작성하는 경우 를 프로그램 선두에 놓으면ATmega128 #include <mega128.h> DDRA,

등 그림 과 에 주어진 레지스터의 이름을 사용해서 아래의 예처럼 값을 직접 할당할PORTA, TCNT1, ICR1 7 8 I/O

수 있다.

예 : DDRA=0xff; PORTA = 0x01 를 출력으로 설정하고 값을 출력하라// PORT A 0x01 .

2.6.5.2.6.5.2.6.5.2.6.5.2.6.5.2.6.5.2.6.5.2.6.5.2.6.5.2.6.5.2.6.5.2.6.5. 연산자연산자연산자연산자연산자연산자연산자연산자연산자연산자연산자연산자

2.6.5.1.2.6.5.1.2.6.5.1.2.6.5.1. 조건 연산자조건 연산자조건 연산자조건 연산자

아래와 같은 형식으로 사용하며 삼항 연산자로 보통 불린다 조건식이 참이거나 이 아니면 식 을 처리하고 거. 0 1

짓이거나 이면 식 를 처리하라는 의미이다0 2 .

변수 조건 식 식= ( ) ? 1 : 2;

2.6.5.2.2.6.5.2.2.6.5.2.2.6.5.2. 데이터 형변환 연산자데이터 형변환 연산자데이터 형변환 연산자데이터 형변환 연산자
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변수가 선언될 때 설정한 데이터형과 다른 데이터형을 사용할 때 사용하는 연산자로 다음과 같이 와 사이에( )

형변환하려는 데이터형의 이름을 넣어 주면 변수 은 데이터형으로 형이 변환되어 변수 에 대입된다1 2 .

변수 데이터형 변수2 = ( ) 1;

2.6.5.3.2.6.5.3.2.6.5.3.2.6.5.3. 콤마 연산자콤마 연산자콤마 연산자콤마 연산자

두 개 이상의 여러 행에 걸쳐 사용하는 문장을 하나의 행에서 실행할 때 사용한다 두 개 이상의 문장을. 를 사,

용하여 구분하여 나열하면 왼쪽부터 차례대로 실행된다 아래의 형태는 문장 을 실행하고 문장 를 실행하고 문장. 1 2

을 실행한다n .

문장 문장 문장1, 2, n;

2.6.5.4.2.6.5.4.2.6.5.4.2.6.5.4. 산술 연산자산술 연산자산술 연산자산술 연산자

연산자 사용예 설명
+ a+b 와 를 더하라a b
- a-b 에서 를 빼라a b
- -a 의 부호를 반대로 바꿔라a
* a*b 와 를 곱하라a b
/ a/b 를 로 나누어라a b
% a%b 의 나머지를 구하라a/b

++
c++ 를 포함한 연산을 수행하고c c= c+1
++c 을 하고 를 포함하여 연산하라c=c+1 c

--
c-- 를 포함한 연산을 수행하고c c= c-1
--c 을 하고 를 포함하여 연산하라c=c-1 c

표 9 산술연산자.

2.6.5.5.2.6.5.5.2.6.5.5.2.6.5.5. 논리와 비교 연산자논리와 비교 연산자논리와 비교 연산자논리와 비교 연산자

조건문에 사용되는 연산자들로 비교 연산자는 크기를 비교할 때 사용되고 논리 연산자는 둘 이상의 비교 연산

자를 묶을 때 사용한다.

연산자 사용예 설명
< a<b 가 보다 작다a b
> a>b 가 보다 크다a b
<= a<=b 가 보다 작거나 같다a b .
>= a>=b 가 보다 크거나 같다a b .
== a==b 와 는 동치이다a b .
!= a!=b 와 는 동치가 아니다a b .
! !(a<b) 의 논리부정(a<b)
&& a>b && b>c 와 의 논리곱a>b b>c
|| a>b || b>c 와 의 논리합a>b b>c

표 10 논리 비교 연산자. ,

2.6.5.6.2.6.5.6.2.6.5.6.2.6.5.6. 비트 연산자비트 연산자비트 연산자비트 연산자

비트를 조작하는 데 사용하는 연산자로 데이터를 비트별로 처리한다.

연산자 사용예 설명
<< a<<2 값을 우측으로 비트 이동a 2
>> a>>2 값을 좌측으로 비트 이동a 2
~ ~a 의 비트반전값a
& a&b 와 의 대응 비트별로 계산한 논리곱a b
| a|b 와 의 대응 비트별로 계산한 논리합a b
^ a^b 와 의 대응 비트별로 계산한a b XOR

표 11 비트 연산자.
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2.6.5.7.2.6.5.7.2.6.5.7.2.6.5.7. 대입 연산자대입 연산자대입 연산자대입 연산자

연산자 사용예 설명
= c = a+b 의 결과를 에 대입하라a+b c
+= c += 2 와 등가c = c+2
-= c -= 3 과 등가c = c -3
*= c *= 3 과 등가c = c*3
/= c /= 2 와 등가c = b/2
%= c %= 3 과 등가c = c % 3
<<= c <<= 3 과 등가c = c << 3
>>= c >>= 2 와 등가c = c >> 2
&= c &= b 과 등가c = c & b
^= c ^= b 과 등가c = c^b
|= c |= b 와 등가c = c|b

표 12 대입 연산자.

2.6.6.2.6.6.2.6.6.2.6.6.2.6.6.2.6.6.2.6.6.2.6.6.2.6.6.2.6.6.2.6.6.2.6.6. 제어문제어문제어문제어문제어문제어문제어문제어문제어문제어문제어문제어문

2.6.6.1.2.6.6.1.2.6.6.1.2.6.6.1. 문문문문ifififif

� 문 아래와 같은 형식으로 괄호안의 조건식이 충족되거나 이 아니면 그 뒤의 문장이나 블록을 수행한다if : 0 .

조건 문장if ( ) ;

� if ~ 문 아래와 같은 형식으로 괄호안의 조건이 충족되거나 이 아니면 문장 을 수행하고 괄호안의 조else : 0 1

건이 충족되지 않으면 문장 를 수행한다 문장 이나 문장 는 블록이 될 수 있다2 . 1 2 .

조건 문장if ( ) 1;
문장else 2;

� if ~ 문 아래와 같은 형식으로 여러 가지의 조건식으로 제어가능하다 우선 문의 조건 이else if ~ else : . if 1

충족되는지 점검하고 충족되거나 이 아니면 문장 을 수행하고 문의 조건 이 성립하지 않으면 문의0 1 if 1 else if

조건 를 점검하고 충족되거나 이 아니면 문장 를 수행하고 문의 조건 가 성립하지 않고 그 다음에2 0 2 else if 2

문이 존재하면 앞서의 과정을 반복하고 문이 나오면 문 뒤의 문장 을 수행한다 문장 이나 문장else if else else n . 1 2,

문장 은 블록이 될 수 있다n .

조건 문장if ( 1 ) 1;
조건 문장else if ( 2 ) 2;

문장else n;

2.6.6.2.2.6.6.2.2.6.6.2.2.6.6.2. 문문문문switch-caseswitch-caseswitch-caseswitch-case

문과 함께 문은 조건문으로 문에서는 조건이 비교연산자의 형태가 되어 변수값이 어떤 범위에if switch-case if

존재하는지 여부를 점검하지만 문에서는switch-case 문의 변수 값이switch 문의 값과 정확히 일치하는지를case

비교해 일치하면 문의 뒤에 오는 문장을 실행한다 아래의 예에서는 변수값을 상수 과 비교해서 같으면 문장case . 1

을 실행하고 에 따라 문의 블록을 빠져 나온다만약 가 없으면 블록을 빠져 나오지 않고1 break switch-case ( break

그 다음 문을 점검한다 변수값이 상수 과 다르면 다음 문으로 가서 상수 와 변수를 비교해서 같으면case ). 1 case 2

문장 를 실행하고2 에 따라 문의 블록을 빠져 나온다 그 다음에 문이 존재하면 앞서의 과break switchc-case . case

정을 반복하고 문이 나오면 문 뒤의 문장 을 수행하고 에 따라 문의 블록을 빠져default default n break switch-case

나온다 문장 이나 문장 문장 은 블록이 될 수 있다. 1 2, n .

변수switch ( ) {
상수case 1 : 문장1;

break;
상수case 2 : 문장2;

break;
default : 문장n;

break; }
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2.6.6.3.2.6.6.3.2.6.6.3.2.6.6.3. 문문문문forforforfor

반복문의 하나로 제어할 변수의 초기화 조건 연산이 하나의 문장으로 해결할 수 있다 아래와 같은 형태로 초, , .

기화식 제어 조건식 연산식은 를 써서 분리되어 있고 초기화식과 연산식은 콤마 를 사용하여 여러 개의 수식이, , ; (,)

사용가능하고 또한 생략도 가능하다 제어 조건식은 반드시 하나만 설정하거나 생략 가능하다 처음에는 초기화식. .

에 따라 제어변수를 초기화하고 제어 조건식을 점검하고 제어 조건식이 성립하면 문장을 실행하고 제어변수를, , ,

연산식에 따라 연산하고 제어 조건식을 다시 점검하고 제어 조건식이 성립하면 문장을 실행하고 제어변수를 연, , ,

산식에 따라 연산한다 이러한 과정을 제어 조건식이 충족되는 동안 반복적으로 수행한다 문장이 제어변수 연산. .

식에 포함된 형태인 경우 문장은 생략가능하다 문장은 블록이 될 수 있다. .

제어변수 초기화식 제어변수 제어 조건식 제어변수 연산식 문장for( ; ; ) ;

2.6.6.4.2.6.6.4.2.6.6.4.2.6.6.4. 문문문문whilewhilewhilewhile

반복문의 하나로 초기화식과 연산식이 생략된 문이라 생각하면 된다 아래와 같은 형태로 조건이 충족되거나for .

조건식의 결과가 이 아닌 동안 반복적으로 문장을 수행한다 문장은 블록이 될 수 있다0 . .

조건 문장while( ) ;

2.6.6.5.2.6.6.5.2.6.6.5.2.6.6.5. 문문문문do-whiledo-whiledo-whiledo-while

아래와 같은 형태로 문과 비슷하나 문이 반복문을 수행하기 전에 조건을 점검하나 문은 반while while do-while

복문을 실행한 다음에 조건을 점검한다 즉 문은 적어도 한 번은 반복문이 수행이 되나 문은 한 번. do-while while

도 수행되지 않을 수 있다 문장은 블록이 될 수 있다. .

문장 조건do { ; } while( ) ;

2.6.6.6.2.6.6.6.2.6.6.6.2.6.6.6. 문문문문breakbreakbreakbreak

반복문이나 조건문 등 제어문의 실행에서 현재의 실행을 중지하고 제어문을 빠져나가게 한다.

2.6.6.7.2.6.6.7.2.6.6.7.2.6.6.7. 문문문문continuecontinuecontinuecontinue

반복문이나 조건문 등 제어문의 실행에서 제어문을 완전히 빠져나가지 말고 현재 차례의 실행만을 중지하고 다

음 횟수의 반복을 진행하게 한다.

2.6.6.8.2.6.6.8.2.6.6.8.2.6.6.8. 문문문문gotogotogotogoto

어셈블리어의 명령과 유사하게 미리 정해져 있는 의 위치로 점프하게 한다 아래의 예와 같은 경우JMP label .

문을 만나면 문장 는 실행이 되지않고 문이 가리키는 으로 점프하여 문장 이 수행된다goto 2 goto label1 1 . 이름label

뒤에는 어셈블리어 프로그래밍에서 처럼 콜론을 붙인다:( ) .

goto label1;
문장2;

label1: 문장1;

2.6.7.2.6.7.2.6.7.2.6.7.2.6.7.2.6.7.2.6.7.2.6.7.2.6.7.2.6.7.2.6.7.2.6.7. 함수와 변수함수와 변수함수와 변수함수와 변수함수와 변수함수와 변수함수와 변수함수와 변수함수와 변수함수와 변수함수와 변수함수와 변수

2.6.7.1.2.6.7.1.2.6.7.1.2.6.7.1. 프로토타입 선언프로토타입 선언프로토타입 선언프로토타입 선언

� 프로토타입 프로그램에서 사용할 함수이름과 리턴값: , 인수 파라미터의 데이터형을( ) 함수 위에서 미리main()

정의하는 것을 프로토타입 선언이라 한다 다음의 형태로 프로토 타입을 정의한다 함수의 내용을 함수. . main()

위에서 정의한 경우는 불필요하다.

리턴데이터형 함수명 인수 의 데이터형 인수 의 데이터형([ 1 , 2 , ...]);

다음의 형태로 인수들을 명기 해도 된다.

리턴데이터형 함수명 데이터형 인수 데이터형 인수([ 1, 2, ...]);

2.6.7.2.2.6.7.2.2.6.7.2.2.6.7.2. 일반 함수의 정의일반 함수의 정의일반 함수의 정의일반 함수의 정의

함수는 반드시 하나의 블럭으로 되어 있어 어떤 내용을 처리하고 그 결과를 리턴하는 등 실제적인 프로그램을

기술하는 부분이다 다음의 형태를 띤다. .
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리턴데이터형 함수명 데이터형 인수 데이터형 인수([ 1, 2, ...])
프로그램 내용{ }

� 리턴데이터형 함수는 내용을 수행하고 리턴데이터가 있는 경우와 없는 경우가 있는데 함수를 한 쪽으로: call

결과를 돌려보내는 경우 프로그램 내용 끝에 다음과 같은 명령을 표시한다.

리턴데이터return ;

리턴데이터형이 정수형인지 문자형인지 실수형인지 등 무엇인지를 기술하는 부분이다 결과를 리턴하지 않는, , .

경우 를 쓴다void .

� 함수명 함수의 이름을 나타내는 심볼로 알파벳 대문자와 소문자과 숫자와 가 가능하며 대 소문자가 구별된: _

다 절의 변수나 상수 이름 짓는 법에 따라 이름을 만들면 된다 함수는 함수명이 으로 반드시. 2.4.3.4 . main main

프로그램에서 만들어야 하는 함수이다C .

� 인수 프로그램을 처리할 때 전달받을 값은 인수들을 통해 하는 데 함수를 정의할 때 인수들의 데이터형과:

함께 안에 써 넣는다 전달받을 값이 없으면 인수를 안쓰거나 라고 쓴다( ) . void .

� 프로그램 내용 안에 정의하여 블록을 이루며 실제 함수의 실행코드가 위치한다: { } .

2.6.7.3.2.6.7.3.2.6.7.3.2.6.7.3. 라이브러리 함수라이브러리 함수라이브러리 함수라이브러리 함수

은 언어의 표준 라이브러리의 함수들을 제공해준다 자세한 것은CodeVisionAVR ANSI C . CodeVisionAVR

를 참조하거나 컴파일러의 를 참조하길 바랍니다manual(http://www.hpinfotech.ro) CodeVisoinAVR C help .

� 이 헤더파일을 시키면 에서 사용할 수 있는stdio.h : include UART getchar(), putchar(), puts(), putsf(),

등의 기본 입출력 함수를 사용할 수 있다printf(), vprintf(), psprintf(), scanf() .

� 이 헤더파일을 시키면 등의 기본 라이stdlib.h : include atoi(), itoa(), ftoa(), atof(), rand(), *malloc(), free()

브러리 함수를 사용할 수 있다.

� 이 헤더파일을 시키면math.h : include abs(), max(), fmax(), min(), fmin(), sign(), sqrt(), ceil(), floor(),

fmod(), exp(), log(), log10(), pow(), sin(), cos(), tan(), sinh(), cosh(), tanh(), asin(), acos(), atan(), atan2()

등의 수학 함수를 사용할 수 있다.

� 이 헤더파일을 시키면 등의 문자열 조string.h : include *strcat(), *strcatf(), strcmp(), *strcpy(), strnlen()

작용 함수를 사용할 수 있다.

2.6.7.4.2.6.7.4.2.6.7.4.2.6.7.4. 인터럽트 함수의 정의인터럽트 함수의 정의인터럽트 함수의 정의인터럽트 함수의 정의

은 다수의 인터럽트 소스를 가지며 이를 위한 특별한 정의가 요구된다 다음의 형태를 띤다AVR . .

인터럽트벡터번호 인터럽트함수명interrupt [ ] void ( void )
인터럽트 서비스 프로그램 내용{ }

� 인터럽트 함수명 인터럽트 함수의 이름을 나타내는 심볼로 알파벳 대문자와 소문자과 숫자와 가 가능하며: _

대 소문자가 구별된다 앞서 설명된 변수나 상수 이름 짓는 법에 따라 이름을 만들면 된다. .

� 인터럽트 벡터번호 각 디바이스가 제공할 수 있는 인터럽트 소스 가운데 선언할 인터럽트를 지정하는: AVR

번호로 다른 일반 함수와 구별하기 위해 반드시 써줘야 한다 헤더파일에 인터럽트 소스명이 정의되어 있다. .

의 경우 에 리셋 인터럽트를 제외한 개의 인터럽트 소스명이 정의되어 있는데 외부인ATmega128 mega128.h 34

터럽트 인터럽트 번호 은 로 정의되어 있다0~7( 2~9) EXT_INT0~EXT_INT7 .

2.6.7.5.2.6.7.5.2.6.7.5.2.6.7.5. 변수변수변수변수

변수는 값의 변화가 있는 데이터를 지칭하며 값을 마음대로 바꿀 수 있는 기억장소를 의미한다 변수는 전역.

지역 정적 외부 변수 레지스터로 나뉠 수 있다(global), (local), (static), (extern) , .

� 전역변수 소스 파일 내부에 있는 모든 함수나 프로그램 블록에서 사용할 수 있다 소스파일 전체에서 서로: .

공유하는 데이터가 있는 경우에 사용하면 좋다.

� 지역변수 하나의 프로그램 블록 안에서 선언되고 사용되는 변수로 선언된 블록 밖에서는 변수로서의 기능을:
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상실한다 프로그램 블록이 실행되는 순간에 지역변수를 위한 기억장소가 확보되고 실행이 종료되면 자동적으로.

해제되어 다른 프로그램 블록이 실행되는 동안에는 메모리에 전혀 영향을 주지 않는다.

� 레지스터변수 의 레지스터를 사용하여 변수를 저장한다 그러므로 연산속도가 향상될 수 있다 일반적으: CPU . .

로 지역변수에만 지정할 수 있고 레지스터의 갯수가 한정이 되어 있으므로 일정 한도가 넘어서면 나머지들은 레

지스터변수로 선언되었어도 무시당하고 지역변수에 할당된다.

� 정적변수 아래와 같이 자료형 앞에 이라는 지시어를 데이터 형 앞에 써 정의하며 정적변수가 선언된: static

함수가 종료되더라도 그 값을 계속 유지하며 프로그램이 종료될 때까지 유효한 변수이다.

static 데이터형 변수명 초기값 변수명 초기값1[= , 2= 2, .... ];

� 외부변수 다른 소스 파일에 정의된 변수를 지칭한다 프로그램 선두에 아래와 같이 이라는 지시어를: . extern

데이터형 앞에 써 정의하여 사용하며 프로그램이 종료될 때까지 유효하다 여러 사람이 공동으로 하나의 프로그.

램을 개발할 때 다른 사람이 만든 변수를 쉽게 사용할 수 있도록 해준다 함수의 경우도 마찬가지로 프로그램 선.

두에 프로토타입선언문 앞에 지시어를 붙여서 선언하여 다른 소스 파일에 정의된 함수를 사용하며 프로extern

그램이 종료될 때까지 유효하다.

extern 데이터형 변수명 초기값 변수명 초기값1[= , 2= 2, .... ];

2.6.7.6.2.6.7.6.2.6.7.6.2.6.7.6. 어셈블리어와 결합어셈블리어와 결합어셈블리어와 결합어셈블리어와 결합

함수내의 소스 중간에 어셈블리어를 사용하기 시작하려면 지시어C 을 사용하고 어셈블리어의 사용을 끝#asm

내려면 지시어 을 사용한다#endasm . 어셈블리어 명령어 도 가능하다#asm(" ") .

2.6.8.2.6.8.2.6.8.2.6.8.2.6.8.2.6.8.2.6.8.2.6.8.2.6.8.2.6.8.2.6.8.2.6.8. 포인터와포인터와포인터와포인터와포인터와포인터와포인터와포인터와포인터와포인터와포인터와포인터와 배열배열배열배열배열배열배열배열배열배열배열배열

2.6.8.1.2.6.8.1.2.6.8.1.2.6.8.1. 배열 선언 방법배열 선언 방법배열 선언 방법배열 선언 방법

배열의 선언은 아래와 같이 데이터형 배열명을 써주고 배열차원수를, [ 기호로 묶어주면 된다] .

데이터형 배열명 배열항목수 배열항목수 배열항목수[ 1][ 2] ... [ n];

� 데이터형 앞에 나온 데이터형을 사용한다: .

� 배열명 배열의 이름을 나타내는 심볼로 알파벳 대문자와 소문자과 숫자와 가 가능하며 대 소문자가 구별된: _

다 절의 변수나 상수 이름 짓는 법에 따라 이름을 만들면 된다. 2.4.3.4

� 배열항목수 배열의 크기를 설정한다 주의할 점은 배열의 마지막 인덱스는 배열차원수 이고 첫 인덱스는: . ( -1)

임에 유의해야 한다 예로 와 같이 선언된 배열 의 첫 번째 항목은 이 아니라 이0 . char buf[3]; buf buf[1] buf[0]

며 두 번째 항목은 가 아니라 이고 세 번째 항목이자 마지막 항목은 이 아니라 이다buf[2] buf[1] buf[3] buf[2] .

2.6.8.2.2.6.8.2.2.6.8.2.2.6.8.2. 배열 초기화배열 초기화배열 초기화배열 초기화

� 차원 배열의 초기화 배열은 선언과 동시에 값을 초기화 할 수 있는데1 : { 기호를 사용하여한다 차원 배} . 1

열의 경우 아래와 같이 차례대로 값을 나열하고 콤마로 구분하고,( ) 기호로 묶어주면 된다 인덱스 에서부터{ } . 0

차례대로 까지 순서대로 주어진 항목값에 따라 초기화된다 배열항목수는 보다 작거나 같을 수 있는 데 작n-1 . n

은 경우 초기화 되지 않은 항목의 값은 자동적으로 으로 초기화된다0 .

데이터형 배열명 배열항목수 번째항목값 번째항목값[ ] = { 1 , .... , n } ;

차원 배열의 선언과 초기화를 동시에 하는 경우 아래와 같이 배열항목수를 빼고 해도 된다 그러나 이 경우1 .

선언된 배열명의 항목수는 으로 됨에 유의해야 한다 그리고 차원 이상의 경우에는 허용되지 않는다n . 2 .

데이터형 배열명 번째항목값 번째항목값[] = { 1 , .... , n } ;

� 문자형 배열의 초기화 문자열의 경우에는 초기화할 때 기호를 사용하지 않고 큰 따옴표를 써서 해도 된: { }

다 그래서 아래의 두 선언문은 같다 정수형이나 다른 데이터형의 경우에는 허용되지 않는다. . .

char buf[11] = "I am HHCHOI";
char buf[[11] = {'I', ' ', 'a', 'm', ' ', 'H', 'H', 'C', 'H', 'O', 'I'};

� 다차원 배열의 초기화 차원배열의 초기화와 비슷하며 다만 중으로 기호를 사용한다 번째값 이 배열: 1 2 { } . 1 1
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의 배열명 의 항목값으로 초기화되고 차례대로 번째항목값 이 배열명 의 항목값[0][0] ... [0] m 1 [0][0] .... [m-1]

으로 초기화된다 번째값 은 배열명 의 항목값으로 초기화되고 차례대로 번째항목값 이 배열명. 1 2 [1][0] ... [0] p 2

의 항목값으로 초기화된다 마찬가지의 과정을 거쳐 차례대로 초기화되며 초기화되지 않은 항목[1][0] ... [p-1] .

의 값은 자동적으로 으로 초기화된다 여기에서 차원 배열과 달리 항목수는 반드시 기입해야 한다0 . 1 .

데이터형 배열명 항목수 항목수 번째값 번째항목값 번째값 번째항목값[ 1] ... [ n] = { {1 1, .... , m 1}, {1 2, .... , p 2} ... } ;

2.6.8.3.2.6.8.3.2.6.8.3.2.6.8.3. 포인터 선언 방법포인터 선언 방법포인터 선언 방법포인터 선언 방법

아래와 같이 일반 변수와 같은 형식으로 선언하되 변수의 이름 앞에 애스터리스크 기호를 붙인다 는 포인*( ) . *

터 변수의 내용을 의미하는 연산자이다.

데이터형 포인터이름* ;

2.6.8.4.2.6.8.4.2.6.8.4.2.6.8.4. 포인터 초기화 및 참조 방법포인터 초기화 및 참조 방법포인터 초기화 및 참조 방법포인터 초기화 및 참조 방법

� 일반 변수 주소를 포인터 변수에 대입하는 방법 아래와 같은 형태로 주소연산자: 를 사용하여 포인터에 데&

이터를 할당하고 초기화할 수 있다.

데이터형 일반변수이름 초기값= ;
데이터형 포인터이름* ;
포인터이름 일반변수이름= & ;

위의 형태는 아래와 같은 형태로 대체될 수 있다.

데이터형 일반변수이름 초기값= ;
데이터형 포인터이름 일반변수이름* = & ;

� 문자열을 포인터로 선언하는 법 포인터를 선언하면서 동시에 문자열 데이터로 초기화할 때는 아래와 같이:

큰따옴표를 사용하면 된다.

char 포인터이름 문자열* = “ ”;

� 포인터로 배열을 가리키게 하기 위해 배열이름을 포인터 변수에 대입하는 방법 미리 선언된 배열을 미리 선:

언된 포인터 변수로 가리키게 하기 위해 다음과 같이 배열이름을 포인터이름에 대입할 수 있다.

데이터형 배열명 배열항목수 번째항목값 번째항목값 포인터이름[ ] = { 1 , .... , n }, * ;
포인터이름 배열이름= ;

위의 형태는 아래와 같은 형태로 대체될 수 있다.

데이터형 배열명 배열항목수 번째항목값 번째항목값[ ] = { 1 , .... , n };
데이터형 포인터이름 배열이름* = ;

� 포인터로 배열을 가리키게 하기 위해 배열의 첫번째 항목의 주소를 포인터 변수에 대입하는 방법 미리 선언:

된 차원배열을 미리 선언된 포인터 변수로 가리키게 하기 위해 다음과 같이 주소연산자1 를 사용하여 배열의&

첫번째 항목의 주소를 사용할 수 있다.

데이터형 배열명 배열항목수 번째항목값 번째항목값 포인터이름[ ] = { 1 , .... , n }, * ;
포인터이름 배열이름= & [0];

� 포인터 변수에서 값 읽기 방법 미리 선언되고 사용중인 포인터변수의 내용을 그 내용과 같은 자료형의 일반:

변수에 값을 써 넣을 때는 연산자 를 사용해 아래와 같이 한다* .

일반변수이름 포인터이름= * ;

� 포인터 변수에 값 쓰기 방법 미리 선언되고 사용중인 포인터 변수의 내용과 같은 자료형의 일반변수 값을:

포인터 변수에 값을 써 넣을 때도 연산자 를 사용해 아래와 같이 한다* .

포인터이름 일반변수이름* = ;

2.6.8.5.2.6.8.5.2.6.8.5.2.6.8.5. 포인터의 연산포인터의 연산포인터의 연산포인터의 연산

포인터변수는 ++, --, +, 등의 연산자를 사용하여 연산이 가능하다 만약 다음과 같이 포인터와 배-, +=, -= .

열이 선언된 경우 가 가리키는 값은 즉 와 같다 여기에서 나 가 연산자보다 우선하기 때*ptr++ buf[1] b . ++ -- *

문에 와 는 동일하고 과 은 동일함에 유의해야 한다*ptr++ *(ptr++) , *ptr-- *(ptr--) .

char buf[6] = "abcdef"; char *ptr = buf;

2.6.8.6.2.6.8.6.2.6.8.6.2.6.8.6. 함수 포인터함수 포인터함수 포인터함수 포인터
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� 함수포인터의 선언 함수프로토타입 선언과 같이 아래처럼 하면 함수 포인터를 선언할 수 있다 함수프로토타: .

입 선언에서처럼 인수들은 생략하고 인수들의 데이터형만 안에 나열해도 된다 인수가 없는 경우에는( ) . 를void

사용한다.

리턴데이터형 함수명 데이터형 인수 데이터형 인수(* ) ([ 1, 2, ...]);

� 함수포인터의 무조건 점프명령에의 활용 아래와 같이 이라는 함수포인터가 선언된 경우: function_ptr

void (* function_ptr) (void);

에 다음과 같은 식으로 절대번지값예 을 대입을 하고 콜을 하면 프로그램카운터 값은function_ptr ( : 0x4000) (PC)

절대번지값 으로 바뀌어 번지부터 명령을 수행하게 된다0x4000 0x4000 .

function_ptr = (void *) 0x4000; function_ptr();

2.6.8.7.2.6.8.7.2.6.8.7.2.6.8.7. 배열과 포인터의 차이점배열과 포인터의 차이점배열과 포인터의 차이점배열과 포인터의 차이점

� 선언 배열은 선언시 차원을 미리 지정해줘야 하나 포인터는 그럴 필요없다: .

� 초기화 배열은 초기화가 쉬우나 포인터는 미리 메모리를 항당받고 해야 한다: .

� 데이터 접근 배열은: [ 기호사이에 넣어진 값 즉 인덱스를 사용하여 바로 필요한 위치의 데이터에 접근 할]

수 있으나 포인터는 포인터 변수의 연산을 통해 데이터를 읽고 써야 한다.

� 메모리의 사용 배열이 선언될 때 필요한 메모리가 할당되어 중간에 메모리 크기를 변경할 수 없으나 포인터:

는 그렇지 않다.

2.6.9.2.6.9.2.6.9.2.6.9.2.6.9.2.6.9.2.6.9.2.6.9.2.6.9.2.6.9.2.6.9.2.6.9. typedef, structure, union, enumtypedef, structure, union, enumtypedef, structure, union, enumtypedef, structure, union, enumtypedef, structure, union, enumtypedef, structure, union, enumtypedef, structure, union, enumtypedef, structure, union, enumtypedef, structure, union, enumtypedef, structure, union, enumtypedef, structure, union, enumtypedef, structure, union, enum

2.6.9.1.2.6.9.1.2.6.9.1.2.6.9.1. 를 사용한 새로운 데이터형 정의법를 사용한 새로운 데이터형 정의법를 사용한 새로운 데이터형 정의법를 사용한 새로운 데이터형 정의법typedeftypedeftypedeftypedef

는 자주 사용하는 데이터형을 기억하기 쉽거나 편리한 이름을 갖는 새로운 데이터형을 정의하여 쓸 수typedef

있도록 한다 사용 형식은 아래와 같다. .

typedef 기존데이터형 새데이터형;

일반적으로 다음과 같은 데이터형의 변경이 많이 쓰인다.

typedef unsigned char byte;
typedef unsigned int word;

2.6.9.2.2.6.9.2.2.6.9.2.2.6.9.2. 구조체의 개념과 필요성구조체의 개념과 필요성구조체의 개념과 필요성구조체의 개념과 필요성

서로 다른 유형의 변수들을 새로운 하나의 데이터형으로 묶어서 정의한 것으로 구조체 는 다양한 유(structure)

형의 변수를 구성원으로 갖는 변수의 묶음이다 인사기록카드를 만드는 경우 사원의 이름 사번 주민번호 나이. , , , ,

최종학력 등이 필요한데 이러한 것은 사원별로 나누어지는 데이터이므로 각 사원에 대하여 하나로 묶어 처리하

면 취급 프로그램 개발과 이해가 매우 쉽겠다, .

2.6.9.3.2.6.9.3.2.6.9.3.2.6.9.3. 구조체 선언법과 초기화구조체 선언법과 초기화구조체 선언법과 초기화구조체 선언법과 초기화

� 방법 우선 아래와 같은 형태로 구조체항목들을 나열하여 로 묶어 구조체이름으로 새로운 데이터형을 정1 : { }

의한다.

struct 구조체이름 {
데이터형 구조체항목1; 데이터형 구조체항목2;
데이터형 구조체항목n; };

이렇게 만든 구조체로 지시어 와 구조체이름을 사용하여 변수를 아래와 같이 선언한다struct .

struct 구조체이름 변수이름;

선언과 동시에 초기화할 경우에는 아래와 같이 한다.

struct 구조체이름 변수이름 구조체항목 의 초기값 구조체항목 의 초기값 구조체항목 의 초기값= { 1 , 2 , n };

� 방법 아래와 같은 형태로 구조체항목들을 나열하여 로 묶어 구조체이름으로 새로운 데이터형을 정의하2 : { }

며 동시에 정의된 구조체형태의 변수를 선언하고 초기화할 수 있다.
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struct 구조체이름 {
데이터형 구조체항목1; 데이터형 구조체항목2;
데이터형 구조체항목n;

변수이름 구조체항목 의 초기값 구조체항목 의 초기값 구조체항목 의 초기값} = { 1 , 2 , n };

� 방법 를 사용하여 우선 아래와 같은 형태로 구조체항목들을 나열하여 로 묶어 구조체이름으로3 : typedef { }

새로운 데이터형을 정의한다.

typedef struct 구조체이름_ {
데이터형 구조체항목이름1; 데이터형 구조체항목이름2;
데이터형 구조체항목이름 구조체이름n; } ;

이렇게 만든 경우 지시어 를 쓸 필요없이 구조체이름만 사용하여 변수를 아래와 같이 선언한다struct .

구조체이름 변수이름;

구조체 변수 선언과 동시에 초기화할 경우에는 아래와 같이 한다.

구조체이름 변수이름 구조체항목이름 의 초기값 구조체항목이름 의 초기값 구조체항목이름 의 초기값= { 1 , 2 , n };

� 방법 를 사용하여 아래와 같은 형태로 구조체를 정의하고 변수의 선언과 초기화는 방법 과 똑같이4 : typedef 3

할 수도 있다.

typedef struct {
데이터형 구조체항목이름1; 데이터형 구조체항목이름2;
데이터형 구조체항목이름n; 구조체이름} ;

� 구조체 포인터 변수나 배열 선언 앞서의 방법 가운데 하나를 사용해서 구조체 이름을 선언하고 변수를: 1~4

포인터나 배열로 선언할 수 있다 절에 주어진 일반 데이터형의 포인터나 배열 선언 방법과 동일하다 예로. 2.4.9 .

구조체 이름을 방법 이나 를 이용하여 선언한 경우 포인터나 배열변수는 아래와 같이 하면 된다3 4 .

구조체이름 구조체포인터변수이름 구조체배열이름 배열항목수* , [ ];

2.6.9.4.2.6.9.4.2.6.9.4.2.6.9.4. 구조체 사용법구조체 사용법구조체 사용법구조체 사용법

� 연산자를 통한 항목 접근 구조체 변수의 항목은 아래와 같이. : 도트 연산자를 통해 접근한다.( ) .

구조체변수이름구조체항목이름.

� 연산자를 통한 항목 접근 구조체 포인터 변수의 항목은 아래와 같이-> : 연산자를 통해 접근한다-> .

구조체보인터변수이름 구조체항목이름->

2.6.9.5.2.6.9.5.2.6.9.5.2.6.9.5. 공용체공용체공용체공용체(union)(union)(union)(union)

� 개념 항목들이 같은 메모리 공간을 점유하는 것을 제외하고 구조체와 동일하다 하나의 변수가 점유하: . union

는 메모리의 크고 변수의 항목에서 가장 큰 것과 동일하다 에서는 에 저장된다 아래의 예를 보면. AVR SRAM .

쉽게 필요성과 사용법을 이해 할 수 있을 것이다 같은 값의 다른 표현에 활용할 수 있다. .

union tag_length {
unsigned int all; unsigned char byte[2]; } data;

data.all = 0x1230; 공용체에 진수 할당//data 16 0x1234
low = data.byte[0] ; 에 의 하위바이트를 할당 즉 와 동치// low data low=0x30
high = data.byte[1] ; 에 의 상위바이트를 할당 즉 와 동치// hig data high=0x12

� 선언법과 초기화 구조체와 같다: .

� 사용법 구조체와 같다: .

2.6.9.6.2.6.9.6.2.6.9.6.2.6.9.6. 열거형 상수열거형 상수열거형 상수열거형 상수

� 개념 정수형 상수의 일종으로 상수값에 일종의 별명을 부여하여 열거해 둔 것이다: .

� 선언법과 초기화 선언법과 초기화는 구조체와 비슷한데 각 항목에 할당되는 값은 만약 번째 항목의 값이: n-1

정수 이라면 번째 항목 값은 이다 초기화는 첫번째 항목값만 정의해주면 된다 첫번째 항목을 정의하지N-1 n N . .

않으면 첫번째 항목에 이 할당된다 아래의 예는 상수 의 항목은 에 는 에0 . d_of_weeks sunday 1 , monday 2 ,.....

에는 을 할당하는 것이다saturday 7 .

enum days {sunday=1, monday, tuesday, wednesday, thursday, friday, saturday} d_of_week;
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3.3.3.3.3.3.3.3.3.3.3.3. 기본 프로그래밍과 입출력 실험기본 프로그래밍과 입출력 실험기본 프로그래밍과 입출력 실험기본 프로그래밍과 입출력 실험기본 프로그래밍과 입출력 실험기본 프로그래밍과 입출력 실험기본 프로그래밍과 입출력 실험기본 프로그래밍과 입출력 실험기본 프로그래밍과 입출력 실험기본 프로그래밍과 입출력 실험기본 프로그래밍과 입출력 실험기본 프로그래밍과 입출력 실험

3.1.3.1.3.1.3.1.3.1.3.1.3.1.3.1.3.1.3.1.3.1.3.1. 기본 프로그래밍 연습기본 프로그래밍 연습기본 프로그래밍 연습기본 프로그래밍 연습기본 프로그래밍 연습기본 프로그래밍 연습기본 프로그래밍 연습기본 프로그래밍 연습기본 프로그래밍 연습기본 프로그래밍 연습기본 프로그래밍 연습기본 프로그래밍 연습

3.1.1.3.1.1.3.1.1.3.1.1.3.1.1.3.1.1.3.1.1.3.1.1.3.1.1.3.1.1.3.1.1.3.1.1. 실험 내부램에 데이터 쓰기실험 내부램에 데이터 쓰기실험 내부램에 데이터 쓰기실험 내부램에 데이터 쓰기1 : 11 : 11 : 11 : 1실험 내부램에 데이터 쓰기실험 내부램에 데이터 쓰기실험 내부램에 데이터 쓰기실험 내부램에 데이터 쓰기1 : 11 : 11 : 11 : 1실험 내부램에 데이터 쓰기실험 내부램에 데이터 쓰기실험 내부램에 데이터 쓰기실험 내부램에 데이터 쓰기1 : 11 : 11 : 11 : 1

� 예제 내부램에 데이터를 쓰는 다양한 방법을 익힌다 내부램 번지에 차례대로 숫자: . 0x130-0x136 1, 2,

와 문자 를 써 넣어라 즉 다음을 하라0xff 'A', 'a', 'F', 'f' . .

(0x130) <-1, (0x131) <-2, (0x132) <-0xff, (0x133) <-'A', (0x132) <-'a', (0x135) <-'F', (0x136) <-'f'

� 프로그램 예 :

#include <mega128.h>
#define DBYTE ((unsigned char volatile *) 0)
#define Im136 *((unsigned char *) 0x0136) 에는 로 종결하지 않음에 주의/* define ; */
unsigned char *pIm130 = 0x0130;
void main(void){

*pIm130++ = 1; /* (0x130) <- 1, pIm130h = pIm130 + 1 */
*(pIm130++) = 2; /* *pIm130++ = *(pIm130++) */
*pIm130 = 0xff ; /* (0x132) <- 0xff */
*++pIm130 = 'A' ; /* pIm130 = pIm130 +1 , *pIm130 <- 'A' */
*(++pIm130) = 'a'; /* *(++pIm130) = *++pIm130 */
DBYTE[0x0135] = 'F'; /* (0x135) <- 'F' */
Im136 = 'f'; /* (0x136) <- 'f' */

}

� 실험방법 의 에디터를 통해 실행파일을 만든 후 디버그세션에 들어간 후 메: CodeVisionAVR AVR Studion4①

인메뉴의 를 실행하여 라는 이름의 창을 생성하고 창에서 을 선택한다 또한[View->Memory] Memory [Data] .

를 실행하여 라는 이름의 창을 생성한다 디버그세션에서 메인메뉴 의 하[View->Register] Register . [Debug]②

위 메뉴인 등을 적절히 활용하면서[Step Into], [Auto Step], [Run to Cusor] Memory, Register, I/O View

창을 통해 내부램과 레지스터의 값의 변화를 확인하라 성공적으로 수행된 경우 내부램 에는 차례. 0x130-0x136

대로 값이 저장된다1,2, 0xff, 0x41, 0x61, 0x46, 0x66 .

� 과제 내부램 번지에 차례대로 문자 를 다양한 방식으로 써: 0x140-0x147 ‘A', 'b', 'C', 'D', 'E', 'F', 'G', 'h'

넣어라.

3.1.2.3.1.2.3.1.2.3.1.2.3.1.2.3.1.2.3.1.2.3.1.2.3.1.2.3.1.2.3.1.2.3.1.2. 실험 내부램에 데이터 쓰기실험 내부램에 데이터 쓰기실험 내부램에 데이터 쓰기실험 내부램에 데이터 쓰기2 : 22 : 22 : 22 : 2실험 내부램에 데이터 쓰기실험 내부램에 데이터 쓰기실험 내부램에 데이터 쓰기실험 내부램에 데이터 쓰기2 : 22 : 22 : 22 : 2실험 내부램에 데이터 쓰기실험 내부램에 데이터 쓰기실험 내부램에 데이터 쓰기실험 내부램에 데이터 쓰기2 : 22 : 22 : 22 : 2

� 예제 내부램 번지에 차례대로 을 써 넣어라: 0x130-0x17F 0xff .

� 프로그램 예 :

#include <mega128.h>
unsigned char *pIm130 = 0x0130;
void main(void){

for(;pIm130<=0x17f;){
포인터 가 가리키는 곳에 를 쓰고 다음 위치를 가르키도록 증가 시킨다*pIm130++ = 0xff; /* pIm130 ff 1 . */

}
}

� 실험방법 실험 과 같은 방식으로 수행하라 성공적으로 수행된 경우 내부램 번지에 차례대: 1 . 0x130H-0x17F

로 값이 저장된다0xff .

� 과제 를 활용하여 같은 역할을 하도록 하라: #define DBYTE ((unsigned char volatile *) 0) .

3.1.3.3.1.3.3.1.3.3.1.3.3.1.3.3.1.3.3.1.3.3.1.3.3.1.3.3.1.3.3.1.3.3.1.3. 실험실험실험실험3 :3 :3 :3 :실험실험실험실험3 :3 :3 :3 :실험실험실험실험3 :3 :3 :3 : 에 데이터 쓰기와 읽기에 데이터 쓰기와 읽기에 데이터 쓰기와 읽기에 데이터 쓰기와 읽기EEPROMEEPROMEEPROMEEPROM에 데이터 쓰기와 읽기에 데이터 쓰기와 읽기에 데이터 쓰기와 읽기에 데이터 쓰기와 읽기EEPROMEEPROMEEPROMEEPROM에 데이터 쓰기와 읽기에 데이터 쓰기와 읽기에 데이터 쓰기와 읽기에 데이터 쓰기와 읽기EEPROMEEPROMEEPROMEEPROM
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� 예제 의 일정영역에 데이터를 저장시켜 놓고 읽는 방법을 익힌다 에: EEPROM . EEPROM 0x3F, 0x06, 0x5B,

등 개의 데이터를 쓰고 저장된 값을 읽어 들여0x4F, 0x66, 0x6D, 0x7D, 0x07, 0x7F, 0x67 10 SRAM 0x130

번지를 시작으로 하여 차례대로 저장한다.

� 프로그램 작성시 유의점 절과 절을 참조하여 작성한다: 1.5.6.4 1.5.6.5 .

� 프로그램 예 :

#include <mega128.h>
명령어를 사용해 에 쓸 수 있다#include <mem.h> // void pokeb(unsigned int addr, unsigned char data) SRAM .

#include <delay.h>
unsigned char read_eeprom(unsigned int addr) { 읽기// EEPROM

while((EECR & 0x02) == 0x02); 인가를 확인한다// EEWE = 0 .
EEAR = addr;
EECR |= 0x01; // EERE =1
return EEDR;

}
void write_eeprom(unsigned int addr,unsigned char data) { 에 쓰기// EEPROM

while((EECR & 0x02) == 0x02); 인가를 확인한다// EEWE = 0 .
EEAR = addr;
EEDR = data;
EECR |= 0x04; // EEMWE = 1
EECR |= 0x02; // EEWE = 1

}
void main(void){

unsigned char arr[ ]={0x3f, 0x06, 0x5B, 0x4F, 0x66, 0x6D, 0x7D, 0x07, 0x7F, 0x67 };
int i, j;
j = 0x00;
while(arr[j] != 0) write_eeprom(j,arr[j++]);
delay_ms(100);
for(i=0x0130, j=0;i<=0x013a; i++, j++) {

pokeb(i, read_eeprom(j)); 읽은 데이터를 램에 쓴다// .
delay_ms(10);}

}

� 실험방법 실험 과 비슷한 방식으로 수행하라 창을 띠우고 이를 통해 성공적으로 써졌는지 확인하: 1 . EEPROM

라 성공적으로 수행된 경우 내부램 에는 차례대로. 0x130-0x13a 0x3F, 0x06, 0x5B, 0x4F, 0x66, 0x6D,

값이 저장된다0x7D, 0x07, 0x7F, 0x67 .

� 과제 플래쉬롬에 등 개의 데이터를: 0x3F, 0x06, 0x5B, 0x4F, 0x66, 0x6D, 0x7D, 0x07, 0x7F, 0x67 10

저장해두고 저장된 값을 읽어 들여 실험 을 참조하여 다른 방식으로 에 번지를 시작으로 하여 차1 EEPROM 0x00

례대로 저장하는 프로그램을 작성하라.

3.1.4.3.1.4.3.1.4.3.1.4.3.1.4.3.1.4.3.1.4.3.1.4.3.1.4.3.1.4.3.1.4.3.1.4. 실험실험실험실험4 :4 :4 :4 :실험실험실험실험4 :4 :4 :4 :실험실험실험실험4 :4 :4 :4 : 롬 데이터 읽기롬 데이터 읽기롬 데이터 읽기롬 데이터 읽기롬 데이터 읽기롬 데이터 읽기롬 데이터 읽기롬 데이터 읽기롬 데이터 읽기롬 데이터 읽기롬 데이터 읽기롬 데이터 읽기

� 예제 플래쉬 롬의 일정영역에 데이터를 저장시켜 놓고 읽는 방법을 익힌다 롬에: . 0x3F, 0x06, 0x5B, 0x4F,

등 개의 데이터를 저장해두고 저장된 값을 읽어 들여0x66, 0x6D, 0x7D, 0x07, 0x7F, 0x67 10 SRAM 0x130

번지를 시작으로 하여 차례대로 저장한다.

� 프로그램 예 :

#include <mega128.h>
명령어를 사용해 에 쓸 수 있다#include <mem.h> // void pokeb(unsigned int addr, unsigned char data) SRAM .

flash unsigned char arr[ ]={0x3f, 0x06, 0x5B, 0x4F, 0x66, 0x6D, 0x7D, 0x07, 0x7F, 0x67 };
void main(void){

int i, j;
for(i=0x0130, j=0;i<=0x013a; i++, j++) pokeb(i, arr[j]);

}
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� 실험방법 실험 과 같은 방식으로 수행하라 성공적으로 수행된 경우 내부램 에는 차례대로: 1 . 0x130-0x13a

값이 저장된다0x3F, 0x06, 0x5B, 0x4F, 0x66, 0x6D, 0x7D, 0x07, 0x7F, 0x67 .

� 과제 플래쉬롬에 등 개의 데이터를: 0x3F, 0x06, 0x5B, 0x4F, 0x66, 0x6D, 0x7D, 0x07, 0x7F, 0x67 10

저장해두고 저장된 값을 읽어 들여 실험 을 참조하여 다른 방식으로 에 번지를 시작으로 하여 차례1 SRAM 0x130

대로 저장하는 프로그램을 작성하라.

3.1.5.3.1.5.3.1.5.3.1.5.3.1.5.3.1.5.3.1.5.3.1.5.3.1.5.3.1.5.3.1.5.3.1.5. 실험실험실험실험5 :5 :5 :5 :실험실험실험실험5 :5 :5 :5 :실험실험실험실험5 :5 :5 :5 : 롬데이터 검색롬데이터 검색롬데이터 검색롬데이터 검색1111롬데이터 검색롬데이터 검색롬데이터 검색롬데이터 검색1111롬데이터 검색롬데이터 검색롬데이터 검색롬데이터 검색1111

� 예제 플래쉬 롬의 일정영역에 저장된 개의 데이터에서 의 배수를 뽑아 부터 저장하고 의: 16 5 SRAM 0x131 5

배수의 개수를 에 저장한다0x130 .

� 프로그램 예 :

#include <mega128.h>
#define DBYTE ((unsigned char volatile *) 0)
flash unsigned char arr[ ]={12, 5, 2 , 25, 3, 9, 15, 19, 25, 99, 45, 56, 77, 99, 34, 26 };
void main(void){

int i = 0x0131, j = 0, k =0 ;
for(;j<=15; j++) 으로 초기화하는 것은 선언문에서 했으므로 생략/* j=0 */

if ( arr[j]%5 == 0 ) { DBYTE[i++] = arr[j]; k++ ; }
DBYTE[0x0130] = k;

}

� 실험방법 실험 과 같은 방식으로 수행하라 창과 창을 띠우고 변화하는 모양을 성공: 1 . Eeprom Data, IO view

적으로 수행된 경우 내부 램 에 차례로 가 저장된다0x130H~0x135H 0x05, 0x05, 0x19, 0x0F, 0x19, 0x2D .

� 과제 프로그램 메모리 일정영역에 저장된 개의 데이터에서 의 배수가 아닌 것을 뽑아 부터: 16 5 SRAM 0x131

저장하고 그 개수를 에 저장하는 프로그램을 작성하라0x130 .

3.1.6.3.1.6.3.1.6.3.1.6.3.1.6.3.1.6.3.1.6.3.1.6.3.1.6.3.1.6.3.1.6.3.1.6. 실험실험실험실험6 :6 :6 :6 :실험실험실험실험6 :6 :6 :6 :실험실험실험실험6 :6 :6 :6 : 롬데이터 검색롬데이터 검색롬데이터 검색롬데이터 검색2222롬데이터 검색롬데이터 검색롬데이터 검색롬데이터 검색2222롬데이터 검색롬데이터 검색롬데이터 검색롬데이터 검색2222

� 예제 롬의 일정영역에 저장된 개의 데이터에서 가장 작은 수를 뽑아 번지에 저장한다: 16 SRAM 0x130 .

� 프로그램 예 :

#include <mega128.h>
#define DBYTE ((unsigned char volatile *) 0)
flash unsigned char arr[ ]={12, 5, 2 , 25, 3, 9, 15, 19, 25, 99, 45, 56, 77, 99, 34, 26 };
void main(void){

unsigned char j = 0;
DBYTE[0x00130] = arr[0]; 가장 작은 수가 될 후보로 로/* arr[0] */
for(j=1;j<=15; j++)

if ( DBYTE[0x0130] > arr[j] ) DBYTE[0x0130] = arr[j];
}

� 실험방법 실험 과 같은 방식으로 수행하라 성공적으로 수행된 경우 내부 램 에 가 저장된다: 1 . 0x0130 2 .

� 과제 프로그램 메모리 일정영역에 저장된 개의 데이터에서 가장 큰 값을 찾아 에 저장하라: 16 SRAM 0x130 .

3.1.7.3.1.7.3.1.7.3.1.7.3.1.7.3.1.7.3.1.7.3.1.7.3.1.7.3.1.7.3.1.7.3.1.7. 실험 비트 진수의실험 비트 진수의실험 비트 진수의실험 비트 진수의7 : 8 27 : 8 27 : 8 27 : 8 2실험 비트 진수의실험 비트 진수의실험 비트 진수의실험 비트 진수의7 : 8 27 : 8 27 : 8 27 : 8 2실험 비트 진수의실험 비트 진수의실험 비트 진수의실험 비트 진수의7 : 8 27 : 8 27 : 8 27 : 8 2 변환변환변환변환BCDBCDBCDBCD 변환변환변환변환BCDBCDBCDBCD 변환변환변환변환BCDBCDBCDBCD

� 예제 비트 진수를 자리수 값으로 변환하는 프로그램을 작성한다 주어진 진수 헥사값예 을: 8 2 3 BCD . 2 ( : 0xFF)

로 변환하여 의 자리수는 번지에 의 자리수는 번지의 상위 비트에 의 자리BCD 100 SRAM 0x0130 10 0x0131 4 1

수는 번지의 하위 비트에 저장하는 프로그램을 작성하라0x0131 4 .

� 프로그램 작성시 유의점 를 시켜서 를 사용해서 해도 되나 이 경우 까지의 값만: bcd.h include bin2bcd() 0~99

사용할 수 있다 비트의 진수는 의 값을 갖는다 그러므로 결과값의 저장은 바이트를 요구하고 의. 8 2 0~255 . 2 100
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자리수가 저장되는 는 의 값을 갖고 에는 의 값을 갖는다0x0130 0~2 0x0131 00~99 .

� 프로그램 예 :

#include <mega128.h>
#define DBYTE ((unsigned char volatile *) 0)
void h2bcd(unsigned char bin){

unsigned char tmp;
DBYTE[0x0130] = bin/100; 의 자리수는 번지에 저장/* 100 0x130 */
DBYTE[0x0131] = ( bin % 100 ) / 10; 의 자리수가 번지의 하위 비트에 저장/* 10 0x131 4 */
tmp = ( bin % 100 ) % 10 ; 의 자리수를 에 임시 저장/* 1 tmp */
DBYTE[0x0131] <<=4 ; 의 자리수를 번지의 상위 비트로 저장하기 위해 번 쉬프트/* 10 0x131 4 4 */
DBYTE[0x0131] |= tmp ; 의 자리수를 번지의 하위 비트로 저장/* 1 0x131 4 */

}
void main(void){

unsigned char bin = 0xff; 주어진 진수를 로 초기화/* 2 0xff */
h2bcd(bin);

}

� 실험방법 실험 과 같은 방식으로 수행하라 성공적으로 수행된 경우 내부램 에는 차례대로: 1 . 0x130, 0x131

값이 저장된다0x02, 0x55 .

� 과제 주어진 진수 를 로 변환하여 의 자리수는 램 번지에 의 자리수는 번: 2 0xE0 BCD 100 0x1000 10 0x1001

지의 상위 비트에 의 자리수는 번지의 하위 비트에 저장하는 프로그램을 실험 을 참조하여 다른 방식4 1 0x1001 4 1

으로 작성하라.

3.1.8.3.1.8.3.1.8.3.1.8.3.1.8.3.1.8.3.1.8.3.1.8.3.1.8.3.1.8.3.1.8.3.1.8. 실험 비트 진수의실험 비트 진수의실험 비트 진수의실험 비트 진수의8 : 16 28 : 16 28 : 16 28 : 16 2실험 비트 진수의실험 비트 진수의실험 비트 진수의실험 비트 진수의8 : 16 28 : 16 28 : 16 28 : 16 2실험 비트 진수의실험 비트 진수의실험 비트 진수의실험 비트 진수의8 : 16 28 : 16 28 : 16 28 : 16 2 변환변환변환변환BCDBCDBCDBCD 변환변환변환변환BCDBCDBCDBCD 변환변환변환변환BCDBCDBCDBCD

� 예제 비트 진수를 자리수 값으로 변환하는 프로그램을 작성한다 주어진 바이트 진수의 헥사값: 16 2 5 BCD . 2 2

예 를 로 변환하여 의 자리수는 번지에 의 자리수는 번지의 상위 비트( : 0xF0FF) BCD 10000 0x130 1000 0x131 4

에 의 자리수는 번지의 하위 비트에 의 자리수는 번지의 상위 비트에 의 자리수는100 0x131 4 10 0x132 4 1 0x132

번지의 하위 비트에 저장하는 프로그램을 작성하라4 .

� 프로그램 작성시 유의점 비트의 진수는 의 값을 갖는다 그러므로 결과값의 저장은 바이트를: 16 2 0~65535 . 5

요구하고 의 자리수가 저장되는 는 의 값을 갖고 에는 의 값을 갖는다10000 0x130 0~6 0x131~0x132 00~99 .

� 프로그램 예 :

#include <mega128.h>
#define DBYTE ((unsigned char volatile *) 0)
void h2bcd2(unsigned int bin){

unsigned char tmp;
DBYTE[0x0130] = (char)(bin/10000); 의 자리수 저장/* 10000 */
DBYTE[0x0131] = (char) (( bin % 10000 ) / 1000) ; 의 자리수가 번지의 하위 비트에 저장/* 1000 0x131 4 */
tmp = (char) ((( bin % 10000 ) % 1000) / 100) ; 의 자리수를 에 임시 저장/* 100 tmp */
DBYTE[0x0131] <<=4 ; 의 자리수를 번지의 상위 비트로 저장하기 위해 번 쉬프트/* 1000 0x131 4 4 */
DBYTE[0x0131] |= tmp ; 의 자리수를 번지의 하위 비트로 저장/* 100 0x131 4 */

의 자리수가 번지의 하위 비트에 저장DBYTE[0x0132] = (char)((( (bin % 10000) % 1000) %100)/10); /* 10 132 4 */
tmp = (char)((( ( bin % 10000 ) % 1000) % 100) % 10); 의 자리수를 에 임시 저장/* 1 tmp */
DBYTE[0x0132] <<=4 ; 의 자리수를 번지의 상위 비트로 저장하기 위해 번 쉬프트/* 10 0x132 4 4 */
DBYTE[0x0132] |= tmp ; 의 자리수를 번지의 하위 비트로 저장/* 1 0x132 4 */

}
void main(void){

unsigned int bin = 0xf0ff; 주어진 진수를 로 초기화/* 2 0xff */
h2bcd2(bin);

}

� 실험방법 실험 과 같은 방식으로 수행하라 성공적으로 수행된 경우 내부램 에는 차례대로: 1 . 0x130~132

값이 저장된다0x06, 0x16, 0x95 .
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� 과제 주어진 진수 를 로 변환하여 의 자리수는 램 번지에 의 자리수는: 2 0xffe0 BCD 10000 0x1000 1000

번지의 상위 비트에 의 자리수는 번지의 하위 비트에 의 자리수는 번지의 상위0x1001 4 100 0x1001 4 10 0x1002 4

비트에 의 자리수는 번지의 하위 비트에 저장하는 프로그램을 실험 을 참조하여 다른 방식으로 작성하1 0x1002 4 1

라.

3.1.9.3.1.9.3.1.9.3.1.9.3.1.9.3.1.9.3.1.9.3.1.9.3.1.9.3.1.9.3.1.9.3.1.9. 실험 아스키 문자의 진수 변환실험 아스키 문자의 진수 변환실험 아스키 문자의 진수 변환실험 아스키 문자의 진수 변환9 : 169 : 169 : 169 : 16실험 아스키 문자의 진수 변환실험 아스키 문자의 진수 변환실험 아스키 문자의 진수 변환실험 아스키 문자의 진수 변환9 : 169 : 169 : 169 : 16실험 아스키 문자의 진수 변환실험 아스키 문자의 진수 변환실험 아스키 문자의 진수 변환실험 아스키 문자의 진수 변환9 : 169 : 169 : 169 : 16

� 예제 아스키코드로 주어진 숫자 배열 을 진수 헥사코드로: {‘0’, ‘1’, ... , ‘9’, 'A', 'B', ..., 'F', 'a', ... , 'f'} 16

변환하여 내부램 를 시작번지로 차례대로 저장한다0x130 .

� 프로그램 작성시 유의점 숫자 의 값은 를 시켜 함수를 사용해서 할 수도 있다 숫자: 0~9 stdlib.h include itoa() .

의 값은 아스키코드는 이고 의 값은 의 값은 이라는 점을 염두에0~9 0x30~0x39 , A~F 0x41~46, a~f 0x61~66

두어야 한다.

� 프로그램 예 :

#include <mega128.h>
#define DBYTE ((unsigned char volatile *) 0)
flash unsigned char arr[ ]= "0123456789ABCDEFabcdef";
unsigned char asc2hex(unsigned char asc){

if ((asc >= '0') && (asc <='9')) return (asc - '0');
else if ((asc >= 'A') && (asc <='F')) return ((asc - 'A')+10);
else if ((asc >= 'a') && (asc <='f')) return ((asc - 'a')+10);
else return(0xff);

}
void main(void){

int j = 0, i=0x0130;
for(;j<=21; j++) DBYTE[i++] = asc2hex(arr[j]);

}

� 실험방법 실험 과 같은 방식으로 수행하라 성공적으로 수행된 경우 내부램 에는 차례대로: 1 . 0x130~13f

값이 에는 값이 저장된다0x00~0x0F 0x140~145 0x0A~0x0F .

3.1.10.3.1.10.3.1.10.3.1.10.3.1.10.3.1.10.3.1.10.3.1.10.3.1.10.3.1.10.3.1.10.3.1.10.실험 숫자의 아스키코드 변환실험 숫자의 아스키코드 변환실험 숫자의 아스키코드 변환실험 숫자의 아스키코드 변환10 :10 :10 :10 :실험 숫자의 아스키코드 변환실험 숫자의 아스키코드 변환실험 숫자의 아스키코드 변환실험 숫자의 아스키코드 변환10 :10 :10 :10 :실험 숫자의 아스키코드 변환실험 숫자의 아스키코드 변환실험 숫자의 아스키코드 변환실험 숫자의 아스키코드 변환10 :10 :10 :10 :

� 예제 한자리를 갖는 진 숫자 배열 를 아스키: 16 {0,1,2,3,4,5,6,7,8,9, 0x0a, 0x0b, 0x0c, 0x0d, 0x0e, 0x0f}

코드로 변환하여 내부램 를 시작번지로 차례대로 저장한다0x130 .

� 프로그램 작성시 유의점 숫자 의 값은 를 시켜 함수를 사용해서 할 수도 있다 숫자: 0~9 stdlib.h include itoa() .

의 값은 아스키코드는 이고 의 값은 의 값은 이라는 점을 염두에0~9 0x30~0x39 , A~F 0x41~46, a~f 0x61~66

두어야 한다.

� 프로그램 예 :

#include <mega128.h>
#define DBYTE ((unsigned char volatile *) 0)
flash unsigned char arr[ ]= {0,1,2,3,4,5,6,7,8,9, 0x0a, 0x0b, 0x0c, 0x0d, 0x0e, 0x0f};
unsigned char hex2asc(unsigned char num){

if(num>=10) return(num+'A'-10);
else return(num+'0');

}
void main(void){

int j = 0, i=0x0130;
for(;j<=15; j++) DBYTE[i++] = hex2asc(arr[j]);

}

� 실험방법 실험 과 같은 방식으로 수행하라 성공적으로 수행된 경우 내부램 에는 차례대로: 1 . 0x130~139

값이 에는 값이 저장된다0x30~0x39 0x13a~13f 0x41~0x46 .
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3.1.11.3.1.11.3.1.11.3.1.11.3.1.11.3.1.11.3.1.11.3.1.11.3.1.11.3.1.11.3.1.11.3.1.11.실험실험실험실험11 :11 :11 :11 :실험실험실험실험11 :11 :11 :11 :실험실험실험실험11 :11 :11 :11 : 지연 루틴지연 루틴지연 루틴지연 루틴지연 루틴지연 루틴지연 루틴지연 루틴지연 루틴지연 루틴지연 루틴지연 루틴

� 예제 타이머를 쓰지 않고 소프트웨어에 의해 적절한 시간지연을 얻는 방법을 익힌다 시간의 지연을: . 100usec

주면서 내부램 에 저장된 값을 증가시키는 프로그램을 작성한다 발진주파수는 라고 가정한다(0x130) .( 16MHz ).

� 프로그램 작성시 유의점 다음과 같이 문을 반복적으로 사용하여 시간지연을 얻는 프로그램을 작성할: while

수 있겠다.

void delay(unsigned char i){
while(i--); }

void main(void){
delay(0x0100);

}

위의 프로그램을 컴파일하고 를 통해 디버그세션에 들어가 메인메뉴의 를AVR Studio 4 [View->Disassembler]

클릭하여 창을 띠우면 문에 해당하는 부분에서 다음과 비슷하게 어셈블리어로 번역되어Disassembler while(i--)

나타난 모습을 확인 할 수 있다.

LDD R30,Y+0 ; Load indirect with displacement, 기계사이클 소요 반복2 ( )
SUBI R30,0x01 ; Subtract immediate, 기계사이클 소요 반복1 ( )
STD Y+0,R30 ; Store indirect with displacement, 기계사이클 소요 반복2 ( )
SUBI R30,0xFF ; Subtract immediate, 기계사이클 소요 반복1 ( )
BRNE PC-0x04 ; Branch if not equal, 기계사이클 소요반복할때 벗어날때1/2 ( 1 2)
ADIW R28,0x01 ; Add immediate to word, 기계사이클 소요2
RET ; Subroutine return, 기계사이클 소요4

위의 루틴에서 값에 대하여 반복 수행하는 데 걸리는 시간을 계산해 기계사이클과 같i (i+1)*(2+1+2+1+1)+7

다 값은 를 갖게 되니 최소지연값은 기계사이클발진주파수 일때 최대지연값. i 0~255 14 ( 16MHz 14/16=0.875usec)

은 기계사이클발진주파수 일때 가 된다 결국 원하는 마이크1799 ( 16MHz 1799/16=112.4375usec) . delaytime_us

로초에 대한 값은 에 의하여 다음처럼 주어진다i (i+1)*(2+1+2+1+1)+7=16*delaytime_us .

i = delaytime_us*16/7 -2

위 식에 따라 를 얻으려면 으로 하면 될 것이다 만약 보다 긴 시간의 지연을 얻으려면100usec i=226 . 112usec

를 여러분 호출하면 될 것이다 위의 루틴으로 정확한 시간지연을 얻기에는 값이 원하는 지연시간에 대하delay() . i

여 정수로 딱 떨어지지도 않아 오차가 생기며 마이컴의 발진주파수에도 좌우되는 등 상황에 따라 시간지연값이

들쭉날쭉해 적절하지 않을 수도 있다 에는 이를 위해 함수가 준비되어 있다. CodeVisionAVR . 헤더파일delay.h

을 시켜 를 사용하여 밀리초나 마이크로초 단위로 비include delay_ms(unsigned int i), delay_us(unsigned int i)

교적 정확하게 시간 지연을 얻을 수 있다 그러나 인터럽트 등에 의해 지연이 발생할 수 있어 아주 정확한 것은.

아니다 아주 정확한 시간 지연은 타이머를 사용하거나 와 같은 를 사용한다. DS1302 RTC IC .

� 프로그램 예1 :

#include <mega128.h>
#include <delay.h>
#define DBYTE ((unsigned char volatile *) 0)
void main(void){

for(;;){ DBYTE[0x0130] += 1; delay_us(100); }
}

� 프로그램 예2 :

#include <mega128.h>
#define DBYTE ((unsigned char volatile *) 0)
void delay(unsigned char i){

while(i--); }
void main(void){

for(;;){ DBYTE[0x0130] += 1; delay(226); }
}
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� 실험방법 실험 과 같은 방식으로 수행하라 시뮬레이션에서 시간 지연은 호스트 의 성능에 좌우된다 시: 1 . PC .

뮬레이션에서의 지연시간이 실제 하드웨어를 구현했을 때의 시간지연과는 다르다는 것을 명심해야 한다 실제 하.

드웨어에 구현하였을 때는 프로그램 예 의 에 의한 시간지연은 마이컴의 발진주파수에 좌우된다2 delay() .

3.2.3.2.3.2.3.2.3.2.3.2.3.2.3.2.3.2.3.2.3.2.3.2. I/O PortI/O PortI/O PortI/O PortI/O PortI/O PortI/O PortI/O PortI/O PortI/O PortI/O PortI/O Port

은 와 외부장치를 연결해주기 위해 양방향성을 갖는 개 의 비트 입출력 포트8051 CPU 6 (PORTA~PORTF) 8 (I/O)

와 개 의 비트 입출력 포트를 갖고 있다 과 달리 개 정도는 구동하기에 충분한 전류1 (PORTG) 5 . 8051 LED 1

를 최대구동전류로 출력하므로 를 포트에 연결할 때 전류흡입형으로 구현할 필요는 없다40mA LED .

3.2.1.3.2.1.3.2.1.3.2.1.3.2.1.3.2.1.3.2.1.3.2.1.3.2.1.3.2.1.3.2.1.3.2.1. 관련 레지스터관련 레지스터관련 레지스터관련 레지스터관련 레지스터관련 레지스터관련 레지스터관련 레지스터관련 레지스터관련 레지스터관련 레지스터관련 레지스터

3.2.1.1.3.2.1.1.3.2.1.1.3.2.1.1. 레지스터레지스터레지스터레지스터DDRxDDRxDDRxDDRx

입출력의 방향설정을 하여 레지스터에 입출력포트에 대응하는 해당 비트에 을 쓰면 출력으로DDRA~DDRG 1 0

을 쓰면 입력으로 설정 된다 초기값은 으로 설정되어 있다 비트별로 만약 포트 의 비트 를 출력으로 설정하. 0 . A 3

려면 로 하면 되 포트 를 전부 출력으로 설정하려면 로 하면 된다DDRA.3 = 1 A DDRA = 0xff .

3.2.1.2.3.2.1.2.3.2.1.2.3.2.1.2. 레지스터레지스터레지스터레지스터PORTxPORTxPORTxPORTx

의 값을 조절하여 출력으로 설정된 경우 레지스터에 해당하는 값을 쓰면 된다 비트별로 설정하DDRx PORTx .

려면 의 형태로 하면 된다 는 은 만약 포트 의 비트 에 을 출력하려면PORTx.n = 1 (x A~G, n 0~7). B 3 1 PORTB.3

로 하면 된다= 1 .

3.2.1.3.3.2.1.3.3.2.1.3.3.2.1.3. 레지스터레지스터레지스터레지스터PINxPINxPINxPINx

입력으로 설정된 경우 레지스터에 해당하는 값을 읽으면 된다 해당 핀의 값을 읽어 들인다 쓰기가 금지PINx . .

되어 있다 비트별로 읽어 들이려면 를 사용 하면 된다 비트별로 만약 포트 의 비트 값을 읽어 들여. PINx.n C 3

라는 비트값에 할당하려면 로 하면 된다led3 led3 = PINC.3 .

3.2.1.4.3.2.1.4.3.2.1.4.3.2.1.4. 레지스터레지스터레지스터레지스터SFIORSFIORSFIORSFIOR

의 비트 를 로 세트하면 풀업 저항을 비활성화SFIOR(Special Function IO Register) 2(PUD: Pull-Up Disable) 1

시킨다.

3.2.2.3.2.2.3.2.2.3.2.2.3.2.2.3.2.2.3.2.2.3.2.2.3.2.2.3.2.2.3.2.2.3.2.2. 구조 및 동작구조 및 동작구조 및 동작구조 및 동작구조 및 동작구조 및 동작구조 및 동작구조 및 동작구조 및 동작구조 및 동작구조 및 동작구조 및 동작

� 기본 구조 그림 에 보여진 것과 같이 양방향성으로 옴의 내부 풀업을 갖는 구조를 갖고 있다: 78 20K~100K .

� 내부풀업저항의 설정 의 비트 를 이용하여 모든 입출력핀의 풀업저항을 비활성화할 수 있다: SFIOR 2 .

의 값을 조절하여 입력으로 설정된 경우에는 해당하는 에 을 쓰면 내부 풀업 저항을 사용할DDRx.n PORTx.n 1

수 있다 내부 풀업 저항을 사용하지 않기 위해서는 에 을 쓰거나 해당 핀을 출력으로 설정하면 된다. PORTx.n 0 .

� 읽어 들이는 동작 레지스터 비트를 읽을 때 안정을 위하여 최대 클럭에서 클럭의 지연이 존재: PINx.n 1.5 0.5

하므로 이를 감안해서 읽어야 한다 결국 비트에 출력한 값을 다시 읽어 들일 때는 클럭이 소요. PORTx.n NOP(1

됨 와 같은 명령을 삽입하는 것이 좋다) .

� 슬립 모드시 핀의 동작 슬립모드가 동작하면 포트의 핀 입력은 접지로 클램프되어 동작이 멈춘다 이때 사용: .

하지 않는 핀은 외부에서 풀업 또는 풀다운으로 확실한 논리 상태를 입력하는 것이 전력소비를 감소시킨다 손쉬.

운 방법으로 내부의 풀업을 이용하는 것이다.

� 포트 핀 내부 풀업 저항이 있는 비트 양방향 입출력 단자 외부메모리를 둘 경우에는A (PA7~PA0: 44-51) : 8 .

주소버스 와 데이터버스 로 사용(A7-A0) (D7-D0) .

� 포트 핀 내부 풀업 저항이 있는 비트 양방향 입출력 단자 용 단자 혹은 단자B (PB7~PB0: 10-17) : 8 . SPI PWM
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로도 사용된다표 참조( 2 ).

� 포트 핀 내부 풀업 저항이 있는 비트 양방향 입출력 단자 외부메모리를 둘 경우에는C (PC7~PC0: 35-42) : 8 .

주소버스 로 사용된다(A15-A8) .

� 포트 핀 내부 풀업 저항이 있는 비트 양방향 입출력 단자 타이머용 단자 혹은 외부인D (PD7~PD0: 25-32) : 8 .

터럽트용 단자로도 사용된다표 참조( 3 ).

� 포트 핀 내부 풀업 저항이 있는 비트 양방향 입출력 단자 타이머용 단자 외부인터럽트E (PE7~PE0: 2-9) : 8 . , ,

아날로그 비교기 용 단자로도 사용된다표 참조, USART ( 4 ).

� 포트 핀 내부 풀업 저항이 있는 비트 양방향 입출력 단자 변환기 혹은 인터F (PF7~PF0: 54-61) : 5 . AD JTAG

페이스용 단자로도 사용된다표 참조( 5 ).

� 포트 핀 내부 풀업 저항이 있는 비트 양방향 입출력 단자 외부 메모리G (PG4~PE0: 19, 18, 43, 34, 33) : 8 .

접속을 위한 스트로브 신호용 타이머용 발진기 단자로도 사용된다표 참조, RTC(Real Time Counter) ( 5 ).

그림 78 포트의 기본 구조출처. I/O ( :ATMEL)

3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3. 단순 출력 연습단순 출력 연습단순 출력 연습단순 출력 연습단순 출력 연습단순 출력 연습단순 출력 연습단순 출력 연습단순 출력 연습단순 출력 연습단순 출력 연습단순 출력 연습

3.3.1.3.3.1.3.3.1.3.3.1.3.3.1.3.3.1.3.3.1.3.3.1.3.3.1.3.3.1.3.3.1.3.3.1. 실험 점멸실험 점멸실험 점멸실험 점멸12 : LED 112 : LED 112 : LED 112 : LED 1실험 점멸실험 점멸실험 점멸실험 점멸12 : LED 112 : LED 112 : LED 112 : LED 1실험 점멸실험 점멸실험 점멸실험 점멸12 : LED 112 : LED 112 : LED 112 : LED 1
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� 예제 포트 에 연결된 개의 를 초 간격으로 좌로 이동하며 한 개씩 켠다 즉 처음 에 연결: C 8 LED 0.4 . PORTC.0

된 만 켜고 초 후에 에 연결된 만 켜고 이런 식으로 반복적으로 개의 를 순차적으로LED 0.4 PORTC.1 LED 8 LED

켠다.

� 프로그램 작성시 유의점 초의 시간지연은 실험 의 루틴을 사용한다 그림 의 회로에서 을 출력: 0.4 10 delay . 79 0

해야 가 켜지고 을 출력하면 꺼진다LED 1 . 를 시켜야 을 사용할 수 있다mega128.h include PORTC.n . delay_ms()

를 사용하려면 를 시켜야 한다delay.h include .

� 회로도 그림 의 시스템을 구성한다: 79 . 는 화합물 반도체의 접합에 빛이 투과하도록 형층을 매우 얇LED PN P

게 만든 소자로 형애노드양극에 전위 형캐소드음극에 전위를 가하면 즉 순방향을 가하면 전류가P ( : ) (+) N ( : ) (-)

흐르면서 전계발광현상에 의해 발광한다 대략 와 정도의 직류전압 전류에서 동작한다 기본적으로. 2 V 20 mA .

전압구동소자가 아니라 전류구동소자이며 발광하는 광의 세기는 전류에 비례하며 각종 표시장치에 응용되는 소

자이다 의 단자중 긴 것이 애노드양극이다 실험할 때는 를 닫고 한다. LED ( ) . LEDSW .

그림 79 기본 입출력 실험을 위한 회로도.

� 프로그램 예 :

#include <mega128.h>
void delay(unsigned char i){ 시간 지연 루틴 약 시간지연 얻을 수 있다// 0.875~112usec

while(i--); } 은 대략 의 시간지연을 얻을 수 있다// delay(226) 0.1msec .
void delayms(unsigned int i){ 시간 지연을 얻을 수 있다// i msec .

unsigned int j,k;
for(j=0;j<i;j++) for(k=0;k<10;k++) delay(226); }

void main(void){
unsigned char led=0xfe;
DDRC = 0xff;

for(;;){
비트 를 켜지 않았으면 비트씩 좌로 시프트하고 빈자리에 을if (led != 0x7f) led = (led << 1 ) | 0x01; /* 7 1 1 */

else led = 0xfe; 비트 을 켰으면 다시 처음으로 와서 비트 를 켠다/* 7 0 . */
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delayms(400); 초 시간 지연 시뮬레이션 할 때는 제거하고 해도 됨/* 0.4 , */
PORTC = led; }

}

� 실험방법 의 에디터를 통해 실행파일을 만든 후 디버그세션에 들어간 후 메: CodeVisionAVR AVR Studion4①

인메뉴의 를 실행하여 라는 이름의 창을 생성하고 창에서 을 선택한다 메인메[View->Memory] Memory [Data] .

뉴의 를 실행하여 라는 이름의 창을 생성하고 창에서 을 선택한다 또한[View->Memory1] Memory1 [Program] .

를 실행하여 라는 이름의 창을 생성한다 디버그세션에서 메인메뉴 의 하[View->Register] Register . [Debug]②

위 메뉴인 등을 적절히 활용하면서[Step Into], [Auto Step], [Run to Cusor] Memory, Register, I/O View

창을 통해 내부램과 레지스터의 값의 변화를 확인하라 시뮬레이션할 때 는 시간을 많이 걸리. delay(), delayms()

게 하므로 제거하고 해도 된다 시뮬레이션이 성공적이었으면 실행파일을 만들고 그림 의 인터페이스회로와. 51③

그림 의 을 연결하고 의 전원을 넣은 상태에서 절에 나온 방법을 참조하여 다운로드하라79 ISP CON 79 2.5.5 . ④

시스템이 성공적으로 동작하는지 확인하라.

� 과제 초마다 우로 이동하며 점멸동작하도록 해보라 가 진 가산형태로 초마다 점멸동작하: 0.3 . LED 2 0.4① ②

도록 해보라.

3.3.2.3.3.2.3.3.2.3.3.2.3.3.2.3.3.2.3.3.2.3.3.2.3.3.2.3.3.2.3.3.2.3.3.2. 실험 점멸실험 점멸실험 점멸실험 점멸13 : LED 213 : LED 213 : LED 213 : LED 2실험 점멸실험 점멸실험 점멸실험 점멸13 : LED 213 : LED 213 : LED 213 : LED 2실험 점멸실험 점멸실험 점멸실험 점멸13 : LED 213 : LED 213 : LED 213 : LED 2

� 예제 포트 에 연결된 개의 를 초 간격으로 좌로 이동하며 한 개씩 켜고 해당하는: C 8 LED 0.04 PORTC.7 LED

까지 켰으면 우로 이동하며 한 개씩 켠다 이것을 반복적으로 수행하여 점멸이 좌우로 흔들리도록 한다. .

� 프로그램 작성시 유의점 그림 의 회로에서 을 출력해야 가 켜지고 을 출력하면 꺼진다: 79 0 LED 1 .

� 회로도 그림 의 시스템을 사용한다 실험할 때는 를 닫고 한다: 79 . LEDSW .

� 프로그램 예 :

#include <mega128.h>
#include <delay.h> 를 이용할 것이다// delay_ms(), delay_us() .
void main(void){
unsigned char led=0xfe, i;
DDRC = 0xff;

for(;;){
비트 를 켜지 않았으면 비트씩 좌로 시프트하고 빈자리에 을for(i=0;i<=6;i++) { led = (led << 1 ) | 0x01; /* 7 1 1 */

delay_ms(40); 시뮬레이션 할 때는 제거하고 해도 됨//
PORTC = led; }

비트 을 켰으면 비트씩 우로 시프트하고 빈자리에 을for(i=0;i<=6;i++) { led = (led >> 1 ) | 0x80; /* 7 1 1 */
delay_ms(40); 시뮬레이션 할 때는 제거하고 해도 됨//
PORTC = led; } }

}

� 실험방법 실험 을 참조해서 하라 시뮬레이션할 때 는 시간을 많이 걸리게 하므로 제거하고 해: 11 . delay_ms()

도 된다.

� 과제 초 간격 이외의 초나 초등 다양한 시간간격으로 똑같은 동작을 구현해보라: 0.04 0.01 0.1 .

3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3.3. 실험 점멸실험 점멸실험 점멸실험 점멸14 : LED 314 : LED 314 : LED 314 : LED 3실험 점멸실험 점멸실험 점멸실험 점멸14 : LED 314 : LED 314 : LED 314 : LED 3실험 점멸실험 점멸실험 점멸실험 점멸14 : LED 314 : LED 314 : LED 314 : LED 3

� 예제 포트에 연결된 개의 를 롬 데이터에 따라 점등패턴과 지속시간을 결정하여 점등한다 롬: PORTC 8 LED .

데이터를 끝까지 다 읽어 점등했으면 다시 처음의 데이터에 따라 점등한다 이를 무한히 반복한다. .

� 프로그램 작성시 유의점 지속시간은 롬데이터에 주어진 값에 을 곱한 값으로 하며 롬데이터의 끝까지: 100

수행한 경우 다시 처음의 데이터를 읽어 반복 수행한다.

� 회로도 그림 의 시스템을 사용한다 실험할 때는 를 닫고 한다: 79 . LEDSW .

� 프로그램 예 :
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#include <mega128.h>
void delay(unsigned char i){ 시간 지연 루틴 약 시간지연 얻을 수 있다// 0.875~112usec

while(i--); } 은 의 시간지연을 얻을 수 있다// delay(226) 0.1msec .
void delayms(unsigned int i){ 시간 지연을 얻을 수 있다// i msec .

unsigned int j,k;
for(j=0;j<i;j++) for(k=0;k<10;k++) delay(226); }

flash unsigned char ledp[ ] = { 0xfe, 0xef, 0x44, 0x11, 0x23, 0x34, 0x35, 0x67};
flash unsigned char ledt[ ] = { 0x22, 0x33, 0x44, 0x45, 0x56, 0x66, 0x78, 0x66};
void main(void){
unsigned char i;

DDRC = 0xff;
for(;;){

for(i=0;i<=8;i++){
PORTC = ledp[i];
delayms((unsigned int)(ledt[i]*100));

}
}

}

� 과제 다양한 시간간격과 패턴으로 점멸하는 동작을 구현해보라: .

3.3.4.3.3.4.3.3.4.3.3.4.3.3.4.3.3.4.3.3.4.3.3.4.3.3.4.3.3.4.3.3.4.3.3.4. 실험 점멸실험 점멸실험 점멸실험 점멸15 : LED 415 : LED 415 : LED 415 : LED 4실험 점멸실험 점멸실험 점멸실험 점멸15 : LED 415 : LED 415 : LED 415 : LED 4실험 점멸실험 점멸실험 점멸실험 점멸15 : LED 415 : LED 415 : LED 415 : LED 4

� 예제 포트에 연결된 개의 를 에 있는 함수를 이용하여 패턴과 지속시간을 결정하여 점: C 8 LED stdlib.h rand()

등한다.

� 프로그램 작성시 유의점 를 사용하여려면 를 프로그램에 포함시켜야 한다 그리고: rand() #include <stdlib.h> .

는 까지의 숫자를 만들어낸다rand() 0~32767 .

� 회로도 그림 의 시스템을 사용한다 실험할 때는 를 닫고 한다: 79 . LEDSW .

� 프로그램 예 :

#include <mega128.h>
#include <stdlib.h> 를 이용할 것이다// rand() .
void delay(unsigned char i){ 시간 지연 루틴 약 시간지연 얻을 수 있다// 0.875~112usec

while(i--); } 은 의 시간지연을 얻을 수 있다// delay(226) 0.1msec .
void delayms(unsigned int i){ 시간 지연을 얻을 수 있다// i msec .

unsigned int j,k;
for(j=0;j<i;j++) for(k=0;k<10;k++) delay(226); }

void main(void){
DDRC = 0xff;
for(;;){ PORTC = (char)(rand() % 0x80);

delayms((unsigned int)(2*rand())); }
}

� 과제 를 하여 로 시간지연하는 프로그램으로 수정해보라: delay.h include delay_ms(), delay_us() .

3.4.3.4.3.4.3.4.3.4.3.4.3.4.3.4.3.4.3.4.3.4.3.4. 단순 입출력 연습단순 입출력 연습단순 입출력 연습단순 입출력 연습단순 입출력 연습단순 입출력 연습단순 입출력 연습단순 입출력 연습단순 입출력 연습단순 입출력 연습단순 입출력 연습단순 입출력 연습

3.4.1.3.4.1.3.4.1.3.4.1.3.4.1.3.4.1.3.4.1.3.4.1.3.4.1.3.4.1.3.4.1.3.4.1. 실험 키 누름수 세기실험 키 누름수 세기실험 키 누름수 세기실험 키 누름수 세기16 :16 :16 :16 :실험 키 누름수 세기실험 키 누름수 세기실험 키 누름수 세기실험 키 누름수 세기16 :16 :16 :16 :실험 키 누름수 세기실험 키 누름수 세기실험 키 누름수 세기실험 키 누름수 세기16 :16 :16 :16 :

� 예제 에 연결된 누름키가 눌린 수를 세어 포트에 연결된 개의 로 표시한다: PD0 C 8 LED .

� 회로도 그림 의 을 그림 의 에 연결하고 실험할 때는 를 닫고 한다 또한 그림: 80 SW_CON 79 D_CON LEDSW .

의 을 누르면서 실험한다80 SW1 .

� 프로그램 작성시 유의점 기계식 키를 누르면 탄성에 의해키를 누르면 이고 안 누른 상태를 이라 가정했: ( 0 1

을 때 상태에 안정적으로 도달하기 전에 과 을 여러번 반복하는 바운스 또는) 0 0 1 (Bounce) 채터링 이(Chattering)
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일어난다 바운스현상은 수십 동안 일어나 사람은 단지 번 누른 것처럼 느끼지만 마이컴은 여러번 눌린. msec 1

것처럼 오인하게된다 키를 눌렀다 뗄 때도 마찬가지로 바운스 현상이 일어난다 키에 개의 게이트를 사. . 2 NAND

용하여 하드웨어적으로 바운스현상을 줄일 수도 있지만 소프트웨어에 의해 할 수 있다 여러 가지 소프트웨어에.

의한 바운스 처리법이 있지만 본 실험에서는 키가 눌리지 않은 상태 레벨에서 시작하여 키가 눌려짐 레벨을(1 ) (0 )

검출하고 적절한 시간지연 후에보통 또 다시 눌려짐 레벨을 검출하는 즉 두 번 확인하는 방식( 20-50 msec) (0 )

을 택한다. 그림 의 회로에서 풀업 저항 옴 대신 무한대의 저항 즉 풀업 저항 옴을 없애고 개방하여80 10K 10K

입력장치로 사용해도 된다 이것은 포트들이 입력으로 사용될 때 내부 풀업 저항을 사용할 수 있기 때문이다. I/O .

이런 경우 해당 포트 핀을 입력으로 설정하기 위해 명령에 부가적으로 명령으로 해당 포DDRx.n=0 PORTx.n=1

트 핀에 을 써 넣어야 내부 풀업 저항을 사용할 수 있다1 .

그림 80 단순 키보드 스캔을 위한 회로도.

� 프로그램 예 :

#include <mega128.h>
#include <delay.h> 를 이용할 것이다// delay_ms(), delay_us() .
void main(void){
unsigned char key_num = 0;

포트 를 출력으로DDRC = 0xff; // C
포트 를 입력으로 디폴트 입력으로 설정되어 있으므로 필요하지는 않음DDRD = 0x00; // D

for(;;) {

while( PIND.0 == 1 ); 눌릴 때 까지 대기 눌리면 아래로/* (PIND.0 ==0) */
delay_ms(40); 약 시간지연하고 다시 읽기/* 40msec */
if( PIND.0 == 0){ 후에도 눌려있으면 유효한 키입력이므로 아래로/* 40msec */
key_num += 1;
PORTC = ~key_num; } 일 때 꺼지고 일때 켜지므로 반전시켜 출력시킨다/* 1 0 . */
while(PIND.0 == 0); } 키 눌림이 해제될 때까지 대기/* */

}

� 실험방법 의 에디터를 통해 실행파일을 만든 후 디버그세션에 들어간 후 메: CodeVisionAVR AVR Studion4①

인메뉴의 를 실행하여 라는 이름의 창을 생성하고 창에서 을 선택한다 메인메[View->Memory] Memory [Data] .

뉴의 를 실행하여 라는 이름의 창을 생성하고 창에서 을 선택한다 또한[View->Memory1] Memory1 [Program] .

를 실행하여 라는 이름의 창을 생성한다 디버그세션에서 메인메뉴 의 하[View->Register] Register . [Debug]②

위 메뉴인 등을 적절히 활용하면서[Step Into], [Auto Step], [Run to Cusor] Memory, Register, I/O View

창을 통해 내부램과 레지스터의 값의 변화를 확인하라 시뮬레이션할 때 는 시간을 많이 걸리게 하므. delay_ms()

로 제거하고 해도 된다 를 누르고 창의 레지스터 비트 의 값을 변화시켜가며. [Auto Step] IO View PIND 0 PORTC

의 변화를 관찰하라 을 변화시킬 때마다 의 값이 증가해야 한다 시뮬레이션이 성공적이었으면. PIND.0 PORTC . ③

실행파일을 소프트웨어와 인터페이스회로를 사용하여 그림 의 시스템에 다운로드하라 시스템이 성공적ISP 79 . ④

으로 동작하는지 확인하라.
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� 과제 시간 지연을 다르게 하여 수행해보라수 단위로 작게 수백 단위로 크게: ( msec msec ).

3.4.2.3.4.2.3.4.2.3.4.2.3.4.2.3.4.2.3.4.2.3.4.2.3.4.2.3.4.2.3.4.2.3.4.2. 실험 파일럿 램프실험 파일럿 램프실험 파일럿 램프실험 파일럿 램프17 : 117 : 117 : 117 : 1실험 파일럿 램프실험 파일럿 램프실험 파일럿 램프실험 파일럿 램프17 : 117 : 117 : 117 : 1실험 파일럿 램프실험 파일럿 램프실험 파일럿 램프실험 파일럿 램프17 : 117 : 117 : 117 : 1

� 예제 딥스위치가 연결된 로부터 입력을 받아 그에 대응하는 에 연결된 를 켠다: PORTD.0~3 PORTD.4~7 LED .

� 프로그램 작성시 유의점 가 켜지는 것이 상태이고 꺼지는 것이 상태이다 그러므로 그림 의 회로에: LED 0 1 . 81

서 딥스위치를 조작했을 때 그에 연결된 가 켜졌다면 입력으로 상태가 들어간 것이다LED 0 .

� 회로도 그림 에 주어진 회로의 을 그림 의 을 연결하고 그림 의 딥스위치의 번을 개: 81 L1 79 D_CON , 81 5~8

방한 상태로 한다 그러면 을 통해 를 점멸할 수 있는 상태가 된다 그림 의 딥스위치의. PORTD.0~3 LED . 81 1~4

번을 열고 닫아 실험하면 된다.

� 프로그램 예 :

#include <mega128.h>
void main(void){
unsigned char ledp;

DDRD = 0xf0; 을 출력으로 나머지를 입력으로 설정// PORTD.4~7
for(;;) {

ledp = PIND;
비트 에 연결된 에 출력하기 위해 번 시프트한다ledp = (ledp << 4) & 0xf0 ; // 4~7 LED 4 .

PORTD = ~ledp; 반전시켜 출력하라// .
}

}

� 실험방법 실험 을 참조해서 수행하라: 16 .

그림 81 딥스위치를 이용한 간단한 입력회로.

3.4.3.3.4.3.3.4.3.3.4.3.3.4.3.3.4.3.3.4.3.3.4.3.3.4.3.3.4.3.3.4.3.3.4.3. 실험 파일럿 램프실험 파일럿 램프실험 파일럿 램프실험 파일럿 램프18 : 218 : 218 : 218 : 2실험 파일럿 램프실험 파일럿 램프실험 파일럿 램프실험 파일럿 램프18 : 218 : 218 : 218 : 2실험 파일럿 램프실험 파일럿 램프실험 파일럿 램프실험 파일럿 램프18 : 218 : 218 : 218 : 2

� 예제 딥스위치가 연결된 포트 로부터 입력을 받아 그에 대응하는 포트 에 연결된 를 켠다: D A LED .

� 회로도 그림 에 주어진 회로의 을 그림 의 을 연결한다 그림 의 를 닫는다 그림: 81 L1 79 D_CON . 79 LEDSW .

의 딥스위치의 번을 열고 닫아 실험하면 된다81 1~8 .

� 프로그램 예 :

#include <mega128.h>
void main(void){

DDRD = 0x00; 를 입력으로 설정// PORTD
DDRA = 0xff; 포트 를 출력으로 설정// A
for(;;) {

PORTA = ~PIND; 반전시켜 출력하라// .
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}
}

3.4.4.3.4.4.3.4.4.3.4.4.3.4.4.3.4.4.3.4.4.3.4.4.3.4.4.3.4.4.3.4.4.3.4.4. 실험 입출력함수 구현실험 입출력함수 구현실험 입출력함수 구현실험 입출력함수 구현19 :19 :19 :19 :실험 입출력함수 구현실험 입출력함수 구현실험 입출력함수 구현실험 입출력함수 구현19 :19 :19 :19 :실험 입출력함수 구현실험 입출력함수 구현실험 입출력함수 구현실험 입출력함수 구현19 :19 :19 :19 :

� 예제 딥스위치가 연결된 포트 비트 로부터 입력을 받아 미리 롬에 기록된 데이타 값에 따라 포트: D 0~2 D 3~7

에 연결된 를 켜고 끈다 본 실험에서 구현된 입출력 관계는 다음과 같다LED . .

입출력 관계: 000->01101, 001->10010, 010->00010, 011->10001,

100->11100, 101->10101, 110->00100, 111->10100

� 회로도 그림 에 주어진 회로의 을 그림 의 을 연결하고 그림 의 딥스위치의 번을 개: 81 L1 79 D_CON , 81 4~8

방한 상태로 한다 그러면 를 통해 를 점멸할 수 있는 상태가 된다 그림 의 딥스위치의. PORTD.3~7 LED . 81 1~3

번을 열고 닫아 실험하면 된다.

� 프로그램 작성시 유의점 가 켜지는 것이 상태이고 꺼지는 것이 상태이다 입력이 일 때 을: LED 0 1 . 000 01101

출력하는 것으로 했는데 롬에 이 패턴을 기록해 둘 때는 여기에서 는 또는 이 되어야 한다 본01101xxx( x 0 1) .

실험에서는 으로 하였다 즉 의 패턴은 로 기록되고 의 패턴은 식으로 한다x=0 . 01101 0x68 10010 0x90 .

� 프로그램 예 :

#include <mega128.h>
unsigned char arr[ ]={ 0x68, 0x90, 0x10, 0x88, 0xE0, 0xA8, 0x20, 0xA0};
void main( void ) {
unsigned char ledp;

비트 는 입력 나머지는 출력DDRD = 0b11111000; // 0~2 ,
for(;;) {
ledp = PIND & 0b00000111 ; 하위 비트만 마스킹/* 3 */
PORTD = arr[ledp] ; 반전시켜 출력한다// .
}

}

� 예제 다른 형태의 입출력 함수를 구현해 보아라: .

3.4.5.3.4.5.3.4.5.3.4.5.3.4.5.3.4.5.3.4.5.3.4.5.3.4.5.3.4.5.3.4.5.3.4.5. 실험 입력값에 따른 점멸속도 조절실험 입력값에 따른 점멸속도 조절실험 입력값에 따른 점멸속도 조절실험 입력값에 따른 점멸속도 조절20 : LED20 : LED20 : LED20 : LED실험 입력값에 따른 점멸속도 조절실험 입력값에 따른 점멸속도 조절실험 입력값에 따른 점멸속도 조절실험 입력값에 따른 점멸속도 조절20 : LED20 : LED20 : LED20 : LED실험 입력값에 따른 점멸속도 조절실험 입력값에 따른 점멸속도 조절실험 입력값에 따른 점멸속도 조절실험 입력값에 따른 점멸속도 조절20 : LED20 : LED20 : LED20 : LED

� 예제 딥스위치가 연결된 포트 로부터 입력을 받아 포트 에 연결된 의 점멸속도를 조절한다: D C LED .

� 회로도 그림 에 주어진 회로의 에 그림 의 을 연결한다 그림 의 딥스위치를 열고 닫아 그: 81 L1 79 D_CON . 81

값을 입력으로 삼아 실험하면 된다 실험할 때는 그림 의 를 닫고 한다. 79 LEDSW .

� 프로그램 예 :

#include <mega128.h>
#include <delay.h>
void main(void){
unsigned char led=0xfe;
unsigned int dt;

DDRC = 0xff; 를 출력으로 설정//Port C .
DDRD = 0x00; 포트 를 입력으로 설정// D
for(;;){
for(dt=0; dt < (int) 256*PIND ;dt++) delay_ms(1); 시간지연 값을 입력받아 시간 지연한다// .

비트 를 켜지 않았으면 비트씩 좌로 시프트하고 빈자리에 을if (led != 0x7f) led = (led << 1 ) | 0x01; // 7 1 1
else led = 0xfe; 비트 을 켰으면 다시 처음으로 와서 비트 를 켠다/* 7 0 . */
PORTC = led; }

}
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4.4.4.4.4.4.4.4.4.4.4.4. 인터럽트와 타이머 실험인터럽트와 타이머 실험인터럽트와 타이머 실험인터럽트와 타이머 실험인터럽트와 타이머 실험인터럽트와 타이머 실험인터럽트와 타이머 실험인터럽트와 타이머 실험인터럽트와 타이머 실험인터럽트와 타이머 실험인터럽트와 타이머 실험인터럽트와 타이머 실험

4.1.4.1.4.1.4.1.4.1.4.1.4.1.4.1.4.1.4.1.4.1.4.1. 외부외부외부외부외부외부외부외부외부외부외부외부 인터럽트 실험인터럽트 실험인터럽트 실험인터럽트 실험인터럽트 실험인터럽트 실험인터럽트 실험인터럽트 실험인터럽트 실험인터럽트 실험인터럽트 실험인터럽트 실험

4.1.1.4.1.1.4.1.1.4.1.1.4.1.1.4.1.1.4.1.1.4.1.1.4.1.1.4.1.1.4.1.1.4.1.1. 인터럽트의 개념과 종류인터럽트의 개념과 종류인터럽트의 개념과 종류인터럽트의 개념과 종류인터럽트의 개념과 종류인터럽트의 개념과 종류인터럽트의 개념과 종류인터럽트의 개념과 종류인터럽트의 개념과 종류인터럽트의 개념과 종류인터럽트의 개념과 종류인터럽트의 개념과 종류

� 인터럽트는 어떤 조건이나 사건의 발생으로 정상적인 프로그램을 일시적으로 중지시키고 보다 시급한 작업을

먼저 수행하고 다시 원래로 복귀하여 실행순서를 변경하도록 만드는 것을 말한다 인터럽트 요청에 따라 수행하.

는 프로그램을 인터럽트 서비스루틴 또는 인터럽트 핸들러라 한다 인터럽트는 마이컴시스템을 구현하는데 커다.

란 역할을 차지하며 발생시기를 예측하기 힘든 사건에 마이컴이 가장 빠르게 대응할 수 있는 방법이며 비교적

저속으로 동작하는 주변장치의 요청에 고속으로 동작하는 마이컴 사이에 효율적으로 일을 수행하는 중요한 수단

이 된다.

� 인터럽트의 요소 발생원 누가 요청했는가 우선순위 개 이상의 요청시 누구를 먼저 서비스 할까3 : : ? : 2 ?① ②

인터럽트벡터 서비스루틴의 시작번지는 어디인가: ?③

� 인터럽트의 종류 발생원인이 존재하는 곳에 따라 내부와 외부로 나뉘고 차단가능성에 따라 차단가능 인터럽: ,

트와 차단 불가능 인터럽트로 나뉘고 인터럽트발생 원인을 확인하는 방법에 따라 조사형과 벡터형으로 나뉜다, .

� 내부 인터럽트는 영으로 나누는 등 금지된 연산이나 금지된 메모리로의 접근 시도 등에 따라 마이컴 내부에서

발생하는 인터럽트며 외부 인터럽트는 입출력장치의 작업종료 타이머의 오버플로 외부장치의 통신요청 등 외부, ,

장치에 의해 발생되는 인터럽트로 일반적으로 인터럽트하면 외부인터럽트를 지칭한다 은 처. ATmega128 8051

럼 내부 인터럽트에 해당하는 것이 없다.

� 프로그램에 의해 인터럽트서비스 요청을 차단하지 못하는 것을 차단불가능 인터럽트라하며 전원이상 등의 매

우 중요한 돌발 사태에 대비하기 위해 대부분의 마이크로프로세서에서 사용되지만 는 처럼 차ATmega128 8051

단불가능 인터럽트를 사용하지 않는다 차단가능한 인터럽트를 차단하는 방법은 특정레지스터값의 설정에 따라.

한다.

� 인터럽트를 요청한 장치가 특정한 상태비트를 세트해 표시해 놓으면 이를 마이컴이 소프트웨어적으로 조사하

고 찾는 순서에 따라 우선순위가 정해지는 방식을 조사형 인터럽트라 하고 인터럽트 발생원인에 따라 미리 지정

된 서비스루틴의 시작번지인터럽트 벡터에서 처리하는 방식을 벡터형이라 하는데 벡터형이 인터럽트 발생원인( )

을 찾고 서비스루틴을 처리하는 시간이 빠른 장점이 있다 은 벡터형을 사용한다. ATmega128 .

� 의 인터럽트는 차단가능한 외부인터럽트에 해당하며 리셋을 포함하여 총 개의 인터럽트 벡터를ATmega128 35

가지고 있다 리셋을 제외한 개의 인터럽트는 외부 핀을 통하여 요청되는 외부인터럽트 개 타이머 관련. 34 8 , 0 2

개 타이머 관련 개 타이머 관련 개 타이머 관련 개 관련 개 관련 개 기타 개, 1 5 , 2 2 , 3 5 , USART0 3 , USART1 3 , 6

로 분류될 수 있다.

4.1.2.4.1.2.4.1.2.4.1.2.4.1.2.4.1.2.4.1.2.4.1.2.4.1.2.4.1.2.4.1.2.4.1.2. 의 인터럽트 처리과정의 인터럽트 처리과정의 인터럽트 처리과정의 인터럽트 처리과정ATmega128ATmega128ATmega128ATmega128의 인터럽트 처리과정의 인터럽트 처리과정의 인터럽트 처리과정의 인터럽트 처리과정ATmega128ATmega128ATmega128ATmega128의 인터럽트 처리과정의 인터럽트 처리과정의 인터럽트 처리과정의 인터럽트 처리과정ATmega128ATmega128ATmega128ATmega128

� 단계단계단계단계1111 매 사이클의 인터럽트 요청이 있는지 확인하고 해당 인터럽트 플랙에 기록한다: .

� 단계단계단계단계2222 어느 인터럽트 요청이 있는지 인터럽트 플랙을 조사하고 우선순위와 허용여부를 결정한다: .

� 단계단계단계단계3333 인터럽트 벡터주소를 찾아가기 위한 명령이 수행되며 다른 인터럽트 발생을 방지하기 위해: CALL

의 비트를 클리어시키고 복귀주소 값을 스택에 저장한다SREG I (PC) .

� 단계단계단계단계4444 인터럽트벡터에 따라 인터럽트 서비스 루틴으로 점프하여 실행한다: .

� 단계단계단계단계5555 를 만나면 스택에 저장된 를 복구하여 원래 프로그램으로 복귀한다: RETI PC .

4.1.3.4.1.3.4.1.3.4.1.3.4.1.3.4.1.3.4.1.3.4.1.3.4.1.3.4.1.3.4.1.3.4.1.3. 인터럽트 처리 시간인터럽트 처리 시간인터럽트 처리 시간인터럽트 처리 시간인터럽트 처리 시간인터럽트 처리 시간인터럽트 처리 시간인터럽트 처리 시간인터럽트 처리 시간인터럽트 처리 시간인터럽트 처리 시간인터럽트 처리 시간
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� 응답시간 인터럽트를 허용하는 명령이 실행되었더라도 최소한 그 다음에 있는 개의 명령이 실행되고: SEI 1

인터럽트가 수행된다 인터럽트 서비스를 끝내고 원래의 프로그램으로 복귀한 경우에도 이미 대기 상태에 있던.

다른 인터럽트를 수행하기 전에 최소한 개의 명령이 실행된다 또한 인터럽트 벡터는 클럭이 요구되는1 . 3 JMP

명령으로 이루어져있어 개의 명령이 최소 클럭이므로 인터럽트 요청 후 서비스 시작하기까지 최소 클럭이 걸1 1 4

린다 이 동안에 다른 인터럽트 발생을 방지하기 위해 의 비트를 클리어시키고 를 스택에 저장하고 인. SREG I PC

터럽트 벡터주소를 찾아가서 거기에 있는 값에 따라 인터럽트 서비스 루틴으로 점프한다 만약 클럭 이상의 명. 2

령을 수행하고 있었으면 응답시간은 증가한다 슬립모드에 있었을 때는 기동시간이 포함되어 응답시간이 증가된.

다.

� 복귀시간 는 클럭이 소요된다 즉 인터럽트 서비스를 마치고 원래 프로그램으로 복귀하는 데에는 클: RETI 4 . 4

럭이 소요된다 이 시간동안 의 값이 스택에서 꺼내지고 스택 포인터가 만큼 증가되며 의 비트가 로. PC 2 SREG I 1

세트된다.

4.1.4.4.1.4.4.1.4.4.1.4.4.1.4.4.1.4.4.1.4.4.1.4.4.1.4.4.1.4.4.1.4.4.1.4. 인터럽트 제어인터럽트 제어인터럽트 제어인터럽트 제어인터럽트 제어인터럽트 제어인터럽트 제어인터럽트 제어인터럽트 제어인터럽트 제어인터럽트 제어인터럽트 제어

4.1.4.1.4.1.4.1.4.1.4.1.4.1.4.1. 벡터 배치벡터 배치벡터 배치벡터 배치

의 비트값과 레지스터의 비트값으로 벡터의 배치를 그림 처럼Fuse High Byte BOOTRST MCUCR IVSEL 82

바꿀 수 있다 그림 에서 는 그림 에 주어졌다. 82 Boot Reset Address 12 .

그림 82 인터럽트 벡터의 배치출처. ( :ATMEL)

그림 은 의 비트값이 로 레지스터의 은 으로 즉 디폴트로 설정83 Fuse High Byte BOOTRST 1 MCUCR IVSEL 0

된 경우의 인터럽트 벡터를 보여준다.

4.1.4.2.4.1.4.2.4.1.4.2.4.1.4.2. 레지스터레지스터레지스터레지스터MCUCRMCUCRMCUCRMCUCR

� 비트 그림 처럼 인터럽트 벡터의 배치를 변경할 수 있다 이 변1(IVSEL:Interrupt Vector SELect) : 82 . IVSEL

경되 인터럽트 벡터의 예기치 않게 이동되는 것을 방지하기 위해 의 변경은 다음의 절차에 따른다IVSEL . ①

비트에 을 쓴다 사이클 이내에 으로 설정하고 에 원하는 비트값으로 설정한다IVCE 1 . 4 IVCE =0 IVSEL .②

� 비트 로 세트하면 을 변경할 수 있다 비트는0(IVCE:Interrupt Vector Change Enable) : 1 IVSEL . IVCE IVSEL

비트를 변경하고 난 이후에 클럭이 지나면 하드웨어의 의해서 으로 자동적으로 클리어된다4 0 .

4.1.4.3.4.1.4.3.4.1.4.3.4.1.4.3. 허용과 우선순위허용과 우선순위허용과 우선순위허용과 우선순위

� 전체적인 허용은 상태레지스터 의 비트 를 로 하여 설정한다(SREG) 7(I) 1 .

� 개별적인 허용은 여러가지 인터럽트 마스크 레지스터를 통하여 개별적으로 허용여부를 제어한다.

� 은 처럼 인터럽트의 우선순위를 줄 수 없고 먼저 들어온 것을 먼저 처리한다 동시에 들어오ATmega128 8051 .

는 경우에는 하드웨어에 의해 순위가 정해져 있는 데 그림 에 벡터표 순서대로 순위가 고정되어 있다83 .

4.1.4.4.4.1.4.4.4.1.4.4.4.1.4.4. 외부 인터럽트 트리거외부 인터럽트 트리거외부 인터럽트 트리거외부 인터럽트 트리거

� 입력 외부 인터럽트 핀 핀 핀 을 통해 입력되는 신호로 발생: INT0~3( 25~28, PD0~3), INT4~7( 6~9, PE4~7)

하며 입출력포트 핀이 출력으로 설정되더라도 발생시킬 수 있다 소프트웨어적으로 해당 핀에 값을 출력시켜 인.
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터럽트를 발생 시킬 수 있다.

그림 83 의 인터럽트 발생원과 벡터값출처. ATmega128 ( :ATMEL)

� 트리거링 논리 의 레벨 하강에지 상승 에지값을 해당 핀에 주어 인터럽트를 발생시킬 수 있다 이들은: 0 , , .

용 용 으로 설정한다 에지 트리거는 이상의 펄스폭을 가져야 한다 레벨EICRA(INT0~3 ), EICRB(INT4~7 ) . 50ns .
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트리거 인터럽트 신호는 워치독 오실레이터에 의해 번 샘플링되며 이 기간이상의 펄스폭을 주어야한다2 .

� 허용 제어 의 비트를 사용하여 전체적인 허용을 제어하고 를 이용하여 트리거링을 설: SREG I EICRA, EICRB

정하고 를 이용하여 개별적으로 허용하여 발생을 제어한다 개별적으로 허용되어 있더라도 의 비트EIMSK . SREG I

가 으로 되어 있으면 인터럽트는 발생되지 않는다 개별적인 허용과 전체적인 허용이 있고 해당핀에 적절한 신0 .

호가 들어와야 인터럽트는 발생될 수 있다.

� 슬립모드의 해제 레벨 트리거로 설정한 경우의 과 하강 또는 상승 에지 트리거 방식으로 설정된: INT0~7

은 인터럽트가 클럭에 관계없이 비동기로 검출되어 슬립모드를 해제하는 데 사용할 수 있다 하강 또는INT0~3 .

상승 에지 트리거 방식으로 설정된 의 경우는 클럭을 필요로 하여 이 클럭이 차단되는 슬립모드들아INT4~7 I/O (

이들 모드를 제외한 모든 슬립모드에서는 슬립모드를 해제하는 데 사용할 수 없다) .

4.1.4.5.4.1.4.5.4.1.4.5.4.1.4.5. 레지스터레지스터레지스터레지스터EICRAEICRAEICRAEICRA

레지스터는 초기값은 으로 외부 인터럽트 의 트리거 설EICRA(External Interrupt Control Register A) 00 0~3

정에 사용된다.

� 비트 여기에서 은 의 값을 갖는다 값이 일 때 을 상승에지7~0(ISCn1, ISCn0) : n 3~0 . ISCn1:ISCn0 = 11 INTn

에서 일때는 하강에지에서 일때는 레벨에서 트리거되도록 설정한다 은 보류되어 있다, 10 , 00 0 . 01 .

4.1.4.6.4.1.4.6.4.1.4.6.4.1.4.6. 레지스터레지스터레지스터레지스터EICRBEICRBEICRBEICRB

� 비트 여기에서 은 의 값을 갖는다 값이 일 때 을 상승에지7~0(ISCn1, ISCn0) : n 7~4 . ISCn1:ISCn0 = 11 INTn

에서 일때는 하강에지에서 일때는 상승에지 또는 하강에지에서 일때는 레벨에서 트리거되도록 설정, 10 , 01 , 00 0

한다.

4.1.4.7.4.1.4.7.4.1.4.7.4.1.4.7. 레지스터레지스터레지스터레지스터EIMSKEIMSKEIMSKEIMSK

레지스터는 의 개별적인 허용 제어에 사용된다EIMSK(External Interrupt MaSK register) INT7~0 .

� 비트 초기값은 으로 로 설정되어 있으면 해당 인터럽트가 허용된다7~0(INT7~0) : 00 1 .

4.1.4.8.4.1.4.8.4.1.4.8.4.1.4.8. 레지스터레지스터레지스터레지스터EIFREIFREIFREIFR

레지스터는 외부 인터럽트가 에지 트리거에 의해 요청된 경우 허용여EIFR(External Interrupt Frag Register)

부에 상관없이 로 세트된다 만약 인터럽트가 허용된 경우 인터럽트 서비스와 함께 자동적으로 으로 클리어 된1 . 0

다 플랙에 을 써 넣음으로 클리어 시킬 수 있다 을 써 넣는 것이 아님에 주의하라 레벨 트리거로 설정한 경. 1 (0 ).

우에는 항상 으로 클리어 된다0 .

4.1.5.4.1.5.4.1.5.4.1.5.4.1.5.4.1.5.4.1.5.4.1.5.4.1.5.4.1.5.4.1.5.4.1.5. 실험 점멸실험 점멸실험 점멸실험 점멸21 : LED 121 : LED 121 : LED 121 : LED 1실험 점멸실험 점멸실험 점멸실험 점멸21 : LED 121 : LED 121 : LED 121 : LED 1실험 점멸실험 점멸실험 점멸실험 점멸21 : LED 121 : LED 121 : LED 121 : LED 1

� 예제 에 연결된 스위치를 누르면 상승 에지 트리거에 의한 인터럽트가 발생하여 에: INT0(PORTD.0) PORTC

연결된 가 칸 옮겨가면서 켜진다LED 1 .

� 회로도 그림 의 을 그림 의 에 연결하고 실험할 때는 를 닫고 한다 또한 그림: 80 SW_CON 79 D_CON LEDSW .

의 을 누르면서 실험한다80 SW1 .

� 프로그램 작성시 유의점 디버깅시 를 누르고 창의 레지스터 비트 의 값을 변화시: [Auto Step] IO View PIND 0

켜가며 의 변화를 관찰하라 을 변화시킬 때마다 의 값이 변화해야 한다PORTC . PIND.0 PORTC . CodeVisoinAVR

에서 인터럽트 번호에 따른 이름을 예로 은 로 의 경우에는INT0~7 EXT_INT0~EXT_INT7 ATmega128

에 정의해 놓았다 이를 이용해서 프로그램을 짜도 된다mega128.h . . 그림 의 회로에서 풀업 저항 옴 대80 10K

신 무한대의 저항 즉 풀업 저항 옴을 없애고 개방하여 입력장치로 사용해도 된다 이것은 포트들이 입력10K . I/O

으로 사용될 때 내부 풀업 저항을 사용할 수 있기 때문이다 이런 경우 해당 포트 핀을 입력으로 설정하기 위해.

명령에 부가적으로 명령으로 해당 포트 핀에 을 써 넣어야 내부 풀업 저항을 사용할DDRx.n=0 PORTx.n=1 1

수 있다.
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� 프로그램 예 :

#include <mega128.h>
#include <delay.h> 를 이용할 것이다// delay_ms(), delay_us() .
void main(void){
unsigned char led = 0xfe;

처럼 에 저장된 정의를 사용해도 됨interrupt [2] void exint0(void){ // interrupt [EXT_INT0] void exint0(void) mega128.h
비트 을 켜지 않았으면 비트씩 좌로 시프트하고 빈자리에는 을 채운다if(led!=0x7f) led = (led << 1) | 0x01; // 7 1 1 .

else led = 0xfe; 비트 을 켰으면 다시 처음으로 와서 비트 을 켠다// 7 0 .
PORTC = led;
delay_ms(5); // 5msec delay

}
void main(void){

포트 를 출력으로DDRC = 0xff; // C
PORTC = led;

포트 를 입력으로 디폴트 입력으로 설정되어 있으므로 필요하지는 않음DDRD = 0x00; // D
SREG.7 = 1; 인터럽트 전체 허용//
EIMSK |= 0x01; 개별 허용// INT0

상승에지 트리거EICRA = 3; //
while(1);

}

� 과제 실제 구현 했을 때 한 번 누를 때마다 하나씩 이동하지 않고 여러 개가 이동하는 현상이 발생할 것: ①

이다 이는 실험 에서도 이야기한 채터링에 의한 현상이다 의 값을 변화시켜 가면서 실험해 보고. 16 . delay_ms(5)

적정한 시간 지연을 찾아 보아라 그림 의 회로 대신 그림 의 회로를 이용하되 시간지연을 작게 해서 실. 80 84②

험해보고 비교해보라 외부인터럽트 으로 같은 역할을 하는 프로그램을 구현해보라. 1~3 .③

그림 84 간단한 채터링 방지 키 입력 회로.

4.1.6.4.1.6.4.1.6.4.1.6.4.1.6.4.1.6.4.1.6.4.1.6.4.1.6.4.1.6.4.1.6.4.1.6. 실험 점멸실험 점멸실험 점멸실험 점멸22 : LED 222 : LED 222 : LED 222 : LED 2실험 점멸실험 점멸실험 점멸실험 점멸22 : LED 222 : LED 222 : LED 222 : LED 2실험 점멸실험 점멸실험 점멸실험 점멸22 : LED 222 : LED 222 : LED 222 : LED 2

� 예제 에 연결된 스위치를 누르면 상승 에지 트리거에 의한 인터럽트가 발생하여 에: INT0(PORTD.0) PORTC

연결된 가 칸 좌로 옮겨가면서 켜진다 에 연결된 스위치를 누르면 레벨 트리거에 의한 인LED 1 . INT1(PORTD.1)

터럽트가 발생하여 에 연결된 가 칸 우로 옮겨가면서 켜진다PORTC LED 1 .
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� 회로도 그림 의 을 그림 의 에 연결하고 실험할 때는 를 닫고 한다 또한 그림: 80 SW_CON 79 D_CON LEDSW .

의 과 를 누르면서 실험한다80 SW1 SW2 .

� 프로그램 예 :

#include <mega128.h>
#include <delay.h> 를 이용할 것이다// delay_ms(), delay_us() .
unsigned char led = 0xfe;

처럼 에 저장된 정의를 사용해도 됨interrupt [2] void exint0(void){ // interrupt [EXT_INT0] void exint0(void) mega128.h
비트 을 켜지 않았으면 비트씩 좌로 시프트하고 빈자리에는 을 채운다if(led!=0x7f) led = (led << 1) | 0x01; // 7 1 1 .

else led = 0xfe; 비트 을 켰으면 다시 처음으로 와서 비트 을 켠다// 7 0 .
PORTC = led;
delay_ms(40);

}
처럼 에 저장된 정의를 사용해도 됨interrupt [3] void exint1(void){ // interrupt [EXT_INT1] void exint1(void) mega128.h

비트 를 켜지 않았으면 비트씩 우로 시프트하고 빈자리에 을if (led != 0xfe) led = (led >> 1 ) | 0x80; /* 0 1 1 */
else led = 0x7f; 비트 을 켰으면 다시 처음으로 와서 비트 를 켠다/* 0 7 . */
PORTC = led;
delay_ms(40);

}
void main(void){

포트 를 출력으로DDRC = 0xff; // C
PORTC = led;

포트 를 입력으로 디폴트 입력으로 설정되어 있으므로 필요하지는 않음DDRD = 0x00; // D
SREG.7 = 1; 인터럽트 전체 허용//
EIMSK |= 0b00000011; 개별 허용// INT0, 1
EICRA = 3; 상승에지 트리거// INT0 레벨 트리거, INT1
while(1);

}

� 과제 와 의 역할을 바꾼 프로그램을 구현해보라 와: INT0(PORTD.0) INT1(PORTD.1) . INT2(PORTD.2)① ②

을 이용하여 같은 역할을 하는 것을 구현해보라INT3(PORTD.3) .

4.1.7.4.1.7.4.1.7.4.1.7.4.1.7.4.1.7.4.1.7.4.1.7.4.1.7.4.1.7.4.1.7.4.1.7. 실험 카운터실험 카운터실험 카운터실험 카운터23 :23 :23 :23 :실험 카운터실험 카운터실험 카운터실험 카운터23 :23 :23 :23 :실험 카운터실험 카운터실험 카운터실험 카운터23 :23 :23 :23 :

� 예제 에지트리거되는 외부 인터럽트를 이용하여 카운트하는 프로그램으로 에 연결된: INT0(PORTD.0) SW1

를 누르면 상승 에지 트리거에 의한 인터럽트가 발생하여 눌린 수를 세어 에 연결된 에 표시한다PORTC LED .

� 회로도 그림 의 을 그림 의 에 연결하고 실험할 때는 를 닫고 한다 또한 그림: 80 SW_CON 79 D_CON LEDSW .

의 을 누르면서 실험한다80 SW1 .

� 프로그램 예 :

#include <mega128.h>
#include <delay.h> 를 이용할 것이다// delay_ms(), delay_us() .
unsigned char led;

처럼 에 저장된 정의를 사용해도 됨interrupt [2] void exint0(void){ // interrupt [EXT_INT0] void exint0(void) mega128.h
PORTC = ~(++led); 를 증가시키고 반전한 것을 출력시킨다/* led 1 */
delay_ms(5);

}
void main(void){

포트 를 출력으로DDRC = 0xff; // C
포트 를 입력으로 디폴트 입력으로 설정되어 있으므로 필요하지는 않음DDRD = 0x00; // D

SREG.7 = 1; 인터럽트 전체 허용//
EIMSK = 0b00000001; 개별 허용// INT0
EICRA = 3; 상승에지 트리거// INT0
PORTC = ~led; 일때 가 켜지고 일때 꺼지므로 반전시켜서 출력/* 0 LED 1 */
for(;;); 인터럽트 발생할 때까지 대기/* */

}
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� 과제 실제 구현 했을 때 한 번 누를 때마다 하나씩 이동하지 않고 여러 개가 이동하는 현상이 발생할 것: ①

이다 이는 실험 에서도 이야기한 채터링에 의한 현상이다 의 값을 변화시켜 가면서 실험해 보고. 16 . delay_ms(5)

적정한 시간 지연을 찾아 보아라 그림 의 회로 대신 그림 의 회로를 이용하되 시간지연을 작게 해서 실. 80 84②

험해보고 비교해보라 외부인터럽트 으로 같은 역할을 하는 프로그램을 구현해보라 에. 1~3 . INT0(PORTD.0)③ ④

연결된 를 누르면 증가하고 에 연결된 를 누르면 감소하는 프로그램을 구현해보라SW1 INT1(PORTD.1) SW2 .

4.2.4.2.4.2.4.2.4.2.4.2.4.2.4.2.4.2.4.2.4.2.4.2. 타이머 실험타이머 실험타이머 실험타이머 실험타이머 실험타이머 실험타이머 실험타이머 실험타이머 실험타이머 실험타이머 실험타이머 실험

� 에는 타이머 모두 개의 타이머카운터가 존재한다 이들은 인터럽트와 출력 기능을 갖ATmega128 0~3 4 / . PWM

고 있다 그 중에서 타이머 는 비트로 서로 기능이 유사하고 타이머 는 비트로 서로 기능이 유사하다. 0, 2 8 1, 3 16 .

다만 타이머 은 다른 타이머와 달리 의 수정 진동자에 접속하는 단자를 가지고 있어서0 32.768KHz TOSC1,2

의 기능을 갖고 있다Real Time Clock .

� 인터럽트는 오버플로에 의해 발생하는 오버플로 인터럽트 카운터 값이 출력비교 레지스터의 값과 같게 되는,

경우 발생하는 출력비교 인터럽트 입력 캡쳐 인터럽트가 있다, .

� 기능은 출력비교 기능을 이용하여 출력비교 신호에 주기와 를 가변할 수 있는 출력신호를 생PWM duty ratio

성하여 단자로 출력하는 것이다OC0, OC2, OC1A~C, OC3A~C .

� 타이머 은 외부 트리거 신호에 의해 현재의 카운터 값을 캡쳐할 수 있는 기능을 갖고 있다1, 3 .

그림 85 타이머 의 블록선도출처. 0 ( :ATMEL)

4.2.1.4.2.1.4.2.1.4.2.1.4.2.1.4.2.1.4.2.1.4.2.1.4.2.1.4.2.1.4.2.1.4.2.1. 타이머 카운터타이머 카운터타이머 카운터타이머 카운터0, 20, 20, 20, 2타이머 카운터타이머 카운터타이머 카운터타이머 카운터0, 20, 20, 20, 2타이머 카운터타이머 카운터타이머 카운터타이머 카운터0, 20, 20, 20, 2

및 비동기 동작 모드를 갖는 비트 업다운 카운터로 비트의 프리스케일러를 갖고 있어 이를 통하여PWM 8 / 10
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내부 클럭을 소스로 받아 타이머나 카운터로 동작한다 오버플로와 출력비교에 의한 인터럽트 기능을 갖고 있으며.

주파수를 발생할 수 있는 기능을 갖고 있고 출력비교와 재장전 기능을 갖고 있다 타이머 의 경우 부가적으로. 0

의 수정 진동자를 단자에 연결해 으로 사용할 수 있는 기능이 있다32.768KHz TOSC1,2 Real Time Clock .

4.2.1.1.4.2.1.1.4.2.1.1.4.2.1.1. 구성구성구성구성

그림 는 비트 타이머의 블록선도를 보여준다85 8 .

� 프리스케일러 타이머 의 경우에는 에 입력된 시스템클럭 주파수의 미만의 외부클럭(prescaler) : 0 TOSC1 1/4 ,

과 단자에 연결된 수정 진동자에 의해 발생되는 클럭이나 내부 클럭TOSC1 TOSC2 을 클럭 소스로 사용하

여 의 분주비로 프리스케일러에서 나누어1, 8, 32, 64, 128, 256, 1024 클럭을 생성한다 타이머 의 클럭. 0

소스는 레지스터로 선택한다 타이머 의 경우에는 핀에 해당하는 것이 없고 대신 핀으로 입ASSR . 2 TOSCT1,2 T2

력되는 외부 클럭을 프리스케일러를 거치지 않고 클럭을 생성하거나 내부 클럭 을 클럭 소스로 사용

하여 의 분주비로 프리스케일러에서 나누어1, 8, 64, 256, 1024 클럭을 생성한다 분주비의 선택은. TCCRn

레지스터로 설정한다.

� 타이머 의 동작모드를 설정하는 레지스터 은 또는TCCRn : n (n 0 2)

� 레지스터 프리스케일러에서 생성된TCNTn (Timer/CouNTer n) : 클럭을 제어로직에 따라 업다운 카운/

팅을 수행하거나 리셋되는 타이머 의 비트 카운터 값을 저장하는 레지스터n 8 .

� 가 카운팅에 의해 에서 로 오버플로우가 일어나면 플랙이 세트되고 오버플로TOVn : TCNTn 0xFF 0x00 TOVn

인터럽트를 발생시킬 수 있게 된다.

� 레지스터 의 값과 출력 비교되기 위한 비트 데이터 값을 저OCRn(Output Compare Resister n) : TCNTn 8

장하고 있는 레지스터로 의 값과 같으면 플랙을 세트시키고 출력비교 인터럽트를 요청하고 출력핀TCNTn OCFn

단자로 적절한 데이터가 출력되도록 한다OCn .

� 제어로직(Control Logic) : 와 가 제로가 되었을 때 발생하는 신호 카운터값TCNTn BOTTOM , TCNTn

이 에 도달하거나 레지스터에 설정된 값에 도달할 때 발생하는 신호를 입력으로 받아들여0xFF OCRn TOP

카운터를 업다운 카운팅을 수행하게 하거나 리셋시킨다TCNTn / .

4.2.1.2.4.2.1.2.4.2.1.2.4.2.1.2. 레지스터레지스터레지스터레지스터TCCRnTCCRnTCCRnTCCRn

는 타이머 의 동작모드를 설정하고 프리스케일러의 분주비를 설정TCCRn(Timer/Counter Control Register n) n

한다.

� 비트 모드가 아닌 경우에만 유효하며 로 설정하면 강제로7(FOCn:Force Output Compare n) : PWM 1

핀 단자타이머 의 경우 핀 에 출력비교가 일치할때 출력하게 되는 값과 동일한 출OC0(PB4, 14) ( 2 OC2(PB7, 17)

력을 내보낸다 이 경우 인터럽트가 발생하지도 않고 모드에서 를 클리어시키지도 않으므로 보통. CTC TCNTn 0

으로 설정한다.

� 비트 타이머 는 가지의 동작모드를 갖는데 각각6, 3(WGMn0, n1: Waveform Generation Mode n0, n1) : n 4

일반 고속 이다 을 으로 하면 일반모드 로 하Normal( ), CTC, PC(Phase Correct) PWM, PWM . WGMn1:n0 00 , 01

면 으로 하면 로 하면 고속 모드로 설정한다PC PWM, 10 CTC, 11 PWM .

� 비트 핀의 동작을 다음처럼 조절한다5,4(COMn1, n0 : Compare Match output mode n1, n0) : OCn .

정상적인 범용 입출력 포트로 동작 출력을 차단00 : (OCn )①

모드가 아닌 경우 출력비교에 의해 출력을 토글시키며 모드에서는 보류되어 있다01 : PWM OCn , PWM .②

모드가 아닌 경우 출력비교에 의해 출력을 클리어 모드의 경우 를 클리어10 : PWM OCn , FAST PWM OCn③

하고 신호를 받아 를 로 세트 모드 상향카운팅의 경우 를 클리어하고TOP OCn 1 , Phase Correct PWM OCn PWM

모드 하향카운팅의 경우 를 로 세트 시킨다OCn 1 .



- 90 -

모드가 아닌 경우 출력비교에 의해 출력을 세트 모드의 경우 를 세트하고11 : PWM OCn , FAST PWM OCn④

신호를 받아 를 클리어 모드 상향카운팅의 경우 를 세트하고 모드 하TOP OCn , Phase Correct PWM OCn PWM

향카운팅의 경우 를 클리어 시킨다OCn .

� 비트 즉 타이머 일 때 클럭의 분주비를 선택하여 일 때 클럭2~0(CSn2~n0: Clock Selectn2~n0) : n=0 0 000

입력을 차단하고 일때 분주 일때 분주 일때 분주 일때 분주 일때 분주 일, 001 1 , 010 8 , 011 32 , 100 64 , 101 128 , 110

때 분주 일때 분주비가 되도록 한다 즉 타이머 의 경우에는 분주비와 클럭소스를 선택하여256 , 111 1024 . n=2 2

일 때 클럭입력을 차단하고 일때 분주 일때 분주 일때 분주 일때 분주 일때000 , 001 1 , 010 8 , 011 64 , 100 256 , 101

분주비가 되도록 하고 일때 핀 핀에서 입력되는 외부 클럭의 하강에지에서 카운터 가 동작1024 110 T2(PD7, 32) 2

하고 일때는 핀 핀에서 입력되는 외부 클럭의 상승에지에서 카운터 가 동작하도록 한다, 111 T2(PD7, 32) 2 .

4.2.1.3.4.2.1.3.4.2.1.3.4.2.1.3. 레지스터레지스터레지스터레지스터TIMSKTIMSKTIMSKTIMSK

레지스터는 타이머 가 발생하는 인터럽트를 개별적으로 허용 제어하는 레TIMSK(Timer Interrupt MaSK) 0,1,2

지스터이다.

� 비트 로 설정되면 타이머 의 출력비교 인7(OCIE2:Output Compare match Interrupt Enable for timer2) : 1 2

터럽트를 개별적으로 허용한다.

� 비트 로 설정되면 타이머 의 오버플로 인터럽트를6(TOIE2:Timer Overflow Interrupt Enable for timer2) : 1 2

개별적으로 허용한다.

� 비트 로 설정되면 타이머 의 출력비교 인1(OCIE0:Output Compare match Interrupt Enable for timer0) : 1 0

터럽트를 개별적으로 허용한다.

� 비트 로 설정되면 타이머 의 오버플로 인터럽트를0(TOIE0:Timer Overflow Interrupt Enable for timer0) : 1 0

개별적으로 허용한다.

4.2.1.4.4.2.1.4.4.2.1.4.4.2.1.4. 레지스터레지스터레지스터레지스터TIFRTIFRTIFRTIFR

레지스터는 타이머 가 발생하는 인터럽트 플랙을 저장한다TIFR(Timer Interrupt Frag Register) 0~2 . 소프트웨

어적으로 강제로 클리어 하려면 을 기록해야 한다1 .

� 비트 타이머 의 레지스터와 출력비교 레지스터 의7(OCF2 : Output Compare match Flag 2) : 2 TCNT2 OCR2

값을 비교하여 같으면 는 로 세트되고 출력비교 인터럽트가 요청된다 인터럽트가 서비스되기 시작하면OCF2 1 .

자동적으로 클리어된다.

� 비트 타이머 에서 오버플로가 발생하면 까지 세고 으로 넘어6(TOV2 : Timer Overflow Flag 2) : 2 (0xFF 0x00

가게 되면 이 는 로 세트되면서 오버플로 인터럽트가 요청된다 인터럽트가 서비스되기 시작하면 자동적) TOV2 1 .

으로 클리어된다 모드에서는 타이머 이 에서 계수방향을 바꿀 때 가 세트된다. Phase correct PWM 2 0x00 TOV2 .

� 비트 타이머 의 레지스터와 출력비교 레지스터 의1(OCF0 : Output Compare match Flag 0) : 0 TCNT0 OCR0

값을 비교하여 같으면 는 로 세트되고 출력비교 인터럽트가 요청된다 인터럽트가 서비스되기 시작하면OCF0 1 .

자동적으로 클리어된다.

� 비트 타이머 에서 오버플로가 발생하면 까지 세고 으로 넘어0(TOV0 : Timer Overflow Flag 0) : 0 (0xFF 0x00

가게 되면 이 는 로 세트되면서 오버플로 인터럽트가 요청된다 인터럽트가 서비스되기 시작하면 자동적) TOV0 1 .

으로 클리어된다 모드에서는 타이머 이 에서 계수방향을 바꿀 때 가 세트된다. Phase correct PWM 0 0x00 TOV0 .

4.2.1.5.4.2.1.5.4.2.1.5.4.2.1.5. 레지스터레지스터레지스터레지스터ASSRASSRASSRASSR

레지스터는 타이머 이 클럭소스를 선택하거나 외부 클럭에 의해 비동기ASSR(ASynchronous Status Register) 0

모드로 동작하는 경우 제어를 위한 레지스터이다.

� 비트 이면 내부클럭3(AS0 : ASynchronous timer 0) : 0 를 클럭소스로 설정하여 동기모드로 타이머0

가 동작하게 하고 이면 을 통해 들어오는 외부클럭을 소스로 설정하여 비동기모드로 동작하게 한다1 TOSC1 .
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의 수정은 의 내용의 변동을 초래하고 예상하지 못한 인터럽트가 발생할 수 있으므AS0 TCNT0, OCR0, TCCR0

로 주의해야 한다.

� 비트 타이머 이 외부에서 단자로 입력되는 클럭을 소2(TCN0UB : Timer/CouNter0 Uptate Busy) : 0 TOSC1

스로 하여 비동기모드로 동작하고 있을 때 레지스터에 새로운 값을 기록하면 로 세트된다 기록이 완료TCNT0 1 .

되면 으로 자동적으로 클리어되어 에 새로운 값을 기록할 수 있음을 표시한다0 TCNT0 .

� 비트 타이머 이 외부에서 단자로 입력되1(OCR0UB : Output Compare Register 0 Update Busy) : 0 TOSC1

는 클럭을 소스로 하여 비동기모드로 동작하고 있을 때 레지스터에 새로운 값을 기록하면 로 세트된다OCR0 1 .

기록이 완료되면 으로 자동적으로 클리어되어 에 새로운 값을 기록할 수 있음을 표시한다0 OCR0 .

� 비트 타이머 이 외부에서 단자로 입력되는0(TCR0UB : Timer Conter Register 0 Update Busy) : 0 TOSC1

클럭을 소스로 하여 비동기모드로 동작하고 있을 때 레지스터에 새로운 값을 기록하면 로 세트된다 기TCCR0 1 .

록이 완료되면 으로 자동적으로 클리어되어 에 새로운 값을 기록할 수 있음을 표시한다0 TCCR0 .

4.2.1.6.4.2.1.6.4.2.1.6.4.2.1.6. 레지스터레지스터레지스터레지스터SFIORSFIORSFIORSFIOR

는 타이머들을 동기화시키는데 사용되는 레지스터이다SFIOR(Special Function I/O Register) .

� 비트 으로 클리어하면 비트가 하드웨어적으로 클리7(TSM : Timer Synchronization Mode) : 0 PSR0, PSR321

어되며 타이머들이 동시에 카운팅 동작을 시작한다 로 하면 비트에 기록한 값을 유지하여 대응. 1 PSR0, PSR321

하는 프리스케일러 리셋신호를 발생하고 해당 타이머의 동작을 정지시켜 같은 값으로 설정할 수 있도록 한다.

� 비트 로하면 타이머 의 프리스케일러를 리셋시키며 완료후에 자동적1(PSR0 : Prescaler Reset Timer 0) : 1 0

으로 클리어된다 이면 자동적으로 클리어되지 않는다. TSM = 1 .

� 비트 로하면 타이머 의 프리스케일러를 리셋시키며 완료후에 자0(PSR123 : Prescaler Reset Timer 123) : 1 0

동적으로 클리어된다 이면 자동적으로 클리어되지 않는다. TSM = 1 .

4.2.1.7.4.2.1.7.4.2.1.7.4.2.1.7. 타이머 의 일반 모드타이머 의 일반 모드타이머 의 일반 모드타이머 의 일반 모드0,20,20,20,2

� 설정 레지스터의 으로 설정한다: TCCRn WGMn1:n0 = 00 .

� 동작 타이머 는 항상 상향 카운터로만 동작한다 의 값이 에서 으로 바뀌는 순간 레지스: n . TCNTn 255 0 TIFR

터의 비트가 세트되며 오버플로 인터럽트 발생이 요청된다 출력비교 인터럽트를 일반모드에서 사용할 수TOVn .

도 있으나 모드를 사용하는 것이 좋다FAST PWM .

� 시간간격 설정 오버플로 인터럽트가 요청될 때 마다 인터럽트를 발생시켜 의 초기값: TCNTn 을 적당하게

설정하면 원하는 시간 간격을 얻을 수 있다 의 비트 값에 따라. TCCRn 2~0(CSn2~0) 1, 8, 32, 64, 128, 256,

분주가 되므로타이머 의 경우 클럭을1024 ( 2 1,8, 64, 256, 1024)  로 사용하는 경우 분주비를MHz 이라 하면

다음에 의해 시간 간격 가 결정된다 즉 오버플로 인터럽트가 요청되는 시간간격은. 이다.

   × 

4.2.1.8.4.2.1.8.4.2.1.8.4.2.1.8. 타이머 의타이머 의타이머 의타이머 의0,20,20,20,2 모드모드모드모드CTCCTCCTCCTC

� 설정 레지스터의 으로 설정한다: TCCRn WGMn1:n0 = 10 .

� 동작 모드에서는 의 값이 레지스터에 설정한 값과 일치: CTC(Clear Timer on Compare match) TCNTn OCRn

되면 그 다음 클럭 사이클에서 의 값이 으로 클리어된다 이때 레지스터의 비트가 세트되며TCNTn 0 . TIFR OCFn

출력비교 인터럽트 발생이 요청된다 이때 인터럽트를 발생시켜 의 값을 바꾸면 주기를 원하는 대로 변경. OCRn

할 수 있다 단자로 하여금 출력파형을 발생하도록 할 수 있는데 의 을 로 설정하고. OCn TCCRn COMn1~n0 01

레지스터 값을 바꿔가면서 출력비교에 의해 의 신호를 토글하는 경우를 그림 이 보여준다OCRn OCn 86 .

� 주기 설정 의 을 로 설정하고 레지스터 값을 어떤 일정한 값 로 놓고 출력: TCCRn COMn1~n0 01 OCRn OCR0

비교에 의해 의 신호를 토글하는 경우 의 비트 값에 따라OCn TCCRn 2~1(CSn2~n0) 1, 8, 32, 64, 128, 256,

분주가 되므로타이머 의 경우 클럭을1024 ( 2 1,8, 64, 256, 1024)  로 사용하고 분주비를MHz 이라 하면 다음
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에 의해 주기 가 결정된다 출력비교 인터럽트가 요청되는 시간간격은. 이다.

     

그림 86 타이머 의 모드 동작출처. 0,2 CTC ( :ATMEL)

4.2.1.9.4.2.1.9.4.2.1.9.4.2.1.9. 타이머 의 고속타이머 의 고속타이머 의 고속타이머 의 고속0, 20, 20, 20, 2 모드모드모드모드PWMPWMPWMPWM

� 설정 레지스터의 으로 설정한다: TCCRn WGMn1:n0 = 11 .

� 동작 는 반복적으로 업카운팅하며 항상 의 값을 갖는다 의 값이 레지스터: TCNTn 0x00~0xFF . TCNTn OCRn

에 설정한 값과 일치되면 레지스터의 비트가 세트되며 출력비교 인터럽트가 요청되며 의 값은TIFR OCFn OCn 0

으로 클리어 된다 그리고 는 업카운팅을 계속하여 는 까지 증가했다가 으로 바뀌는 순간. TCNTn TCNTn 255 0

레지스터의 비트가 세트되어 오버플로 인터럽트가 요청되며 는 로 세트된다 그림 참조TIFR TOVn OCn 1 . ( 87 ).

비트가 세트되어 오버플로 인터럽트가 요청될 때 인터럽트를 발생시켜 의 값을 바꾸어 듀티비를 제TOVn OCRn

어할 수 있다 레지스터 값과 듀티비가 비례함을 그림 에서 알 수 있다 일 때 듀티비는. OCRn 88 . OCRn = 0x00

이며 일 때 가 됨을 알 수 있다 레귤레이터 정류 및 변환에 적합하다 특히 고주파1/256 OCRn=0xFF 100% . , DA .

를 사용하기 때문에 코일 콘덴서 등 외부소자가 필요 없어 비용을 절감시킬 수 있다, .

그림 87 타이머의 고속 모드 동작출처. PWM ( :ATMEL)

� 주기 설정 의 을 혹은 로 설정하고 레지스터 값을 변화시켜가며 출력비교에: TCCRn COMn1~n0 10 11 OCRn

의해 의 신호를 하는 경우 의 비트 값에 따라 분OCn PWM TCCRn 2~1(CSn2~n0) 1, 8, 32, 64, 128, 256, 1024
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주가 되므로타이머 의 경우 클럭을( 2 1,8, 64, 256, 1024)  로 사용하고 분주비를MHz 이라 하면 다음에 의해

주기 가 결정된다 즉 오버플로 인터럽트가 요청되는 시간간격은. 이다.

   ×

4.2.1.10.4.2.1.10.4.2.1.10.4.2.1.10. 타이머 의타이머 의타이머 의타이머 의0, 2 Phase Correct0, 2 Phase Correct0, 2 Phase Correct0, 2 Phase Correct 모드모드모드모드PWMPWMPWMPWM

� 설정 레지스터의 으로 설정한다: TCCRn WGMn1:n0 = 01 .

� 동작 는 업카운팅하여 으로 증가하다가 다운카운팅으로 으로 감소를 반복한다 의: TCNTn 0xFF 0x00 . TCCRn

을 혹은 로 설정하고 레지스터 값을 변화시켜가며 출력비교에 의해 의 신호를COMn1~n0 10 11 OCRn OCn PWM

하는 경우 의 값이 레지스터에 설정한 값과 일치되면 레지스터의 비트가 세트되며 출력TCNTn OCRn TIFR OCFn

비교 인터럽트 발생이 요청되며 의 값은 상향 카운팅의 경우에는 으로 하향의 경우에는 로 세트된다 그OCn 0 1 .

리고 는 업카운팅을 계속하여 는 에 도달하면 의 값이 경신되고 하향카운팅이 시작된TCNTn TCNTn 255 OCR2

다 하향카운팅을 하다가 에 도달하면 레지스터의 비트가 세트되며 오버플로 인터럽트가 요청된다. 0 TIFR TOVn

그림 참조 모드에서는 레지스터에 이중 버퍼링 기능이 있어 주기를 변경하기 위해( 88 ). PC PWM OCRn PWM

레지스터에 새로운 값을 기록하더라도 즉기 변경되지 않고 이 에 도달하면 갱신된다그림OCRn TCNTn 255 ( 88

참조 레지스터 값과 듀티비가 비례함을 그림 에서 알 수 있다 일 때 듀티비는 이며). OCRn 88 . OCRn = 0x00 0

일 때 가 됨을 알 수 있다OCRn=0xFF 100% .

그림 88 타이머 의 위상교정 모드 동작 출처. 0, 2 PWM ( :ATMEL)

� 주기 설정 의 을 혹은 로 설정하고 레지스터 값을 변화시켜가며 출력비교에: TCCRn COMn1~n0 10 11 OCRn

의해 의 신호를 하는 경우 의 비트 값에 따라 분OCn PWM TCCRn 2~1(CSn2~n0) 1, 8, 32, 64, 128, 256, 1024

주가 되므로타이머 의 경우 클럭을( 2 1,8, 64, 256, 1024)  로 사용하고 분주비를MHz 이라 하면 다음에 의해

주기 가 결정된다 즉 오버플로 인터럽트가 요청되는 시간간격은. 이다.

   ×

4.2.2.4.2.2.4.2.2.4.2.2.4.2.2.4.2.2.4.2.2.4.2.2.4.2.2.4.2.2.4.2.2.4.2.2. 타이머 카운터타이머 카운터타이머 카운터타이머 카운터1, 31, 31, 31, 3타이머 카운터타이머 카운터타이머 카운터타이머 카운터1, 31, 31, 31, 3타이머 카운터타이머 카운터타이머 카운터타이머 카운터1, 31, 31, 31, 3

개의 출력 및 캡춰 기능을 갖는 비트 업다운 카운터로 비트의 프리스케일러를 갖고 있어 이를 통3 PWM 16 / 10

하여 내부 클럭을 소스로 받아 타이머나 카운터로 동작한다 오버플로와 출력비교에 의한 인터럽트 이외에 입력.



- 94 -

캡춰 인터럽트 기능을 갖고 있고 주파수를 발생할 수 있는 기능과 출력비교와 재장전 기능을 갖고 있다.

4.2.2.1.4.2.2.1.4.2.2.1.4.2.2.1. 구성구성구성구성

그림 는 타이머 과 의 블록선도를 보여준다89 1 3 .

그림 89 타이머 의 불록선도출처. 1,3 ( :ATMEL)

� 프리스케일러 내부 클럭(prescaler) : 을 클럭 소스로 사용하여 의 분주비로 나누어1, 8, 64, 256, 1024

에 사용될 클럭을 생성한다 분주비의 선택은 레지스터로 설정한다 는 또는TCLK . TCCRxB (x 1 3).

� 핀으로 입력되는 외부 클럭을 프리스케일러를 거치지 않고 클럭이 생성되거나 내부 클럭TCLK : Tx TCLK

을 프리스케일러에서 나누어 클럭이 생성된다TCLK .

� 타이머 의 설정을 위한 레지스터TCCRxA~C : x .

� 레지스터 클럭을 제어로직에 따라 업다운 카운팅을 수행하거나 리셋되TCNTx (Timer/CouNTer x) : TCLK /

는 타이머 의 비트 카운터 값을 저장하는 레지스터x 16 .

� 가 카운팅에 의해 에서 로 오버플로우가 일어나면 플랙이 세트되고 오TOVx : TCNTx 0xFFFF 0x0000 TOVx

버플로 인터럽트를 발생시킬 수 있게 된다.

� 레지스터 의 값과 출력 비교되기 위한 비트 데이OCRxA~C(Output Compare Resister x A~C) : TCNTx 16
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터 값을 저장하고 있는 레지스터로 의 값과 같으면 플랙이 세트되고 출력비교 인터럽트를 요TCNTx OCFxA~C

청하여 출력핀 단자로 적절한 데이터가 출력되도록 한다OCxA~C .

� 입력캡쳐핀 타이머 의 경우에는 아날로그 비교기의 출력신호도 가능ICRx(Input Capture Register x) : ICx( 1 )

으로 들어오는 신호변화를 검출하여 일어나는 입력캡쳐시 의 카운터 값을 저장하는 비트 레지스터로TCNTx 16

이때 플랙이 세트되고 입력캡쳐인터럽트가 요청된다 어떤 신호의 주기 측정에 응용될 수 있다ICFx . .

� 제어로직 가 제로가 되었을 때 발생하는 신호 카운터값이(Control Logic) : TCNTx BOTTOM , TCNTx

에 도달하거나 카운터가 실제로 도달할 수 있는 최대값 혹은 에 설정된 값에 도달하면0xFFFF OCRxA~C, ICRx

발생하는 신호를 입력으로 받아들여 카운터를 업다운 카운팅을 수행하게 하거나 리셋시킨다TOP TCNTx / .

4.2.2.2.4.2.2.2.4.2.2.2.4.2.2.2. 레지스터레지스터레지스터레지스터TCCRxATCCRxATCCRxATCCRxA

는 타이머 의 동작모드와 출력비교 단자의 파형 발생법 등을TCCRxA(Timer/Counter Control Register x A) x

설정한다.

� 비트 핀의 동작을 아래처럼 설정7~6(COMxA1~0:Compare match Output Mode for channel A) : OCxA .

� 비트 핀의 동작을 아래처럼 설정5~4(COMxB1~0:Compare match Output Mode for channel B) : OCxB .

� 비트 핀의 동작을 아래처럼 설정3~2(COMxC1~0:Compare match Output Mode for channel C) : OCxC .

정상적인 범용 입출력 포트로 동작 출력을 차단00 : (OCxn , n=A,B,C)①

모드가 아닌 경우 출력비교에 의해 출력을 토글시키며 모드에서는 모드 의01 : PWM OCxn , FAST PWM 15②

경우 출력비교에 의해 출력을 토글하고 는 출력을 차단하고 기타의 모드에서 출력을OCxA OCxB, OCxC OCxn

차단하며 모드에서 모드 의 경우 출력비교에 의해 출력을 토글하고, Phase Correct PWM 9,11 OCxA OCxB,

는 출력을 차단하고 기타의 모드에서 출력을 차단한다OCxC OCxn .

모드가 아닌 경우 출력비교에 의해 출력을 클리어 모드에서 출력 비교에 의10 : PWM OCxn , FAST PWM③

해 출력을 클리어하고 신호를 받아 를 로 세트 모드 상향카운팅의 경우OCxn TOP OCxn 1 , Phase Correct PWM

를 클리어하고 모드 하향카운팅의 경우 를 로 세트 시킨다OCxn PWM OCxn 1 .

모드가 아닌 경우 출력비교에 의해 출력을 세트 모드의 경우 를 세트하11 : PWM OCxn , FAST PWM OCxn④

고 신호를 받아 를 클리어 모드 상향카운팅의 경우 를 세트하고 모TOP OCxn , Phase Correct PWM OCxn PWM

드 하향카운팅의 경우 를 클리어 시킨다OCxn .

� 비트 타이머 는 가지의 동작모드를 갖는데1~0(WGMx0~1: Waveform Generation Mode x 1~0) : x 16

의 비트 와 결합하여 동작모드를 설정한다 그림 은 모드의 번호 비트값TCCRxB 4~3(WGMx3~2) . 90 , WGMx4~0 ,

모드의 동작 값 레지스터의 업데이트 시점 플랙의 세트 시점을 보여준다, TOP , OCRx , TOVx .

4.2.2.3.4.2.2.3.4.2.2.3.4.2.2.3. 레지스터레지스터레지스터레지스터TCCRxBTCCRxBTCCRxBTCCRxB

는 타이머 의 동작모드와 분주비 등을 설정한다TCCRxB(Timer/Counter Control Register x B) x .

� 비트 로 세트하면 입력캡쳐단자 로 입력되는 캡쳐신호를 위7(ICNCx:Input Capture Noise Canceler x) : 1 ICx

한 노이즈 회로를 작동시켜 필터링을 한다 필터링에 의해 캡쳐신호가 클럭 지연된다. 4 .

� 비트 로 세트하면 로 입력되는 캡쳐신호가 상승에지일 때 이6(ICESx:Input Capture Edge Selectr x) : 1 ICx 0

면 하강에지일때 캡쳐가 수행된다.

� 비트 보류된 비트5 :

� 비트 타이머 는 가지의 동작모드를 갖는데3~2(WGMx3~2: Waveform Generation Mode x 3~2) : x 16

의 비트 와 결합하여 동작모드를 설정한다 그림 은 모드의 번호 비트값TCCRxA 1~0(WGMx1~0) . 90 , WGMx4~0 ,

모드의 동작 값 레지스터의 업데이트 시점 플랙의 세트 시점을 보여준다, TOP , OCRx , TOVx .

� 비트 분주비와 클럭소스를 선택하여 일 때 클럭입력을 차단하고2~0(CSx2~0: Clock Select x2~x0) : 000 ,
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일때 분주 일때 분주 일때 분주 일때 분주 일때 분주비가 되도록 하고001 1 , 010 8 , 011 64 , 100 256 , 101 1024 110

일때 핀에서 입력되는 외부 클럭의 하강에지에서 카운터 가 동작하고 일때는 핀에서 입력되는 외부Tx x , 111 Tx

클럭의 상승에지에서 카운터 가 동작하도록 한다x .

그림 90 타이머 의 동작 모드 설정출처. 1,3 ( :ATMEL)

4.2.2.4.4.2.2.4.4.2.2.4.4.2.2.4. 레지스터레지스터레지스터레지스터TCCRxCTCCRxCTCCRxCTCCRxC

� 비트 모드가 아닌 경우에만 유효하며 로 설정하면7~5(FOCxA~C:Force Output Compare x A~C) : PWM 1

강제로 에 출력비교가 일치할 때 출력하게 되는 값과 동일한 출력을 내보낸다 이 경우 인터럽트가 발OCxA~C .

생하지도 않고 모드에서 를 클리어시키지도 않으므로 보통 으로 설정한다CTC TCNTx 0 .

4.2.2.5.4.2.2.5.4.2.2.5.4.2.2.5. 레지스터레지스터레지스터레지스터TIMSKTIMSKTIMSKTIMSK

레지스터는 타이머 가 발생하는 인터럽트를 개별적으로 허용 제어하는 레TIMSK(Timer Interrupt MaSK) 0,1,2

지스터이다.

� 비트 로 설정되면 타이머 의 입력캡쳐 인터럽트를 개5(TICIE1:Timer Input Capture Interrupt Enable 1) : 1 1

별적으로 허용한다.

� 비트 로 설정되면 타이머 의4~3(OCIE1A~B: Output Compare match Interrupt Enable timer 1 A~B) : 1 1

출력비교 인터럽트 를 개별적으로 허용한다A, B .

� 비트 로 설정되면 타이머 의 오버플로 인터럽트2(TOIE1:Timer Overflow Interrupt Enable for timer 1) : 1 1

를 개별적으로 허용한다.

4.2.2.6.4.2.2.6.4.2.2.6.4.2.2.6. 레지스터레지스터레지스터레지스터ETIMSKETIMSKETIMSKETIMSK

레지스터는 타이머 이 발생하는 인터럽트를 개별적으로 허용ETIMSK(Extended Timer Interrupt MaSK) 1, 3

제어하는 레지스터이다.

� 비트 로 설정되면 타이머 의 입력캡쳐 인터럽트를 개5(TICIE3:Timer Input Capture Interrupt Enable 3) : 1 3

별적으로 허용한다.

� 비트 로 설정되면 타이머 의4~3(OCIE3A~B: Output Compare match Interrupt Enable timer 3 A~B) : 1 3
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출력비교 인터럽트 를 개별적으로 허용한다A, B .

� 비트 로 설정되면 타이머 의 오버플로 인터럽트2(TOIE3:Timer Overflow Interrupt Enable for timer 1) : 1 3

를 개별적으로 허용한다.

� 비트 로 설정되면 타이머 의 출력비1~0(OCIExC: Output Compare match Interrupt Enable timer x C) : 1 x

교 인터럽트 를 개별적으로 허용한다C .

4.2.2.7.4.2.2.7.4.2.2.7.4.2.2.7. 레지스터레지스터레지스터레지스터TIFRTIFRTIFRTIFR

레지스터는 타이머 가 발생하는 인터럽트 플랙을 저장한다TIFR(Timer Interrupt Frag Register) 0~2 . 소프트웨

어적으로 강제로 클리어 하려면 을 기록해야 한다1 .

� 비트 타이머 의 입력캡쳐신호 또는 아날로그 비교기로부터의 신호에 의해5(ICF1 : Input Capture Flag 1) : 1

캡쳐 동작이 수행될 때 로 세트되고 입력캡쳐 인터럽트가 요청된다 레지스터가 값으로 사용되는 동1 . ICR1 TOP

작 모드에서 의 값이 과 같아질 때 로 세트되고 인터럽트가 요청된다 인터럽트가 서비스되기 시작TCNT1 TOP 1 .

하면 자동적으로 클리어된다.

� 비트 타이머 의 레지스터와 출력비교 레지4~3(OCF1A~B : Output Compare match Flag 1 A~B) : 1 TCNT1

스터 의 값을 비교하여 같으면 는 로 세트되고 출력비교 인터럽트가 요청된다 인터럽트가OCR1A~B OCF1A~B 1 .

서비스되기 시작하면 자동적으로 클리어된다.

� 비트 타이머 에서 오버플로가 발생하면 까지 세고 으로2(TOV1 : Timer Overflow Flag 1) : 1 (0xFFFF 0x0000

넘어가게 되면 이 는 로 세트되면서 오버플로 인터럽트가 요청된다 인터럽트가 서비스되기 시작하면 자) TOV1 1 .

동적으로 클리어된다 모드에서는 타이머 이 에서 계수방향을 바꿀 때 가 세트. Phase correct PWM 1 0x00 TOV1

된다.

4.2.2.8.4.2.2.8.4.2.2.8.4.2.2.8. 레지스터레지스터레지스터레지스터ETIFRETIFRETIFRETIFR

레지스터는 타이머 가 발생하는 인터럽트 플랙을 저장한ETIFR(Extenede Timer Interrupt Frag Register) 1,3

다. 소프트웨어적으로 강제로 클리어 하려면 을 기록해야 한다1 .

� 비트 타이머 의 입력캡쳐신호 또는 아날로그 비교기로부터의 신호에 의해5(ICF3 : Input Capture Flag 3) : 3

캡쳐 동작이 수행될 때 로 세트되고 입력캡쳐 인터럽트가 요청된다 레지스터가 값으로 사용되는 동1 . ICR3 TOP

작 모드에서 의 값이 과 같아질 때 로 세트되고 인터럽트가 요청된다 인터럽트가 서비스되기 시작TCNT3 TOP 1 .

하면 자동적으로 클리어된다.

� 비트 타이머 의 레지스터와 출력비교 레4,3,1(OCF3A,B,C: Output Compare match Flag 3 A,B,C) : 3 TCNT3

지스터 의 값을 비교하여 같으면 는 로 세트되고 출력비교 인터럽트가 요청된다 인터럽트OCR3A~C OCF3A~C 1 .

가 서비스되기 시작하면 자동적으로 클리어된다.

� 비트 타이머 에서 오버플로가 발생하면 까지 세고 으로2(TOV3 : Timer Overflow Flag 3) : 3 (0xFFFF 0x0000

넘어가게 되면 이 는 로 세트되면서 오버플로 인터럽트가 요청된다 인터럽트가 서비스되기 시작하면 자) TOV3 1 .

동적으로 클리어된다 모드에서는 타이머 이 에서 계수방향을 바꿀 때 가 세트. Phase correct PWM 1 0x00 TOV3

된다.

� 비트 타이머 의 레지스터와 출력비교 레지스터0(OCF1C: Output Compare match Flag 1 C) : 1 TCNT1

의 값을 비교하여 같으면 는 로 세트되고 출력비교 인터럽트가 요청된다 인터럽트가 서비스되기OCR1C OCF1C 1 .

시작하면 자동적으로 클리어된다.

4.2.2.9.4.2.2.9.4.2.2.9.4.2.2.9. 타이머 의 일반 모드타이머 의 일반 모드타이머 의 일반 모드타이머 의 일반 모드1, 31, 31, 31, 3

� 설정 의 으로 설정한다: TCCRxA~B WGMx3~0 = 00 .

� 동작 타이머 는 항상 상향 카운터로만 동작한다 의 값이 에서 으로 바뀌는 순간 비: x . TCNTx 0xFFFF 0 TOVx

트가 세트되며 오버플로 인터럽트가 발생이 요청된다 출력비교 인터럽트를 일반모드에서 사용할 수도 있으나.
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모드를 사용하는 것이 좋다FAST PWM .

� 시간간격 설정 오버플로 인터럽트가 요청될 때 마다 인터럽트를 발생시켜 의 초기값: TCNTx 을 적당하게

설정하면 원하는 시간 간격을 얻을 수 있다 의 비트 값에 따라 가 될. TCCRxB 2~0(CSx2~0) 1,8, 64, 256, 1024

수 있으므로 클럭을  로 사용하는 경우 분주비를MHz 이라 하면 다음에 의해 주기 가 결정된다 즉 오버플.

로 인터럽트가 요청되는 시간간격은 이다.

   × 

4.2.2.10.4.2.2.10.4.2.2.10.4.2.2.10. 타이머 의타이머 의타이머 의타이머 의1, 31, 31, 31, 3 모드모드모드모드CTCCTCCTCCTC

� 설정 레지스터의 을 또는 로 설정한다: TCCRxB WGMx3~0 4 12 .

� 동작 모드의 번 모드에서는 의 값이 레지스터에 설: CTC(Clear Timer on Compare match) 4 TCNTx OCRxA

정한 값과 일치되면 그 다음 클럭 사이클에서 의 값이 으로 클리어된다 이때 비트가 세트되며TCNTx 0 . OCFxA

출력비교 인터럽트 발생이 요청된다 이때 인터럽트를 발생시켜 의 값을 바꾸면 주기를 원하는 대로 변경. OCRxA

할 수 있다 단자로 하여금 출력파형을 발생하도록 할 수 있는데 을 로 설정하고 레. OCx COMxn1~0 01 OCRxA

지스터 값을 바꿔가면서 출력비교에 의해 의 신호를 토글하는 경우는 그림 과 비슷하다여기에서OCxn 86 ( x=1,3,

번 모드에서는 의 값이 입력캡춰 레지스터 에 설정한 값과 일치되면 그 다음 클럭 사n=A,B,C). 12 TCNTx ICRx

이클에서 의 값이 으로 클리어된다 이때 비트가 세트되며 입력캡춰 인터럽트 발생이 요청된다 이TCNTx 0 . ICFx .

때 인터럽트를 발생시켜 의 값을 바꾸면 주기를 원하는 대로 변경할 수 있다 단자로 하여금 출력파ICRx . OCxn

형을 발생하도록 할 수 있는데 을 로 설정하고 레지스터 값을 바꿔가면서 출력비교에 의해COMxn1~0 01 OCRxn

의 신호를 토글하는 경우는 그림 과 비슷하다OCxn 86 .

� 주기 설정 을 로 설정하고 나 레지스터 값을 어떤 일정한 값 로 놓고 출력비: COMxn1~0 01 OCRxA ICRx CR0

교에 의해 의 신호를 토글하는 경우 의 비트 값에 따라 의 분주OCxn TCCRxB 2~0(CSx2~0) 1,8, 64, 256, 1024

비로 분주되므로 클럭을  로 사용하고 분주비를MHz 이라 하면 다음에 의해 주기 가 결정된다 즉 오버플로.

인터럽트가 요청되는 시간간격은 이다.

    

4.2.2.11.4.2.2.11.4.2.2.11.4.2.2.11. 타이머 의 고속타이머 의 고속타이머 의 고속타이머 의 고속1, 31, 31, 31, 3 모드모드모드모드PWMPWMPWMPWM

� 설정 레지스터의 을 로 설정한다: TCCRxB WGMx3~0 5,6,7,14,15 .

� 동작 는 반복적으로 업카운팅하며 항상 의 값을 갖는다 의 값은 모드 번호에 따: TCNTx 0x0000~TOP . TOP

라 을 갖는다그림 참조 의 값이 값과 일치되면 그 다0x00FF, 0x1FF, 0x03FF, ICRx, OCRxA ( 90 ). TCNTx TOP

음 사이클에서 으로 클리어되며 비트가 세트되어 출력비교 인터럽트가 요청되거나 비트가 세트되어0 OCFxA ICFx

입력캡춰 인터럽트가 요청되거나 비트가 세트되어 오버플로 인터럽트가 요청될 수 있으며 와TOVx OCRxA TOP

값을 업데이트 할 수 있다 을 으로 세팅한 경우 의 값은 나 값과 같아지면. COMxn1~0 10 TCNTx ICRx OCRxn

의 값은 으로 클리어 된다 그리고 는 업카운팅을 계속하여 까지 증가했다가 으로 바뀌는 순OCxn 0 . TCNTx TOP 0

간 는 로 세트된다 인터럽트가 요청될 때 인터럽트를 발생시켜 값이나 의 값을 바꾸어 듀OCxn 1 . TOP OCRxn

티비를 제어할 수 있다 레귤레이터 정류 및 변환에 적합하다 특히 고주파를 사용하기 때문에 코일 콘덴서. , DA . ,

등 외부소자가 필요 없어 비용을 절감시킬 수 있다.

� 주기설정 값을 업카운팅하므로 의 비트 값에 따라 의 분: 0~TOP TCCRxB 2~0(CSx2~x0) 1,8, 64, 256, 1024

주비로 분주되므로 클럭을  로 사용하고 분주비를MHz 이라 하면 다음에 의해 파형의 주기 가 결정된다 즉.

오버플로 인터럽트가 요청되는 시간간격은 이다.

    ×

4.2.2.12.4.2.2.12.4.2.2.12.4.2.2.12. 타이머 의타이머 의타이머 의타이머 의1, 3 Phase Correct1, 3 Phase Correct1, 3 Phase Correct1, 3 Phase Correct 모드모드모드모드PWMPWMPWMPWM

� 설정 레지스터의 을 로 설정한다: TCCRxB WGMx3~0 1, 2, 3, 10, 11 .

� 동작 는 업카운팅하여 으로 증가하다가 다운카운팅으로 으로 감소를 반복한다 의: TCNTx TOP 0x0000 . TOP
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값은 모드 번호에 따라 을 갖는다그림 참조 가 값에0x00FF, 0x1FF, 0x03FF, ICRx, OCRxA ( 90 ). TCNTx TOP

도달하면 의 값이 경신되고 비트가 세트되어 출력비교 인터럽트가 요청되거나 비트가OCRxn, TOP OCFxA ICFx

세트되어 입력캡춰 인터럽트가 요청될 수 있다 가 에 도달하면 비트가 세트되어 오버플로. TCNTx 0x0000 TOVx

인터럽트가 요청될 수 있다 을 으로 세팅한 경우 의 값이 레지스터에 설정한 값과. COMxn1~0 10 TCNTx OCRxn

일치되면 의 값은 상향 카운팅의 경우에는 으로 하향의 경우에는 로 세트된다 그리고 는 업카운OCxn 0 1 . TCNTx

팅을 계속하여 에 도달하면 하향카운팅이 시작된다그림 참조 모드에서는 레지스터에TOP ( 88 ). PC PWM OCRxn

이중 버퍼링 기능이 있어 주기를 변경하기 위해 레지스터에 새로운 값을 기록하더라도 즉시 변경PWM OCRxn

되지 않고 이 에 도달하면 갱신된다그림 참조 레지스터 값과 듀티비가 비례함을 그림TCNTxn TOP ( 88 ). OCRxn

에서 알 수 있다88 .

� 주기 설정 값을 업다운 카운팅하므로 의 비트 값에 따라: 0~TOP / TCCRxB 2~0(CSx2~x0) 1,8, 64, 256,

의 분주비로 분주되므로 클럭을1024  로 사용하고 분주비를MHz 이라 하면 다음에 의해 주기 가 결정된다.

즉 오버플로 인터럽트가 요청되는 시간간격은 이다.

   ×

4.2.2.13.4.2.2.13.4.2.2.13.4.2.2.13. 타이머 의타이머 의타이머 의타이머 의1, 3 Phase and Frequency Correct1, 3 Phase and Frequency Correct1, 3 Phase and Frequency Correct1, 3 Phase and Frequency Correct 모드모드모드모드PWMPWMPWMPWM

� 설정 레지스터의 을 로 설정한다: TCCRxB WGMx3~0 8,9 .

� 동작 모드와 거의 똑같고 다른 점은 의 값이 모드 번호에 따라 만을 갖는다는: PC PWM TOP ICRx, OCRxA

것이고 새로운 값으로의 경신이 가 일 때 이루어진다는 것이다그림 참조 는 업카운팅하여TCNTx 0 ( 90 ).TCNTx

으로 증가하다가 다운카운팅으로 으로 감소를 반복한다 가 값에 도달하면 비트TOP 0x0000 . TCNTx TOP OCFxA

가 세트되어 출력비교 인터럽트가 요청되거나 비트가 세트되어 입력캡춰 인터럽트가 요청될 수 있다ICFx .

가 에 도달하면 의 값이 경신되고 비트가 세트되어 오버플로 인터럽트가 요청TCNTx 0x0000 OCRxn, TOP TOVx

될 수 있다 을 으로 세팅한 경우 의 값이 레지스터에 설정한 값과 일치되면. COMxn1~0 10 TCNTx OCRxn OCxn

의 값은 상향 카운팅의 경우에는 으로 하향의 경우에는 로 세트된다 그리고 는 업카운팅을 계속하여0 1 . TCNTx

에 도달하면 하향카운팅이 시작된다그림 참조TOP ( 88 ).

� 주기설정 과 동일: Phase Correct PWM .

4.2.2.14.4.2.2.14.4.2.2.14.4.2.2.14. 출력비교 변조출력비교 변조출력비교 변조출력비교 변조

그림 91 타이머 를 이용한 출력비교 변조의 예. 1,2

� 설정 타이머 용 출력비교 설정을 위한 레지스터의 비트 를 이나 로 설정하: 1 TCCR1A 3~2(COM1C1~0) 10 11

여 출력비교가 이루어지도록 하는 동시에 타이머 용 출력비교 설정을 위한 레지스터의 비트2 TCCR2

를 로 설정하여 출력비교가 이루어지도록하고 로 한다5~4(COM21~0) 01~11 DDRB.7=1 .
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� 동작 의 값을 로 세트시키면 와 의 신호를 시킨 것이 번핀 에: PORTB.7 1 OC1C OC2 OR 17 (PB7, OC1C, OC2)

서 출력되고 으로 하면 와 를 시킨 신호가 번핀에서 출력된다0 0C1C OC2 AND 17 .

4.2.3.4.2.3.4.2.3.4.2.3.4.2.3.4.2.3.4.2.3.4.2.3.4.2.3.4.2.3.4.2.3.4.2.3. 실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸24 : LED 124 : LED 124 : LED 124 : LED 1실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸24 : LED 124 : LED 124 : LED 124 : LED 1실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸24 : LED 124 : LED 124 : LED 124 : LED 1

� 예제 타이머 의 일반모드를 이용하여 밀리초 간격으로 오버플로 인터럽트를 발생시켜 에 연결된: 0 10 PORTC

가 칸씩 왼쪽으로 회전시키며 점멸시킨다LED 1 .

� 회로도 그림 의 을 그림 의 에 연결하고 실험할 때는 를 닫고 한다: 80 SW_CON 79 D_CON LEDSW .

� 프로그램 작성시 유의점 디버깅시 를 누르고 창의 와 의 변화를 관찰하: [Auto Step] IO View TCNT0 PORTC

라 그림 과 같이 타이머 의 오버플로 인터럽트는 번이다 에서 인터럽트. 83 0~3 17, 15, 11, 30 . CodeVisoinAVR

번호에 따른 이름을 로 에 정의해 놓았다 이를 이용해도 된다 시뮬레이션에TIM0_OVF~TIM3_OVF mega128.h . .

서는 밀리초의 간격으로 회전시키면 시간이 너무 많이 걸리므로 줄여서 구현하라10 .

� 프로그램 예 :

#include <mega128.h>
unsigned char led = 0xfe;
unsigned int cnt;

로 해도 됨interrupt [17] void timerint0(void){ // interrupt [TIM0_OVF] void timerint0(void)
if(cnt++ >= 9999){ // 10000*1 = 10000 usec
cnt = 0;
if(led!=0x7f) led = (led << 1) | 0x01; 비트 을 안켰으면 비트씩 좌로 시프트하고 빈자리에는 을 채운다// 7 1 1 .
else led = 0xfe; } 비트 을 켰으면 다시 처음으로 와서 비트 을 켠다// 7 0 .
TCNT0 = 240; 재정의 와 분주비 사용시// 1usec = 1*(256-240)/16 16MHz 1
PORTC = led;

}
void main(void){

포트 를 출력으로DDRC = 0xff; // C
PORTC = led;
SREG |= 0x80; 인터럽트 전체 허용//
TIMSK |= 1; 타이머 오버플로 인터럽트 개별허용// 0
TCCR0 |= 1; 분주비를 로 설정// 1
TCNT0 = 240;
while(1);

}

� 과제 동일한 일을 타이머 을 이용하여 수행하라 초 간격으로 가 증가하는 형태로 켜지도록 프: 1~3 . 1 LED① ②

로그램하라.

4.2.4.4.2.4.4.2.4.4.2.4.4.2.4.4.2.4.4.2.4.4.2.4.4.2.4.4.2.4.4.2.4.4.2.4. 실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸25 : LED 225 : LED 225 : LED 225 : LED 2실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸25 : LED 225 : LED 225 : LED 225 : LED 2실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸25 : LED 225 : LED 225 : LED 225 : LED 2

� 예제 타이머 의 일반모드를 이용하여 오버플로 인터럽트를 발생시키지 말고 밀리초 간격으로 에: 1 100 PORTC

연결된 가 칸씩 왼쪽으로 회전시키며 점멸시킨다LED 1 .

� 회로도 그림 의 을 그림 의 에 연결하고 실험할 때는 를 닫고 한다: 80 SW_CON 79 D_CON LEDSW .

� 프로그램 작성시 유의점 타이머 는 초기값에서 시작하여 까지 다 세면오버플로가 발생하면: 1 0xFFFF ( ) TOV1

가 로 세트된다 문을 이용하여 가 세트되는 것을 감시하여 인터럽트 발생없이 에 연결된1 . while TOV1 PORTC

를 왼쪽으로 회전시키며 점멸시킨다 인터럽트를 발생시키지 않았기 때문에 는 자동으로 클리어되지LED . TOV1

않기 때문에 오버플로가 발생할 때마다 클리어 시켜야 됨을 유의해야 한다. 인터럽트 플랙의 클리어는 을 기록1

해야 된다. 시뮬레이션에서는 밀리초의 간격으로 회전시키면 시간이 너무 많이 걸리므로 줄여서 구현하라100 .

� 프로그램 예 :

#include <mega128.h>
unsigned char led = 0xfe;
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void delay_i_ms(unsigned int i){
do{
while(!(TIFR & 0x04)); 가 세트되었는지 확인// TOV1
TIFR |= 0x04; 인터럽트 발생없이 타이머 사용했으므로 자동적으로 클리어되지 않으므로 강제로 클리어/* */

재정의 초를 얻기 위한 시간정수TCNT1H = (65536-16000)/256; TCNT1L = (65536-16000) % 256; /* , 1msec */
i--;
} while(i);

}
void main(void){

포트 를 출력으로DDRC = 0xff; // C
TCCR1B |= 1; 분주비를 로 설정// 1
TCNT1H = (65536-16000)/256; TCNT1L = (65536-16000) % 2;
for(;;){
PORTC = led;
if (led != 0x7f) led = (led << 1 ) | 0x01; else led = 0xfe;
delay_i_ms(100); } 시간 지연/* 100*1 msec */

}

� 과제 동일한 일을 타이머 을 이용하여 수행하라 초 간격으로 가 증가하는 형태로 켜지도록: 0,2,3 . 0.1 LED① ②

프로그램하라.

4.2.5.4.2.5.4.2.5.4.2.5.4.2.5.4.2.5.4.2.5.4.2.5.4.2.5.4.2.5.4.2.5.4.2.5. 실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸26 : LED 326 : LED 326 : LED 326 : LED 3실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸26 : LED 326 : LED 326 : LED 326 : LED 3실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸26 : LED 326 : LED 326 : LED 326 : LED 3

� 예제 타이머 의 모드를 이용하여 밀리초 간격으로 출력비교 인터럽트를 발생시켜 에 연결: 2 CTC 500 PORTC

된 가 칸씩 왼쪽으로 회전시키며 점멸시킨다LED 1 .

� 회로도 그림 의 을 그림 의 에 연결하고 실험할 때는 를 닫고 한다: 80 SW_CON 79 D_CON LEDSW .

� 프로그램 작성시 유의점 그림 과 같이 출력비교 인터럽트는 타이머 타이머 타이머: 83 16( 0), 13( 1A), 14( 1B)

타이머 타이머 타이머 타이머 타이머 번이다 에서 인터럽트25( 1C), 10( 2), 27( 3A), 28( 3B), 29( 3C) . CodeVisoinAVR

번호에 따른 이름을 여기에서 는 은 로 에 정의해 놓았다 이를 이용해TIMx_COMPn( x 0~3, n A,B,C) mega128.h .

도 된다 시뮬레이션에서는 밀리초의 간격으로 회전시키면 시간이 너무 많이 걸리므로 줄여서 구현하라. 500 .

� 프로그램 예 :

#include <mega128.h>
unsigned char led = 0xfe;
unsigned int cnt;

로 해도 됨interrupt [10] void timerint(void){ // interrupt [TIM2_COMP] void timerint(void)
if(cnt++ >= 49999){ // 50000*10 = 500 msec
cnt = 0;
if(led!=0x7f) led = (led << 1) | 0x01; 비트 을 안켰으면 비트씩 좌로 시프트하고 빈자리에는 을 채운다// 7 1 1 .
else led = 0xfe; } 비트 을 켰으면 다시 처음으로 와서 비트 을 켠다// 7 0 .
PORTC = led;

}
void main(void){

포트 를 출력으로DDRC = 0xff; // C
PORTC = led;
SREG |= 0x80; 인터럽트 전체 허용//
TIMSK |= 0x80; 타이머 출력비교 인터럽트 개별허용// 2
TCCR2 |= 1; 분주비를 로 설정// 1
TCCR2 |= 0x20; // CTC mode
OCR2 = 159; 와 분주비 사용시// 10usec = 1*(1+159)/16 16MHz 1
for(;;);

}

� 과제 동일한 일을 타이머 을 이용해서 수행하라 동일한 일을 실험 와 비슷한 요령으로 인터럽트: 0,1,3 . 25① ②

발생없이 를 감시하면서 를 회전시키면 점멸시키는 프로그램을 구현해보라OCF2 LED .
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4.2.6.4.2.6.4.2.6.4.2.6.4.2.6.4.2.6.4.2.6.4.2.6.4.2.6.4.2.6.4.2.6.4.2.6. 실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸27 : LED 427 : LED 427 : LED 427 : LED 4실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸27 : LED 427 : LED 427 : LED 427 : LED 4실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸27 : LED 427 : LED 427 : LED 427 : LED 4

� 예제 타이머 의 모드를 이용하여 밀리초 간격으로 오버플로 인터럽트 플랙을 감시하여 인터: 3 Fast PWM 500

럽트 발생없이 에 연결된 가 칸씩 왼쪽으로 회전시키며 점멸시킨다PORTC LED 1 .

� 회로도 그림 의 을 그림 의 에 연결하고 실험할 때는 를 닫고 한다: 80 SW_CON 79 D_CON LEDSW .

� 프로그램 작성시 유의점 타이머 는 초기값에서 시작하여 모드번호에 따라 다른 값을 갖는다 값까지: 3 TOP( )

다 세면오버플로가 발생하면 가 로 세트된다 문을 이용하여 가 세트되는 것을 감시하여 인( ) TOV3 1 . while TOV3

터럽트 발생없이 에 연결된 를 왼쪽으로 회전시키며 점멸시킨다 인터럽트를 발생시키지 않았기 때PORTC LED .

문에 는 자동으로 클리어되지 않기 때문에 오버플로가 발생할 때마다 클리어 시켜야 됨을 유의해야 한다TOV3 .

인터럽트 플랙의 클리어는 을 써주어야 한다1 . 시뮬레이션에서는 밀리초의 간격으로 회전시키면 시간이 너무500

많이 걸리므로 줄여서 구현하라.

� 프로그램 예 :

#include <mega128.h>
unsigned char led = 0xfe;
void delay_i_ms(unsigned int i){

do{
while(!(ETIFR & 0x04)); 가 세트되었는지 확인// TOV3
ETIFR |=0x04; 인터럽트 발생없이 타이머 사용했으므로 강제로 클리어/* */
i--;
} while(i);

}
void main(void){

포트 를 출력으로DDRC = 0xff; // C
TCCR3B |= 1; 분주비를 로 설정// 1
TCCR3A |= 0b00000011; 고속 모드의 번으로 설정 하여 를 로 설정// PWM 15 TOP OCR3A
TCCR3B |= 0b00011000; 고속 모드의 번으로 설정 하여 를 로 설정// PWM 15 TOP OCR3A
ETIMSK |= 0x04; 타이머 오버플로 인터럽트 개별허용// 3
OCR3AH = (unsigned char) 15999/256;
OCR3AL = (unsigned char) 15999%256; 시간지연// 1msec
for(;;){
PORTC = led;
if (led != 0x7f) led = (led << 1 ) | 0x01; else led = 0xfe;
delay_i_ms(500); } 시간 지연/* 500*1 msec */

}

� 과제 동일한 일을 타이머 을 이용해서 수행하라 초 간격으로 가 증가하는 형태로 켜지도록 프로: 1 . 1 LED① ②

그램하라 인터럽트를 사용해서 동일한 일을 하도록 구현해보라. .③

4.2.7.4.2.7.4.2.7.4.2.7.4.2.7.4.2.7.4.2.7.4.2.7.4.2.7.4.2.7.4.2.7.4.2.7. 실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸28 : LED 528 : LED 528 : LED 528 : LED 5실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸28 : LED 528 : LED 528 : LED 528 : LED 5실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸실험 타이머를 이용한 점멸28 : LED 528 : LED 528 : LED 528 : LED 5

� 예제 타이머 의 모드를 이용하여 밀리초 간격으로 오버플로 인터럽트을 사용하여: 1 Phase Correct PWM 500

에 연결된 가 칸씩 왼쪽으로 회전시키며 점멸시킨다PORTC LED 1 .

� 회로도 그림 의 을 그림 의 에 연결하고 실험할 때는 를 닫고 한다: 80 SW_CON 79 D_CON LEDSW .

� 프로그램 작성시 유의점 타이머 는 초기값에서 시작하여 모드번호에 따라 다른 값을 갖는 값까지 상향: 1 TOP

카운팅을 하다가 다시 하향카운팅을 하여 에 도달하면 가 로 세트된다 시뮬레이션에서는 밀리초의0 TOV1 1 . 500

간격으로 회전시키면 시간이 너무 많이 걸리므로 줄여서 구현하라.

� 프로그램 예 :

#include <mega128.h>
unsigned char led = 0xfe;
unsigned int cnt;



- 103 -

로 해도 됨interrupt [15] void timerint(void){ // interrupt [TIM1_OVF] void timerint(void)
if(cnt++ == 499){ // 500*1 = 500 msec
cnt = 0;
if(led!=0x7f) led = (led << 1) | 0x01; 비트 을 안켰으면 비트씩 좌로 시프트하고 빈자리에는 을 채운다// 7 1 1 .
else led = 0xfe; } 비트 을 켰으면 다시 처음으로 와서 비트 을 켠다// 7 0 .
PORTC = led;

}
void main(void){

포트 를 출력으로DDRC = 0xff; // C
PORTC = led;
SREG |= 0x80; 인터럽트 전체 허용//
TCCR1B |= 1; 분주비를 로 설정// 1
TCCR1A |= 0b00000011; 모드의 번으로 설정 하여 를 로 설정// PC PWM 11 TOP OCR1A
TCCR1B |= 0b00010000; 모드의 번으로 설정 하여 를 로 설정// PC PWM 11 TOP OCR1A
TIMSK |= 0x04; 타이머 오버플로 인터럽트 개별허용과 타이머 스타트// 1
OCR1A = 8000; 시간지연// 1msec
for(;;);

}

� 과제 동일한 일을 타이머 를 이용해서 수행하라 초 간격으로 가 증가하는 형태로 켜지도록 프로: 3 . 1 LED① ②

그램하라 인터럽트를 사용하지 말고 인터럽트 플랙을 감시하여 동일한 일을 하도록 구현해보라. .③

4.2.8.4.2.8.4.2.8.4.2.8.4.2.8.4.2.8.4.2.8.4.2.8.4.2.8.4.2.8.4.2.8.4.2.8. 실험 워치독 타이머실험 워치독 타이머실험 워치독 타이머실험 워치독 타이머29 :29 :29 :29 :실험 워치독 타이머실험 워치독 타이머실험 워치독 타이머실험 워치독 타이머29 :29 :29 :29 :실험 워치독 타이머실험 워치독 타이머실험 워치독 타이머실험 워치독 타이머29 :29 :29 :29 :

� 예제 타이머 의 일반모드를 이용하여 초 간격으로 오버플로 인터럽트를 발생시켜 에 연결된: 0 1 PORTC LED

로 를 반복적으로 쓴다 워치독 타이머의 주기기 완료되기 전에 워치독 타이머를 리셋하지 않으면 워치독 리0~9 .

셋이 발생하는 것을 배워본다.

� 회로도 그림 의 을 그림 의 에 연결하고 실험할 때는 를 닫고 한다: 80 SW_CON 79 D_CON LEDSW .

� 프로그램 작성시 유의점 시뮬레이션에서는 초의 간격으로 점멸시키면 시간이 너무 많이 걸리므로 줄여서: 1

구현하라.

� 프로그램 예 :

#include <mega128.h>
unsigned char led = 0x00;
unsigned int cnt;

로 해도 됨interrupt [17] void timerint0(void){ // interrupt [TIM0_OVF] void timerint0(void)
if(cnt++ >= 999){ // 1000*1 = 1 sec
cnt = 0;
if(led++==9) led=0; } 이면 다시 처음으로 와서 비트 을 켠다// 9 0 .
TCNT0 = 6; 재정의 와 분주비 사용시// 1msec = 64*(256-6)/16 16MHz 64
PORTC = ~led;
#asm("wdr");

}
void main(void){

포트 를 출력으로DDRC = 0xff; // C
PORTC = ~led;
SREG |= 0x80; 인터럽트 전체 허용//
TIMSK |= 1; 타이머 오버플로 인터럽트 개별허용// 0
TCCR0 |= 4; 분주비를 로 설정// 64
TCNT0 = 6;
WDTCR = 0x18;
WDTCR = 0x0f; 워치독 타이머 타임아웃 주기 약 초로 설정// 2 .
while(1);

}

� 과제 를 없애고 수행해보라 동일한 일을 타이머 을 이용하여 수행하라: #asm("wdr") . 1~3 .① ②
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4.2.9.4.2.9.4.2.9.4.2.9.4.2.9.4.2.9.4.2.9.4.2.9.4.2.9.4.2.9.4.2.9.4.2.9. 실험실험실험실험30 :30 :30 :30 :실험실험실험실험30 :30 :30 :30 :실험실험실험실험30 :30 :30 :30 : 타이머를 이용한 카운터타이머를 이용한 카운터타이머를 이용한 카운터타이머를 이용한 카운터타이머를 이용한 카운터타이머를 이용한 카운터타이머를 이용한 카운터타이머를 이용한 카운터타이머를 이용한 카운터타이머를 이용한 카운터타이머를 이용한 카운터타이머를 이용한 카운터

� 예제 타이머 를 카운터로 사용해 번핀에 연결된 스위치가 눌릴 때마다 에 연결된: 2 T2(PD7, 32 ) PORTC LED

가 증가형태로 점멸한다.

� 회로도 그림 의 을 그림 의 에 연결하고 실험할 때는 를 닫고 한다 또한 그림: 80 SW_CON 79 D_CON LEDSW .

의 을 누르면서 실험한다80 SW8 .

� 프로그램 작성시 유의점 스위치가 눌리면 하강에지가 발생한다 이때 입력캡쳐 인터럽트 플랙 을 클리: . ICF1

어하고 스위치가 해제될 때 상승에지가 발생하므로 시뮬레이션에서는 초의 간격으로 점멸시키면 시간이 너무1

많이 걸리므로 줄여서 구현하라.

� 프로그램 예 :

#include <mega128.h>
#include <delay.h>
void main(void){

DDRC = 0xff; 포트 를 출력으로// C
TCCR0 |= 6; 하강에지에서 카운트//
TCNT2 = 0; 초기화// TCNT2
while(1){ PORTC = ~TCNT2; delay_ms(5);}

}

� 과제 실제 구현 했을 때 한 번 누를 때마다 하나씩 이동하지 않고 여러 개가 이동하는 현상이 발생할 수: ①

도 있을 것이다 이는 실험 에서도 이야기한 채터링에 의한 현상이다 의 값을 변화시켜 가면서. 16 . delay_ms(5)

실험해 보고 적정한 시간 지연을 찾아 보아라 그림 의 회로 대신 그림 의 회로를 이용하되 시간지연을. 80 84②

작게 해서 실험해보고 비교해보라 동일한 일을 타이머 을 사용해서 구현해 보라. 1,3 .③

4.2.10.4.2.10.4.2.10.4.2.10.4.2.10.4.2.10.4.2.10.4.2.10.4.2.10.4.2.10.4.2.10.4.2.10.실험실험실험실험31 :31 :31 :31 :실험실험실험실험31 :31 :31 :31 :실험실험실험실험31 :31 :31 :31 : 펄스 폭 측정펄스 폭 측정펄스 폭 측정펄스 폭 측정펄스 폭 측정펄스 폭 측정펄스 폭 측정펄스 폭 측정펄스 폭 측정펄스 폭 측정펄스 폭 측정펄스 폭 측정

� 예제 번핀에 연결된 스위치가 눌린 시간을 즉 펄스 폭을 측정하여 에 연결된 에: IC1(PD4, 29 ) PORTC LED

단위로 표시한다msec .

� 회로도 그림 의 을 그림 의 에 연결하고 실험할 때는 를 닫고 한다 또한 그림: 80 SW_CON 79 D_CON LEDSW .

의 을 누르면서 실험한다 분주비를 로 한다 결국 의 해상도로 최대80 SW5 . 64 . 4 usec 64*65536/16 usec =

까지 펄스폭을 잴 수 있다 대충 값만큼의 로 펄스폭이 구해짐을 알 수있다256msec . ICR1H msec .

� 프로그램 예 :

#include <mega128.h>
#include <delay.h>
void main(void){
unsigned char pwidth;

DDRC = 0xff; 포트 를 출력으로// C
while(1){
TCCR1B |= 0x03; 분주 타이머 시작// 64
TIFR |= 0x20; 클리어// ICF1
while(!(TIFR & 0x20)); 하강에지가 검출될 때까지 기다린다// .
TIFR |= 0x20; 하강에지가 검출되었으므로 을 클리어// ICF1
TCNT1 = 0;
TCCR1B |=0x40; 상승에지에서 캡춰하도록 설정//
TCCR1B |= 0x03; 분주// 64
while(!(TIFR & 0x20)); 상승에지가 검출될 때까지 기다린다// .
pwidth = (unsigned char) (( 256*ICR1H + ICR1L )*4 /1000);
PORTC = ~pwidth; delay_ms(50);}

}

� 과제 타이머 를 사용해서 구현해 보라: 3 .
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4.3.4.3.4.3.4.3.4.3.4.3.4.3.4.3.4.3.4.3.4.3.4.3. 인터럽트와인터럽트와인터럽트와인터럽트와인터럽트와인터럽트와인터럽트와인터럽트와인터럽트와인터럽트와인터럽트와인터럽트와 타이머 복합 실험타이머 복합 실험타이머 복합 실험타이머 복합 실험타이머 복합 실험타이머 복합 실험타이머 복합 실험타이머 복합 실험타이머 복합 실험타이머 복합 실험타이머 복합 실험타이머 복합 실험

4.3.1.4.3.1.4.3.1.4.3.1.4.3.1.4.3.1.4.3.1.4.3.1.4.3.1.4.3.1.4.3.1.4.3.1. 실험 점멸 속도 조절실험 점멸 속도 조절실험 점멸 속도 조절실험 점멸 속도 조절32 : LED32 : LED32 : LED32 : LED실험 점멸 속도 조절실험 점멸 속도 조절실험 점멸 속도 조절실험 점멸 속도 조절32 : LED32 : LED32 : LED32 : LED실험 점멸 속도 조절실험 점멸 속도 조절실험 점멸 속도 조절실험 점멸 속도 조절32 : LED32 : LED32 : LED32 : LED

� 예제 에 연결된 가 초 간격으로 왼쪽으로 회전하며 점멸하다가 핀 에 연: PORTC LED 0.1 INT0(PORTD.0, 25)

결된 스위치를 누르면 상승 에지 트리거에 의한 인터럽트가 발생하여 속도가 느려지고 핀 에INT1(PORTD.1, 26)

연결된 푸시버튼을 누르면 회전 속도가 빨라진다.

� 프로그램 작성시 유의점 일정한 시간 간격을 얻기 위해 타이머 의 일반모드 인터럽트를 사용한다 최대로 느: 0 .

린 회전속도 간격은 초이고 빠른 간격은 초로 한다 시뮬레이션에서는 너무 느리므로 타이머 인터럽트0.15 0.05 .

서비스 루틴의 시간지연을 조정 한다 실제 하드웨어 구현할 때는 제거한다. .

� 회로도 그림 의 을 그림 의 에 연결하고 실험할 때는 를 닫고 한다 또한 그림: 80 SW_CON 79 D_CON LEDSW .

의 를 누르면서 실험한다80 SW1, SW2 .

� 프로그램 예 :

#include <mega128.h>
unsigned char led=0xfe;
unsigned int cnt, delaytime, step, delaymax, delaymin;

처럼 에 저장된 정의를 사용해도 됨interrupt [2] void exint0(void){ // interrupt [EXT_INT0] void exint0(void) mega128.h
if( delaytime + step <= delaymax ) delaytime += step;

}
처럼 에 저장된 정의를 사용해도 됨interrupt [3] void exint1(void){ // interrupt [EXT_INT1] void exint1(void) mega128.h

if( delaytime - step >= delaymin ) delaytime -= step;
}

로 해도 됨interrupt [17] void timerint0(void){ // interrupt [TIM0_OVF] void timerint0(void)
if(cnt-- == 1){ //
cnt = delaytime;
if(led!=0x7f) led = (led << 1) | 0x01; else led = 0xfe; }
TCNT0 = 6; PORTC = led;

}
void main(void){

포트 를 출력으로DDRC = 0xff; // C
PORTC = led;
SREG |= 0x80; 인터럽트 전체 허용//
EIMSK |= 0b00000011; 개별 허용// INT0, 1
EICRA |= 0x0f; 상승에지 트리거// INT0, 1
TIMSK |= 1; 타이머 오버플로 인터럽트 개별허용// 0
TCCR0 |= 4; 분주비를 로 설정// 64
TCNT0 = 6; // 64*(256-6)/16=1000usec = 1msec
delaytime = 100; cnt = delaytime; 점멸회전주기를 초로 초기화/* 100*0.001 = 0.1 */
delaymax = 1000; delaymin = 10; 점멸회전주기의 최대값과 최소값을 초와 초로 초기화/* 1 0.01 */
step = 10; 주기 변경 폭을 으로 초기화/* 10 */
while(1);

}

� 과제 동일한 일을 수행하되 타이머 대신에 타이머 을 사용하는 프로그램을 작성하라: 0 1~3 .① ②

핀 에 연결된 푸시버튼를 누르면 속도가 변하지 않고 점멸 회전 방향이 바뀌는 프로그INT3(PORTD.2, 27)) LED

램을 작성하라.

4.3.2.4.3.2.4.3.2.4.3.2.4.3.2.4.3.2.4.3.2.4.3.2.4.3.2.4.3.2.4.3.2.4.3.2. 실험실험실험실험33 :33 :33 :33 :실험실험실험실험33 :33 :33 :33 :실험실험실험실험33 :33 :33 :33 : 스톱 워치스톱 워치스톱 워치스톱 워치스톱 워치스톱 워치스톱 워치스톱 워치스톱 워치스톱 워치스톱 워치스톱 워치

� 예제 핀 에 연결된 스위치를 누르면 상승 에지 트리거에 의한 인터럽트가 발생하여 타: INT0(PORTD.0, 25)

이머 의 카운팅이 정지되고 다시 한번 누르면 카운팅을 시작한다1 .
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� 회로도 그림 의 을 그림 의 에 연결하고 실험할 때는 를 닫고 한다 또한 그림: 80 SW_CON 79 D_CON LEDSW .

의 를 누르면서 실험한다80 SW1 .

� 프로그램 예 :

#include <mega128.h>
unsigned char led, onoff=1;

처럼 에 저장된 정의를 사용해도 됨interrupt [2] void exint0(void){ // interrupt [EXT_INT0] void exint0(void) mega128.h
if(onoff == 0) onoff = 1; else onff=0;

}
void delay_i_ms(unsigned int i){

do{
while(!(TIFR & 0x04)); 가 세트되었는지 확인// TOV1
TIFR |= 0x04; 인터럽트 발생없이 타이머 사용했으므로 자동적으로 클리어되지 않으므로 강제로 클리어/* */

재정의 초를 얻기 위한 시간정수TCNT1H = (65536-16000)/256; TCNT1L = (65536-16000) % 256; /* , 1msec */
i--;
} while(i);

}
void main(void){

포트 를 출력으로DDRC = 0xff; // C
포트 를 입력으로 디폴트 입력으로 설정되어 있으므로 필요하지는 않음DDRD = 0x00; // D

SREG.7 = 1; 인터럽트 전체 허용//
EIMSK |= 0x01; 개별 허용// INT0
EICRA |= 3; 상승에지 트리거//
TCCR1B |= 1; 타이머에 클록을 분주로 클록 공급// 1
TCNT1H = (65536-16000)/256; TCNT1L = (65536-16000) % 256;
for(;;){
PORTC = ~led ;

시간 지연delay_i_ms(1000); /* 1 sec */
if(onoff==0) led++;}

}

� 과제 타이머 를 사용하는 프로그램을 작성하라 타이머 의 인터럽트를 사용해서 구현해보라: 0,2,3 . 0~3 .① ②

4.3.3.4.3.3.4.3.3.4.3.3.4.3.3.4.3.3.4.3.3.4.3.3.4.3.3.4.3.3.4.3.3.4.3.3. 실험실험실험실험34 :34 :34 :34 :실험실험실험실험34 :34 :34 :34 :실험실험실험실험34 :34 :34 :34 : 신호 발생신호 발생신호 발생신호 발생PWM 1PWM 1PWM 1PWM 1신호 발생신호 발생신호 발생신호 발생PWM 1PWM 1PWM 1PWM 1신호 발생신호 발생신호 발생신호 발생PWM 1PWM 1PWM 1PWM 1

� 예제 에 연결된 가 핀 에 연결된 푸쉬버튼을 누르면 점점 밝아지고: PORTC LED INT0(PORTD.0, 25)

핀 에 연결된 푸시버튼을 누르면 어두워진다INT1(PORTD.1, 26) .

� 프로그램 작성시 유의점 일정한 시간간격에서 이 지속되는 시간을 조절하여 밝기를 조절한다 일정한 시간: 1 .

간격을 얻기 위해 타이머 를 사용한다2 .

� 회로도 그림 의 을 그림 의 에 연결하고 실험할 때는 를 닫고 한다 또한 그림: 80 SW_CON 79 D_CON LEDSW .

의 를 누르면서 실험한다80 SW1, SW2 .

� 프로그램 예 :

#include <mega128.h>
unsigned char led;
unsigned int cnt, step=10, duration=500, MAX=999;

처럼 에 저장된 정의를 사용해도 됨interrupt [2] void exint0(void){ // interrupt [EXT_INT0] void exint0(void) mega128.h
if(MAX > duration+step ) duration += step;

}
처럼 에 저장된 정의를 사용해도 됨interrupt [3] void exint1(void){ // interrupt [EXT_INT1] void exint1(void) mega128.h

if( duration-step >0 ) duration -=step;
}

로 해도 됨interrupt [10] void timerint(void){ // interrupt [TIM2_COMP] void timerint(void)
if(cnt < duration) led = 0xff;
else led = 0x00;
if(cnt++ >= MAX) cnt = 0; // 1000*10 = 10 msec
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}
void main(void){

포트 를 출력으로DDRC = 0xff; // C
SREG |= 0x80; 인터럽트 전체 허용//
EIMSK |= 0b00000011; 개별 허용// INT0, 1
EICRA |= 0x0f; 상승에지 트리거// INT0, 1
TIMSK |= 0x80; 타이머 출력비교 인터럽트 개별허용// 2
TCCR2 |= 1; 분주비를 로 설정// 1
TCCR2 |= 0x20; // CTC mode
OCR2 = 159; 와 분주비 사용시// 1usec = 1*(1+159)/16 16MHz 1
for(;;) PORTC = led;

}

� 과제 와 을 배 이상으로 하고 수행해보라 어떤 현상이 일어나나 살피고 그 원인에 대하여: MAX duration 10 .①

생각해보라 타이머 으로 구현해 보아라. 0,1,3 .②

4.3.4.4.3.4.4.3.4.4.3.4.4.3.4.4.3.4.4.3.4.4.3.4.4.3.4.4.3.4.4.3.4.4.3.4. 실험실험실험실험35 :35 :35 :35 :실험실험실험실험35 :35 :35 :35 :실험실험실험실험35 :35 :35 :35 : 신호 발생신호 발생신호 발생신호 발생PWM 2PWM 2PWM 2PWM 2신호 발생신호 발생신호 발생신호 발생PWM 2PWM 2PWM 2PWM 2신호 발생신호 발생신호 발생신호 발생PWM 2PWM 2PWM 2PWM 2

� 예제 타이머의 모드를 이용해서 의 밝기를 조절한다 핀 에 연결된 푸쉬버튼을: PWM LED . INT0(PORTD.0, 25)

누르면 점점 밝아지고 핀 에 연결된 푸시버튼을 누르면 어두워진다INT1(PORTD.1, 26) .

� 프로그램 작성시 유의점 타이머 의 신호는 번핀 에서 출력된다 시뮬레이션을 할 때는 타: 0 PWM OC0(14 , PB4) .

이머의 카운트가 너무 오래 걸릴 수 있으므로 분주비를 적절하게 조절해야 한다.

� 회로도 그림 의 과 그림 의 를 각각 그림 의 과 에 연결한다 또한 그림: 80 SW_CON 92 L2 79 D_CON B_CON .

의 를 누르면서 실험한다80 SW1, SW2 .

그림 92 배열 회로. LED .

#include <mega128.h>
unsigned int step=5;

처럼 에 저장된 정의를 사용해도 됨interrupt [2] void exint0(void){ // interrupt [EXT_INT0] void exint0(void) mega128.h
if( OCR0 < 0xff - step ) OCR0 += step;

}
처럼 에 저장된 정의를 사용해도 됨interrupt [3] void exint1(void){ // interrupt [EXT_INT1] void exint1(void) mega128.h

if( OCR0 > step ) OCR0 -=step;
}
void main(void){

DDRB.4 = 1; 를 출력으로// PORTB bit 4
SREG |= 0x80; 인터럽트 전체 허용//
EIMSK |= 0b00000011; 개별 허용// INT0, 1
EICRA |= 0x0f; 상승에지 트리거// INT0, 1
TCCR0 |= 6; 분주비를 로 설정// 256
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TCCR0 |= 0b01001000; 타이머 모드로 설정// 0 FAST PWM
TCCR0 |= 0x20; 출력비교모드 설정//
OCR0 = 0x7F;
for(;;);

}

� 과제 타이머 으로 구현해 보아라: 1~3 .①
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5.5.5.5.5.5.5.5.5.5.5.5. 응용 실험응용 실험응용 실험응용 실험응용 실험응용 실험응용 실험응용 실험응용 실험응용 실험응용 실험응용 실험

5.1.5.1.5.1.5.1.5.1.5.1.5.1.5.1.5.1.5.1.5.1.5.1. FND(Flexible Numeric Display)FND(Flexible Numeric Display)FND(Flexible Numeric Display)FND(Flexible Numeric Display)FND(Flexible Numeric Display)FND(Flexible Numeric Display)FND(Flexible Numeric Display)FND(Flexible Numeric Display)FND(Flexible Numeric Display)FND(Flexible Numeric Display)FND(Flexible Numeric Display)FND(Flexible Numeric Display)

5.1.1.5.1.1.5.1.1.5.1.1.5.1.1.5.1.1.5.1.1.5.1.1.5.1.1.5.1.1.5.1.1.5.1.1. 의 개요의 개요의 개요의 개요FNDFNDFNDFND의 개요의 개요의 개요의 개요FNDFNDFNDFND의 개요의 개요의 개요의 개요FNDFNDFNDFND

� 구성 는 세그먼트 표시기로도 불리며 그림 처럼 보통 개의 중 개의 를 자형태로 배열: FND 7 93 8 LED 7 LED 8

하고 까지의 숫자와 값을 표시하는 데 사용한다 나머지 는 소숫점의 표시에 사용한다0-9 ABCDEF(HEX ) . LED .

� 종류 모든 의 양극을 한데 묶은 양극공통형 음극을 묶은 음극공통형 형이 있다: LED (CA), (CC) .

� 핀배치 정면에서 보았을 때 왼쪽아래에서부터 핀번호가 번으로 시작하여 반시계방향으로 배열되어 있다그: 1 (

림 참조 만약 형의 경우 을 표시하려면 번과 번핀에 를 연결하고 번과 번핀에 을 연결한다49 ). CA 1 3 8 Vcc 6 4 0 .

만약 형의 경우 을 표시하려면 번과 번핀에 를 연결하고 번핀에 을 연결한다CA 3 3 8 Vcc 2,4,6,7,10 0 .

� 특성 는 소형으로 발열이 거의 없고 수명이 반영구적이며 응답속도가 빠르고 발광효율이 높고 가격이: LED ,

싸며 보통 이상의 구동전류가 필요한데 직류의 저전압에서 동작이 가능하다는 등의 장점이 있어 도10mA FND

마찬가지의 장점이 있다 또한 캐릭터. 16x2 가 만원정도인데 비해 는 개당 수백원 꼴이라 값싼 시스템LCD FND

을 위한 표시장치로 쓰인다 형을 위한 디코딩용 구동 은. CA TTL 형을 위한 디코딩용 구동 은7447, CC TTL

이 있다7446 .

그림 93 의 내부구성과 핀배치. FND

5.1.2.5.1.2.5.1.2.5.1.2.5.1.2.5.1.2.5.1.2.5.1.2.5.1.2.5.1.2.5.1.2.5.1.2. 실험 디코더 없는 구동실험 디코더 없는 구동실험 디코더 없는 구동실험 디코더 없는 구동36 : FND36 : FND36 : FND36 : FND실험 디코더 없는 구동실험 디코더 없는 구동실험 디코더 없는 구동실험 디코더 없는 구동36 : FND36 : FND36 : FND36 : FND실험 디코더 없는 구동실험 디코더 없는 구동실험 디코더 없는 구동실험 디코더 없는 구동36 : FND36 : FND36 : FND36 : FND

� 예제 형의 를 에 직접 연결시키고 값을 넣었을 때 패턴을 살핀다: CA FND C_CON 00~FFH .

� 프로그램 작성시 유의점 너무 빨리 패턴이 지나가지 않도록 시간 지연을 준다: .

� 회로도 그림 의 왼쪽 디코더 없는 회로를 구현하고 을 그림 에 보여진 시스템의 에: 94 FND_CON 79 C_CON

연결한다.

� 프로그램 예 :

#include <mega128.h>
#include <delay.h>
unsigned char int;
void main(void){
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DDRC = 0xff; 포트 를 출력으로// C
for(;;) {delay_ms(500); PORTC = led++;}

}

그림 94 기초 실험도왼쪽디코더 비사용 오른쪽디코더 사용. FND ( : , : )

� 과제 값을 표시하기 위한 입력패턴 값을 찾아라 찾은 패턴값을 이용하여: 0~9, A,B,C,D,E,F . 0~9,① ②

값을 초 간격으로 표시하는 프로그램을 작성하라A,B,C,D,E,F 1 .

5.1.3.5.1.3.5.1.3.5.1.3.5.1.3.5.1.3.5.1.3.5.1.3.5.1.3.5.1.3.5.1.3.5.1.3. 실험 디코더를 사용한 구동실험 디코더를 사용한 구동실험 디코더를 사용한 구동실험 디코더를 사용한 구동37 : FND37 : FND37 : FND37 : FND실험 디코더를 사용한 구동실험 디코더를 사용한 구동실험 디코더를 사용한 구동실험 디코더를 사용한 구동37 : FND37 : FND37 : FND37 : FND실험 디코더를 사용한 구동실험 디코더를 사용한 구동실험 디코더를 사용한 구동실험 디코더를 사용한 구동37 : FND37 : FND37 : FND37 : FND

� 예제 형의 를: CA FND 을 이용하여 구동하고 패턴을 살핀다7447 .

� 프로그램 작성시 유의점 너무 빨리 패턴이 지나가지 않도록 시간 지연을 준다: .

� 회로도 그림 의 오른쪽 회로를 구현하고 을 그림 에 보여진 시스템의 에 연결한다: 94 FND_CON 79 C_CON .

� 프로그램 예 :

#include <mega128.h>
#include <delay.h>
unsigned char int;
void main(void){

DDRC = 0xff; 포트 를 출력으로// C
for(;;) {delay_ms(500); PORTC = led++;}

}

� 과제 위의 프로그램은 의 오름차순으로 표시하는 것이다 내림차순으로 표시하는 프로그램을: 0x00~0xff .①

작성하라 값을 반복적으로 표시하는 프로그램을 작성하라 를 사용하지 말고 타이머를. 0~9 . delay_ms() 0~3② ③

을 사용하여 시간지연을 주어 표시하는 프로그램을 작성하라.

5.1.4.5.1.4.5.1.4.5.1.4.5.1.4.5.1.4.5.1.4.5.1.4.5.1.4.5.1.4.5.1.4.5.1.4. 실험실험실험실험38 : FND38 : FND38 : FND38 : FND실험실험실험실험38 : FND38 : FND38 : FND38 : FND실험실험실험실험38 : FND38 : FND38 : FND38 : FND 동적 구동동적 구동동적 구동동적 구동동적 구동동적 구동동적 구동동적 구동동적 구동동적 구동동적 구동동적 구동

� 예제 형의 의 개를 하나만을 할애하여 동적으로 구동한다 마다 각 들을: CA FND0~5 6 C_CON . 2msec FND

번갈아 구동시켜 잔상에 의해 개 모두가 켜져 동작하는 것처럼 보이게 한다6 .

� 프로그램 작성시 유의점 의 주기를 얻기 위해 타이머 의 일반모드 인터럽트를 이용한다 각 에: 2msec 0 . FND

표시할 데이터값은 이라고 가정한다 시뮬레이션을 수행할 때는 너무 오래 걸릴 수 있으므로 시간지연1,2,3,4,5,6 .

을 적절히 조절해서 한다 로 출력되는 값의 상위 비트가 데이터값이고 하위 비트로 활성화될 를 지. PORTC 4 4 FND

정한다.

� 회로도 그림 의 회로를 구현하고 을 그림 에 보여진 시스템의 에 연결한다: 95 FND_CON 79 C_CON .

� 프로그램 예 :

#include <mega128.h>
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unsigned char dbuf[6], dbuf_index;
unsigned int cnt;

로 해도 됨interrupt [17] void timerint0(void){ // interrupt [TIM0_OVF] void timerint0(void)
unsigned char tmpbuf;
if( ++cnt == 2 ){
cnt = 0; if( dbuf_index++ == 5 ) dbuf_index= 0; }
tmpbuf = dbuf[dbuf_index];
PORTC = (( tmpbuf << 4 )&0xf0) | dbuf_index;

표시할 데이터와 의 위치는 의 상위비트와 하위비트로/* FND tmpbuf */
TCNT0 = 6; 재정의 시뮬레이션할 때는 조절할 필요가 있음// 1msec = 64*(256-6)/16

}
void main(void){

포트 를 출력으로DDRC = 0xff; // C
SREG |= 0x80; 인터럽트 전체 허용//
TIMSK |= 1; 타이머 오버플로 인터럽트 개별허용// 0
TCCR0 |= 4; 분주비를 로 설정// 64 시뮬레이션할 때는 조절할 필요가 있음
TCNT0 = 6; // 1msec = 64*(256-6)/16 시뮬레이션할 때는 조절할 필요가 있음
dbuf[0]= 1; dbuf[1] = 2; dbuf[2]=3; dbuf[3] = 4; dbuf[4] = 5; dbuf[5] = 6; 표시할 데이터 초기화/* */
for(;;); 인터럽트 발생할 때까지 대기/* */

}

그림 95 의 동적 구동을 위한 회로도. FND

� 과제 타이머 대신 타이머 을 사용하고 주기를 로 하여라 주기를 이상 예로: 0 1~3 1 msec . 12 msec 40① ②

로 하여 하드웨어를 구현해보고 어떤 현상이 나타나나 보아라msec .

5.1.5.5.1.5.5.1.5.5.1.5.5.1.5.5.1.5.5.1.5.5.1.5.5.1.5.5.1.5.5.1.5.5.1.5. 실험실험실험실험39 :39 :39 :39 :실험실험실험실험39 :39 :39 :39 :실험실험실험실험39 :39 :39 :39 : 시계시계시계시계시계시계시계시계시계시계시계시계

� 예제 형의 에 시간의 의 자리값 에 시간의 의 자리값 에 분의 의 자리값: CA FND5 10 , FND4 1 , FND3 10 , FND2

에 분의 의 자리값 에 초의 의 자리값 에 초의 의 자리값을 표시하는 시계를 만든다1 , FND1 10 , FND0 1 .

� 프로그램 작성시 유의점 타이머 의 일반모드를 사용하였고 를 주기로 를 동적으로 구동한다: 0 1 msec FND .
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� 회로도 그림 의 회로를 구현하고 을 그림 에 보여진 시스템의 에 연결한다: 95 FND_CON 79 C_CON .

� 프로그램 예 :

#include <mega128.h>
unsigned char dbuf[6], dbuf_index;
unsigned char hou, min, sec;
unsigned int cnt;
void hex2bcd(unsigned char hex, unsigned char *ptr) { 이하의 헥사값을 로 바꾼다/* 0x63 bcd */

*ptr = hex % 10;
*(ptr+1) = hex / 10;

}
void watch(void){

if( ++sec == 60) { sec = 0;
if( ++min == 60 ) { min = 0;

if( ++hou == 24 ) hou = 0;
}

}
hex2bcd(sec, &dbuf[0]);
hex2bcd(min, &dbuf[2]);
hex2bcd(hou, &dbuf[4]);

}
로 해도 됨interrupt [17] void timerint0(void){ // interrupt [TIM0_OVF] void timerint0(void)

unsigned char tmpbuf;
if( ++cnt == 1000 ){
cnt = 0; watch(); }
if( dbuf_index++ == 5 ) dbuf_index= 0;
tmpbuf = dbuf[dbuf_index];
PORTC = (( tmpbuf << 4 )&0xf0) | dbuf_index;

표시할 데이터와 의 위치는 의 상위비트와 하위비트로/* FND tmpbuf */
TCNT0 = 6; 재정의 시뮬레이션할 때는 조절할 필요가 있음// 1msec = 64*(256-6)/16

}
void main(void){

포트 를 출력으로DDRC = 0xff; // C
SREG |= 0x80; 인터럽트 전체 허용//
TIMSK |= 1; 타이머 오버플로 인터럽트 개별허용// 0
TCCR0 |= 4; 분주비를 로 설정// 64 시뮬레이션할 때는 조절할 필요가 있음
TCNT0 = 6; // 1msec = 64*(256-6)/16 시뮬레이션할 때는 조절할 필요가 있음
for(;;); 인터럽트 발생할 때까지 대기/* */

}

� 과제 타이머 대신 타이머 을 사용하여라: 0 1~3 .

5.1.6.5.1.6.5.1.6.5.1.6.5.1.6.5.1.6.5.1.6.5.1.6.5.1.6.5.1.6.5.1.6.5.1.6. 실험실험실험실험40 :40 :40 :40 :실험실험실험실험40 :40 :40 :40 :실험실험실험실험40 :40 :40 :40 : 스톱 워치스톱 워치스톱 워치스톱 워치스톱 워치스톱 워치스톱 워치스톱 워치스톱 워치스톱 워치스톱 워치스톱 워치

� 예제 형의 에 시간의 의 자리값 에 시간의 의 자리값 에 분의 의 자리값: CA FND5 10 , FND4 1 , FND3 10 , FND2

에 분의 의 자리값 에 초의 의 자리값 에 초의 의 자리값을 표시하는 시계를 만든다1 , FND1 10 , FND0 1 .

핀 에 연결된 스위치를 누르면 상승 에지 트리거에 의한 인터럽트가 발생하여 타이머 의 카INT0(PORTD.0, 25) 1

운팅이 정지되고 다시 한번 누르면 카운팅을 시작한다.

� 회로도 그림 의 회로를 구현하고 을 그림 에 보여진 시스템의 에 연결한다 그림: 95 FND_CON 79 C_CON . 80

의 을 그림 의 에 연결한다 또한 그림 의 를 누르면서 실험한다SW_CON 79 D_CON . 80 SW1 .

� 프로그램 작성시 유의점 타이머 의 일반모드를 사용하여 를 주기로 를 동적으로 구동한다 그: 0 10 msec FND .

리고 타이머 의 일반모드를 사용하여 시간을 잰다2 .

� 프로그램 예 :

#include <mega128.h>
unsigned char dbuf[6], dbuf_index;
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unsigned char hou, min, sec, onoff;
unsigned int cnt0, cnt2;
void hex2bcd(unsigned char hex, unsigned char *ptr) { 이하의 헥사값을 로 바꾼다/* 0x63 bcd */

*ptr = hex % 10;
*(ptr+1) = hex / 10;

}
void watch(void){

if( ++sec == 60) { sec = 0;
if( ++min == 60 ) { min = 0;

if( ++hou == 24 ) hou = 0;
}

}
hex2bcd(sec, &dbuf[0]);
hex2bcd(min, &dbuf[2]);
hex2bcd(hou, &dbuf[4]);

}
처럼 에 저장된 정의를 사용해도 됨interrupt [2] void exint0(void){ // interrupt [EXT_INT0] void exint0(void) mega128.h

if(onoff == 0) onoff = 1; else onoff = 0;
}

로 해도 됨interrupt [17] void timerint0(void){ // interrupt [TIM0_OVF] void timerint0(void)
if(onoff == 0) if( ++cnt0 == 1000 ){
cnt0 = 0; watch(); }
TCNT0 = 6; 재정의 시뮬레이션할 때는 조절할 필요가 있음// 1msec = 64*(256-6)/16

}
로 해도 됨interrupt [11] void timerint2(void){ // interrupt [TIM2_OVF] void timerint0(void)

unsigned char tmpbuf;
if( ++cnt2 == 10 ){
if( dbuf_index++ == 5 ) dbuf_index= 0;
tmpbuf = dbuf[dbuf_index];
PORTC = (( tmpbuf << 4 )&0xf0) | dbuf_index; }

표시할 데이터와 의 위치는 의 상위비트와 하위비트로/* FND tmpbuf */
TCNT2 = 6; 재정의 시뮬레이션할 때는 조절할 필요가 있음// 1msec = 64*(256-6)/16

}
void main(void){

DDRC = 0xff; 포트 를 출력으로// C
DDRD = 0x00; 포트 를 입력으로 디폴트 입력으로 설정되어 있으므로 필요하지는 않음// D
SREG.7 = 1; 인터럽트 전체 허용//
EIMSK |= 0x01; 개별 허용// INT0
EICRA |= 3; 상승에지 트리거//
TIMSK |= 1; 타이머 오버플로 인터럽트 개별허용// 0
TCCR0 |= 4; 분주비를 로 설정// 64 시뮬레이션할 때는 조절할 필요가 있음
TCNT0 = 6; // 1msec = 64*(256-6)/16 시뮬레이션할 때는 조절할 필요가 있음
TIMSK |= 0x40; 타이머 오버플로 인터럽트 개별허용// 2
TCCR2 |= 3; 분주비를 로 설정// 64 시뮬레이션할 때는 조절할 필요가 있음
TCNT2 = 6; // 1msec = 64*(256-6)/16 시뮬레이션할 때는 조절할 필요가 있음
for(;;); 인터럽트 발생할 때까지 대기/* */

}

� 과제 타이머 과 의 역할을 바꿔 프로그램 하여라 타이머 을 이용하여 구현해보라: 0 2 . 1,3 .① ②

5.1.7.5.1.7.5.1.7.5.1.7.5.1.7.5.1.7.5.1.7.5.1.7.5.1.7.5.1.7.5.1.7.5.1.7. 실험 시간 조정이 가능한실험 시간 조정이 가능한실험 시간 조정이 가능한실험 시간 조정이 가능한41 :41 :41 :41 :실험 시간 조정이 가능한실험 시간 조정이 가능한실험 시간 조정이 가능한실험 시간 조정이 가능한41 :41 :41 :41 :실험 시간 조정이 가능한실험 시간 조정이 가능한실험 시간 조정이 가능한실험 시간 조정이 가능한41 :41 :41 :41 : 시계시계시계시계시계시계시계시계시계시계시계시계

� 예제 형의 에 시간의 의 자리값 에 시간의 의 자리값 에 분의 의 자리값: CA FND5 10 , FND4 1 , FND3 10 , FND2

에 분의 의 자리값 에 초의 의 자리값 에 초의 의 자리값을 표시하는 시계를 만든다1 , FND1 10 , FND0 1 .

핀 에 연결된 스위치를 누르면 상승 에지 트리거에 의한 인터럽트가 발생하여 타이머 의 카INT0(PORTD.0, 25) 1

운팅이 정지되고 다시 한번 누르면 카운팅을 시작한다 핀 에 연결된 스위치를 누르면 상승. INT1(PORTD.1, 26)

에지 트리거에 의한 인터럽트가 발생하여 분값이 증가하고 핀 에 연결된 스위치를 누르면 상INT2(PORTD.1, 27)

승 에지 트리거에 의한 인터럽트가 발생하여 시간값이 증가한다.
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� 회로도 그림 의 회로를 구현하고 을 그림 에 보여진 시스템의 에 연결한다 그림: 95 FND_CON 79 C_CON . 80

의 을 그림 의 에 연결한다 또한 그림 의 를 누르면서 실험한다SW_CON 79 D_CON . 80 SW1~3 .

� 프로그램 예 :

#include <mega128.h>
unsigned char dbuf[6], dbuf_index;
unsigned char hou, min, sec, onoff=1;
unsigned int cnt0, cnt2;
void hex2bcd(unsigned char hex, unsigned char *ptr) { 이하의 헥사값을 로 바꾼다/* 0x63 bcd */

*ptr = hex % 10;
*(ptr+1) = hex / 10;

}
void watch(void){

if( ++sec == 60) { sec = 0;
if( ++min == 60 ) { min = 0;

if( ++hou == 24 ) hou = 0;
}

}
hex2bcd(sec, &dbuf[0]);
hex2bcd(min, &dbuf[2]);
hex2bcd(hou, &dbuf[4]);

}
처럼 에 저장된 정의를 사용해도 됨interrupt [2] void exint0(void){ // interrupt [EXT_INT0] void exint0(void) mega128.h

if(onoff == 0) onoff = 1; else onoff = 0;
}

처럼 에 저장된 정의를 사용해도 됨interrupt [3] void exint1(void){ // interrupt [EXT_INT1] void exint1(void) mega128.h
if( ++min == 60 ) { min = 0; if( ++hou == 24 ) hou = 0; }

}
처럼 에 저장된 정의를 사용해도 됨interrupt [4] void exint2(void){ // interrupt [EXT_INT2] void exint2(void) mega128.h

if( ++hou == 24 ) hou = 0;
}

로 해도 됨interrupt [17] void timerint0(void){ // interrupt [TIM0_OVF] void timerint0(void)
if(onoff == 0) if( ++cnt0 == 1000 ){
cnt0 = 0; watch(); }
TCNT0 = 6; 재정의 시뮬레이션할 때는 조절할 필요가 있음// 1msec = 64*(256-6)/16

}
로 해도 됨interrupt [11] void timerint2(void){ // interrupt [TIM2_OVF] void timerint0(void)

unsigned char tmpbuf;
if( ++cnt2 == 10 ){
if( dbuf_index++ == 5 ) dbuf_index= 0;
tmpbuf = dbuf[dbuf_index];
PORTC = (( tmpbuf << 4 )&0xf0) | dbuf_index; }

표시할 데이터와 의 위치는 의 상위비트와 하위비트로/* FND tmpbuf */
TCNT2 = 6; 재정의 시뮬레이션할 때는 조절할 필요가 있음// 1msec = 64*(256-6)/16

}
void main(void){

DDRC = 0xff; 포트 를 출력으로// C
DDRD = 0x00; 포트 를 입력으로 디폴트 입력으로 설정되어 있으므로 필요하지는 않음// D
SREG.7 = 1; 인터럽트 전체 허용//
EIMSK |= 0x01; 개별 허용// INT0
EIMSK |= 0x02; 개별 허용// INT0
EIMSK |= 0x04; 개별 허용// INT0
EICRA |= 3; 상승에지 트리거//
TIMSK |= 1; 타이머 오버플로 인터럽트 개별허용// 0
TCCR0 |= 4; 분주비를 로 설정// 64 시뮬레이션할 때는 조절할 필요가 있음
TCNT0 = 6; // 1msec = 64*(256-6)/16 시뮬레이션할 때는 조절할 필요가 있음
TIMSK |= 0x40; 타이머 오버플로 인터럽트 개별허용// 2
TCCR2 |= 3; 분주비를 로 설정// 64 시뮬레이션할 때는 조절할 필요가 있음
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TCNT2 = 6; // 1msec = 64*(256-6)/16 시뮬레이션할 때는 조절할 필요가 있음
for(;;); 인터럽트 발생할 때까지 대기/* */

}

� 과제 타이머 를 사용하여 프로그램 하여라 초값은 표시하지 않아 시간과 분만을 표시하여 개: 1,3 . FND 4① ②

만을 사용하는 시간조정이 가능한 시계용 프로그램을 작성해보아라.

5.2.5.2.5.2.5.2.5.2.5.2.5.2.5.2.5.2.5.2.5.2.5.2. 키보드 스캐닝키보드 스캐닝키보드 스캐닝키보드 스캐닝키보드 스캐닝키보드 스캐닝키보드 스캐닝키보드 스캐닝키보드 스캐닝키보드 스캐닝키보드 스캐닝키보드 스캐닝

5.2.1.5.2.1.5.2.1.5.2.1.5.2.1.5.2.1.5.2.1.5.2.1.5.2.1.5.2.1.5.2.1.5.2.1. 실험 단순 키보드 스캔실험 단순 키보드 스캔실험 단순 키보드 스캔실험 단순 키보드 스캔42 :42 :42 :42 :실험 단순 키보드 스캔실험 단순 키보드 스캔실험 단순 키보드 스캔실험 단순 키보드 스캔42 :42 :42 :42 :실험 단순 키보드 스캔실험 단순 키보드 스캔실험 단순 키보드 스캔실험 단순 키보드 스캔42 :42 :42 :42 :

� 예제 에 연결된 개의 누름키에서 에 연결된 것부터 차례대로 의 일련번: D_CON 8 PORTD.0 SW1, SW2, ...SW8

호를 붙이고 눌린 번호키의 진수값을 에 연결된 에 표시하는 프로그램을 작성한다2 PORTC LED .

� 프로그램 작성시 유의점 채터링현상을 소프트웨어적으로 처리하기 위해 유효한 값을 읽기 위해 그림 의: 96

순서도에 주어진 순서를 따라한다 먼저 연속해서 두번 읽어 같은 값이 감지되었는지 확인한다 그 후 감지된 값. .

이 키가 눌린 경우읽힌 값은 가 아니다인지 여부를 확인한다 읽은 값이 이전에 읽어( 0xff ) . (20-50 msec)

에 보관된 값과 같으면 유효한 키값으로 에 저장하고 그렇지 않으면 시간 정도의 지oldkey keybuf 20-50 msec

연 후에 같은 과정을 반복한다 즉 두 번 확인하는 방식을 택한다. .

� 회로도 그림 의 을 그림 의 에 연결하고 실험할 때는 를 닫고 한다 또한 그림: 80 SW_CON 79 D_CON LEDSW .

의 을 누르면서 실험한다80 SW1 .

그림 96 키보드 스캔을 위한 순서도.

� 프로그램 예 :

#include <mega128.h>
#include <delay.h> 를 이용할 것이다// delay_ms(), delay_us() .
unsigned char keybuf=0xff, oldkey=0xff;
void scankey(void){

unsigned char tmp;
do{
tmp = PIND; 첫번째 읽은 것을 에 저장/* tmp */
} while( tmp != PIND ); 첫번째 읽은 값과 두번째 읽은 값이 일치하지 않으면 다시 읽는다/* */
if(tmp != 0xff) { 두번 읽은 것이 키가 눌린 경우이면 이면 아무키도 안눌린 상태임 아래로/* (0xff ) */



- 116 -

if(tmp == oldkey) { 현재 읽어들인 값 와 가 같으면 아래로/* (tmp) oldkey */
if(tmp == 0xfe) keybuf = 1;
else if( tmp == 0xfd ) keybuf = 2;
else if( tmp == 0xfb ) keybuf = 3;
else if( tmp == 0xf7 ) keybuf = 4;
else if( tmp == 0xef ) keybuf = 5;
else if( tmp == 0xdf ) keybuf = 6;
else if( tmp == 0xbf ) keybuf = 7;
else if( tmp == 0x7f ) keybuf = 8;
else oldkey = 0xff;
oldkey = 0xff; }

else oldkey = tmp; 현재 읽어들인 값 와 가 다르면 를 로 바꾼다/* (tmp) oldkey oldkey tmp . */
}

}
void main(void){

포트 를 출력으로DDRC = 0xff; // C
포트 를 입력으로 디폴트 입력으로 설정되어 있으므로 필요하지는 않음DDRD = 0x00; // D

for(;;){
scankey();
PORTC = keybuf;
delay_ms(50); 시간 지연/* 50 msec */
}

}

� 과제 타이머인터럽트를 사용하여 마다 키보드 스캔을 하는 프로그램를 작성 하여라: 30msec .

5.2.2.5.2.2.5.2.2.5.2.2.5.2.2.5.2.2.5.2.2.5.2.2.5.2.2.5.2.2.5.2.2.5.2.2. 실험 키 매트릭스 스캔실험 키 매트릭스 스캔실험 키 매트릭스 스캔실험 키 매트릭스 스캔43 :43 :43 :43 :실험 키 매트릭스 스캔실험 키 매트릭스 스캔실험 키 매트릭스 스캔실험 키 매트릭스 스캔43 :43 :43 :43 :실험 키 매트릭스 스캔실험 키 매트릭스 스캔실험 키 매트릭스 스캔실험 키 매트릭스 스캔43 :43 :43 :43 :

� 예제 에 연결된 키 매트릭스에 차례대로 의 일련번호를 붙이고 눌린 번호키: D_CON 5X5 SW1, SW2, ...SW25

의 진수값을 에 연결된 에 표시하는 프로그램을 작성한다2 PORTC LED .

� 프로그램 작성시 유의점 채터링현상을 소프트웨어적으로 처리하기 위해 유효한 값을 읽기 위해 그림 의: 96

순서도에 주어진 순서를 따라한다.

� 회로도 그림 의 을 그림 의 에 연결하고 실험할 때는 를 닫고 한다 또한 그림: 80 SW_CON 79 D_CON LEDSW .

의 을 누르면서 실험한다80 SW1 .

� 프로그램 예 :

#include <mega128.h>
unsigned int cnt;
unsigned char keybuf=0xff, oldkey=0xff;
void scankey(void){

unsigned char tmp, row, cul;
for(row=0; row<5 ;row++){

do{
PORTC = 0xf8 | row; 에 을 쓴다/* row 1 */
tmp = PIND & 0xf8 ; 첫번째 읽은 포트 의 비트 비트 값을 에 저장/* 3 7~ 3 tmp */
PORTC = 0xf8 | row; 두번째 읽기 위해 을 쓴다/* 1 */
} while( (PIND & 0xf8) != tmp ); 첫번째와 두번째 읽은 값이 일치하지 않으면 다시 읽는다/* */
if(tmp != 0xf8) { 두번 읽은 값이 일치하고 키 눌림이 있는 경우라면 아래로/* */

tmp += row;
if(tmp == oldkey) { 현재의 키값 이 값과 같으면 아래로/* (tmp) oldkey */

tmp = (tmp >>3) &0x1f;
if(tmp == 0x1e) cul = 1;
else if( tmp == 0x1d ) cul = 2;
else if( tmp == 0x1b ) cul = 3;
else if( tmp == 0x17 ) cul = 4;
else if( tmp == 0x0f ) cul = 5;
else goto next;
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keybuf = row*6 + cul;
next: oldkey = 0xff; }
else oldkey = tmp; 현재의 키값과 값이 다르면/* oldkey oldkey <- tmp */

}
}

}
로 해도 됨interrupt [17] void timerint0(void){ // interrupt [TIM0_OVF] void timerint0(void)

if( ++cnt == 50 ){ 값을 시뮬레이션할 때는 조절할 필요가 있음// 50
cnt = 0; scankey(); }
TCNT0 = 6; 재정의 시뮬레이션할 때는 조절할 필요가 있음// 1msec = 64*(256-6)/16

}
void main(void){

포트 를 출력으로DDRC = 0xff; // C
포트 의 비트 를 출력으로 설정DDRD = 0x07; // D 0~2

SREG.7 = 1; 인터럽트 전체 허용//
TCCR0 |= 4; 분주비를 로 설정// 64 시뮬레이션할 때는 조절할 필요가 있음
TCNT0 = 6; // 1msec = 64*(256-6)/16 시뮬레이션할 때는 조절할 필요가 있음
for(;;) PORTC = keybuf;

}

� 과제 타이머인터럽트 를 사용하는 프로그램를 작성 하여라: 1~3 .

그림 97 키 매트릭스. 5X5

5.3.5.3.5.3.5.3.5.3.5.3.5.3.5.3.5.3.5.3.5.3.5.3. 음향 발생음향 발생음향 발생음향 발생음향 발생음향 발생음향 발생음향 발생음향 발생음향 발생음향 발생음향 발생

5.3.1.5.3.1.5.3.1.5.3.1.5.3.1.5.3.1.5.3.1.5.3.1.5.3.1.5.3.1.5.3.1.5.3.1. 음향 발생 개요음향 발생 개요음향 발생 개요음향 발생 개요음향 발생 개요음향 발생 개요음향 발생 개요음향 발생 개요음향 발생 개요음향 발생 개요음향 발생 개요음향 발생 개요

� 음향 발생 원리 스피커에 레벨과 레벨 신호를 반복적으로 주어 온오프시키는데 주기를 바꾸어 주면 음의: 1 0

고저가 다른주파수가 다른 신호를 발생시킬 수 있고 지속시간을 바꾸어 주어 장단이 다른 신호를 발생시킨다( ) .

� 음계 발생 프로그램 기법 내고자 하는 음계의 주파수주기의 역수가 주어지고 내고자 하는 음계의 지속시간: ( )

이 주어지면 반주기주파수 역수의 반 동안 스피커를 온시켜주고 반주기 동안은 스피커를 오프시키는 것을 반복( )

하되 지속시간 박자를 로 정규화한 이 지나면 끝내도록 하면 된다 표 과 표 에 음계와 박자(1/32 1 time_data) . 13 14
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에 따른 시간 정보를 보였다.

음계 주파수x2(2/T) 반주기(msec) 음계 주파수x2(2/T) 반주기(msec)
도 1046.5 0.95 도# 1100.7 0.90
레 1174.7 0.84 레# 1244.5 0.80
미 1318.5 0.75 파 1396.9 0.71
파# 1479.9 0.67 솔 1567.9 0.63
라 1760.0 0.56 라# 1864.6 0.53
시 1975.6 0.50 도 2093.0 0.47
도# 2201.4 0.45 레 2349.4 0.42
레# 2489.0 0.39 미 2637.0 0.37
파 2793.8 0.35 파# 2959.8 0.33
솔 3135.8 0.31 솔# 3322.4 0.29
라 3520.0 0.28 라# 3729.2 0.26
시 3951.2 0.25 도 4186.0 0.23

표 13 음계에 따른 값. tone_data

박자 시간(msec) time_data 박자 시간(msec) time_data
1/32 21.306 1 1/16 42.613 2
1/8 85.227 4 1/4 170.454 8
1/2 340.909 16 1 681.818 32
과1 1/2 1,022.727 48 2 1,363.636 64
와2 1/2 1,704.545 80 3 2,045.454 96

표 14 박자에 따른 지속시간값.

5.3.2.5.3.2.5.3.2.5.3.2.5.3.2.5.3.2.5.3.2.5.3.2.5.3.2.5.3.2.5.3.2.5.3.2. 실험 사이렌 소리내기실험 사이렌 소리내기실험 사이렌 소리내기실험 사이렌 소리내기44 :44 :44 :44 :실험 사이렌 소리내기실험 사이렌 소리내기실험 사이렌 소리내기실험 사이렌 소리내기44 :44 :44 :44 :실험 사이렌 소리내기실험 사이렌 소리내기실험 사이렌 소리내기실험 사이렌 소리내기44 :44 :44 :44 :

� 예제 저주파의 소리에서 점점 고주파의 소리를 변하게 하는 것을 반복적으로 한다 에 연결된 스위: . PORTD.0

치를 누르면 에 연결된 스피커에서 소리를 내기 시작한다 박자마다 주파수를 변하게 한다PORTC.0 . 3 .

� 프로그램 작성시 유의점 이 경우에는 음계에 따라 반주기값을 바꿔 줄 필요가 없다: .

� 회로도 그림 의 회로를 구현하고 을 그림 의 에 연결한다 그림 의 을: 98 BUZZ_CON 79 C_CON . 80 SW_CON

그림 의 에 연결하고 그림 의 을 누르면서 실험한다 그림 에서79 D_CON 80 SW1 . 98 와 사2SC1815Y PORTC.0

이에 들어가는 콘덴서와 저항과 다이오드는 필터역할을 하는 것으로 생략가능하다 즉 다이오드를 없애.

의 베이스와 에미터를 개방시키고 콘덴서와 저항은 없애고 과 의 베이스를 연결2SC1815Y PORTC.0 2SC1815Y

해서 사용해도 된다.

� 프로그램 예 :

#include <mega128.h>
#include <delay.h>
unsigned char time_data;

로 해도 됨interrupt [17] void timerint0(void){ // interrupt [TIM0_OVF] void timerint0(void)
time_data--;
TCNT0 = 77; 시뮬레이션할 때는 조절할 필요가 있음// 21.306msec = 1024*(256-77)/16

}
는 반주기값 는 박자값void playtone(unsigned int tone, unsigned char time){ // tone 1usec, time

unsigned int buf;
TCCR0 |= 7; 분주비를 로 설정// 1024 시뮬레이션할 때는 조절할 필요가 있음
TCNT0 = 77; 시뮬레이션할 때는 조절할 필요가 있음// 21.306msec = 1024*(256-77)/16
time_data = time;
buf = tone;
do{
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PORTC.0 = 1; do{ delay_us(1);} while(buf--);
PORTC.0 = 0; do{ delay_us(1);} while(tone--);

} while(time_data);
time_data = time;
TCNT0 = 77; 시뮬레이션할 때는 조절할 필요가 있음// 21.306msec = 1024*(256-77)/16
while(time_data);
TCCR0 =0x00;

}
void main(void){

unsigned int tone_data=0xffff;
DDRC = 0xff; 포트 를 출력으로// C
DDRD = 0x00; 포트 를 입력으로 디폴트 입력으로 설정되어 있으므로 필요하지는 않음// D
SREG.7 = 1; 인터럽트 전체 허용//
TIMSK |= 1; 타이머 오버플로 인터럽트 개별허용// 0
for(;;){

loop: while(PIND.0 == 1); 가 눌릴때까지 대기/* PORTD.0 */
delay_ms(50);
if(PIND.0 == 1) goto loop; 눌림이 동안 지속 안되면 키입력은 무시된다/* 50msec */
while(PIND.0 !=1); 가 해제될 때까지 대기/* PORTD.0 */
if(tone_data > 100){tone_data -=200; playtone(tone_data,250); }
else tone_data=0xffff;

}
}

그림 98 음향 발생을 위한 회로도.

� 과제 타이머 를 사용해 구현해 보라 에 연결된 스위치를 누르면 소리가 나고 초후에 멈추: 1~3 . PORTD.0 5① ②

는 프로그램을 작성하라.

5.3.3.5.3.3.5.3.3.5.3.3.5.3.3.5.3.3.5.3.3.5.3.3.5.3.3.5.3.3.5.3.3.5.3.3. 실험 전화벨 소리내기실험 전화벨 소리내기실험 전화벨 소리내기실험 전화벨 소리내기45 :45 :45 :45 :실험 전화벨 소리내기실험 전화벨 소리내기실험 전화벨 소리내기실험 전화벨 소리내기45 :45 :45 :45 :실험 전화벨 소리내기실험 전화벨 소리내기실험 전화벨 소리내기실험 전화벨 소리내기45 :45 :45 :45 :

� 예제 에 연결된 스위치가 눌리면 소리를 내기 시작하여 박자 박자를 번: PORTD.0 480Hz 1/32 , 320Hz 1/32 20

반복하여 소리를 내고 멈춘다.

� 프로그램 작성시 유의점 와 의 주기는 각각 와 이다 박자만큼 지속: 480Hz 320Hz 2.083msec 3.125msec . 1/32

하므로 를 로 주면 된다time_data 1 .

� 회로도 그림 의 회로를 구현하고 을 그림 의 에 연결한다 그림 의 을: 98 BUZZ_CON 79 C_CON . 80 SW_CON

그림 의 에 연결하고 그림 의 을 누르면서 실험한다79 D_CON 80 SW1 .

� 프로그램 예 :

#include <mega128.h>
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#include <delay.h>
unsigned char time_data;

로 해도 됨interrupt [17] void timerint0(void){ // interrupt [TIM0_OVF] void timerint0(void)
time_data--;
TCNT0 = 77; 시뮬레이션할 때는 조절할 필요가 있음// 21.306msec = 1024*(256-77)/16

}
는 반주기값 는 박자값void playtone(unsigned char tone, unsigned char time){ // tone 10usec, time

unsigned char buf;
TCCR0 |= 7; 분주비를 로 설정// 1024 시뮬레이션할 때는 조절할 필요가 있음
TCNT0 = 77; 시뮬레이션할 때는 조절할 필요가 있음// 21.306msec = 1024*(256-77)/16
time_data = time;
buf = tone;
do{

PORTC.0 = 1; do{ delay_us(10);} while(buf--);
PORTC.0 = 0; do{ delay_us(10);} while(tone--);

} while(time_data);
time_data = time;
TCNT0 = 77; 시뮬레이션할 때는 조절할 필요가 있음// 21.306msec = 1024*(256-77)/16
while(time_data);
TCCR0 =0x00;

}
void main(void){

unsigned char i;
DDRC = 0xff; 포트 를 출력으로// C
DDRD = 0x00; 포트 를 입력으로 디폴트 입력으로 설정되어 있으므로 필요하지는 않음// D
SREG.7 = 1; 인터럽트 전체 허용//
TIMSK |= 1; 타이머 오버플로 인터럽트 개별허용// 0
for(;;){

loop: while(PIND.0 == 1); 가 눌릴때까지 대기/* PORTD.0 */
delay_ms(50);
if(PIND.0 == 1) goto loop; 눌림이 동안 지속 안되면 키입력은 무시된다/* 50msec */
while(PIND.0 !=1); 가 해제될 때까지 대기/* PORTD.0 */
for(i=0;i<20;i++){ playtone(208/2,1);
playtone(313/2,1);}

}
}

� 과제 타이머 를 사용해 구현해 보라 에 연결된 스위치를 누르면 전화벨 소리가 나고: 1~3 . PORTC.0① ②

에 연결된 스위치를 누르면 사이렌소리가 나는 프로그램을 작성하라PORTC.1 .

5.3.4.5.3.4.5.3.4.5.3.4.5.3.4.5.3.4.5.3.4.5.3.4.5.3.4.5.3.4.5.3.4.5.3.4. 실험 동요 재생하기실험 동요 재생하기실험 동요 재생하기실험 동요 재생하기46 :46 :46 :46 :실험 동요 재생하기실험 동요 재생하기실험 동요 재생하기실험 동요 재생하기46 :46 :46 :46 :실험 동요 재생하기실험 동요 재생하기실험 동요 재생하기실험 동요 재생하기46 :46 :46 :46 :

� 예제 에 연결된 스위치를 누르면 동요 곰 세마리가 연주한다: PORTC.0 .

� 회로도 그림 의 회로를 구현하고 을 그림 의 에 연결한다 그림 의 을: 98 BUZZ_CON 79 C_CON . 80 SW_CON

그림 의 에 연결하고 그림 의 을 누르면서 실험한다79 D_CON 80 SW1 .

� 프로그램 작성시 유의점 메모리에 동요 곰 세마리의 음계와 박자를 저장하되 마지막에 박자에 가 들어가: 00

도록 한다 순서대로 읽어 들이되 박자가 이면 연주가 끝났으므로 처음으로 복귀하여 스위치가 눌리는지를 감. 0

시하도록 한다.

� 프로그램 예 :

#include <mega128.h>
#include <delay.h>
unsigned char time_data;
unsigned char timetone[ ]={32, 95, 16, 95, 32, 95, 32, 95, 32, 75, 16, 63, 16, 63, 32, 75, 32, 95,

16, 63, 16, 63, 32, 75, 16, 63, 16, 63, 32, 75, 32, 95, 32, 95, 64, 95,
32, 63, 32, 63, 32, 75, 32, 95, 32, 63, 32, 63, 64, 63,
32, 63, 32, 63, 32, 75, 32, 95, 32, 63, 32, 63, 64, 63,
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32, 63, 32, 63, 32, 75, 32, 95, 24, 63, 8, 63, 16, 63, 16, 63, 64, 63,
16, 31, 16, 0, 16, 63, 16, 0, 16, 31, 16, 0, 16, 63, 16, 0, 32, 75, 32, 84, 64, 95, 0};

로 해도 됨interrupt [17] void timerint0(void){ // interrupt [TIM0_OVF] void timerint0(void)
time_data--;
TCNT0 = 77; 시뮬레이션할 때는 조절할 필요가 있음// 21.306msec = 1024*(256-77)/16

}
는 반주기값 는 박자값void playtone(unsigned char tone, unsigned char time){ // tone 10usec, time

unsigned char buf;
TCCR0 |= 7; 분주비를 로 설정// 1024 시뮬레이션할 때는 조절할 필요가 있음
TCNT0 = 77; 시뮬레이션할 때는 조절할 필요가 있음// 21.306msec = 1024*(256-77)/16
time_data = time;
buf = tone;
do{

PORTC.0 = 1; do{ delay_us(10);} while(buf--);
PORTC.0 = 0; do{ delay_us(10);} while(tone--);

} while(time_data);
time_data = time;
TCNT0 = 77; 시뮬레이션할 때는 조절할 필요가 있음// 21.306msec = 1024*(256-77)/16
while(time_data);
TCCR0 =0x00;

}
void main(void){
unsigned char dataidx, tone_data, time;

DDRC = 0xff; 포트 를 출력으로// C
DDRD = 0x00; 포트 를 입력으로 디폴트 입력으로 설정되어 있으므로 필요하지는 않음// D
SREG.7 = 1; 인터럽트 전체 허용//
TIMSK |= 1; 타이머 오버플로 인터럽트 개별허용// 0
for(;;){

dataidx = 0;
loop: while(PIND.0 == 1); 가 눌릴때까지 대기/* PORTD.0 */

delay_ms(50);
if(PIND.0 == 1) goto loop; 눌림이 동안 지속 안되면 키입력은 무시된다/* 50msec */
while(PIND.0 !=1); 가 해제될 때까지 대기/* PORTD.0 */
while ( (time =timetone[dataidx++]) != 0) {

tone_data=timetone[dataidx++];
playtone(tone_data, time);}

}
}

� 과제 타이머 를 사용해 구현해 보라 다른 동요를 저장하고 연주하는 프로그램을 작성해보라: 1~3 . .① ②

5.3.5.5.3.5.5.3.5.5.3.5.5.3.5.5.3.5.5.3.5.5.3.5.5.3.5.5.3.5.5.3.5.5.3.5. 실험 전자 오르간실험 전자 오르간실험 전자 오르간실험 전자 오르간47 :47 :47 :47 :실험 전자 오르간실험 전자 오르간실험 전자 오르간실험 전자 오르간47 :47 :47 :47 :실험 전자 오르간실험 전자 오르간실험 전자 오르간실험 전자 오르간47 :47 :47 :47 :

� 예제 에 연결된 스위치가 눌리면 맞는 음계의 소리를 발생시킨다: PORTD .

� 회로도 그림 의 회로를 구현하고 을 그림 의 에 연결한다 그림 의 을: 98 BUZZ_CON 79 C_CON . 80 SW_CON

그림 의 에 연결하고 그림 의 을 누르면서 실험한다79 D_CON 80 SW1~8 .

� 프로그램 작성시 유의점 박자를 위해 타이머를 쓸 필요없이 눌림을 감지해 감지되면 한 주기 동안만 해당:

음계의 소리가 나도록 한다 이 눌리면 도 음계가 발생하고 가 눌리면 레 음계가 발생하는 식으로 짠. SW1 SW2

다.

� 프로그램 예 :

#include <mega128.h>
#include <delay.h>
unsigned char time_data;

로 해도 됨interrupt [17] void timerint0(void){ // interrupt [TIM0_OVF] void timerint0(void)
time_data--;
TCNT0 = 77; 시뮬레이션할 때는 조절할 필요가 있음// 21.306msec = 1024*(256-77)/16
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}
는 반주기값 는 박자값void playtone(unsigned char tone, unsigned char time){ // tone 10usec, time

unsigned char buf;
TCCR0 |= 7; 분주비를 로 설정// 1024 시뮬레이션할 때는 조절할 필요가 있음
TCNT0 = 77; 시뮬레이션할 때는 조절할 필요가 있음// 21.306msec = 1024*(256-77)/16
time_data = time;
buf = tone;
do{

PORTC.0 = 1; do{ delay_us(10);} while(buf--);
PORTC.0 = 0; do{ delay_us(10);} while(tone--);

} while(time_data);
time_data = time;
TCNT0 = 77; 시뮬레이션할 때는 조절할 필요가 있음// 21.306msec = 1024*(256-77)/16
while(time_data);
TCCR0 =0x00;

}
void main(void){
unsigned char tone_data, keybuf;

DDRC = 0xff; 포트 를 출력으로// C
DDRD = 0x00; 포트 를 입력으로 디폴트 입력으로 설정되어 있으므로 필요하지는 않음// D
SREG.7 = 1; 인터럽트 전체 허용//
TIMSK |= 1; 타이머 오버플로 인터럽트 개별허용// 0
for(;;){
keybuf = PIND; 읽은 값을 에 저장/* keybuf */
if((keybuf == PIND) && (keybuf !=0xff) ) { 두번 읽어 같으며 가 아니면 유효한 키입력이다/* 0xff */

if(keybuf == 0xfe) tone_data= 95;
else if (keybuf == 0xfd) tone_data = 84;
else if (keybuf == 0xfb) tone_data = 75;
else if (keybuf == 0xf7) tone_data = 71;
else if (keybuf == 0xef) tone_data = 63;
else if (keybuf == 0xef) tone_data = 56;
else if (keybuf == 0xbf) tone_data = 50;
else if (keybuf == 0x7f) tone_data = 47;
else tone_data = 0;
if(tone_data !=0)playtone(tone_data,1);

}}
}

� 과제 타이머 를 사용해 구현해 보라: 1~3 .

5.4.5.4.5.4.5.4.5.4.5.4.5.4.5.4.5.4.5.4.5.4.5.4. 문자문자문자문자16x216x216x216x2 문자문자문자문자16x216x216x216x2 문자문자문자문자16x216x216x216x2 LCDLCDLCDLCDLCDLCDLCDLCDLCDLCDLCDLCD

5.4.1.5.4.1.5.4.1.5.4.1.5.4.1.5.4.1.5.4.1.5.4.1.5.4.1.5.4.1.5.4.1.5.4.1. 문자문자문자문자16x216x216x216x2 문자문자문자문자16x216x216x216x2 문자문자문자문자16x216x216x216x2 모듈 개요모듈 개요모듈 개요모듈 개요LCDLCDLCDLCD 모듈 개요모듈 개요모듈 개요모듈 개요LCDLCDLCDLCD 모듈 개요모듈 개요모듈 개요모듈 개요LCDLCDLCDLCD

� 개요 동적 와 전계효과 가 있는데 전계효과형이 가장 흔히 사용되어 전자계산기 시계와 컴퓨LCD : LCD LCD ,

터 등에 사용된다 일반적으로 약. 300 μA 의 작은 구동전류에서 작동하나 교류전원을 요구한다 표시부. LCD

와 제어부를 하나로 하여 모듈로 시판된다 문자형과 그래픽형 가지가 있다 영문자와 숫자표시에는LCD LCD . 2 .

문자형이 적당하며 한글이나 그래픽 표시를 자유롭게 하려면 그래픽형을 사용해야 한다 문자형에는 문자. 8x1(8

를 라인에 표시 등 다양한 종류가 있다1 ), 8x2, 16x1, ..., 16x4, 20x1, ..., 20x4 .

� 제어기 특징 제어기에 가장 보편적으로 사용되는 히타치사의 제어기HD44780 16x2 LCD : 16x2 LCD , 5V

단일 전원 사용 나 도트의 내장 폰트 존재 비트 나 비트 데이터 버스 방식 최대 문자까지 표, 5x7 5x10 , 8 4 , 80

시할 문자 저장하는 바이트 내장 폰트는 개 폰트는 개를 수용80 DDRAM(Display Data RAM) , 5x7 160 5x10 32

할 수 있는 내장CGROM(Character Generator ROM) .

� 핀배치 번 번 번 휘도조절 보통 에 연결 번 핀: 1 (Vss:GND), 2 (Vdd: +5V), 3 (Vo: , GND ), 4 (RS: Register Select
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으로 레벨이면 데이터레지스터가 선택되고 레벨이면 명령레지스터가 선택됨 번 읽기 쓰기 제1 0 ), 5 (R/W: (H), (L)

어 번 신호로 레벨이면 에 명령이나 데이터를 보낼 수 있다 번 백라이트양극 번), 6 (E: Enable 1 LCD ), 15 (A: ), 16

백라이트 음극 번 데이터버스 비트모드의 경우 를 사용하여 상위 비트 하위 비트(K: ), 7-14 (DB0-DB7: , 4 D4-D7 4 4

순으로 읽고 씀)

5.4.2.5.4.2.5.4.2.5.4.2.5.4.2.5.4.2.5.4.2.5.4.2.5.4.2.5.4.2.5.4.2.5.4.2. 제어기의 내부 구성제어기의 내부 구성제어기의 내부 구성제어기의 내부 구성LCDLCDLCDLCD 제어기의 내부 구성제어기의 내부 구성제어기의 내부 구성제어기의 내부 구성LCDLCDLCDLCD 제어기의 내부 구성제어기의 내부 구성제어기의 내부 구성제어기의 내부 구성LCDLCDLCDLCD

명령 과 데이터 를 위한 개의 레지스터 문자발생램(Instruction) (Data) 2 , BF(Busy Flag), AC(Address Counter),

문자발생롬 데이터표시램 이 있다(CGRAM), (CGROM), (DDRAM) .

� 레지스터

명령레지스터 과 에 대한 어드레스와 클리어 커서시프트 등 제어명령을 보유(IR): DDRAM CGRAM ,

데이터레지스터 과 에 쓴 데이터나 읽은 데이터를 일지적으로 저장(DR): DDRAM CGRAM

레지스터 선택방법 번핀과 번핀을 사용하여 선택: RS(4 ) R/W(5 )

쓰기 각종 제어 명령 쓰기RS=0, R/W=0 : IR ( )

읽기 읽기RS=0, R/W=1 : BF , AC

쓰기RS=1, R/W=0 : DR

읽기RS=1, R/W=1 : DR

� 이면 의 콘트롤러가 동작 중으로 명령 수행 불능 이면 다음 명령 수행 가능 표시BF : 1 LCD , 0

� 과 의 주소를 지정할 때 사용하는데 에 주소 정보를 쓰면 주소 정보가 로 전송되고AC : DDRAM CGRAM IR AC

이나 에 데이터를 쓰면 는 자동으로 혹은 이 된다DDRAM DDROM AC +1 -1 .

� 비트 용량으로 개의 비트 아스키코드를 저장할 수있다 주DDRAM(Data Display RAM) : 80x8 80 8 . 0x00-0F

소가 행의 번째 주소가 행의 번째 문자로 표시된다 행 행의 번호 불연속임LCD 1 1-16 , 0x40-4F LCD 2 1-16 .(1 2

에 주의해야 한다.)

� 사용자가 자유로이 문자를 만들 때 사용하는 램으로 은 개CGRAM(Character Generator RAM) : 5x7 8 , 5x10

은 개 만들어 저장 가능하다4 .

� 도트의 문자를 내장하고 있다 특수기호 숫자 영문자의CGROM(Character Generator ROM) : 5x7, 5x10 . , ,

문자코드는 아스키코드와 일치한다.

5.4.3.5.4.3.5.4.3.5.4.3.5.4.3.5.4.3.5.4.3.5.4.3.5.4.3.5.4.3.5.4.3.5.4.3. 명령어명령어명령어명령어명령어명령어명령어명령어명령어명령어명령어명령어

번 번 번 신호 번 백라이트양극 번 백라이트 음극 번4 (RS), 5 (R/W), 6 (E: ENABLE ), 15 (A: ), 16 (K: ), 7-14

값을 이용하여 제어한다 이어야 명령이 유효하다(DB0-DB7) . E=1 .

� 표시클리어 실행시간 표시내용을 소거하고 커서는 홈 행 열 번: RS=R/W=0, DB=0b00000001, 1.64msec, (1 1 , 0

지 로 돌아감 에 스페이스코드 가 쓰여지고 으로 됨) , DDRAM (0x20) AC=0

� 커서홈 실행시간 의 로 세트되어 커서가 홈으로: RS=R/W=0, DB=0b0000001x, 1.64msec, DDRAM AC=0x00

가며 의 내용은 변동 없음DDRAM

� 엔트리모드 설정 커서의 이동방향과 표시 내용의 시프트 여부 설정 실행시간: , 0.04msec

에 데이터를 써넣은 후 표시 전체를 좌로 이동 커서는 이동 안함RS=R/W=0, DB=0b00000101 : DDRAM ,

에 데이터를 써넣은 후 표시 전체를 우로 이동 커서는 이동 안함RS=R/W=0, DB=0b00000111 : DDRAM ,

표시를 이동하지 않고 를 감소시키고 커서가 좌측으로 이동하게 함RS=R/W=0, DB=0b00000100 : AC
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표시를 이동하지 않고 를 증가시키고 커서가 우측으로 이동하게 함RS=R/W=0, DB=0b00000110 : AC

� 표시 온오프제어 커서나 전체표시의 온오프제어 및 커서위치 문자의 깜박임 제어 실행시간: , 0.04msec

일때 전체 온 커서 온 커서 위치 문자 점멸RS=R/W=0, DB=0b00001dcb : d=1 , c=1 , b=1

� 커서표시 시프트 의 내용을 변경시키지 않은 상태에서 커서를 움직이거나 전체문자를 이동 실행시간/ : DDRAM ,

0.04msec

를 감소시키고 커서를 좌로 이동RS=R/W=0, DB=0b000100xx : AC 1

를 증가시키고 커서를 우로 이동RS=R/W=0, DB=0b000101xx : AC 1

모든 표시와 커서를 좌로 이동RS=R/W=0, DB=0b000110xx :

모든 표시와 커서를 우로 이동RS=R/W=0, DB=0b000111xx :

� 기능 설정 표시행수와 문자 폰트 인터페이스 길이를 설정 실행시간: , , 0.04msec

비트 인터페이스RS=R/W=0, DB=0b0011NFxx : 8

비트 인터페이스RS=R/W=0, DB=0b0010NFxx : 4

여기에서 행 폰트 행 폰트 행 폰트NF=00(1 5x7 ), NF=01(1 5x10 ), NF=1x(2 5x7 )

� 주소설정 의 비트 주소를 설정 설정 후 전송 데이터는 의 데이터로 취급됨 실행시CGRAM : CGRAM 6 , CGRAM ,

간 0.04msec

부분의 값이 로 설정됨RS=R/W=0, DB=0b01xxxxxx : xxxxxx AC

� 주소설정 의 비트 주소를 설정 설정 후 전송 데이터는 의 데이터로 취급됨 실행DDRAM : DDRAM 7 , DDRAM ,

시간 0.04msec

부분의 값이 로 설정됨RS=R/W=0, DB=0b1xxxxxxx : xxxxxxx AC

� 와 읽기 의 값이나 의 값을 읽어 들인다 실행시간BF AC : BF AC . 0.04msec

이 의 값이고 가 값이다RS=0, R/W=1 : DB7 BF DB6-0 AC .

� 에 데이터 쓰기 이전에 주소가 설정된 램에 쓰고 엔트리 모드에 따라 주소값이 혹은CGRAM, DDRAM : +1

-1

기능설정의 인터페이스 길이에 따라 를 통해 쓴다RS=1, R/W=0 : DB .

� 에 데이터 읽기 읽기 전에 주소설정 명령을 해야 함 안 그러면 두 번째 데이터부터 유효CGRAM, DDRAM : ,

기능설정의 인터페이스 길이에 따라 를 통해 읽는다RS=1, R/W=1 : DB .

5.4.4.5.4.4.5.4.4.5.4.4.5.4.4.5.4.4.5.4.4.5.4.4.5.4.4.5.4.4.5.4.4.5.4.4. 초기화 방법 비트 인터페이스 경우초기화 방법 비트 인터페이스 경우초기화 방법 비트 인터페이스 경우초기화 방법 비트 인터페이스 경우(4 )(4 )(4 )(4 )초기화 방법 비트 인터페이스 경우초기화 방법 비트 인터페이스 경우초기화 방법 비트 인터페이스 경우초기화 방법 비트 인터페이스 경우(4 )(4 )(4 )(4 )초기화 방법 비트 인터페이스 경우초기화 방법 비트 인터페이스 경우초기화 방법 비트 인터페이스 경우초기화 방법 비트 인터페이스 경우(4 )(4 )(4 )(4 )

전원 온 가 이상된 후 지연 출력-> Vdd 4.5V 15msec -> RS=R/W=0, DB=0b0010xxxx

지연 지연-> 5msec -> RS=R/W=0, DB=0b0010xxxx -> 0.1msec ->

비트 인터페이스 기능설정 는 적절한 값-> 4 RS=R/W=0, DB=0b0010NFxx(NF )

표시 온오프 제어-> RS=R/W=0, DB=0b00001100

표시클리어-> RS=R/W=0, DB=0b00000001

엔트리모드 설정 는 적절한 값 초기화 완료-> RS=R/W=0, DB=0b000001**(** ) ->

5.4.5.5.4.5.5.4.5.5.4.5.5.4.5.5.4.5.5.4.5.5.4.5.5.4.5.5.4.5.5.4.5.5.4.5. 실험 초기화실험 초기화실험 초기화실험 초기화48 : LCD48 : LCD48 : LCD48 : LCD실험 초기화실험 초기화실험 초기화실험 초기화48 : LCD48 : LCD48 : LCD48 : LCD실험 초기화실험 초기화실험 초기화실험 초기화48 : LCD48 : LCD48 : LCD48 : LCD
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� 예제 에 연결된 를 비트 인터페이스 모드로 초기화하고 라는 문자열을 행에: PORTC LCD 4 Enjoy yourselves 1

라는 문자열을 행에 출력한다mega128 u-COM 2 .

� 프로그램 작성시 유의점 다른 응용에서도 시켜 써먹을 수 있도록 작성하였다 그러므로 작성된 프로: include .

그램으로 실험할 때에는 의 앞뒤에 있는 과 주석표시를 제거한다main() /********* *******/ . 헤더파일을 다lcd.h

음처럼 시키면 된다include .

#asm
포트 에 위치.equ __lcd_port= 0x15 ; C LCD

#endasm
#include <lcd.h>

그러면 다음 함수를 사용해서 를 제어할 수 있다lcd .

개의 열을 갖는 를 사용할 수 있도록 초기화한다lcd_init(unsigned char lcd_columns) : lcd_columns LCD .

에 써진 것을 지운다lcd_clear() : LCD .

커서를 열 행 위치로 보낸다lcd_gotoxy(unsighed char x, unsigned char y) : x+1 , y+1 .

의 현재 커서에 문자 를 표시한다lcd_putchar(char c) : LCD c .

에 위치한 스트링을 의 현재 커서를 시작점으로 하여 표시한다lcd_putsf(char flash *str) : flash LCD .

� 회로도 그림 의 회로를 구현하고 을 그림 의 에 연결한다: 99 LCD_CON 79 C_CON .

그림 99 문자 실험 회로도. 16x2 LCD

� 프로그램 예1 :

#include <mega128.h>
#include <delay.h>
#define CUR11 0x02 커서 홈에 위치시키는 명령어 값/* */
#define CUR21 0xC0 커서 라인 열에 위치시키는 명령어 값/* 2 1 */
#define LCDON 0x0C 명령어 값/* LCD ON */
#define LCDOFF 0x08 명령어 값/* LCD OFF */
#define MODE4 0x20 비트 인터페이스 설정/* 4 */
#define FSET 0x28 기능설정 비트 인터페이스 행 폰트/* , 4 , NF=10 : 2 5x7 */
#define LCDCLR 0x01 클리어/* LCD */
#define MODENT 0x06 엔트리모드 설정 표시는 이동 않고 증가 커서 우측 이동/* , , AC , */
void lcd_cmd(unsigned char ch){ 에 명령어값 바이트 쓰는 서브루틴 는 명령어 값/* LCD 1 , ch */

unsigned char temp0, temp1;
delay_ms(15); 약/* 15msec delay */
DDRC = 0xff; 포트 를 출력으로// C
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temp0 = ch & 0xf0; 상위 비트 마스크/* 4 */
temp1 = temp0 | 0x04; 하위 비트에 써넣기/* 4 0100b(RS=R/W=0, E=1) */
PORTC = temp1; 에 명령어값의 상위 비트 써넣기/* LCD 4 */
temp1 = temp0 & 0xf0; 하위 비트에 써넣기/* 4 0000b(RS=R/W=0, E=0) */
PORTC = temp1; 에 입력 불허/* LCD */
delay_us(10); 약 시간지연/* 0.01 msec */
temp0 = (ch << 4) & 0xf0 ; 하위 비트를 상위로 옮기고 마스크/* 4 */
temp1 = temp0 | 0x04 ; 하위 비트에 써넣기/* 4 0100b(RS=R/W=0, E=1) */
PORTC = temp1; 에 명령어값의 하위 비트 써넣기/* LCD 4 */
temp1 = temp0 & 0xf0; 하위 비트에 써넣기/* 4 0000b(RS=R/W=0, E=0) */
PORTC = temp1; 에 입력 불허/* LCD */
delay_ms(1); 약 시간지연/* 1 msec */

}
void lcd_ln11(void){ 의 행 열에 커서를 위치시키는 서브루틴/* LCD 1 1 */

lcd_cmd(CUR11);
}
void lcd_ln21(void){ 의 행 열에 커서를 위치시키는 서브루틴/* LCD 2 1 */

lcd_cmd(CUR21);
}
void lcd_dat(unsigned char ch){ 에 글자 쓰는 서브루틴 는 글자의 아스키 코드 값/* LCD 1 , ch */

unsigned char temp0, temp1;
delay_ms(15); 약/* 15msec delay */
DDRC = 0xff; 포트 를 출력으로// C
temp0 = ch & 0xf0; 상위 비트 마스크/* 4 */
temp1 = temp0 | 0x05; 하위 비트에 써넣기/* 4 0101b(RS=1, R/W=0, E=1) */
PORTC = temp1; 에 값의 상위 비트 써넣기/* LCD DATA 4 */

하위 비트에 써넣기temp1 = temp0 | 0x01; /* 4 0001b(RS=1, R/W=0, E=0) */
PORTC = temp1; 에 입력 불허/* LCD */
delay_us(10); 약 시간지연/* 0.01 msec */
temp0 = (ch << 4) & 0xf0 ; 하위 비트를 상위로 옮기고 마스크/* 4 */
temp1 = temp0 | 0x05; 하위 비트에 써넣기/* 4 0101b(RS=1, R/W=0, E=1) */
PORTC = temp1; 에 값의 하위 비트 써넣기/* LCD DATA 4 */

하위 비트에 써넣기temp1 = temp0 | 0x01; /* 4 0001b(RS=1, R/W=0, E=0) */
PORTC = temp1; 에 입력 불허/* LCD */
delay_ms(1); 약 시간지연/* 1 msec */

}
void lcd_init(void){ 초기화 서브루틴/* LCD */

delay_ms(15); 약/* 15msec delay */
lcd_cmd(MODE4);
delay_ms(5); 약/* 5msec delay */
lcd_cmd(MODE4); delay_us(100);
lcd_cmd(MODE4);
lcd_cmd(FSET); 기능설정 비트 인터페이스 행 폰트/* , 4 , NF=10 : 2 5x7 */
lcd_cmd(LCDON); 명령어 값/* LCD ON */
lcd_cmd(LCDCLR); 명령어 값/* LCD Clear */
lcd_cmd(MODENT); 엔트리모드 설정 표시는 이동 않고 증가 커서 우측 이동/* , , AC , */

}
void lcd_str(char flash *str){ 에 에 저장된 문자열을 출력하는 함수/* LCD flash */

unsigned int i=0;
for(;str[i] != 0; i++) lcd_dat(str[i]);

}
/*************************************
void main(void){

lcd_init();
lcd_ln11();
lcd_str("Enjoy yourselves");
lcd_ln21();
lcd_str("mega128 u-COM");

}
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*********************************/

� 프로그램 예 를 사용하면 다음처럼 쉽게 짤 수 있다2 : lcd.h .

#include <mega128.h>
#include <delay.h>
#asm

포트 에 위치.equ __lcd_port= 0x15 ; C LCD
#endasm
#include <lcd.h>
void main(void){

lcd_init(16); lcd_gotoxy(0,0); lcd_putsf("Enjoy yourselves");
lcd_gotoxy(0,1); lcd_putsf("mega128 u-COM");

}

5.4.6.5.4.6.5.4.6.5.4.6.5.4.6.5.4.6.5.4.6.5.4.6.5.4.6.5.4.6.5.4.6.5.4.6. 실험 점멸하며 문자표시하기실험 점멸하며 문자표시하기실험 점멸하며 문자표시하기실험 점멸하며 문자표시하기49 :49 :49 :49 :실험 점멸하며 문자표시하기실험 점멸하며 문자표시하기실험 점멸하며 문자표시하기실험 점멸하며 문자표시하기49 :49 :49 :49 :실험 점멸하며 문자표시하기실험 점멸하며 문자표시하기실험 점멸하며 문자표시하기실험 점멸하며 문자표시하기49 :49 :49 :49 :

� 예제 에 연결된 를 비트 인터페이스 모드로 초기화하고 라는 문자열을 행에: PORTC LCD 4 Enjoy yourselves 1

라는 문자열을 행에 출력하되 초 정도 간격으로 깜박이도록 한다mega128 u-COM 2 1 .

� 회로도 그림 의 회로를 구현하고 을 그림 의 에 연결한다: 99 LCD_CON 79 C_CON .

� 프로그램 작성시 유의점 실험 의 프로그램 함수를 제거해버린을 라고 저장하고 이를: 45 (main() ) lcdchoi.h

시켜 초기화하기 위한 서브루틴 커서위치를 위한 서브루틴 과 명령 출력을 위include lcd_init, lcd_ln11 lcd_ln21,

한 서브루틴 데이터 출력을 위한 서브루틴 을 재정의 없이 사용한다lcd_cmd, lcd_dat() .

� 프로그램 예 :

#include "lcdchoi.h"
void main(void){

lcd_init(); lcd_ln11(); lcd_str("Enjoy yourselves");
lcd_ln21(); lcd_str("mega128 u-COM");

for(;;){
lcd_cmd(LCDOFF);
delay_ms(1000); 약 초 시간지연/* 1 */
lcd_cmd(LCDON); delay_ms(1000); }

}

5.4.7.5.4.7.5.4.7.5.4.7.5.4.7.5.4.7.5.4.7.5.4.7.5.4.7.5.4.7.5.4.7.5.4.7. 실험 사용자 폰트 이용하기실험 사용자 폰트 이용하기실험 사용자 폰트 이용하기실험 사용자 폰트 이용하기50 :50 :50 :50 :실험 사용자 폰트 이용하기실험 사용자 폰트 이용하기실험 사용자 폰트 이용하기실험 사용자 폰트 이용하기50 :50 :50 :50 :실험 사용자 폰트 이용하기실험 사용자 폰트 이용하기실험 사용자 폰트 이용하기실험 사용자 폰트 이용하기50 :50 :50 :50 :

� 예제 최한호라는 폰트를 만들고 등록하여 의 행에는 라는 문자열을 출력하고 행에: LCD 1 ‘Choi Han Ho is' 2

는 최한호라는 문자열을 출력한다’ ' .

� 프로그램 작성시 유의점 은 폰트 개 폰트 개를 사용자가 정의해서 자유롭게 사용할 수: CGRAM 5x8 8 , 5x10 4

있다 폰트의 패턴제작은 그림 을 참조하면 알 수있다 의 행렬에 원하는 문자를 형상화한다고 생각하고. 100 . 5x8

채워야 하는 곳은 을 써 넣고 공백으로 남겨야 하는 곳에 을 써서 만든다그림 에서 는 무정의 조건으로1 0 ( 100 x

이되도 상관없다 그러므로 패턴값 나 나 나 같다 문자폰트를 등록하기 위해서는 번1 . 0x09 0x49 0x89 ). CGRAM

지 설정 명령을 에 보내고 패턴값 데이터를 보내주면 된다 한 개의 문자폰트를 등록하기 위해서는 폰LCD . 5x8

트의 경우 번지 설정 명령과 패턴값 데이터 보내는 것을 번 수행해야 한다 문자폰트의 등록은 한 문자당 개8 . 8

번지가 소요되면 번지 등등 처럼 등록이 된다 등록된 문자폰트의 코드는 차례로 부터 일련0~7, 8~15, 16~23 . 0

번호가 붙으므로 두번째로 등록된 문자폰트 번지에 등록이 되어 있는 문자폰트를 불러 쓸려면(8~15 )

에 있는 서브루틴명령을 사용하면 된다lcd_dat(0x01) (lcdchoi.h ) .

� 회로도 그림 의 회로를 구현하고 을 그림 의 에 연결한다: 99 LCD_CON 79 C_CON .

� 프로그램 예 :

#include "lcdchoi.h"
void main(void){
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unsigned char i, chhcode[24] = { 0x09, 0x1D, 0x09, 0x15, 0x15, 0x01, 0x09, 0x1D,
0x0A, 0x1E, 0x0A, 0x17, 0x0A, 0x02, 0x10, 0x1E,
0x04, 0x1F, 0x0E, 0x11, 0x11, 0x0E, 0x04, 0x1F};

lcd_init();
for(i=0;i<24;i++){ 에 패턴 저장하기/* CGRAM */

lcd_cmd(0x40+i); 주소는 부터 시작/* CGRAM 0x40 */
lcd_dat(chhcode[i]); /* data write */

}
lcd_ln11();
lcd_str("Choi Han Ho is ");
lcd_ln21();
lcd_dat(0x00); lcd_dat(0x01); lcd_dat(0x02);

}

그림 100 에 문자 등록을 위해 패턴값 구하는 예. LCD

� 과제 다른 글자를 등록하고 이를 표시하는 프로그램를 작성 하여라: .

5.4.8.5.4.8.5.4.8.5.4.8.5.4.8.5.4.8.5.4.8.5.4.8.5.4.8.5.4.8.5.4.8.5.4.8. 실험 시간 조정이 가능한실험 시간 조정이 가능한실험 시간 조정이 가능한실험 시간 조정이 가능한51 :51 :51 :51 :실험 시간 조정이 가능한실험 시간 조정이 가능한실험 시간 조정이 가능한실험 시간 조정이 가능한51 :51 :51 :51 :실험 시간 조정이 가능한실험 시간 조정이 가능한실험 시간 조정이 가능한실험 시간 조정이 가능한51 :51 :51 :51 : 시계시계시계시계시계시계시계시계시계시계시계시계

� 예제 핀 에 연결된 스위치를 누르면 상승 에지 트리거에 의한 인터럽트가 발생하여 타이: INT0(PORTD.0, 25)

머 의 카운팅이 정지되고 다시 한번 누르면 카운팅을 시작한다 핀 에 연결된 스위치를 누1 . INT1(PORTD.1, 26)

르면 상승 에지 트리거에 의한 인터럽트가 발생하여 분값이 증가하고 핀 에 연결된 스위치를INT2(PORTD.1, 27)

누르면 상승 에지 트리거에 의한 인터럽트가 발생하여 시간값이 증가한다 의 행에는. LCD 1 ‘ Hour Min Sec '

라는 문자열을 출력하고 행에는 형태로 시간 분 초가 나타난다2 ’ hh mm ss ' , , .

� 회로도 그림 의 회로를 구현하고 을 그림 의 에 연결한다그림 의 을 그림: 99 LCD_CON 79 C_CON . 80 SW_CON

의 에 연결한다 또한 그림 의 를 누르면서 실험한다79 D_CON . 80 SW1~3 .

� 프로그램 작성시 유의점 타이머 의 모드 을 사용하였고 메인프로그램에서는 키가 눌렸는지를 감시한다: 0 1 .

라고 저장하고 이를 시켜 초기화하기 위한 서브루틴 커서위치를 위한 서브루틴lcdchoi.h include lcd_init,

과 명령 출력을 위한 서브루틴 데이터 출력을 위한 서브루틴 그리고lcd_ln11() lcd_ln21(), lcd_cmd(), lcd_dat(),

시간지연 서브루틴 를 재정의 없이 사용한다 타이머로 계산한 시간 데이터 숫자값을 출력하기 위해서는delay() .

숫자에 해당하는 코드를 에 써줘야 하는데 의 코드는 의 코드는 의 코드는 식이LCD ‘0’ 0x30, '1' 0x31, ‘2’ 0x32

다 그러므로 이를 감안해서 서브루틴을 콜해야 에 표시된다. lcd_dat() LCD .

� 프로그램 예 :

#include "lcdchoi.h"
unsigned char hou, min, sec, onoff=1;
unsigned char dbufh[2], dbufm[2], dbufs[2];
unsigned int cnt0;
void h2b2asc(unsigned char hex, unsigned char *ptr) { 에 출력하기 위해 아스키코드로 변환/* lcd */

*ptr = (hex / 10) + '0'; *(ptr+1) = (hex % 10) + '0';
}
void watch(void){

if( ++sec == 60) { sec = 0;
if( ++min == 60 ) { min = 0;

if( ++hou == 24 ) hou = 0;
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}
}
h2b2asc(sec, dbufs); h2b2asc(min, dbufm); h2b2asc(hou, dbufh);
lcd_ln21(); 행 렬에 커서를 위치시킨다// lcd 2 1 .
lcd_str(" ");
lcd_dat(dbufh[0]); lcd_dat(dbufh[1]); 시간값 출력/* */
lcd_str(" ");
lcd_dat(dbufm[0]); lcd_dat(dbufm[1]); 분값 출력/* */
lcd_str(" ");
lcd_dat(dbufs[0]); lcd_dat(dbufs[1]); 초값 출력/* */

}
처럼 에 저장된 정의를 사용해도 됨interrupt [2] void exint0(void){ // interrupt [EXT_INT0] void exint0(void) mega128.h

if(onoff == 0) onoff = 1; else onoff = 0;
}

처럼 에 저장된 정의를 사용해도 됨interrupt [3] void exint1(void){ // interrupt [EXT_INT1] void exint1(void) mega128.h
if( ++min == 60 ) { min = 0; if( ++hou == 24 ) hou = 0; }

}
처럼 에 저장된 정의를 사용해도 됨interrupt [4] void exint2(void){ // interrupt [EXT_INT2] void exint2(void) mega128.h

if( ++hou == 24 ) hou = 0;
}

로 해도 됨interrupt [17] void timerint0(void){ // interrupt [TIM0_OVF] void timerint0(void)
if(onoff == 0) if( ++cnt0 == 1000 ){ cnt0 = 0; watch(); }
TCNT0 = 6; 재정의 시뮬레이션할 때는 조절할 필요가 있음// 1msec = 64*(256-6)/16

}
void main(void){

DDRC = 0xff; 포트 를 출력으로// C
DDRD = 0x00; 포트 를 입력으로 디폴트 입력으로 설정되어 있으므로 필요하지는 않음// D
SREG.7 = 1; 인터럽트 전체 허용//
EIMSK |= 0x07; 개별 허용// INT0,1,2
EICRA |= 0x3f; 상승에지 트리거//
TIMSK |= 1; 타이머 오버플로 인터럽트 개별허용// 0
TCCR0 |= 4; 분주비를 로 설정// 64 시뮬레이션할 때는 조절할 필요가 있음
TCNT0 = 6; // 1msec = 64*(256-6)/16 시뮬레이션할 때는 조절할 필요가 있음
lcd_init();
lcd_str(" Hour Min Sec ");
for(;;);

}

� 과제 를 사용하여 같은 기능의 프로그램을 작성해보라 타이머 를 사용하여 프로그램 하여라: lcd.h . 1~3 .① ②

초값은 표시하지 않아 시간과 분만을 표시하는 시간조정이 가능한 시계용 프로그램을 작성해보아라.③

5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5. 모터 제어모터 제어모터 제어모터 제어모터 제어모터 제어모터 제어모터 제어모터 제어모터 제어모터 제어모터 제어

5.5.1.5.5.1.5.5.1.5.5.1.5.5.1.5.5.1.5.5.1.5.5.1.5.5.1.5.5.1.5.5.1.5.5.1. 스텝모터 개요스텝모터 개요스텝모터 개요스텝모터 개요스텝모터 개요스텝모터 개요스텝모터 개요스텝모터 개요스텝모터 개요스텝모터 개요스텝모터 개요스텝모터 개요

5.5.1.1.5.5.1.1.5.5.1.1.5.5.1.1. 특징특징특징특징

� 모터의 총회전각은 입력펄스수의 총수에 비례한다.

� 모터의 속도는 초당 입력펄스수펄스레이트에 비례보통수십 정도가 사용됨한다1 ( ) ( kpps ) .

� 기동 정지 회전방향 변경 변속이 쉽고 응답특성도 양호하다, , , .

� 높은 유지토크를 내어 특정 위치에 정지할 수 있고 기동 정지 응답특성이 양호하여 서보모터로 사용가능하다.

� 스텝당 각도오차가 이내이며 회전각의 오차가 누적되지 않는다1 5% .

� 회전각 검출이 필요 없어 제어기가 간단하고 가격이 상대적으로 저렴하다.

� 직류모터에서와 같이 브러쉬 교환 등 보수를 필요로 하지 않아 유지보수가 쉽고 부품수가 적어 신뢰성이 높다.
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� 진동 공진이 발생하기 쉽고 관성이 있는 부하에 약하다, .

� 모터가 정지할 때 흔들이와 같이 진동하면서 정지 진동음이 큰 경우도 종종 발생한다. .

� 펄스레이트가 모터의 고유진동수의 정수분의 일때 큰 진동이 발생한다1 .

� 통상 이하에서 공진이 발생하는 경우가 많고 탈조등의 현상이 발생한다100pps .

� 고속운전시 모터 인덕턴스의 영향으로 권선에 충분한 전류가 흐르지 않아 토크가 저하하고 탈조하기 쉽다.

5.5.1.2.5.5.1.2.5.5.1.2.5.5.1.2. 종류종류종류종류

� 고정자 권선에 따른 종류 고정자에 있는 독립된 권선의 개수에 따라 상 상 상등의 모터가 있고 상은 저: 2 ,3 ,4 2

출력 상은 가변 릴럭턴스형 모터 상은 고출력장치에 적용된다, 3 4 .

� 구조에 따른 종류 :

영구자석형 회전자가 영구자석으로 고정자에 감긴 코일에 전류를 흘리면 회전자가 전류가 흘러진 고정자와:①

정렬하면서 회전하게 됨 보통 스텝각이 도이다. 1.8, 7.5, 15, 30, 34, 90 .

가변릴럭턴스형 회전자가 연강재질로 톱니바퀴 형태 고정자 권선에 전류를 가하면 회전자는 최소 자기저항: .②

을 갖도록 정렬하면서 회전하게됨 보통 스텝각이 도이다 회전자의 관성이 작고 고속응답특성이 우수하나. 7.5, 15 .

권선에 전류를 흘리지 않을 때 유지토크가 임0

하이브리드형 영구자석형의 높은 효율과 가변릴럭턴스형의 작은 스텝각의 장점을 조합 회전자가 원통형의: .③

영구자석위에 톱니형의 규소강판이 적층되어 있음 스텝각은 도임 고정밀 고출력토크용. 0.8, 1.8 . ,

그림 101 스텝모터의 토크 속도 특성.

5.5.1.3.5.5.1.3.5.5.1.3.5.5.1.3. 특성과 사양특성과 사양특성과 사양특성과 사양

그림 에 스텝모터의 속도와 토크의 관계가 보여졌다101 .

� 스텝각 한 입력 펄스당 회전각:

� 유지토크 정지상태에서 모터에 작용 가능한 최대 부하 토크(holding torque):

� 슬루영역 가감속 회전 역회전 정지 기동이 펄스입력에 동기가능한 범위(slew range) : , , ,

� 최대인입속도 무부하시 펄스입력에 동기되어 기동 가능한 최대 입력펄스 수:

� 최대이탈속도 무부하시 입력펄스에 동기되어 회전 가능한 최대 입력펄스 수:

5.5.1.4.5.5.1.4.5.5.1.4.5.5.1.4. 상 스텝 모터의 결선 확인법상 스텝 모터의 결선 확인법상 스텝 모터의 결선 확인법상 스텝 모터의 결선 확인법4444

상 스텝 모터의 경우 선이 개 혹은 개 나와 있다 전원을 순서로 가하면 시계 방향으로 회전한다4 6 5 . A-B-C-D

고 가정하고 선이 개나와 있다고 가정하자 이럴 경우 결선들의 상은 아래에 따라 결정하면 된다6 . .

먼저 공통선 를 찾기 위해 저항계를 사용하여 저항이 무한대가 아닌 짝들을 찾아낼 수 있Ground G(G1,G2)①
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을 것이다 개의 선이 나와있는 경우는 개의 선들로 이루어진 짝들을 찾아 짝 짝이라 하자 그림 의 경. 6 3 X Y . 60

우에는 와 짝을 찾을 수 있다(A,G1,C) (B,G1,D) .

먼저 짝에서 저항계를 다시 이용하여 공통선을 찾고 다음 짝에서 공통선을 찾는다 그림 에서X Y . 102②

짝의 경우 간의 저항은 그리고 간의 저항의 배 정도가 될 것이다(A,G1,C) (A,C) (A,G1) (G1,C) 2 .

공통선 를 연결하고 단계 에서 찾은 와 짝 중 짝에서 공통선이 아닌 두 선을 와Ground G(G1,G2) 1) X Y X Xa③

라 하고 짝에서도 마찬가지로 와 라 하자 먼저 와 공통선간에 정격전원을 가해본다 전원을 끊고Xb Y Ya Yb . Xa . Ya

와 공통선간에 정격전원을 가하면 회전을 하게 되는데 시계 방향으로 회전하면 는 상 는 상 는 상Xa A Xb C Ya B

는 상으로 하면 된다 반시계 방향으로 회전하면 는 상 는 상 는 상 는 상이다Yb D . Xa A Xb C Ya D Yb B .

그림 102 상 스텝모터의 결선도. 4

5.5.2.5.5.2.5.5.2.5.5.2.5.5.2.5.5.2.5.5.2.5.5.2.5.5.2.5.5.2.5.5.2.5.5.2. 상 스텝 모터의 구동원리상 스텝 모터의 구동원리상 스텝 모터의 구동원리상 스텝 모터의 구동원리4444상 스텝 모터의 구동원리상 스텝 모터의 구동원리상 스텝 모터의 구동원리상 스텝 모터의 구동원리4444상 스텝 모터의 구동원리상 스텝 모터의 구동원리상 스텝 모터의 구동원리상 스텝 모터의 구동원리4444

5.5.2.1.5.5.2.1.5.5.2.1.5.5.2.1. 상 여자 방법상 여자 방법상 여자 방법상 여자 방법1111

각 스위치를 닫아 각 상에 전류가 흐르면 극이 회전축 방향으로 자화가 된다고 하자 먼저 을 닫으면 그림S . sw1

의 왼쪽과 같이 되고 다음 을 열고 만 닫으면 회전자가 도 회전하여 그림 의 오른쪽과 같이된103 sw1 sw2 90 103

다 마찬가지로 를 열고 만 닫으면 회전자가 도 회전한다 결국 상 순서로 전류를 흘리면 모. sw2 sw3 90 . A-B-C-D

터가 회전함을 알 수 있다 마찬가지로 순서로 전류를 흘리면 모터가 반시계방향으로 회전한다 개의. D-C-B-A . 1

상만 전류를 흘려서여자시켰는데 회전시켜 상여자 방법이라 한다( ) 1 .

5.5.2.2.5.5.2.2.5.5.2.2.5.5.2.2. 상 여자 방법상 여자 방법상 여자 방법상 여자 방법2222

과 만 닫혔다고 하자 그러면 그림 의 왼쪽과 같이 될 것이다 다음 이 열리고 와 가sw1 sw2 . 104 . sw1 sw2 sw3

닫혔다고 하자 그러면 회전자는 도 회전하여 그림 의 오른쪽과 같이 된다 마찬가지로 가 열고 와. 90 104 . sw2 sw3

가 닫으면 회전자는 도 회전하게 된다 결국 상 순서로 전류를 흘리면 모터가 회전함을 알sw4 90 . AB-BC-CD-DA

수 있다 마찬가지로 순서로 전류를 흘리면 모터가 반시계방향으로 회전한다 이처럼 개의. AB-AD-DC-CB-BA . 2

상을 여자시켜 스텝모터를 구동하는 방법을 상여자 방법이라 한다 상여자에 비해 두배의 전력을 요하나 그 만2 . 1

큼 힘이 좋은 구동 방법이다

5.5.2.3.5.5.2.3.5.5.2.3.5.5.2.3. 상 여자 방법상 여자 방법상 여자 방법상 여자 방법1-21-21-21-2

처음에 만 닫고 그 다음 과 만 닫고 그 다음은 을 열고 만 닫고 이런 식으로sw1 sw1 sw2 sw1 sw2

식으로 여자하면 도씩 회전하게 된다 이처럼 개의 상 그 다음은 개의 상을A-AB-B-BC-C-CD-D-DA-... 45 . 1 2

번갈아 여자시켜 스텝모터를 구동하는 방법을 상여자 방법이라 한다 여자 순서가 복잡해지나 회전 각도의1-2 .

을 증가시킬 수 있는 방법이다resolution

그림 103 상 여자 방법왼쪽 만 닫힌 경우 오른쪽 만 닫힌 경우. 1 ( : sw1 , : sw2 )
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그림 104 상 여자 방법왼쪽 만 닫힌 경우 오른쪽 만 닫힌 경우. 2 ( : sw1, sw2 , : sw2, sw3 )

5.5.3.5.5.3.5.5.3.5.5.3.5.5.3.5.5.3.5.5.3.5.5.3.5.5.3.5.5.3.5.5.3.5.5.3. 스텝 모터의 위치 제어법스텝 모터의 위치 제어법스텝 모터의 위치 제어법스텝 모터의 위치 제어법스텝 모터의 위치 제어법스텝 모터의 위치 제어법스텝 모터의 위치 제어법스텝 모터의 위치 제어법스텝 모터의 위치 제어법스텝 모터의 위치 제어법스텝 모터의 위치 제어법스텝 모터의 위치 제어법

스텝 모터는 여자를 상에서 상 상에서 상 이렇게 순서대로 함에 따라 스텝각이라 불리는 각도만큼씩 회A B , B C

전하게 되기 때문에 각도의 정밀도는 스텝각에 따라 의존하게 된다 상여자나 상여자를 사용하여 구동하는 경. 1 2

우에는 스텝각도가 그 정밀도 한계가 되고 상여자의 경우에는 스텝각의 가 위치 제어의 정밀도 한계가 된1-2 1/2

다 원하는 각도만큼 회전시키기 위해서는 그 각도를 정밀도 한계로 나누어 얻어진 값과 가장 근사한 정수만큼 여.

자순서를 바꾸어 주면 원하는 각도만큼 회전시켜 회전자를 위치시킬 수 있다.

� 상의 스텝모터 상여자 방법 에 의해 시계 방향으로 스텝각의 배만큼 회전시키는 경우를 생각해보자 이4 1 : n .

를 위해 마이콤을 사용하여 를 열고 닫는 여자 패턴을 생성시켜 제어하는 경우 다음과 같sw1, sw2, sw3, sw4

이 여자패턴을 번 만들어 출력포트로 내보내 주면 될 것이다n

번 번 번 번10001000 -> 01000100(1 ) -> 00100010(2 ) -> 00010001(3 ) -> .....(n )

의 작동은 출력포트 값중 하위 나 상위 중 아무 신호를 사용하여 작동시키면 된다sw1, sw2, sw3, sw4 4bit 4bit .

그리고 위의 패턴으로부터 시계방향으로 번 회전시킬 경우 시작값 을 어떤 레지스터에 저장해서 출력n 10001000

하고 레지스터 값을 왼쪽으로 회전시켜서 어느 시간 간격후에 출력시키고 또 레지스터 값을 왼쪽으로 회전시켜서

어느 시간 간격후에 출력시키는 과정을 번 반복 수행하는 식으로 마이콤 프로그램을 짜면 됨을 알 수 있다 반시n .

계방향의 경우는 오른쪽으로 레지스터 값을 회전시켜서 출력하면 된다.

� 상여자의 경우 다음과 같은 여자패턴을 사용한다2 : .

번 번 번 번11001100 -> 01100110(1 ) -> 00110011(2 ) -> 10011001(3 ) -> .....(n )

� 상 여자의 경우 다음과 같이 여자 패턴을 발생시킨다 의 작동은 출력포트 값중1-2 : . sw1, sw2, sw3, sw4

번째 의 신호를 사용하여 작동시키면 된다 위의 상 여자 패턴으로부터 처음에는 만 닫히고 그1,3,5,7 bit . 1-2 sw1

다음은 과 가 닫히고 그 다음은 만 닫히고 그 다음은 와 가 닫히도록 하는 식으로 신호가sw1 sw2 sw2 sw2 sw3

발생됨을 확인할 수 있다.

번 번 번 번11100000 -> 01110000(1 ) -> 00111000(2 ) -> 00011100(3 ) -> .....(n )

5.5.4.5.5.4.5.5.4.5.5.4.5.5.4.5.5.4.5.5.4.5.5.4.5.5.4.5.5.4.5.5.4.5.5.4. 스텝 모터의 속도 제어법스텝 모터의 속도 제어법스텝 모터의 속도 제어법스텝 모터의 속도 제어법스텝 모터의 속도 제어법스텝 모터의 속도 제어법스텝 모터의 속도 제어법스텝 모터의 속도 제어법스텝 모터의 속도 제어법스텝 모터의 속도 제어법스텝 모터의 속도 제어법스텝 모터의 속도 제어법

스텝 모터의 속도는 여자시키기 위해 각 상에 전원을 순서대로 끊고 연결시키는 간격에 따라 좌우된다 즉 한.

여자패턴에서 다음 스텝각으로 회전시키기 위한 여자패턴으로의 이동시간 간격에 따라 좌우된다 예로 상 여자방. 1

식으로 스텝모터를 마이콤을 사용하여 스텝각의 배만큼 회전시키는 경우 다음과 같은 신호들이 출력되고n

번 번 번 번10001000 -> 01000100(1 ) -> 00100010(2 ) -> 00010001(3 ) -> .....(n )

각 신호의 값들이 생성되어 출력되는 간격이 좁으면 회전속도는 빠르고 간격이 넓으면 늦을 것이다 만약 일정.

하다면 정속도 운전이 될 것이고 간격이 넓었다고 좁아지면 가속 운전이 되고 좁았다고 넓어지면 감속 운전이 될
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것이다 스텝모터는 기계적인 한계로 인해 최저 속도와 최고 속도가 사양으로 주어지기 때문에 원하는 응용에 맞.

는 규격을 갖는 스텝모터를 선정하고 이 한도 내에서 여자 간격을 줌으로써 안정적인 속도를 갖도록 제어할 수

있다.

5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5.5. 스텝 모터의 가감속 제어시 펄스레이트 결정법스텝 모터의 가감속 제어시 펄스레이트 결정법스텝 모터의 가감속 제어시 펄스레이트 결정법스텝 모터의 가감속 제어시 펄스레이트 결정법스텝 모터의 가감속 제어시 펄스레이트 결정법스텝 모터의 가감속 제어시 펄스레이트 결정법스텝 모터의 가감속 제어시 펄스레이트 결정법스텝 모터의 가감속 제어시 펄스레이트 결정법스텝 모터의 가감속 제어시 펄스레이트 결정법스텝 모터의 가감속 제어시 펄스레이트 결정법스텝 모터의 가감속 제어시 펄스레이트 결정법스텝 모터의 가감속 제어시 펄스레이트 결정법

가감속제어를 위해서는 여자패턴의 이동시간 간격을 제어해야 하는 데 간격을 결정하는 법을 설명하겠다 초기.

속도 f1 최종속도, fN 최종속도에 도달에 필요한 스텝수, N 이 주어졌고 그림 와 같은 가속패턴이 요구105

된다고 가정하자 감속의 경우는. fN 과 f1 을 바꿔놓으면 된다.

그림 105 스텝모터의 가속 패턴.

t 1=1/f 1 , t k- t k - 1= 1/f k , f k- f 1= ( f N- f 1)( t N- t 1) ( t k- t 1), k= 2, ...,N 이 성립하고 각 시간 간격,

마다 한 스텝씩 움직이는 것이므로 각각의 마름모의 면적은 이 되어야 한다 그러므로 다음의 수식이 성립한다1 . .

2(k-1)=( f k+f 1)( t k-t 1) , 2(N-1)=( f 1+fN)( tN-t 1)
결국 다음의 수식을 얻을 수 있다.

f2k-f21= ( f2N-f21)(k-1)(N-1) , t k-t k-1= 1
f21+ ( f2N-f21)(k-1)(N-1)

예로 최종속도에 도달에 필요한 스텝수 N=10 으로 초기속도와 최종속도가 로 각각pps f 1=500 ,
f 10=1000 일 때 스텝인덱스 와 이에 따른 각 스텝에서의 속도와 시간간격은 표 과 같다k 15 .

k fk(pps) t k-t k -1(msec) tk(msec)
1 500.0 2.0000 2.0000
2 577.4 1.7321 3.7321
3 645.5 1.5491 5.2812
4 707.1 1.4142 6.6955
5 763.8 1.3093 8.0048
6 816.5 1.2247 9.2295
7 866.0 1.1547 10.3842
8 912.9 1.0954 11.4797
9 957.4 1.0445 12.5241
10 1000 1.0000 13.5241

표 15. f 1=500 , f 10=1000 일 때 에 따른 속도k

5.5.6.5.5.6.5.5.6.5.5.6.5.5.6.5.5.6.5.5.6.5.5.6.5.5.6.5.5.6.5.5.6.5.5.6. 모터 구동용모터 구동용모터 구동용모터 구동용모터 구동용모터 구동용모터 구동용모터 구동용모터 구동용모터 구동용모터 구동용모터 구동용 브리지 회로브리지 회로브리지 회로브리지 회로HHHH브리지 회로브리지 회로브리지 회로브리지 회로HHHH브리지 회로브리지 회로브리지 회로브리지 회로HHHH
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그림 에 보여진 회로는 브리지 회로로 여러가지 모터를 구동하기 위해 쓰일 수 있다106 H .

� 와C3205Y 쌍의 역할 출력으로 유출입되는 전류의 흐름을 통제하는 스위치의 역할을 한다A1273Y : on-off .

입력이 일 때 은 상태 는 상태로 되어 출력이 에 연결되고IN1 1(5V level) C3205Y off A1273Y on OUT1 GND ,

입력이 일 때 은 켜지고 는 꺼져 출력은 에 연결된다 그래서 부하IN1 0(0V level) C3205Y A1273Y OUT1 VCC .

를 과 사이에 연결하고 에 레벨을 입력시키고 에 레벨을 입력시키면 부하에는 전류가OUT1 OUT2 IN1 1 IN2 0

측에서 흘러들어가 측으로 흘러 나가게 된다OUT2 OUT1 . 파워 과2SD560 ( TR:npn) 쌍으로 혹은2SB601

과BDX53C(npn) 쌍으로 대체가능하다BDX54C .

� 옴(0.5 [1W], 과 옴2SC1815Y) (0.5 [1W], 의 역할 출력으로 유출유입되는 전류가 어느 한도를2SA1015Y) : ( )

넘으면 혹은 가 도통이 되고 혹은 이 꺼지게 되어 출력으로 유출유입2SC1815Y( 2SA1015Y) C3205Y( A1273Y) ( )

되는 전류를 제한한다 주어진 회로도에서는 옴가 한도가 된다 저항값을 조정함으로써 출력쪽. 1.2 A(=0.6V/0.5 ) .

으로의 유출입 전류 상한값을 설정할 수 있다.

� 의 역할 스위치 역할을 하는 혹은 가 손상되는 것을 방지하는 환류다이오드의 역할FR105 : C3205Y( A1273Y)

은 한다 이들 트랜지스터가 켜져있다가 갑자기 꺼지게 되면 출력의 부하가 인덕턴스 성분을 갖는 모타의 경우.

부하 전류가 급격히 변화할 수 없는 상황에서 전류가 흐를 곳이 없어 트랜지스터를 파괴하고 흐를 소지가 있다.

이 때 다이오드 가 전류의 통로를 마련해준다FR105 .

그림 106 다목적 브리지 회로의 예. H

5.5.7.5.5.7.5.5.7.5.5.7.5.5.7.5.5.7.5.5.7.5.5.7.5.5.7.5.5.7.5.5.7.5.5.7. 모터 구동용모터 구동용모터 구동용모터 구동용 ICICICIC모터 구동용모터 구동용모터 구동용모터 구동용 ICICICIC모터 구동용모터 구동용모터 구동용모터 구동용 ICICICIC 의 개요의 개요의 개요의 개요L298L298L298L298의 개요의 개요의 개요의 개요L298L298L298L298의 개요의 개요의 개요의 개요L298L298L298L298

� 특징 와 두개의 브리지 회로 내장 회로가 간단하고 부피가 적음 최대 전류 평균 전류: A B H , , 2.5A,

구동이 가능 환류다이오드를 외부에서 달아 주어야 함0.2-0.25A, 2000~4000 pps . .

� 핀배치 번 번 브리지회로의 인에블 단자로 레벨이면 동작허용 번 브리지회로의: 8 (GND), 6 (ENA:A 1 ), 5 (IN1:A

입력 번 브리지회로의 출력 번 브리지회로의 입력 번 브리지회로의 출력1), 2 (OUT1:A 1), 7 (IN2: A 2), 3 (OUT1:A

번 브리지회로의 입력 번 브리지회로의 인에블 단자로 레벨이면 동작허용 번2), 10 (IN3:B 1), 11 (ENB:B 1 ),13

브리지회로의 출력 번 브리지회로의 입력 번 브리지회로의 출력 번(OUT3:B 1), 12 (IN4: B 2), 14 (OUT4:B 2), 4

모터측 전원으로 마이컴측 전원보다 이상 커야 함 와 사이에 콘덴서를 필히 연결해야(VS: 2.5V , GND 100nF

함 번 마이컴측 전원단자 와 사이에 콘덴서를 필히 연결해야 함 번 브리지회로), 9 (VSS: . GND 100nF ), 1 (ISENA:A

에 흐르는 부하 전류를 측정하기 위해 와 사이에 저항을 삽입하기 위한 단자 과부하 전류 차단용 제어회로GND ,

나 제어에 활용 가능 번PWM ), 15 (ISENB)

� 동작방법 레벨 레벨 레벨시 브리지회로가 동작하고 에서 전류가 흘러나와: IN1=1 , IN2=0 , ENA=1 A OUT1

쪽으로 전류가 흘러들어간다 레벨 레벨 레벨시 브리지회로가 동작하고 에서OUT2 . IN1=0 , IN2=1 , ENA=1 A OUT2

전류가 흘러나와 쪽으로 전류가 흘러들어간다 이며 레벨시 급속하게 정지되고 레OUT1 . IN1=IN2 ENA=1 ENA=0

벨시 입력에 관계없이 천천히 정지한다 브리지회로도 마찬가지이다 결국 를 레벨로 고정시키고 입력. B . ENx 1 INx
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을 조정하여 모터의 정지 운전 회전방향을 제어할 수도 있고 를 어느 한방향으로 전류가 흘러들어가게 고, , , INx

정시키고 를 조정하여 회전방향은 일정하게 놓고 모터의 정지와 운전만을 제어할 수도 있고 와 를ENx , ENx INx

모두 조정하여 모터의 정지 운전 회전방향을 제어할 수도 있다, , .

5.5.8.5.5.8.5.5.8.5.5.8.5.5.8.5.5.8.5.5.8.5.5.8.5.5.8.5.5.8.5.5.8.5.5.8. 실험 스텝 모터 정속 제어실험 스텝 모터 정속 제어실험 스텝 모터 정속 제어실험 스텝 모터 정속 제어52 :52 :52 :52 :실험 스텝 모터 정속 제어실험 스텝 모터 정속 제어실험 스텝 모터 정속 제어실험 스텝 모터 정속 제어52 :52 :52 :52 :실험 스텝 모터 정속 제어실험 스텝 모터 정속 제어실험 스텝 모터 정속 제어실험 스텝 모터 정속 제어52 :52 :52 :52 :

� 예제 에 연결된 스위치가 홀수번 눌리면 포트에 연결된 스텝모터를 로 스텝모터를 회전시: PORTD.0 C 500pps

킨다 짝수번 눌리면 정지한다. .

� 프로그램 작성시 유의점 로 회전시키기 위해서는 마다 여자 패턴을 바꾸어 주어야 한다 타이: 500pps 2msec .

머 의 노말모드를 이용하여 마다 인터럽트를 발생시키고 여자 패턴을 바꾸어준다 상여자로 한다고 가0 2msec . 1

정한다 그림 의 회로에서는 를 레벨에 고정시켰음에 유의해서 작성해야 한다. 107 ENx 1 .

그림 107 모터 실험 회로도.

� 회로도 그림 의 회로를 구현하고 을 그림 의 에 연결한다 그림 의 을: 107 L_CON 79 C_CON . 107 MOTOR_CON

모터측 전원과 상과 에 연결한다 단자를 에 직접 연결하여 부하전류의 궤환을 하지A,B,C,D GND . ISENx GND

않는다 그림 의 을 그림 의 에 연결한다 또한 그림 의 를 누르면서 실험한다. 80 SW_CON 79 D_CON . 80 SW1 .

� 프로그램 예 :

#include <mega128.h>
unsigned int cnt0;
unsigned char led=0x88, onoff=1;

처럼 에 저장된 정의를 사용해도 됨interrupt [2] void exint0(void){ // interrupt [EXT_INT0] void exint0(void) mega128.h
if(onoff == 0) onoff = 1; else onoff = 0;

}
로 해도 됨interrupt [17] void timerint0(void){ // interrupt [TIM0_OVF] void timerint0(void)

if(onoff == 0) if( ++cnt0 == 2 ){
cnt0 = 0; led >>= 1; if(led == 0x08) led=0x88; }
PORTC = led;
TCNT0 = 6; 재정의 시뮬레이션할 때는 조절할 필요가 있음// 1msec = 64*(256-6)/16

}
void main(void){

DDRC = 0xff; 포트 를 출력으로// C
DDRD = 0x00; 포트 를 입력으로 디폴트 입력으로 설정되어 있으므로 필요하지는 않음// D
SREG.7 = 1; 인터럽트 전체 허용//
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EIMSK |= 0x01; 개별 허용// INT0
EICRA |= 3; 상승에지 트리거//
TIMSK |= 1; 타이머 오버플로 인터럽트 개별허용// 0
TCCR0 |= 4; 분주비를 로 설정// 64 시뮬레이션할 때는 조절할 필요가 있음
TCNT0 = 6; // 1msec = 64*(256-6)/16 시뮬레이션할 때는 조절할 필요가 있음
for(;;);

}

� 과제 타이머 을 이용하여 작성해보라: 1~3 .

5.5.9.5.5.9.5.5.9.5.5.9.5.5.9.5.5.9.5.5.9.5.5.9.5.5.9.5.5.9.5.5.9.5.5.9. 실험 스텝 모터 속도 제어실험 스텝 모터 속도 제어실험 스텝 모터 속도 제어실험 스텝 모터 속도 제어53 :53 :53 :53 :실험 스텝 모터 속도 제어실험 스텝 모터 속도 제어실험 스텝 모터 속도 제어실험 스텝 모터 속도 제어53 :53 :53 :53 :실험 스텝 모터 속도 제어실험 스텝 모터 속도 제어실험 스텝 모터 속도 제어실험 스텝 모터 속도 제어53 :53 :53 :53 :

� 예제 에 연결된 스위치가 홀수번 눌리면 포트에 연결된 스텝모터를 로 스텝모터를 회전: PORTD.0 C 500pps

시킨다 짝수번 눌리면 정지한다 에 연결된 스위치가 눌리면 속도가 증가하고 에 연결된 스. . PORTD.1 PORTD.2

위치가 눌리면 감속된다.

� 프로그램 작성시 유의점 로 회전시키기 위해서는 마다 여자 패턴을 바꾸어 주어야 한다 타이: 500pps 2msec .

머 의 노말모드를 이용하여 인터럽트를 발생시키고 여자 패턴을 바꾸어준다 상여자로 한다고 가정한다 외부0 . 1 .

인터럽트를 사용하여 가감속을 제어한다.

� 회로도 그림 의 회로를 구현하고 을 그림 의 에 연결한다 그림 의 을: 107 L_CON 79 C_CON . 107 MOTOR_CON

모터측 전원과 상과 에 연결한다 단자를 에 직접 연결하여 부하전류의 궤환을 하지A,B,C,D GND . ISENx GND

않는다 그림 의 을 그림 의 에 연결한다 또한 그림 의 를 누르면서 실험한다. 80 SW_CON 79 D_CON . 80 SW1~3 .

� 프로그램 예 :

#include <mega128.h>
unsigned int cnt, delaytime, step, delaymax, delaymin;
unsigned char led=0x88, onoff=1;

처럼 에 저장된 정의를 사용해도 됨interrupt [2] void exint0(void){ // interrupt [EXT_INT0] void exint0(void) mega128.h
if(onoff == 0) onoff = 1; else onoff = 0;

}
처럼 에 저장된 정의를 사용해도 됨interrupt [3] void exint1(void){ // interrupt [EXT_INT1] void exint1(void) mega128.h

if( delaytime + step <= delaymax ) delaytime += step;
}

처럼 에 저장된 정의를 사용해도 됨interrupt [4] void exint2(void){ // interrupt [EXT_INT2] void exint2(void) mega128.h
if( delaytime - step >= delaymin ) delaytime -= step;

}
로 해도 됨interrupt [17] void timerint0(void){ // interrupt [TIM0_OVF] void timerint0(void)

if(onoff == 0) if( cnt-- == 1 ){
cnt = delaytime;
led >>= 1; if(led == 0x08) led=0x88; }

재정의 시뮬레이션할 때는 조절할 필요가 있음TCNT0 = 231; // 1msec = 64*(256-6)/16
PORTC = led;

}
void main(void){

포트 를 출력으로DDRC = 0xff; // C
PORTC = led;
SREG |= 0x80; 인터럽트 전체 허용//
EIMSK |= 0b00000111; 개별 허용// INT0, 1,2
EICRA |= 0x3f; 상승에지 트리거// INT0, 1,2
TIMSK |= 1; 타이머 오버플로 인터럽트 개별허용// 0
TCCR0 |= 4; 분주비를 로 설정// 64
TCNT0 = 231; // 64*(256-231)/16=100usec = 0.1msec
delaytime = 20; cnt = delaytime; 점멸주기를 로 초기화/* 20*0.0001 = 2msec */
delaymax = 40; delaymin = 1; 점멸회전주기의 최대 최소값을 초로 초기화/* , 4m, 0.1m */
step = 2; 주기 변경 폭을 으로 초기화/* 10 */
while(1);

}
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� 과제 최소 최대 사이에서 작동하도록 프로그램을 변경하여 보아라: 200pps 2000pps .

5.5.10.5.5.10.5.5.10.5.5.10.5.5.10.5.5.10.5.5.10.5.5.10.5.5.10.5.5.10.5.5.10.5.5.10.실험 스텝 모터 가감속 제어실험 스텝 모터 가감속 제어실험 스텝 모터 가감속 제어실험 스텝 모터 가감속 제어54 :54 :54 :54 :실험 스텝 모터 가감속 제어실험 스텝 모터 가감속 제어실험 스텝 모터 가감속 제어실험 스텝 모터 가감속 제어54 :54 :54 :54 :실험 스텝 모터 가감속 제어실험 스텝 모터 가감속 제어실험 스텝 모터 가감속 제어실험 스텝 모터 가감속 제어54 :54 :54 :54 :

� 예제 에 연결된 스위치가 한번 눌리면 포트 에 연결된 스텝모터를 에서 로 단계: PORTD.0 C 500pps 1000pps 10

에 걸쳐 가속시켜 그 이후에 로 운전하고 또 눌리면 반대로 감속시켜 정지시킨다1000pps .

� 프로그램 작성시 유의점 표 에 주어진: 15 t k-t k -1를 프로그램메모리에 저장시키고 이를 불러다가 사용한다.
� 회로도 회로도 그림 의 회로를 구현하고 을 그림 의 에 연결한다 그림 의: : 107 L_CON 79 C_CON . 107

을 모터측 전원과 상과 에 연결한다 단자를 에 직접 연결하여 부하전MOTOR_CON A,B,C,D GND . ISENx GND

류의 궤환을 하지 않는다 그림 의 을 그림 의 에 연결한다 또한 그림 의 를 누르. 80 SW_CON 79 D_CON . 80 SW1

면서 실험한다.

� 프로그램 예:

#include <mega128.h>
#include <delay.h>
unsigned char led=0x88, status, vtblidx;
unsigned int vtbl[ ] = {2000,1732,1549,1414,1309,1225,1155,1095,1045,1000 };
unsigned int cnt, cvt;

로 해도 됨interrupt [17] void timerint0(void){ // interrupt [TIM0_OVF] void timerint0(void)
if(cnt++ >= cvt){

cnt = 0;
if(status !=0){

if(vtblidx<=8) vtblidx++;
led >>= 1; if(led == 0x08) led=0x88;

}
else {

if(vtblidx>0) {
vtblidx--;
led >>= 1; if(led == 0x08) led=0x88;}

} }
TCNT0 = 240; 재정의 와 분주비 사용시// 1usec = 1*(256-240)/16 16MHz 1
PORTC = led;

}
void main(void){

DDRC = 0xff; 포트 를 출력으로// C
PORTC = led;
SREG |= 0x80; 인터럽트 전체 허용//
TIMSK |= 1; 타이머 오버플로 인터럽트 개별허용// 0
TCCR0 |= 1; 분주비를 로 설정// 1
TCNT0 = 240;
for(;;){

loop: while(PIND.0 == 1); 가 눌릴때까지 대기/* PORTD.0 */
delay_ms(50); 시간지연/* 50msec */
if(PIND.0 == 1) goto loop; 눌림이 동안 지속 안되면 무효 다시 키입력을 받는다/* 50msec */
while(PIND.0 !=1); 가 해제될 때까지 대기/* PORTD.0 */
cvt = vtbl[vtblidx];
status = ~status;
}

}

5.5.11.5.5.11.5.5.11.5.5.11.5.5.11.5.5.11.5.5.11.5.5.11.5.5.11.5.5.11.5.5.11.5.5.11.직류모터 개요직류모터 개요직류모터 개요직류모터 개요직류모터 개요직류모터 개요직류모터 개요직류모터 개요직류모터 개요직류모터 개요직류모터 개요직류모터 개요

5.5.11.1.5.5.11.1.5.5.11.1.5.5.11.1. 특징특징특징특징

� 기동토크가 크고 입력 전압에 비례하는 회전속도를 얻을 수 있다.
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� 토크에 대하여 회전속도는 반비례하는 특성을 갖고 있다.

� 입력전류에 대하여 출력토크가 직선적이며 출력 효율도 양호하며 가격이 저렴하다.

� 양호한 토크 속도 토크 전류 특성으로 광범위한 속도 제어와 여러 다양한 제어방법의 적용이 가능하다- , - .

� 직류 모터는 높은 회전력 광범위한 속도 제어 능력 휴대 용이 속도 회전력 특성 양호 여러 다양한 제어 방, , , ,

법 적용가능 등의 특성 때문에 로봇 카셋트 테이프 하드디스크 기계공구 등 광범위하게 사용되고 있다, , , .

� 브러시와 정류자의 기계식 접점때문에 소음과 노이즈 먼지가 많이 발생하며 브러시등을 교환해주어야 하기,

때문에 유지보수가 스텝모터에 비해 쉽지않다브리시리스 직류모터는 제외( ).

5.5.11.2.5.5.11.2.5.5.11.2.5.5.11.2. 직류모터 구동원리직류모터 구동원리직류모터 구동원리직류모터 구동원리

그림 의 왼쪽그림에서 만약 단자에 를 걸면 플레밍의 왼손 법칙에 의해 단자측 도선은 아래쪽으108 AB +Vcc A

로 힘이 작용하고 단자측 도선은 위쪽으로 힘이 작용하여 축에 대하여 반시계 방향으로 회전력이 발생한다B aa' .

만약 도선을 여러 개로 하여 회전축으로 회전 가능한 원통에 방사상으로 배치하여 고정시킨 그림 의 오른쪽aa' 108

과 같은 경우 의 좌측 도선은 지면으로 흘러 들어가는 방향으로 전류를 흘리고 의 우측 도선은 지면에서 흘bb' bb'

러 나오는 방향으로 전류를 흘리면 축을 중심으로 하여 반시계 방향으로 회전력이 발생하여 도선이 고정된 원aa'

통은 반시계 방향으로 회전할 수 있다 어떤 장치를 사용하여 의 좌측에 위치하는 도선은 항상 지면으로 흘러. bb'

들어가게 전류를 주고 의 우측에 위치하는 도선은 항상 지면에서 흘러 나오게 전류를 주면 계속적으로 원통을bb'

회전하게 할 수 있다.

그림 108 직류모터의 구동원리.

5.5.11.3.5.5.11.3.5.5.11.3.5.5.11.3. 직류모터 구조직류모터 구조직류모터 구조직류모터 구조

그림 에 보여진 것과 구조가 유사하여 영구 자석으로 이루어진 고정자가 있고 도선이 감긴 원통형의 회전자108

가 있으며 회전자의 도선에 흐르는 전류의 방향을 축의 좌측 또는 우측에 위치하느냐에 따라 일정한 방향으로bb'

흘러 들어가게 하는 정류자와 브러시라는 장치로 구성되어 있다 회전자가 영구자석으로 이루어지고 고정자에 도.

선을 감은 형태의 직류모터도 있다.

5.5.12.5.5.12.5.5.12.5.5.12.5.5.12.5.5.12.5.5.12.5.5.12.5.5.12.5.5.12.5.5.12.5.5.12.실험 직류모터 속도 제어실험 직류모터 속도 제어실험 직류모터 속도 제어실험 직류모터 속도 제어55 : 155 : 155 : 155 : 1실험 직류모터 속도 제어실험 직류모터 속도 제어실험 직류모터 속도 제어실험 직류모터 속도 제어55 : 155 : 155 : 155 : 1실험 직류모터 속도 제어실험 직류모터 속도 제어실험 직류모터 속도 제어실험 직류모터 속도 제어55 : 155 : 155 : 155 : 1

� 예제 에 연결된 스위치가 홀수번 눌리면 포트에 연결된 직류모터를 회전시킨다 짝수번 눌리면: PORTD.0 C .

정지한다 에 연결된 스위치가 눌리면 속도가 증가하고 에 연결된 스위치가 눌리면 감속된다. PORTD.1 PORTD.2 .

� 프로그램 작성시 유의점 타이머 의 노말모드를 이용하여 인터럽트를 발생시켜 출력을 온오프시킨다 외부: 0 .

인터럽트를 사용하여 온오프의 듀티비를 조절하여 가감속을 제어한다.

� 회로도 그림 의 회로를 구현하고 을 그림 의 에 연결한다 그림 의: 107 L_CON 79 C_CON . 107 MOTOR_CON

의 번을 모터측 단자에 를 모터측 단자에 연결한다 단자를 에 직접 연결하여 부하전류의2 A GND B . ISENx GND

궤환을 하지 않는다 그림 의 을 그림 의 에 연결한다 또한 그림 의 를 누르면. 80 SW_CON 79 D_CON . 80 SW1~3

서 실험한다.

� 프로그램 예:



- 139 -

#include <mega128.h>
unsigned int cnt, step=1, delaymax=10, delaymin=1, speed=5;
unsigned char onoff=1;

처럼 에 저장된 정의를 사용해도 됨interrupt [2] void exint0(void){ // interrupt [EXT_INT0] void exint0(void) mega128.h
if(onoff == 0) onoff = 1; else onoff = 0;

}
처럼 에 저장된 정의를 사용해도 됨interrupt [3] void exint1(void){ // interrupt [EXT_INT1] void exint1(void) mega128.h

if( speed + step < delaymax ) speed += step;
}

처럼 에 저장된 정의를 사용해도 됨interrupt [4] void exint2(void){ // interrupt [EXT_INT2] void exint2(void) mega128.h
if( speed - step >= delaymin ) speed -= step;

}
로 해도 됨interrupt [17] void timerint0(void){ // interrupt [TIM0_OVF] void timerint0(void)

if(onoff == 0) { if( cnt-- == 0 ) cnt = delaymax;
if(speed <= cnt ) PORTC.0 = 1;
else PORTC.0 = 0; }

else PORTC.0 = 0;
TCNT0 = 6; 재정의 시뮬레이션할 때는 조절할 필요가 있음// 1msec = 64*(256-6)/16

}
void main(void){

DDRC = 0xff; 포트 를 출력으로// C
PORTC = 0x00;
SREG |= 0x80; 인터럽트 전체 허용//
EIMSK |= 0b00000111; 개별 허용// INT0, 1,2
EICRA |= 0x3f; 상승에지 트리거// INT0, 1,2
TIMSK |= 1; 타이머 오버플로 인터럽트 개별허용// 0
TCCR0 |= 4; 분주비를 로 설정// 64
TCNT0 = 6; // 64*(256-6)/16=1000usec = 1msec
while(1);

}

� 과제 타이머 대신 타이머 을 사용해서 작성해 보아라: 0 1~3 .

5.5.13.5.5.13.5.5.13.5.5.13.5.5.13.5.5.13.5.5.13.5.5.13.5.5.13.5.5.13.5.5.13.5.5.13.실험 직류모터 속도 제어실험 직류모터 속도 제어실험 직류모터 속도 제어실험 직류모터 속도 제어56 : 256 : 256 : 256 : 2실험 직류모터 속도 제어실험 직류모터 속도 제어실험 직류모터 속도 제어실험 직류모터 속도 제어56 : 256 : 256 : 256 : 2실험 직류모터 속도 제어실험 직류모터 속도 제어실험 직류모터 속도 제어실험 직류모터 속도 제어56 : 256 : 256 : 256 : 2

� 예제 타이머 의: 3 모드를 이용해서 직류모터의 속도를 제어한다 에 연결된 스위치가 눌리면 속PWM . PORTD.0

도가 감소하고 에 연결된 스위치가 눌리면 증가된다PORTD.2 .

� 프로그램 작성시 유의점 타이머 의 출력비교 모드를 이용하여 신호를 발생시켜 출력을 온오프시킨다: 3 PWM .

외부 인터럽트를 사용하여 온오프의 듀티비를 조절하여 가감속을 제어한다.

� 회로도 그림 의 회로를 구현하고 을 그림 의 에 연결한다 그림 의: 107 L_CON 79 E_CON . 107 MOTOR_CON

의 번을 모터측 단자에 를 모터측 단자에 연결한다 단자를 에 직접 연결하여 부하전류의2 A GND B . ISENx GND

궤환을 하지 않는다 그림 의 을 그림 의 에 연결한다 또한 그림 의 를 누르면. 80 SW_CON 79 D_CON . 80 SW1~2

서 실험한다.

� 프로그램 예:

#include <mega128.h>
unsigned int step=50;

처럼 에 저장된 정의를 사용해도 됨interrupt [2] void exint0(void){ // interrupt [EXT_INT0] void exint0(void) mega128.h
unsigned int ocr3a;

ocr3a = 256*OCR3AH+OCR3AL;
if( ocr3a > step ) {

ocr3a -= step;
OCR3AH = ocr3a/256;
OCR3AL = ocr3a%256;}

}
처럼 에 저장된 정의를 사용해도 됨interrupt [3] void exint1(void){ // interrupt [EXT_INT1] void exint1(void) mega128.h
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unsigned int ocr3a;
ocr3a = 256*OCR3AH+OCR3AL;

if( ocr3a < 0xffff - step ) {
ocr3a += step;
OCR3AH = ocr3a/256;
OCR3AL = ocr3a%256;}

}
void main(void){

DDRE.3 = 1; 를 출력으로// PORTE bit 4
SREG |= 0x80; 인터럽트 전체 허용//
EIMSK |= 0b00000111; 개별 허용// INT0, 1,2
EICRA |= 0x3f; 상승에지 트리거// INT0, 1,2
TCCR3B |= 2; 분주비를 로 설정// 8
TCCR3A |=2; 타이머 모드 로 설정// 3 PC PWM 14
TCCR3B |= 0x10; 타이머 모드 로 설정// 3 PC PWM 14
TCCR3A |= 0x80; 출력비교모드 설정//
OCR3AH = 0x7f;
OCR3AL = 0xff;
ICR3H = 0xff;
ICR3L = 0xff;
for(;;);

}

5.6.5.6.5.6.5.6.5.6.5.6.5.6.5.6.5.6.5.6.5.6.5.6. 변환변환변환변환DADADADA 변환변환변환변환DADADADA 변환변환변환변환DADADADA

5.6.1.5.6.1.5.6.1.5.6.1.5.6.1.5.6.1.5.6.1.5.6.1.5.6.1.5.6.1.5.6.1.5.6.1. 변환기의 종류변환기의 종류변환기의 종류변환기의 종류DADADADA변환기의 종류변환기의 종류변환기의 종류변환기의 종류DADADADA변환기의 종류변환기의 종류변환기의 종류변환기의 종류DADADADA

디지털 아날로그 변환기는 진부호로 표현된 디지털량을 그에 대응하는 직류전압으로 변환하는 회로로 그림- 2

에 보여진 것처럼 가산형과 사다리형이 있다109 .

가산형 진 하중 저항형(2 ):① n 비트의 디지털값을 아날로그량으로 변환하기 위해 R,2R,4R,⋯, 2 n - 1R 값의
저항들과 연산증폭기를 사용하여 가산증폭기 형태로 구성한 변환기로 정밀한 변환을 위해서는 최대저항과 최D/A

소저항 사이의 저항비가 정밀해야하고 비트수가 많아지면 최대저항과 최소저항 사이의 저항비가 너무 커지며 각

디지털입력은 서로 다른 부하를 갖는 단점을 지녀 비트 이상의 변환에 거의 사용되지 않는다 그림 왼4 D/A . 109(

쪽 에 비트의 디지털값을 아날로그량으로 변환하기 위한 가산형 변환기가 보여졌다 레벨 입력전압이) 4 D/A . 1

V r 일 때 출력값 V o 는 디지털값 b i 에 의존하여 다음과 같이 주어진다

V o=- R FR (
b 11 +

b 22 +
b 34 +

b 48 )V r
사다리형 형(R-2R ):② R, 2R 두 종류의 저항과 연산증폭기를 사용하여 구성한 변환기로 고정도로 만들 수D/A

있다 저가로 많이 사용되는 내셔날세미컨덕터사의 시리즈 변환기가 사다리형의 대표적인 예이다 그림. DAC08 D/A .

오른쪽에 비트의 디지털값을 아날로그량으로 변환하기 위한 사다리형 변환기가 보여졌다 레벨 입력전62( ) 4 D/A . 1

압이 V r 일 때 출력값 V o 는 디지털값 b i 에 의존하여 다음과 같이 주어진다.

V o= ( b 12 +
b 24 +

b 38 +
b 416 )V r
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그림 109 변환기의 종류 가산형왼쪽과 사다리형오른쪽. D/A . ( ) ( )

5.6.2.5.6.2.5.6.2.5.6.2.5.6.2.5.6.2.5.6.2.5.6.2.5.6.2.5.6.2.5.6.2.5.6.2. 소개소개소개소개DAC 0800DAC 0800DAC 0800DAC 0800소개소개소개소개DAC 0800DAC 0800DAC 0800DAC 0800소개소개소개소개DAC 0800DAC 0800DAC 0800DAC 0800

� 특징 비트 분해능 넓은 범위의 전원 이나 와 직접 연결가능 의 변환시간: 8 , (4.5~18V), TTL CMOS , 100 nsec ,

저전력소비 에서(5V 33mW)

� 핀배치 번 논리임계값 제어핀으로 보통 에 연결한다 번 전류출력핀 번 전원단: 1 (VLC: GND .), 2 (/IOUT: ), 3 (V-:-

자 번 전류출력핀 번 입력단자 번 전원단자 번 최대출력전압 번), 4 (IOUT: ), 5-12 (D7-D0 ) 13 (V+:+ ), 14 (VREF+: ), 15

최저출력전압 번 보정용 단자로 콘덴서를 통해 에 연결(VREF-: ), 16 (COMP: V- )

5.6.3.5.6.3.5.6.3.5.6.3.5.6.3.5.6.3.5.6.3.5.6.3.5.6.3.5.6.3.5.6.3.5.6.3. 실험 톱니파 발생실험 톱니파 발생실험 톱니파 발생실험 톱니파 발생57 :57 :57 :57 :실험 톱니파 발생실험 톱니파 발생실험 톱니파 발생실험 톱니파 발생57 :57 :57 :57 :실험 톱니파 발생실험 톱니파 발생실험 톱니파 발생실험 톱니파 발생57 :57 :57 :57 :

� 예제 에 연결된 누름 스위치가 눌리면 톱니파가 발생한다: PORTD.0 .

� 회로도 그림 의 회로를 구현하고 을 그림 의 에 연결한다 또한 그림 의 회로를: 110 DAC_CON 79 C_CON . 80

그림 의 에 연결한다 을 누르면서 실험한다79 D_CON . SW1 .

� 프로그램 예 :

#include <mega128.h>
#include <delay.h>
void main(void){

unsigned char i=0xff;
DDRC = 0xff; 를 출력으로// PORTC

loop: while(PIND.0 == 1); 가 눌릴때까지 대기/* PORTD.0 */
delay_ms(50); 시간지연/* 50msec */

if(PIND.0 == 1) goto loop; 눌림이 동안 지속 안되면 무효 다시 키입력을 받는다/* 50msec */
while(PIND.0 !=1); 가 해제될 때까지 대기/* PORTD.0 */
for(;;i--){
PORTC = i;
delay_ms(20); 시간지연/* 20msec */
}

}

5.6.4.5.6.4.5.6.4.5.6.4.5.6.4.5.6.4.5.6.4.5.6.4.5.6.4.5.6.4.5.6.4.5.6.4. 실험 사인파 발생실험 사인파 발생실험 사인파 발생실험 사인파 발생58 :58 :58 :58 :실험 사인파 발생실험 사인파 발생실험 사인파 발생실험 사인파 발생58 :58 :58 :58 :실험 사인파 발생실험 사인파 발생실험 사인파 발생실험 사인파 발생58 :58 :58 :58 :

� 예제 에 연결된 누름 스위치가 눌리면 사인파가 발생한다:PORTD.0 .

� 프로그램 작성시 유의점 삼각함수와 관련된 명령을 사용하지 않고 사인값을 등분하여 구하고 표로 만들: 100

어 롬에 저장시켜 놓고 사용한다.

� 그림 의 회로를 구현하고 을 그림 의 에 연결한다 또한 그림 의 회로를 그림 의110 DAC_CON 79 C_CON . 80 79
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에 연결한다 을 누르면서 실험한다D_CON . SW1 .

� 프로그램 예 :

#include <mega128.h>
#include <delay.h>
flash unsigned char sin_tbl[ ] = {128, 136, 144, 151, 159, 167, 175, 182, 189, 196, 203, 209, 215, 221, 226,

249, 247, 243, 240, 236, 231, 226, 221, 215, 209, 203, 196, 189, 182, 175,
167, 159, 151, 144, 136, 127, 119, 111, 104, 96, 88, 80, 73, 66, 59,
52, 46, 40, 34, 29, 24, 19, 15, 12, 8, 6, 4, 2, 1, 0, 0, 0, 1, 2, 4,
6, 8, 12, 15, 19, 24, 29, 34, 40, 46, 52, 59, 66, 73, 80, 88, 96, 104, 111, 119 };

void main(void){
unsigned char i=0;
DDRC = 0xff; 를 출력으로// PORTC

loop: while(PIND.0 == 1); 가 눌릴때까지 대기/* PORTD.0 */
delay_ms(50); 시간지연/* 50msec */
if(PIND.0 == 1) goto loop; 눌림이 동안 지속 안되면 무효 다시 키입력을 받는다/* 50msec */
while(PIND.0 !=1); 가 해제될 때까지 대기/* PORTD.0 */
for(;;){
PORTC = sin_tbl[i];
delay_ms(20); 시간지연/* 20msec */
if(i<=98) i++;
else i=0;}

}

그림 110 변환 실험 회로도. D/A

5.7.5.7.5.7.5.7.5.7.5.7.5.7.5.7.5.7.5.7.5.7.5.7. 변환변환변환변환ADADADAD 변환변환변환변환ADADADAD 변환변환변환변환ADADADAD

5.7.1.5.7.1.5.7.1.5.7.1.5.7.1.5.7.1.5.7.1.5.7.1.5.7.1.5.7.1.5.7.1.5.7.1. 변환과정변환과정변환과정변환과정ADADADAD변환과정변환과정변환과정변환과정ADADADAD변환과정변환과정변환과정변환과정ADADADAD

의 변환은 다음 과정을 통해 이루어진다AD .

전처리 아날로그 신호에 포함된 잡음을 제거하고 신호의 대역폭을 제한하여 엘리어싱 을 줄인다: (aliasing) .①

표본화 신호 대역폭 두배이상의 일정한 샘플링 주파수에 따라 신호값을 취하여 즉 신호에 포함된: (sampling) ,②

최고 주파수 성분 주기의 보다 작은 주기로 신호값을 취하여 저장한다1/2 .
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양자화 표본화된 아날로그 신호는 연속적인 양으로 이를 진화하면 무한한 자리수를 요구할 수도 있다 그러: 2 .③

므로 표본화된 값을 소구간으로 분할하여 유한한 단계의 유한한 자리수를 갖는 불연속적인 대표값에 할당할 필요

가 있는 데 이 것을 양자화라 한다 양자화 단계의 갯수가 많으면 실제값과 대표값의 차인 양자화오차를 줄일 수.

있으나 디지털 출력의 비트수가 증가하여 이를 처리하기 위한 시간과 장치가 많이 요구된다.

부호화 양자화된 값에 진 디지털 코드를 부여하는 것을 부호화라 한다: 2 .④

5.7.2.5.7.2.5.7.2.5.7.2.5.7.2.5.7.2.5.7.2.5.7.2.5.7.2.5.7.2.5.7.2.5.7.2. 변환기의 종류변환기의 종류변환기의 종류변환기의 종류ADADADAD변환기의 종류변환기의 종류변환기의 종류변환기의 종류ADADADAD변환기의 종류변환기의 종류변환기의 종류변환기의 종류ADADADAD

변환기는 적분방식과 비교방식으로 크게 나뉠 수 있고 적분방식은 저속으로 변환이 이루어지는 데 전압시AD

간변환 이중적분 전압주파수변환형이 있고 비교방식은 적분방식에 비해 고속으로 변환이 이루어지는 데 축차비, ,

교 추종비교 병렬비교형이 있다, , .

전압시간변환형 기준신호를 적분한 것과 샘플링된 입력전압을 비교하여 입력전압의 크기에 비례하는 계수시:①

간을 결정하고 그 시간 동안 기준펄스의 수를 계수하여 변환하는 방식으로 비교적 간단하나 빠른 속도와 높은 정

도를 기대하기 힘들다.

이중적분형 샘플링된 의 입력전압을 미리 설정된 일정한 시간동안 적분한 값을 초기치로 하여 의 기준신: + -②

호를 적분한 값이 에 도달할 때까지 기준펄스의 수를 계수하여 변환하는 방식으로 전압시간변환형보다는 안정되0

어 디지털 전압계 등에 많이 활용된다.

전압주파수변환형 샘플링된 입력신호에 비례하는 반복 주파수 펄스를 발생시키고 카운터로 계수하여 변: A/D③

환한다.

계수비교형 샘플링회로 변환기 업카운터 비교기로 구성되어 있다 부터 차례로 증가시킨 카운터의 값: , D/A , , . 0④

을 변환기로 아날로그값으로 변환하여 샘플링된 입력신호와 비교기에서 비교하여 같아지면 업카운터의 카운D/A

팅을 중지시켜 변환한다 최악의 경우A/D . n 비트형의 경우 2 n-1 번 비교를 실행해야 하므로 변환속도가 느리
나 회로구성이 비교적 간단하고 가격이 저렴하다.

축차비교형연속근사형 샘플링회로 변환기 연속근사 레지스터 비교기로 구성되어 있다 계수비교형과( ): , D/A , , .⑤

달리 카운터의 최상위비트값만 로 세트해 놓고 입력신호와 비교하여 최상위비트값을 결정하기 시작하여 다음 상1

위비트값들의 값을 결정해나가는 방식의 변환기로A/D n 비트형의 경우 n 번의 비교로 변환이 완료되어 변환시
간은 백 μs 이하로 계수비교형에 비해 작고 일반적인 응용범위에 널리 사용된다 저가로 많이 사용되는 내셔날.

세미컨덕터사의 시리즈는 비트 축차비교형 변환기의 대표적 예이다ADC08 8 A/D .

병렬비교형 샘플링회로 사다리형 저항기 다수개의 비교기 디코더로 구성되어 있다: , , , .⑥ n 비트 변환기의 경우
2 n-1 개의 비교기를 사용하여 사다리형 저항기에 따라 적절히 분압된 입력전압을 동시에 병렬처리하여 디코더
를 통해 디지털 출력값을 만들어 내기 때문에 현재 변환기 중 변환속도가 수십 이하로 가장 빠르나 가장 고가ns

이다 아날로그디바이스사의 이나 은 비트 병렬비교형 변환기의 대표적 예이다. AD5010 AD6020 6 A/D .

5.7.3.5.7.3.5.7.3.5.7.3.5.7.3.5.7.3.5.7.3.5.7.3.5.7.3.5.7.3.5.7.3.5.7.3. 의의의의ATmega128ATmega128ATmega128ATmega128의의의의ATmega128ATmega128ATmega128ATmega128의의의의ATmega128ATmega128ATmega128ATmega128 ADCADCADCADCADCADCADCADCADCADCADCADC

5.7.3.1.5.7.3.1.5.7.3.1.5.7.3.1. 특징특징특징특징

� 비트 채널 핀번호 의 축차비교형 단극성 변환기 제공10 8 (PF0~7, 61~54)

� 채널의 차동입력 변환기로 사용 가능7

� 배 또는 배의 증폭률을 가진 채널의 차동입력 변환기능 제공10 200 2

� 범위의 전압을 입력으로 갖을 수 있다 차동의 경우 까지 가능하다 기준 전압 는0~Vref . -Vref ~ Vref . Vref

를 초과할 수 없다VCC .

� 변환완료 인터럽트가 제공된다 완료시 레지스터의 플랙이 세트된다. ADCSRA ADIF .
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� 의 변환시간을 사용자가 설정할 수 있다13~260 usec .

5.7.3.2.5.7.3.2.5.7.3.2.5.7.3.2. 레지스터레지스터레지스터레지스터ADCH, ADCLADCH, ADCLADCH, ADCLADCH, ADCL

결과를 단극성의 경우ADC ×  로 범위값으로차동입력의 경우 의 보수를 사용하여0~1023 , 2

××    로 범위의 값으로 저장한다 초기값은 이다 레지스-512~ 511 . 0x0000 . ADMMUX

터의 값에 따라 그림 에 보여진 방식으로 정렬하여 저장한다ADLAR 111 .

그림 111 레지스터출처. ADCH, ADCL ( :ATMEL)

5.7.3.3.5.7.3.3.5.7.3.3.5.7.3.3. 레지스터레지스터레지스터레지스터ADMUXADMUXADMUXADMUX

이 로 세트되어 변환이 시작될 때마다 의 설정값에 따라 변환이 진행된다 설정값ADSC, ADEN 1 AD ADMUX AD .

의 변환은 차동입력을 사용하는 경우에는 변환을 시작한 후 적어도 가 경과한 후에 한다AD 125usec .

� 비트 입력전압의 범위의 기준전압 를 선택한다7~6(REFS1~0 : REFerence Selection 1~0) : Vref .

외부의 단자 번핀로 입력된 전압을 기준전압으로 사용00 : AREF (62 ) .①

외부의 단자 번핀로 입력된 전압을 기준전압으로 사용01 : AVCC (64 ) .②

보류10 :③

내부의 를 기준전압으로 사용11 : 2.56V .④

� 비트 변환결과가 데이터 레지스터에 저장될 때 모양을 그림5(ADLAR : ADC Left Adjust Result) : ADC 111

의 경우 처럼 결정한다.

� 비트 그림 처럼 의 입력단자를 선택하고 차동입력의 경우 이득을 선택 하는데 사용4~0(MUX4~0) : 112 ADC

한다.

5.7.3.4.5.7.3.4.5.7.3.4.5.7.3.4. 레지스터레지스터레지스터레지스터ADCSRAADCSRAADCSRAADCSRA

� 비트 로 설정하여 동작을 허용하고 으로 하여 중지시킨다7(ADEN : ADc ENable) : 1 0 .

� 비트 로 설정하면 변환이 시작된다 변환이 완료되면 자동적으로 클리어6(ADSC : ADc Start Conversion) : 1 .

된다.

� 비트 로하면 모드로 설정한다5(ADFR : ADc Free Running select) : 1 Free running .

� 비트 레지스터가 갱신되면 가 로 세트되며 인터럽트를4(ADIF : ADc Interrupt Flag) : ADCH, ADCL ADIF 1

요청한다.

� 비트 로 세트된 경우 변환완료 인터럽트를 개별적으로 허용한다3(ADIE : ADc Interrupt Enable) : 1 .

� 비트 시스템 클럭을 분주하여2~0(ADPS2~0 : ADc Prescaleer Select 2~0) : 를 만들 때 분주비를

결정한다 이면 분주비를 로 이면 분주비를 로 이면 분주비를 로 이면 분주비를 으. 000, 001 2 , 010 4 , 011 8 , 100 16

로 이면 로 이면 로 이면 분주비를 로 한다, 101 32 , 110 64 , 111 128 .

5.7.3.5.5.7.3.5.5.7.3.5.5.7.3.5. 동작동작동작동작

� 단일변환 모드 레지스터에서 플랙을 로 설정하여 변환을 시작시킬 수 있다 최초: ADCSRA ADEN, ADSC 1 .
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변환에 개의25 클록이 필요하다 변환이 완료되면 변환 결과가 레지스터에 결과가 저장되. ADCH, ADCL

면 가 로 세트되며 변환완료 인터럽트가 요청되고 비트는 자동적으로 클리어된다 다시 변환을ADIF 1 AD ADSC .

시작시키려면 플랙을 로 하면 된다 그리고 이때부터는 개의ADSC 1 . 13 클록이 필요하다.

� 모드 레지스터에서 플랙을 로 설정하여 변환을 시작시킬 수Free Running : ADCSRA ADEN, ADSC, ADFR 1

있다 변환완료에 개의. 13 클록이 필요하다 변환이 완료되면 변환 결과가 레지스터에 결. ADCH, ADCL

과가 저장되면서 즉시 그 다음 차례의 변환이 자동적으로 시작된다AD .

그림 112 채널과 의 설정출처. ADC Gain ( :ATMEL)

5.7.3.6.5.7.3.6.5.7.3.6.5.7.3.6. 잡음 제거 방법잡음 제거 방법잡음 제거 방법잡음 제거 방법

� 아날로그 입력 신호선을 최소한으로 짧게 한다.

� 단자에는 디지털 전원 를 필터로 안정화시켜 인가한다그림 참조AVCC VCC LC ( 113 ).
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� 변환을 하는 중에는 나머지 중에서 디지탈 입출력 포트로 사용하는 포트의 값을 스위칭하지 않는다AD PF7~0 .

� 모드를 이용하면 매우 안정적인 변환을 이룰 수 있다ADC noise reduction .

그림 113 아날로그 전원 단자의 처리출처. ( :ATMEL)

5.7.4.5.7.4.5.7.4.5.7.4.5.7.4.5.7.4.5.7.4.5.7.4.5.7.4.5.7.4.5.7.4.5.7.4. 실험 조도 변화 측정실험 조도 변화 측정실험 조도 변화 측정실험 조도 변화 측정59 :59 :59 :59 :실험 조도 변화 측정실험 조도 변화 측정실험 조도 변화 측정실험 조도 변화 측정59 :59 :59 :59 :실험 조도 변화 측정실험 조도 변화 측정실험 조도 변화 측정실험 조도 변화 측정59 :59 :59 :59 :

� 예제 조도에 따라 저항값이 변화하는 의 저항변화를 측정하여 표시한다: CdS .

� 회로도 그림 의 회로를 구현하고 을 그림 의 에 연결한다 그림 의 회로를 구현하: 114 CdS_CON 79 F_CON . 95

고 을 그림 의 에 연결한다그림 에서 만 이용할 것이므로 그 개만 구현하면 된FND_CON 79 C_CON . 95 FND0~3 4

다.

� 프로그램 예 :

#include <mega128.h>
#include <delay.h>
unsigned char dbuf[4], dbuf_index;
unsigned int cnt;
void hex2bcd(unsigned int hex, unsigned char *ptr) { 이하의 헥사값을 자리수 로 변환한다/* 1024 3 bcd . */

*ptr = hex / 1000;
*(ptr+1) = (hex % 1000) / 100;
*(ptr+2) = ((hex % 1000) % 100 ) / 10;
*(ptr+3) = ((hex % 1000) % 100 ) %10;

}
로 해도 됨interrupt [17] void timerint0(void){ // interrupt [TIM0_OVF] void timerint0(void)

unsigned char tmpbuf;
if( ++cnt == 2 ){
cnt = 0; if( dbuf_index++ == 3 ) dbuf_index= 0; }
tmpbuf = dbuf[dbuf_index];
PORTC = (( tmpbuf << 4 )&0xf0) | dbuf_index;
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표시할 데이터와 의 위치는 의 상위비트와 하위비트로/* FND tmpbuf */
TCNT0 = 6; 재정의 시뮬레이션할 때는 조절할 필요가 있음// 1msec = 64*(256-6)/16

}
void main(void){
unsigned int sum;
unsigned char i;

포트 를 출력으로DDRC = 0xff; // C
SREG |= 0x80; 인터럽트 전체 허용//
TIMSK |= 1; 타이머 오버플로 인터럽트 개별허용// 0
TCCR0 |= 4; 분주비를 로 설정// 64 시뮬레이션할 때는 조절할 필요가 있음
TCNT0 = 6; // 1msec = 64*(256-6)/16 시뮬레이션할 때는 조절할 필요가 있음
ADMUX = 0x00; 를 사용하고 사용// ADC0 Vref = Vcc

분주비는ADCSRA = 0x83; // ADEN = 1 , 8
delay_ms(10);
for(;;){ sum=0;

for(i=0;i<16;i++){
ADCSRA |= 0x40; 변환시작// ADSC = 1 ,
while((ADCSRA & 0x10) != 0x10); 변환완료때까지 기다린다// .
sum += ADCH*256 + ADCL;}
sum = sum >> 4; 으로 나누어 평균값을 구한다// 16 .

hex2bcd(sum, dbuf); 표시할 데이터 초기화/* */
}

}

그림 114 조도 측정 회로.

5.8.5.8.5.8.5.8.5.8.5.8.5.8.5.8.5.8.5.8.5.8.5.8. 아날로그아날로그아날로그아날로그아날로그아날로그아날로그아날로그아날로그아날로그아날로그아날로그 비교기비교기비교기비교기비교기비교기비교기비교기비교기비교기비교기비교기

5.8.1.5.8.1.5.8.1.5.8.1.5.8.1.5.8.1.5.8.1.5.8.1.5.8.1.5.8.1.5.8.1.5.8.1. 구성구성구성구성구성구성구성구성구성구성구성구성

그림 는 에 내장된 아날로그 비교기의 구성을 보여준다115 ATmega128 .

� 핀 비교기 양극성 입력 비교기 음극성 입력AIN0~1(PE2~3: 4~5) : ,

� 레지스터의 비트 플랙으로 양극성 입력이 음극성 입력보다 크면ACO(Analog Comparator Output) : ACSR 5

로 세트된다1 .

� 아날로그 비교기의 인터럽트 모드를 설정한다ACIS1~0 : .

� 밴드갭 레퍼런스 양극성입력으로 사용될 수 있는 내부 기준 전압: 1.23V

� 음극성 입력으로 사용될 수 있는 의 입력신호들ADC MUX OUTPUT : ADC ADC0~7
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그림 115 아날로그 비교기의 블록 선도출처. ( :ATMEL)

5.8.2.5.8.2.5.8.2.5.8.2.5.8.2.5.8.2.5.8.2.5.8.2.5.8.2.5.8.2.5.8.2.5.8.2. 제어제어제어제어제어제어제어제어제어제어제어제어

와 레지스터를ACSR(Analog Comparator control and Status Register) SFIOR(Special Function IO Register)

사용해서 아날로그 비교기의 기능과 입력신호를 선택할 수 있고 동작 상태를 알아 낼 수 있다.

5.8.2.1.5.8.2.1.5.8.2.1.5.8.2.1. 레지스터레지스터레지스터레지스터ACSRACSRACSRACSR

� 비트 이면 아날로그 비교기의 동작을 금지시켜 소비전력을 감소시킨7(ACD:Analog Comparator Disable) : 1

다 디폴트는 이므로 비교기를 사용하지 않는 경우 로 하면 전력소비를 줄일 수 있다. 0 1 .

� 비트 아날로그 비교기의 양극성 입력을 선택하여 이면 내부6(ACBG:Analog Comparator Bandgap Select) : 1

기준 전압 가 선택되고 이면 단자 핀 로 선택된다1.23V 0 AIN0 (PE2, 4) .

� 비트 비교기의 출력값으로 클럭과 동기되어 발생된다 양극성입력이 음5(ACO:Analog Comparator Output) : .

극성 입력보다 크면 로 세트된다1 .

� 비트 아날로그 비교기의 인터럽트 발생 플랙으로 의 설4(ACI:Analog Comparator Interrupt Flag) : ACIS1~0

정에 따라 결정된다 비교기 인터럽트 개별허용 비트가 가 로 세트되어 있고 일 일때 인터럽트는. ACIE 1 SREG.7 1

서비스되고 그와 함께 자동적으로 비트는 클리어된다ACI .

� 비트 비교기 인터럽트 개별허용 비트3(ACIE:Analog Comparator Interrupt Enable) :

� 비트 아날로그 비교기의 출력 값을 타이머 의 입력2(ACIC:Analog Comparator Input Capture Enable) : ACO 1

캡춰 트리거 신호로 사용될 수 있도록 설정한다.

� 비트 아날로그 비교기 인터럽트 모드를 설1~0(ACIS1~0:Analog Comparator Interrupt mode Select 1~0) :

정한다 설정을 변경하는 경우 원하지 않는 인터럽트가 발생할 수 있으므로 는 클리어하고 변경한다. ACIE .

의 하강 및 상승에지에서 아날로그 비교기 인터럽트 발생00 : ACO①

보류01 :②

의 하강에지에서 아날로그 비교기의 인터럽트 발생10 : ACO③

의 상승에지에서 아날로그 비교기의 인터럽트 발생11 : ACO④

5.8.2.2.5.8.2.2.5.8.2.2.5.8.2.2. 레지스터레지스터레지스터레지스터SFIORSFIORSFIORSFIOR

� 비트 아날로그 비교기의 음극성 입력에 입력을 사3(ACME : Analog Comparator Multiplexer Enable) : ADC
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용할 수 있도록 허용한다 이며 음극성 입력으로 핀 가 사용되며 로 세트시키고 레지스. 0 AIN1( 5, PE3) 1 ADCSRA

터의 비트 비트를 으로 클리어하여 의 동작을 정지시키면 중 하나를 음극성 입력으로 사7(ADEN ) 0 ADC ADC0~7

용할 수 있다 이때 중 하나를 선택하는 것은 레지스터의 비트 비트로 설정한다. ADC0~7 ADMUX 2~0(MUX2~0 ) .

5.8.3.5.8.3.5.8.3.5.8.3.5.8.3.5.8.3.5.8.3.5.8.3.5.8.3.5.8.3.5.8.3.5.8.3. 실험 아날로그 비교기 실험실험 아날로그 비교기 실험실험 아날로그 비교기 실험실험 아날로그 비교기 실험60 :60 :60 :60 :실험 아날로그 비교기 실험실험 아날로그 비교기 실험실험 아날로그 비교기 실험실험 아날로그 비교기 실험60 :60 :60 :60 :실험 아날로그 비교기 실험실험 아날로그 비교기 실험실험 아날로그 비교기 실험실험 아날로그 비교기 실험60 :60 :60 :60 :

� 예제 조도에 따라 저항값이 변화하는 의 저항변화가 어느 이상이면 소리를 낸다: CdS .

� 회로도 그림 의 회로를 구현하고 을 그림 의 에 연결한다 그림 의 회로를 구현하: 114 CdS_CON 79 F_CON . 98

고 을 그림 의 에 연결한다BUZZ_CON 79 C_CON .

� 프로그램 예 :

#include <mega128.h>
#include <delay.h>
unsigned char time_data;

로 해도 됨interrupt [17] void timerint0(void){ // interrupt [TIM0_OVF] void timerint0(void)
time_data--;
TCNT0 = 77; 시뮬레이션할 때는 조절할 필요가 있음// 21.306msec = 1024*(256-77)/16

}
는 반주기값 는 박자값void playtone(unsigned int tone, unsigned char time){ // tone 1usec, time

unsigned int buf;
DDRC.0 = 1; 을 출력으로 설정// PORTC.0
TCCR0 |= 7; 분주비를 로 설정// 1024 시뮬레이션할 때는 조절할 필요가 있음
TCNT0 = 77; 시뮬레이션할 때는 조절할 필요가 있음// 21.306msec = 1024*(256-77)/16
time_data = time;
buf = tone;
do{

PORTC.0 = 1; do{ delay_us(1);} while(buf--);
PORTC.0 = 0; do{ delay_us(1);} while(tone--);

} while(time_data);
time_data = time;
TCNT0 = 77; 시뮬레이션할 때는 조절할 필요가 있음// 21.306msec = 1024*(256-77)/16
while(time_data);
TCCR0 =0x00;

}
void main(void){
unsigned int sum;
unsigned char i;

포트 를 출력으로DDRC = 0xff; // C
SREG |= 0x80; 인터럽트 전체 허용//
TIMSK |= 1; 타이머 오버플로 인터럽트 개별허용// 0
TCCR0 |= 4; 분주비를 로 설정// 64 시뮬레이션할 때는 조절할 필요가 있음
TCNT0 = 6; // 1msec = 64*(256-6)/16 시뮬레이션할 때는 조절할 필요가 있음
ADMUX = 0x00; 를 사용하고 사용// ADC0 Vref = Vcc

분주비는ADCSRA = 0x83; // ADEN = 1 , 8
delay_ms(10);
for(;;){ sum=0;

for(i=0;i<16;i++){
ADCSRA |= 0x40; 변환시작// ADSC = 1 ,
while((ADCSRA & 0x10) != 0x10); 변환완료때까지 기다린다// .
sum += ADCH*256 + ADCL;}
sum = sum >> 4; 으로 나누어 평균값을 구한다// 16 .

hex2bcd(sum, dbuf); } 표시할 데이터 초기화/* */
}
void main(void){

unsigned int tone_data=0xffff;
DDRC = 0xff; 포트 를 출력으로// C
SREG.7 = 1; 인터럽트 전체 허용//
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TIMSK |= 1; 타이머 오버플로 인터럽트 개별허용// 0
ACSR |= 0x40; 양극성 입력을 으로// 1.23

입력을 입력으로SFIOR |= 0x08; // ADC -
ADCSR &=0x7f; // ADEN = 0
ADMUX &=0xf8; 을 입력으로// ADC0 -
delay_ms(100);
for(;;){
if((ACSR & 0x20) != 0x20){ // if 1.23 > ADC0 and (ACSR & 0x20) == 0x20

if(tone_data > 100){tone_data -=200; playtone(tone_data,250); }
else tone_data=0xffff;}

delay_ms(100); }
}

5.9.5.9.5.9.5.9.5.9.5.9.5.9.5.9.5.9.5.9.5.9.5.9. 직렬 통신직렬 통신직렬 통신직렬 통신직렬 통신직렬 통신직렬 통신직렬 통신직렬 통신직렬 통신직렬 통신직렬 통신

5.9.1.5.9.1.5.9.1.5.9.1.5.9.1.5.9.1.5.9.1.5.9.1.5.9.1.5.9.1.5.9.1.5.9.1. 포트 제어포트 제어포트 제어포트 제어SPISPISPISPI 포트 제어포트 제어포트 제어포트 제어SPISPISPISPI 포트 제어포트 제어포트 제어포트 제어SPISPISPISPI

은 주변 장치 또는 동일한 계열간의 고속 직렬 동기 통신용 모듈인ATmega128 AVR SPI(Serial Peripheral

를 제공하는데Interface) SS 선을(PB0, pin 10), SCK(PB1, pin 11), MOSI(PB2, pin 12), MISO(PB3, pin 13) 4

이용하여 전이중으로 통신이 가능하며 마스터 및 슬레이브 동작을 가능하게 하며 개의 전송속도를 제공하여 최, , 7

대 수십 까지의 통신이 가능하며 전송완료 인터럽트를 제공한다 또한 아이들 모드를 해제하는 기능도 제공MHz .

한다 그림 은 의 포트의 블록선도이다 는 의 플래쉬롬에 프로그램을 다운. 116 ATmega 1298 SPI . SPI ATmega128

로드하는 기능도 제공한다ISP .

그림 116 포트의 블록선도출처. SPI ( :ATMEL)

5.9.1.1.5.9.1.1.5.9.1.1.5.9.1.1. 의 동작의 동작의 동작의 동작SPISPISPISPI

� 반드시 개의 마스터와 개의 슬레이브 사이에서만 이루어져 마스터가 슬레이브에게 데이터를 보내려면 여러1 1

슬레이브에서 원하는 슬레이브에게 SS 신호를 레벨로 출력하여 선택하고 마스터는 클록 신호를(Slave Select) 0

발생하여 을 통해 출력하고 송신할 데이터를 시프트 레지스터에 데이터를 준비하여SCK(Serial Clock) MOSI

단자로 출력한다 이때 동시에 단자를 통해서(Master Output Slave Input) . MISO (Master Input Slave Output)

는 더미 데이터가 입력된다그림 참조( 117 ).

� 슬레이브 모드 : SS 가 입력핀으로 동작하며 레벨상태로 입력되는 경우에만 가 활성화되고 가 출0 SPI MISO
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력단자로 된다 이때 외부에서 입력된 신호에 의하여 데이터 레지스터의 바이트가 전송되고 나면. SCK 1 SPSR

의 비트 이 로 되면서 전송완료 인터럽트가 요청된다 만약 슬레이브 모드에(SPi Status Register) 7(SPIF) 1 SPI .

서 SS 단자에 레벨상태가 입력되면 송신 및 수신 로직을 즉시 리셋시키고 시프트 레지스터에 일부 수신된 데1

이터도 버리고 는 입력되는 데이터를 받을 수 없는 비활성상태로 된다SPI .

� 마스터 모드 의 비트 가 로 설정되면 마스터가 되며 사용자는: SPCR(SPi Control Register) 4(MSTR) 1 SS 핀

의 방향을 비트를 사용하여 결정할 수 있다 마스터 모드에서DDRB0 . SS 핀이 입력으로 설정되어 있고 레벨0

이면 외부에서 다른 마스터가 슬레이브로 지정하고 데이터를 전송하기 시작하는 것으로 해석될 수 있으므로 SS

핀을 입력으로 설정하면 반드시 풀업저항과 같은 외부회로에 의해 레벨로 유지되어야 한다 마스터가 되어1 . SS

핀을 출력으로 설정하고 레벨을 출력시켜 슬레이브를 지정한 경우 에 데이터를 기록0 SPDR(SPi Data Register)

하여 송신할 수 있다 이 때 클럭이 발생되고 하드웨어적으로 이 쉬프트되며 슬레이브로 전송된다 전송이. SPDR .

끝나면 클럭이 정지되고 의 비트 이 세트되면서 전송완료 인터럽트가 요청된다 이후 에SPSR 7(SPIF) SPI . SPDR

데이터를 다시 기록하면 다시 전송이 반복된다 데이터 패킷의 전송을 마치려면. SS로 레벨을 출력시키면 된다1 .

그림 117 의 동작출처. SPI ( :ATMEL)

5.9.1.2.5.9.1.2.5.9.1.2.5.9.1.2. 레지스터레지스터레지스터레지스터SPCRSPCRSPCRSPCR

� 비트 로 세트하면 전송완료 인터럽트 개별 허용7(SPIE:SPi Interrupt Enable) : 1 SPI

� 비트 로 세트하면 직렬통신을 허용6(SPE: SPi Enable) : 1 SPI

� 비트 로 설정하면 부터 전송하고 으로 하면 부터 전송한다5(DORD:Data ORDer) : 1 LSB 0 MSB .

� 비트 로 설정하면 마스터로 동작하고 으로 하면 슬레이브로 동작한다 마4(MSTR:Master/Slaver Select) : 1 0 .

스터로 설정하고 SS 핀이 입력으로 설정되어 레벨이 입력되면 비트는 자동으로 클리어되며 슬레이브 모0 MSTR

드로 되고 의 비트 이 세트되면서 인터럽트가 요청된다SPSR 7(SPIF) .

� 비트 데이터 샘플링 동작이 수행되는 클록의 극성을 설정한다 디폴트값인3(CPOL:Clock POLarity) : SCK . 0

이면 의 경우는 상승 에지로 의 경우에는 하강에지로 선정된다 이면Leading Edge , Trailing Edge . CPOL=1

의 경우는 하강 에지로 의 경우에는 상승에지로 선정된다Leading Edge , Trailing Edge .

� 비트 데이터 샘플링 동작이 수행되는 클록의 위상을 설정한다 디폴트값인 이2(CPHA:Clock PHAse) : SCK . 0

면 의 경우는 샘플링이 되고 의 경우에는 셋업된다 이면 반대로 된다Leading Edge , Trailing Edge . CPHA=1 .

� 비트 의 비트 비트과 함께 클럭신호의 주파수1~0(SPR1~0:SPi clock Rate select 1~0): SPSR 0(SPI2X ) SCK

분주비를 설정한다 의 비트 이 인 상태에서 이면 시스템 클록의 분주 이면 분주 이면 분. SPSR 0 0 00 4 , 01 16 , 10 64

주 이면 분주로 설정된다 의 비트 이 인 상태에서는 주파수를 두배로 하여 분주비를 반감시키는데, 11 128 . SPSR 0 1

이면 시스템 클록의 분주 이면 분주 이면 분주 이면 분주로 설정된다00 2 , 01 8 , 10 32 , 11 64 .

5.9.1.3.5.9.1.3.5.9.1.3.5.9.1.3. 레지스터레지스터레지스터레지스터SPSRSPSRSPSRSPSR

� 비트 전송이 완료되면 로 세트되면서 인터럽트가 요청된다 마스터로 설정하고7(SPIF:SPi Interrupt Flag) : 1 .

SS 핀이 입력으로 설정되어 레벨이 입력되면 의 비트 는 자동으로 클리어되며 슬레이브 모드로0 SPCR 4(MSTR)
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되고 가 세트되면서 인터럽트가 요청된다 인터럽트가 서비스되면 자동으로 클리어된다 을 읽고SPIF . . SPSR

에 접근하는 경우에 과 함께 클리어된다SPDR WCOL .

� 비트 를 통해 데이터를 전송하고 있는 동안에 레지스터를 기록하려6(WCOL:Write COLision flag) : SPI SPDR

고 하면 세트된다 을 읽고 에 접근하는 경우에 와 함께 클리어된다. SPSR SPDR SPIF .

� 비트 마스터로 동작할 때 클록 신호의 주파수를 배로 설정한다0(SPI2X:SPI Double speed) : SCK 2 .

5.9.2.5.9.2.5.9.2.5.9.2.5.9.2.5.9.2.5.9.2.5.9.2.5.9.2.5.9.2.5.9.2.5.9.2. 포트 제어포트 제어포트 제어포트 제어USARTUSARTUSARTUSART 포트 제어포트 제어포트 제어포트 제어USARTUSARTUSARTUSART 포트 제어포트 제어포트 제어포트 제어USARTUSARTUSARTUSART

은 비트 병렬 데이터를 직렬형태로 바꾸어 송신하고 수신된 직렬 데이터를 병렬 데이터로 바꿔ATmega128 8

에 입력하는 기능의 직렬통신포트를 개 내장하고 있다 직렬통신포트는 송신과 수신을 동시에 할 수 있는CPU 2 .

완전 이중방식이며 동기 및 비동기 전송이 가능하다 또한 멀티 프로세서 통신 모드로 동작하는 것도 가능하며 높.

은 정밀도의 보레이트 발생기를 내장하고 있다 송신완료 송신 데이터 레지스터 준비완료 수신완료 등 가지의. , , 3

인터럽트를 제공한다.

5.9.2.1.5.9.2.1.5.9.2.1.5.9.2.1. 데이터 프레임 포맷데이터 프레임 포맷데이터 프레임 포맷데이터 프레임 포맷

그림 에 보여진 것처럼 비트의 스타트 비트 비트의 데이터 비트 비트의 패리티118 (1 ) +( 5,6,7,8,9 ) + ( 0, 1

비트 비트의 스탑비트 프레임으로 이루어져 최소 비트 최대 비트로 구성가능하다) + (1,2 ) 7 13 .

그림 118 통신의 데이터 프레임출처. USART ( :ATMEL)

� 스타트 비트 비트로 이루어 졌으며 항상 레벨이다 송신시에 자동적으로 생성된다: 1 0 . .

� 데이터 비트 비트가 가능하다: 5,6,7,8,9 .

� 패리티 비트 패리티를 사용하지 않을 수도 있고 사용하는 경우 홀수 혹은 짝수 패리티 비트를 사용한다: 1 .

� 스탑 비트 개의 비트가 가능하며 항상 레벨이다 송신시에 자동적으로 생성된다: 1,2 1 . .

5.9.2.2.5.9.2.2.5.9.2.2.5.9.2.2. 레지스터레지스터레지스터레지스터UDRnUDRnUDRnUDRn

� 레지스터는 포트의 송수신 데이터의 버퍼의 기능을 수행하는 비UDRn(Usart i/o Data Register n) USARTn 8

트 레지스터이다여기에서 은 또는 송신 및 수신 버퍼는 동일한 번지에 위치하지만 내부적으로는 서로( n 0 1).

다른 별개의 레지스터로 송신할 데이터를 에 쓰면 송신 데이터 버퍼 에 저장되고 수신된 데이터를UDRn TXBn

으로 읽으면 수신 데이터 버퍼 에 수신되어 있는 값이 읽힌다UDRn RXBn .

� 송신 버퍼는 레지스터의 비트가 세트된 경우에만 쓰기가 가능하다UCSRnA UDREn .

5.9.2.3.5.9.2.3.5.9.2.3.5.9.2.3. 레지스터레지스터레지스터레지스터UCSRnAUCSRnAUCSRnAUCSRnA

레지스터는 포트의 송수신 동작을 제어하거나 상UCSRnA(Usart Control and Status Register n A) USART

태를 저장하는 비트 레지스터이다8 .

� 비트 의 수신 버퍼에 읽히지 않은 수신 문자가 있으면 세트되고 읽은7(RXCn: Receive Complete n) : UDRn

경우 으로 클리어 된다 세트되는 경우 수신완료 인터럽트가 요청된다 을 쓰면 소프트웨어적으로 클리어된다0 . . 1 .

� 비트 의 송신 버퍼에 아직 새로운 송신 문자가 기록되지 않은 경우6(TXCn: Transmit Complete n) : UDRn

세트된다 이 경우 송신완료 인터럽트를 요청하고 인터럽트가 서비스 시작되면 자동으로 으로 클리어된다. 0 .

� 비트 의 송신 버퍼가 비어 있어서 송신 문자를 받을 준비가5(UDREn: Usart Data Register Empty n) : UDRn

되어 있으면 세트된다 세트되는 경우 송신 데이터 레지스터 준비완료 인터럽트가 요청된다 을 쓰면 소프트웨. . 1
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어적으로 강제로 클리어된다.

� 비트 의 수신 버퍼에 저장되어 있는 문자를 수신하는 동안에 수신 문자의 첫4(FEn: Frame Error n) : UDRn

번째 스톱 비트가 으로 검출되는 프레임 에러가 발생하였음을 나타내며 세트되는 플랙비트로 이 때 세트된 것0

은 레지스터를 기록하면 클리어된다UCSRnA .

� 비트 수신동작에서 의 수신 버퍼에 읽지 않은 수신 문자가 들어 있는3(DORn: Data Overrun Error n) : UDRn

상태에서 수신 시프트 레지스터에 새로운 문자가 수신 완료되고 다시 그 다음 수신 문자의 스타트 비트가 검출

되는 오버런 에러가 발생하였음을 나타내며 세트되는 플랙비트로 레지스터를 기록하면 클리어된다UCSRnA .

� 비트 의 수신 버퍼에 저장된 문자에 패리티 에러가 발생하였음을 나타2(UPEn:Usart Parity Error n) : UDRn

내는 플랙비트로 레지스터의 이 세트되어 패리티 비트를 사용하도록 설정된 경우에만 세트될 수UCSRnC UPMn1

있다 레지스터를 기록하면 클리어된다. UCSRnA .

� 비트 비동기 모드에서만 유효한 것으로 로 세트하면 클럭의 분주비1(U2Xn:Usart 2 transmission speed) : 1

를 에서 로 낮추어 전송속도를 배 증가시킬 수 있다16 8 2 .

� 비트 로 세트하면 멀티 프로레서 통신모드로 설정한0(MPCMn:Multi-Processor Communication Mode n) : 1

다.

5.9.2.4.5.9.2.4.5.9.2.4.5.9.2.4. 레지스터레지스터레지스터레지스터UCSRnBUCSRnBUCSRnBUCSRnB

� 비트 수신완료 인터럽트를 개별 허용 비트7(RXCIEn: RX Complete Interrupt Enable n) :

� 비트 송신완료 인터럽트를 개별 허용 비트6(TXCIEn: TX Complete Interrupt Enable n) :

� 비트 송신 데이터 레지스터 준비완료 인터럽트 개별 허용 비트5(UDRIE : UDR empty Interrupt Enable n) :

� 비트 로 세트하면 가 용 수신단자로 동작하는 것을 허4(RXENn: RX ENable n) : 1 RxD0,1(PE0, PD2) USART

용하고 에러 플랙 비트 의 동작을 허용한다DORn, UPEn, U2Xn .

� 비트 로 세트하면 가 용 송신단자로 동작하는 것을 허3(TXENn: TX ENable n) : 1 TxD0,1(PE1, PD3) USART

용한다 클리어하더라도 송신이 완료될 때까지는 송신단자로 동작한다. .

� 비트 레지스터의 비트 와 함께 전송 문자의2(UCSZn2:Usart Character SiZe n2) : UCSRnC 2~1(UCSZn1~0)

데이터 비트수를 설정하는 데 사용한다 비트 비트 비트 비트. 000 : 5 , 001 : 6 , 010 : 7 , 011 : 8 , 111① ② ③ ④ ⑤

비트 보류: 9 , 100~110: .⑥

� 비트 전송문자가 비트로 설정된 경우 수신된 문자의 번째 비트를 저장한다 반1(RXB8n:RX data Bit 8 n) : 9 9 .

드시 레지스터보다 먼저 읽혀져야 한다UDRn .

� 비트 전송문자가 비트로 설정된 경우 송신할 문자의 번째 비트를 저장한다 반0(TXB8n:TX data Bit 8 n) : 9 9 .

드시 레지스터보다 먼저 기록되야 한다UDRn .

5.9.2.5.5.9.2.5.5.9.2.5.5.9.2.5. 레지스터레지스터레지스터레지스터UCSRnCUCSRnCUCSRnCUCSRnC

� 비트 이면 포트를 동기 모드로 이면 비동기 모드로 설정6(UMSELn:Usart Mode SELect n) : 1 USARTn 0

� 비트 패리티 모드를 설정한다 패리티 체크 기능을 사용하5~4(UPMn1~0:Usart Parity Mode 1~0) : . 00 :①

지 않는다 보류 짝수 패리티 사용 홀수 패리티 사용. 01 : 10 : 11 :② ③ ④

� 비트 로 세트하면 스톱비트를 개로 설정하고 이면 스톱비트를 개로3(USBSn:Usart Stop Bit Select n) : 1 2 0 1

설정한다.

� 비트 레지스터의 비트 와 함께 전송문자의2~1(UCSZn1~0:Usart Character SiZe n1~0) : UCSRnB 2(UCSZn2)

비트수를 설정한다 비트 비트 비트 비트 비트. 000 : 5 , 001 : 6 , 010 : 7 , 011 : 8 , 111 : 9 ,① ② ③ ④ ⑤ ⑥

보류100~110: .

� 비트 동기 전송 모드의 슬레이브 동작에서만 유효한 것으로 로 설정0(UCPOLn:Usart Clock POLarity n) : 1
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하면 송신 데이터는 클럭의 하강에지에서 새로운 값이 출력되고 수신 문자는 의 상승에지에서 얻어XCKn XCKn

진다 클리어된 경우는 반대로 된다. .

5.9.2.6.5.9.2.6.5.9.2.6.5.9.2.6. 레지스터레지스터레지스터레지스터UBRRnH, UBRRnLUBRRnH, UBRRnLUBRRnH, UBRRnLUBRRnH, UBRRnL

은 비트 레지스터로 그 중 하위 비트가 유효한 것으로 송수신 속도UBRRn(Usart Baud Rate Register n) 16 12

를 다음의 공식에 따라 설정한다 그림 는 클럭이 인 경우의 보레이트와. 119 16MHz 레지스터의 설정값UBRRn ,

레지스터의 비트 의 설정값 그리고 에러를 보여준다 를 제외하고 모든 전송속도에UCSRnA 1(U2Xn) , . 230,400bps

서 해당 보레이트와 을 설정하여 에러를 무시하고 사용될 수 있다UBRRn, U2Xn .

레이트   ×  

그림 119 보레이트와 의 관계출처. UBRR ( :ATMEL)

5.9.3.5.9.3.5.9.3.5.9.3.5.9.3.5.9.3.5.9.3.5.9.3.5.9.3.5.9.3.5.9.3.5.9.3. 개요개요개요개요RS232CRS232CRS232CRS232C 개요개요개요개요RS232CRS232CRS232CRS232C 개요개요개요개요RS232CRS232CRS232CRS232C

� 용도 저가로 동기식 혹은 비동기식으로 직렬통신하기 위한 규격으로 프린터나 모뎀 등 각종 주변장치를 컴:

퓨터에 연결할 때 사용된다.

� 특징 통신속도는 수십 이상까지 다양하게 사용하며 신호를 노이즈에 강하고 멀리 보낼수 있도: 110bps~ kbps ,

록 하기 위해 레벨과 달리 이면 레벨 이면 레벨로 한다 에 장착된 직렬포트의 경우 개의 핀TTL 10V 0 , 0V 1 . PC 9

으로 구성되어 있지만 컴퓨터간의 통신에서는 송신선과 수신선 그라운드선 등 개를 연결하여 통신이 가능하다, 3 .

� 연결길이 규격에서는 선의 길이는 약 로 되어 있으나 실제의 경우에 고품질의 케이블을 사용하면 최장: 15m

까지 사용가능하고 일반적으로 보레이트가 이하로 작은 경우 고품질 케이블을 사용하면 까지 사3km 1kbps 1km

용가능하고 보통의 케이블을 사용하면 까지 사용가능하고 보레이트가 증가하면 사용가능 거리도 줄어300m

에서 고품질의 케이블을 사용하면 보통 케이블을 사용하면 까지 사용가능하다9600 75m, 30m .

� 인터페이스 칩 의 직렬포트에서 나오는 신호는 레벨로 와 를 사용하고 반전된 상태이다: PC RS232C 10V 0V .

레벨을 사용하는 마이컴으로 와 직렬통신하기 위해서는 레벨과 레벨로 바꿔주고 반전시켜TTL PC RS232C TTL

주기위한 인터페이스가 필요하다 이러한 기능을 하는 가장 흔한 칩에. 가 있다MAX232 .

� 터미널프로그램 설치 마이컴과 의 직렬통신시 측에서 표시를 담당할 터미널프로그램으로 윈도우 기본: PC PC

프로그램중 하나인 하이퍼터미널을 사용하면 된다 시작메뉴 보조프로그램 통신 하이퍼터미널 을 선택하여. [ -> -> -> ]

실행한다 설치가 되어 있지 않은 경우에는 제어판 프로그램 추가제거 윈도우즈 구성요소 추가제거 를 선. [ -> / -> / ]
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택하여 설치하면 된다 하이퍼터미널을 실행하면 연결 설명 창이 나타난다 여기에서 이름 에 적절한 이름. “ ” . [ (N)]

을 입력하고 아이콘 에 적절한 아이콘을 선택한다 연결 대상 창이 나타나면 연결에 사용할 모뎀 에[ (I)] . “ ” [ (N)]

이나 등에서 사용자에 맞는 포트를 선택한다 포트설정을 위한 창이 나타나면 흐름제어 메뉴에COM1 COM2 . [ (F)]

서 없음을 선택하고 비트초 에서 으로 보레이트를 설정하고 데이터 비트 에서 패리티 에서[ / (B)] 9600 , [ (D)] 8, (P)

없음 정지비트 에서 을 선택한다여기에서는 보레이트로 를 사용한다고 가정한 것인데 포트설정, [ (S)] 1 ( 9600bps

값들은 마이컴에 탑재할 응용프로그램의 직렬통신 모드 설정에 따라 달라짐).

5.9.4.5.9.4.5.9.4.5.9.4.5.9.4.5.9.4.5.9.4.5.9.4.5.9.4.5.9.4.5.9.4.5.9.4. 실험 와 통신실험 와 통신실험 와 통신실험 와 통신61 : PC 161 : PC 161 : PC 161 : PC 1실험 와 통신실험 와 통신실험 와 통신실험 와 통신61 : PC 161 : PC 161 : PC 161 : PC 1실험 와 통신실험 와 통신실험 와 통신실험 와 통신61 : PC 161 : PC 161 : PC 161 : PC 1

� 예제 직렬통신을 통해 문자열을 전송해 의 하이퍼터미널에 표시한다: PC .

� 프로그램 작성시 유의점 비동기 모드로 보레이트 을 사용한다고 가정한다: USART0 9600 .

� 회로도 그림 의 회로를 구현하고 을 그림 의 에 연결한다 그림 의 핀 코넥터: 120 SC_CON 79 E_CON . 120 9

를 의 시리얼포트에 연결한다 와 가 서로 간섭을 일으킬 수 있으므로 될도록 이면 프로(CONDB9) PC . ISP USART

그램을 다운로드할 때에는 핀 코넥터를 연결하지 않도록 하고 통신을 할 때는 케이블을 연결하지9 USART ISP

않도록 한다.

그림 120 통신을 위한 인터페이스. RS232C

� 프로그램 예 :

#include <mega128.h>
#include <delay.h>
void serial_init(void){ delay_ms(10);

DDRE = 0xfe;
UBRR0H = 0; UBRR0L = 103; // baud rate 9600
UCSR0A = 0; 비동기 모드//
UCSR0B = 0x18; 통신// usart enable,
UCSR1C = 0x06; // no parity, 1 stop bit, 8 data bit

}
void putch(unsigned char ch){ 한개의 문자를 로 송신한다/* pc . */

while((UCSR0A & 0x20) == 0); UDR0 = ch;
UCSR0A |= 0x20; 문자 송신준비완료//

}
void putstrf(flash unsigned char *str){ 문자열을 로 송신한다/* pc . */

unsigned int i=0;
for(;str[i] != 0; i++) putch(str[i]);
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}
void main(void){

serial_init();
putch(0x0d); putch(0x0a); 는 리턴의 는 라인피드의 아스키코드/* 0x0d , 0x0a */
putstrf("MY NAME IS HAN HO CHOI\r\n"); 은 리턴 은 라인피드/* \r , \n */

}

� 과제 다른 글자를 보내는 프로그램를 작성 하여라 그림 의 을 그림 의 에 연결하: . 80 SW_CON 79 D_CON① ②

고 그림 의 을 누를 때마다 글자를 보내게 하는 프로그램을 작성하여라80 SW1 .

5.9.5.5.9.5.5.9.5.5.9.5.5.9.5.5.9.5.5.9.5.5.9.5.5.9.5.5.9.5.5.9.5.5.9.5. 실험 와 통신실험 와 통신실험 와 통신실험 와 통신62 : PC 262 : PC 262 : PC 262 : PC 2실험 와 통신실험 와 통신실험 와 통신실험 와 통신62 : PC 262 : PC 262 : PC 262 : PC 2실험 와 통신실험 와 통신실험 와 통신실험 와 통신62 : PC 262 : PC 262 : PC 262 : PC 2

� 예제 의 키보드를 치면 아스키코드값이 직렬포트를 통해 전송되어 에 연결된 에 표시된다: PC PORTC LED .

� 회로도 그림 의 회로를 구현하고 을 그림 의 에 연결한다 그림 의 핀 코넥터: 120 SC_CON 79 E_CON . 120 9

를 의 시리얼포트에 연결한다 실험을 할 때는 를 닫고 한다(CONDB9) PC . LED_SW .

� 프로그램 예 :

#include <mega128.h>
#include <delay.h>
void serial_init(void){ delay_ms(10); DDRE = 0xfe;

UBRR0H = 0; UBRR0L = 103; // baud rate 9600
UCSR0A = 0; UCSR0B = 0x18; UCSR1C = 0x06;

}
unsigned char getch(void){ 한개의 문자를 에서 수신한다/* pc . */

while((UCSR0A & 0x80) == 0); UCSR0A |= 0x80; return(UDR0);
}
void main(void){

serial_init();
DDRC = 0xff; 포트 를 출력으로// C
for(;;) PORTC = getch();

}

� 과제 타이머 모드 를 사용하는 프로그램를 작성 하여라: 0 2 .

5.9.6.5.9.6.5.9.6.5.9.6.5.9.6.5.9.6.5.9.6.5.9.6.5.9.6.5.9.6.5.9.6.5.9.6. 실험 와 통신실험 와 통신실험 와 통신실험 와 통신63 : PC 363 : PC 363 : PC 363 : PC 3실험 와 통신실험 와 통신실험 와 통신실험 와 통신63 : PC 363 : PC 363 : PC 363 : PC 3실험 와 통신실험 와 통신실험 와 통신실험 와 통신63 : PC 363 : PC 363 : PC 363 : PC 3

� 예제 인터럽트를 이용해 에서 보낸 아스키 코드값을 다시 송신한다: USART PC .

� 회로도 그림 의 회로를 구현하고 을 그림 의 에 연결한다 그림 의 핀 코넥터: 120 SC_CON 79 E_CON . 120 9

를 의 시리얼포트에 연결한다(CONDB9) PC

� 프로그램 예 :

#include <mega128.h>
#include <delay.h>
void serial_init(void){ delay_ms(10); DDRE = 0xfe;

UBRR0H = 0; UBRR0L = 103; // baud rate 9600
UCSR0A = 0; UCSR0B = 0x18; UCSR1C = 0x06;

}
void putch(unsigned char ch){ 한개의 문자를 로 송신한다/* pc . */

while((UCSR0A & 0x20) == 0); UDR0 = ch;
UCSR0A |= 0x20; 문자 송신준비완료//

}
void putstrf(flash unsigned char *str){ 문자열을 로 송신한다/* pc . */

unsigned int i=0;
for(;str[i] != 0; i++) putch(str[i]);

}
interrupt [19] void u0rx(void){

putch(0x0d); putch(0x0a);
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putstrf("Pressed key is ");
putch(UDR0);
putstrf("\r\n"); 은 리턴 은 라인피드/* \r , \n */
UCSR1A |= 0x80;
putch(0x0d); putch(0x0a); 는 리턴의 는 라인피드의 아스키코드/* 0x0d , 0x0a */
putstrf("PRESS ANY KEY!!!!\r\n"); 은 리턴 은 라인피드/* \r , \n */

}
void main(void){

serial_init();
SREG.7 = 1;
UCSR0B |=0x80; 개별 허용// rx interrupt
putch(0x0d); putch(0x0a); 는 리턴의 는 라인피드의 아스키코드/* 0x0d , 0x0a */
putstrf("PRESS ANY KEY!!!!\r\n"); 은 리턴 은 라인피드/* \r , \n */
for(;;);

}

� 과제 인터럽트를 사용하지 말고 프로그램를 작성해보아라: .

5.9.7.5.9.7.5.9.7.5.9.7.5.9.7.5.9.7.5.9.7.5.9.7.5.9.7.5.9.7.5.9.7.5.9.7. 실험 와 통신실험 와 통신실험 와 통신실험 와 통신64 : PC 464 : PC 464 : PC 464 : PC 4실험 와 통신실험 와 통신실험 와 통신실험 와 통신64 : PC 464 : PC 464 : PC 464 : PC 4실험 와 통신실험 와 통신실험 와 통신실험 와 통신64 : PC 464 : PC 464 : PC 464 : PC 4

� 예제 에 연결된 누름 스위치가 눌리면 그 값이 눌렸음을 직렬포트를 통해 에 알리고 표시한다: PORTD PC .

� 회로도 그림 의 회로를 구현하고 을 그림 의 에 연결한다 그림 의 핀 코넥터: 120 SC_CON 79 E_CON . 120 9

를 의 시리얼포트에 연결한다 그림 의 을 그림 의 에 연결한다 또한 그림(CONDB9) PC . 80 SW_CON 79 D_CON .

의 을 누르면서 실험한다80 SW1~3 .

� 프로그램 예 :

#include <mega128.h>
#include <delay.h>
void serial_init(void){ delay_ms(10); DDRE = 0xfe;

UBRR0H = 0; UBRR0L = 103; // baud rate 9600
UCSR0A = 0; UCSR0B = 0x18; UCSR1C = 0x06;

}
void putch(unsigned char ch){ 한개의 문자를 로 송신한다/* pc . */

while((UCSR0A & 0x20) == 0); UDR0 = ch;
UCSR0A |= 0x20; 문자 송신준비완료//

}
void putstrf(flash unsigned char *str){ 문자열을 로 송신한다/* pc . */

unsigned int i=0;
for(;str[i] != 0; i++) putch(str[i]);

}
void main(void){

serial_init();
for(;;){
putch(0x0d); putch(0x0a); 는 리턴의 는 라인피드의 아스키코드/* 0x0d , 0x0a */
putstrf("PRESS ANY KEY!!!!\r\n"); 은 리턴 은 라인피드/* \r , \n */
if(PIND.0 == 0) {putstrf("PRESSED KEY IS D.0\r\n"); 가 눌렸으므로 가 눌렸음을 알린다/* D.0 D.0. . */
delay_ms(50); 시간 지연/* 50msec */
while(PIND.0 == 0);} 가 눌렸다가 안눌린 상태로 복귀할 때가지 기다린다/* D.0 . */
if(PIND.1 == 0) {putstrf("PRESSED KEY IS D.1\r\n"); delay_ms(50); while(PIND.1 == 0);}
if(PIND.2 == 0) {putstrf("PRESSED KEY IS D.2\r\n"); delay_ms(50); while(PIND.2 == 0);}}

}

� 과제 타이머 모드 를 사용하는 프로그램를 작성 하여라: 0 2 .

5.9.8.5.9.8.5.9.8.5.9.8.5.9.8.5.9.8.5.9.8.5.9.8.5.9.8.5.9.8.5.9.8.5.9.8. 실험 와 통신실험 와 통신실험 와 통신실험 와 통신65 : PC 565 : PC 565 : PC 565 : PC 5실험 와 통신실험 와 통신실험 와 통신실험 와 통신65 : PC 565 : PC 565 : PC 565 : PC 5실험 와 통신실험 와 통신실험 와 통신실험 와 통신65 : PC 565 : PC 565 : PC 565 : PC 5

� 예제 프로그램을 실행하면 맨 처음에 터미널프로그램인 하이퍼터미널 화면에 뒤에 설명할: 'P', 'A', 'R', 'I',

명령에 대한 설명이 나타나고 그 다음 이라는 프롬프트가 나타난다 라고 의 키보드를 치면'H' 'Com>> ' . P PC
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라는 문자가 나타나고 이때 진수값을 바이트 입력시키면 그 값이 직렬포트를 통해 전'Enter PortC value!' 16 1

송되어 에 연결된 에 표시된다 라고 의 키보드를 치면 내부메모리 의 값들이 로PORTC LED . A PC 0x00~0xFF PC

전송되어 하이퍼터미널 화면에 나타난다 과 는 내부메모리 범용레지스터의 값과 레지스터의 값들을 하이. R I I/O

퍼터미널 화면에 나타낸다 와 는 메뉴에 대한 설명을 화면에 나타낸다. H ? .

� 프로그램 작성시 유의점 개까지의 문자열 입력을 받기 위한 서브루틴 를 위한 순서도는 그림 과: 10 gets 121

같다 라는 명령에 의해 입력된 값을 에 표시할 때 입력된 값은 아스키코드이므로 이를 진수값으로 변환. P LED 16

할 때 아스키코드로 의 값은 이고 의 값은 의 값은 이라는 점을 염두0~9 0x30~39 , A~F 0x41~46, a~f 0x61~66

에 두어야 한다.

� 회로도 그림 의 회로를 구현하고 을 그림 의 에 연결한다 그림 의 핀 코넥터: 120 SC_CON 79 E_CON . 120 9

를 의 시리얼포트에 연결한다 그림 의 는 닫고 실험한다(CONDB9) PC . 79 LED_SW .

그림 121 직렬통신에 의한 문자열 수신 순서도.

� 프로그램 예 :

#include <mega128.h>
#include <delay.h>
#define DBYTE ((unsigned char *) 0)
#define BS 0x08 백스페이스 정의/* */
unsigned char pstr[10];
void serial_init(void){ delay_ms(10); DDRE = 0xfe;

UBRR0H = 0; UBRR0L = 103; // baud rate 9600
UCSR0A = 0; UCSR0B = 0x18; UCSR1C = 0x06;

}
void putch(unsigned char ch){ 한개의 문자를 로 송신한다/* pc . */

while((UCSR0A & 0x20) == 0); UDR0 = ch; UCSR0A |= 0x20;
}
void putstrf(flash unsigned char *str){ 문자열을 로 송신한다/* pc . */

unsigned int i=0;
for(;str[i] != 0; i++) putch(str[i]);

}
unsigned char asc2hex(unsigned char asc){ 아스키코드를 헥사값으로 바꾼다/* . */

if ((asc >= '0') && (asc <='9')) return (asc - '0');
else if ((asc >= 'A') && (asc <='F')) return ((asc - 'A')+10);
else if ((asc >= 'a') && (asc <='f')) return ((asc - 'a')+10);
else return(0xff);

}
unsigned char hex2asc(unsigned char num){ 헥사값을 아스키코드로 바꾼다/* . */

if(num>=10) return(num+'A'-10); else return(num+'0');
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}
void putstr(unsigned char *str){ 문자열을 로 송신한다/* pc . */

unsigned int i=0;
for(;str[i] != 0; i++) putch(str[i]);

}
void puthex(unsigned char num){ 바이트 헥사값을 바이트의 아스키코드로 변환해서 로 송신한다/* 1 2 pc . */

putch(hex2asc(num>>4)); putch(hex2asc(num&0x0f));
}
unsigned char getch(void){ 한개의 문자를 에서 수신한다/* pc . */

while((UCSR0A & 0x80) == 0); UCSR0A |= 0x80; return(UDR0);
}
void gets(void){ 로부터 개까지의 문자를 수신한다 개 이상의 문자는 무시된다/* pc 10 . 10 . */

unsigned char ch, sindex=0;
gets1: ch = getch();

putch(ch);
if(ch == BS ){ if(sindex == 0) putch(' ');

else { pstr[--sindex] = 0x0d; putch(' '); putch(BS); }
goto gets1;

}
else { if(sindex != 10){

if(ch != 0x0d) {pstr[sindex++] = ch; goto gets1;}
else {pstr[sindex] = ch; putch(0x0a);}

}
}

}
void psubrt(void){ 메뉴의 서비스 루틴/* P */

DDRC = 0xff; 를 출력으로 설정// PORTC
psubrt1: putstrf("\r\nEnter PortC value ! : ");

gets();
if(pstr[0] != 0x0d){
PORTC = ~((asc2hex(pstr[0]) << 4) | asc2hex(pstr[1]));
goto psubrt1;}

}
void asubrt(void){ 메뉴의 서비스 루틴/* a */

unsigned char i,j;
putstrf("\r\n\r\n\r\n");
putstrf("Address 00--01--02--03--04--05--06--07--08--09--0A--0B--0C--0D--0E--0F\r\n");
putstrf("------+---+---+---+---+---+---+---+---+---+---+---+---+---+---+---+---\r\n");
do{
putstrf(" 0x"); puthex(j); putstrf(" : "); 내부 램의 번지를 로 송신/* pc */

for(i=0;i<=15;i++){ 내부 램의 값 개를 로 송신/* 16 pc */
puthex(DBYTE[j++]); putstrf(" "); }

putstrf("\r\n"); } while(j != 0);
}
void rsubrt(void){ 메뉴의 서비스 루틴/* r */

unsigned char i,j;
putstrf("\r\n\r\n\r\n");
putstrf("Address 00--01--02--03--04--05--06--07--08--09--0A--0B--0C--0D--0E--0F\r\n");
putstrf("------+---+---+---+---+---+---+---+---+---+---+---+---+---+---+---+---\r\n");
do{ putstrf(" 0x"); puthex(j); putstrf(" : ");

for(i=0;i<=15;i++){ puthex(DBYTE[j++]); putstrf(" "); }
putstrf("\r\n"); } while(j != 0x20);

}
void rsubrt(void){ 메뉴의 서비스 루틴/* i */

unsigned char i,j=0x20;
putstrf("\r\n\r\n\r\n");
putstrf("Address 00--01--02--03--04--05--06--07--08--09--0A--0B--0C--0D--0E--0F\r\n");
putstrf("------+---+---+---+---+---+---+---+---+---+---+---+---+---+---+---+---\r\n");
do{ putstrf(" 0x"); puthex(j); putstrf(" : ");
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for(i=0;i<=15;i++){ puthex(DBYTE[j++]); putstrf(" "); }
putstrf("\r\n"); } while(j != 0x60);

}
void hsubrt(void){ 메뉴/* help */

putstrf("\r\n-----------------------------");
putstrf("\r\n H : Help ");
putstrf("\r\n ? : Help ");
putstrf("\r\n P : Output 0xXX to PortC ");
putstrf("\r\n A : Dump memory 0x00~FF ");
putstrf("\r\n R : Dump R0~R31 ");
putstrf("\r\n I : Dump I/O memory ");
putstrf("\r\n-----------------------------\r\n");

}
void main(void){

serial_init();
hsubrt();
for(;;){ putstrf("\r\n\r\nCom >> ");

gets(); 문자열을 입력받는다/* . */
switch(pstr[0]){

case 'P': psubrt(); break; case 'p': psubrt(); break;
case 'A': isubrt(); break; case 'a': isubrt(); break;
case 'R': isubrt(); break; case 'r': isubrt(); break;
case 'I': isubrt(); break; case 'i': isubrt(); break;
case 'H': isubrt(); break; case 'h': isubrt(); break;
case '?': isubrt(); break; case '?': isubrt(); break;
case '\r': break;
default: putstrf("\r\n\r\nINVALID COMMAND!!\r\n");

}
}

}

� 과제 문자열 입력을 인터럽트를 사용해서 받는 것으로 구현해보라 데이터 값을 읽거나 쓰: . EEPROM① ②

는 메뉴 아니면 포트 에 쓰거나 값을 읽어 들이는 등의 다른 메뉴도 구현해 보라A, B, D, F .
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7.7.7.7.7.7.7.7.7.7.7.7. 색인색인색인색인색인색인색인색인색인색인색인색인

특수문자와 숫자특수문자와 숫자특수문자와 숫자특수문자와 숫자( )( )( )( )

! 60

# 32, 57

$ 31

% 60

& 60, 65

* 60, 65, 66

*/ 57

*= 61

+ 58, 60, 65

++ 60

+= 61

, 60, 64

- 58, 60, 65

-- 60

-= 61

-> 67

. 67

/ 60

/* 57

// 57

/= 61

: 30, 62

; 30, 56

< 60

<< 60

= 61

> 60

>> 60

@ 31

[ 64, 66

\ 57

] 64, 66

^ 60

_ 30, 58

{ 56, 64

| 60

} 64

~ 60

진수10 58

진수16 58

2SA1015Y 134

2SB601 134

2SC1815Y 118, 134

2SD560 134

74LS46 109

74LS47 109, 110

진수8 58

(A)(A)(A)(A)

변환기A/D 143

A1273Y 134

ACI 148

ACIE 148

ACME 148

ACSR 148

ADC 21, 143

ADC0804 143

ADCH 144

ADCSRA 144

ADD 27

ADEN 144, 149

ADIF 144

ADMUX 144

AEC 42

ALE/PROG 4

AND 27

asm 64

ASSR 90

AVR ISP 42

AVR studio 42

(B)(B)(B)(B)

BCD 70, 71

BDX53C 134

BDX54C 134

bit 59

BLD 27

BOOTRST 16

BOOTSZ 16

BRBS 27

BRCS 27

BREAK 27

break 61, 62
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BRTS 27

BSET 27

BYTE 31

(C)(C)(C)(C)

C3205Y 134

CALL 27

case 61

CBI 27

CBR 27

char 58

CISC 1, 3

CLI 27

CLR 27

Codevision 43

COM 27

const 59

continue 62

CP 27

CSEG 30

CTC 91, 98

(D)(D)(D)(D)

변환기D/A 140

DAC 141

DAC0800 141

DATA 31

DB 31

DD 31

DDRx 74

DEC 27

DEF 31

default 61

define 31, 57, 59

delay.h 73

do 62

double 58

DQ 31

DSEG 30

DW 31

(E)(E)(E)(E)

EEAR 12

EECR 12

EEDR 12

EEPROM 12, 68

eeprom 59

EICRA 85

EICRB 85

EIFR 85

EIMSK 85

ELIF 31

elif 57

ELPM 27

ELSE 31

else 31, 57, 61

endasm 64

ENDIF 31

endif 31, 57

ENDM 31

ENDMACRO 31

enum 67

EOR 27

EQU 30, 31

ERROR 32

ESEG 30

ETIFR 97

ETIMSK 96

extern 64

(F)(F)(F)(F)

flash 59

float 58

FMUL 27

FND 109

for 62

FR105 134

Fuse 16

(G)(G)(G)(G)

goto 62

(H)(H)(H)(H)

HD44780 122

브리지H 133

(I)(I)(I)(I)

I/O 8, 10

ICALL 27

ICE 40
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ICR 95

모드Idle 20

IF 31

if 57, 61

IFDEF 31

ifdef 57

IFNDEF 31

ifndef 57

IJMP 27

IN 27

INC 27

INCLUDE 31

include 31, 57

int 58

interrupt 63

ISP 1, 3, 41, 54

(J)(J)(J)(J)

JMP 27

(L)(L)(L)(L)

L298 134

Label 30

LABEL 30

label 62

LCD 109, 122

lcd.h 125

LD 27

LDI 27

led 76

long 58

LPM 27

LSL 27

(M)(M)(M)(M)

MACRO 31

main 57, 62

math.h 63

MAX232 154

MCUCR 14, 20, 83

MCUCSR 25

mega128.h 76

MISO 3

MOSI 3

MOV 27

MOVW 27

MUL 27

(N)(N)(N)(N)

NEG 27

NOP 27

(O)(O)(O)(O)

OCR 89, 94

OP 27

Operand 27

OR 27

ORG 31

OUT 27

(P)(P)(P)(P)

PINx 74

POP 27

PonyProg2000 42

PORTx 74

pragma 64

Prescaler 89

PUSH 27

PWM 92, 93, 98, 99, 106, 107, 139

(R)(R)(R)(R)

RAMPZ 10

RCAL 27

RET 27

return 63

RISC 1, 3

RJMP 27

ROL 27

RS232C 150, 154

RST(ReSeT) 5, 74

(S)(S)(S)(S)

SBC 27

SBI 27

sbit 59

SBR 27

SCLK 3

SEC 27

SEI 27

SEN 27
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SER 27

SET 27, 31

SFIOR 74, 91, 148

sfrb 59

SLEEP 27

Sleep 20

SPCR 151

SPI 3, 41, 150

SPI2X 152

SPIE 151

SPIF 151

SPM 27

SPSR 151

SRAM 10

SREG 9

ST 27

static 64

stdio.h 63

stdlib.h 63

string.h 63

struct 66

SUB 27

SWAP 27

switch 61

Symbol 30

(T)(T)(T)(T)

TCCRn 89

TCCRxA 95

TCCRxB 95

TCCRxC 96

TCLK 94

TCNTn 89

TCNTx 94

TIFR 90, 97

TIMSK 90, 96

TOVn 89

TOVx 94

TST 27

typedef 66, 67

(U)(U)(U)(U)

UBRRn 154

UCSRnA 152

UCSRnB 153

UCSRnC 153

UDRn 152

UNDEF 31

undef 31, 57

union 67

unsigned 58

USART 152

(V)(V)(V)(V)

void 57, 63, 66

volatile 68

(W)(W)(W)(W)

WARNING 32

Watchdog 3

WDTCR 25

while 62

(X)(X)(X)(X)

레지스터X,Y,Z 8

XDIV 20

XMCRA 14

XMCRB 14

ᄀᄀᄀᄀ( )( )( )( )

간접지정 27

ᄂᄂᄂᄂ( )( )( )( )

내부램 7

ᄃᄃᄃᄃ( )( )( )( )

도트 67

동적구동 110

디버깅 37, 51

ᄅᄅᄅᄅ( )( )( )( )

라벨 30

레지스터지정 27

롬라이터 41

롬에뮬레이터 40

리셋 22

리턴데이터형 63

ᄆᄆᄆᄆ( )( )( )( )

메모리 LOCK 15
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명령코드 27

모터 129

문자 58

문장 56

ᄇᄇᄇᄇ( )( )( )( )

발진회로 17

배열 64

범용 레지스터 8

변수 58

블록 56

비교기 147

ᄉᄉᄉᄉ( )( )( )( )

상수 58

상태레지스터 9

소스파일 57

숫자 58

스택 10

스텝모터 129

스톱워치 105, 112

시간지연 73

시계 111, 113, 128

심볼 56

ᄋᄋᄋᄋ( )( )( )( )

오퍼랜드 27

외부롬 68, 69, 70

외부변수 64

음계 117

음향 117

인수 57, 62, 63

인터럽트 82, 105

ᄌᄌᄌᄌ( )( )( )( )

전역변수 63

정적변수 64

주소지정방식 27

지시어 56

지역변수 63

직렬통신 117

직류모터 137

직접상수지정 27

직접지정 27

ᄎᄎᄎᄎ( )( )( )( )

채터링 78

ᄏᄏᄏᄏ( )( )( )( )

카운터 104

키보드 115

키워드 56

ᄐᄐᄐᄐ( )( )( )( )

타이머 88, 105

터미널프로그램 154

ᄑᄑᄑᄑ( )( )( )( )

포인터 64, 65

프로그램 56

프로토타입 57, 62

ᄒᄒᄒᄒ( )( )( )( )

하이퍼터미널 154

함수 63

헤더파일 57


